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1 SYSTEM DESCRIPTION

1.1 Introduction
The Seafloor Information System (SIS) is a real time software
designed to be the user interface and real time data processing
system for hydrographic instruments produced by Kongsberg
Maritime.
SIS is included on all deliveries of multibeam echo sounders
from Kongsberg Maritime. SIS can also log data from single
beam echo sounders supplying output data on NMEA format, or
from standalone navigation systems.
SIS operates under Windowst as well as Linuxt operating
systems, and is compatible with the HWS 10 Work Station
hardware. One or two display screens can be used.
The design of the SIS is based on more than 50 years of
hydrographic experience with echo sounders, sonars and
underwater positioning for civilian and military use. Kongsberg
Maritime is today a part of the Kongsberg Group, a world wide
organisation supplying advanced instrumentation for civilian,
research and military maritime communities.
The Kongsberg Maritime echo sounders are complete systems.
All necessary sensor interfaces, data displays for quality control
and sensor calibration, seabed visualization, and data logging
are standard parts of the systems, as is integrated seabed
acoustical imaging capability (sidescan).

Figure 1 Instrument interfaces
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1.2 SIS system information
Operating systems supported:
• Windows XPt
• Linuxt
Hardware supported:
• HWS 10 / HWS 11 or equivalent
• 1 or 2 displays
License control:
• By dongle connected to USB port
Options/versions:
• Basic/Instrument control
• Multibeam echo sounder support
• Real time data cleaning
• Water column imaging
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1.3 SIS licenses
The SIS software is subject to license control. Licensing of SIS
is controlled by a HASP dongle. This dongle is programmed
according to what SIS version has been purchased.
A licensed version of SIS contains all functionality available,
and will then be complete software for operation. However,
there are two options for multibeam echo sounders:
• Water column data storage
• CUBE implementation
The control part of SIS is unlicensed. This version gives access
to the following applications:
• Installation and runtime parameters
• Start/stop logging
• Survey administration
• New survey
• Messages, Beam intensity, Cross track, Time series, Seabed

image, Numerical display and Water column windows
An unlicensed version of SIS will also work as an interface to
third party software.
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The figure below shows the principle drawing of the hardware
setup with the SIS software package, integrated with single
beam or multibeam echo sounder systems.
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Figure 2 Principle drawing, hardware setup with SIS
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1.4 SIS system overview

Introduction
The main task of SIS is to be a logical and user friendly
interface to the surveyor, providing him with the functionality
that he needs for running a survey efficiently.
The main features of SIS are:
• Control of both single- and multibeam echo sounders
• Real Time Data Cleaning module. This module processes first

a set of pings from the current line, but also does area based
processing where all previous data from the same area is
processed together.

• Real time terrain models are built from the cleaned dataset
• 3D-displays using OpenGL
• C-MAP background maps can be used as underlay for the

survey
• Import of xyz-data from other sources (such as Neptune) can be

used as background maps

Basic version/instrument control
With this you can select which instrument to operate, switch the
instrument on or off, change setup and operating parameters,
record/export data, and you have access to graphic windows for
simple quality checking of the data produced. Sound velocity at
the transducer and sound velocity profile is interfaced and
handled.
Instrument control also includes activation of instrument
hardware testing, and reporting of error situations and system
messages.
The Geographical window can be displayed in 2D or in 3D. In
2D mode it will typically include a background map (DXF,
C-MAP and KSGPL formats supported), planned survey lines, a
vessel symbol, and a raw (limited) or gridded (unlimited)
representation of sounding data which has been collected. There
is functionality for defining and editing survey lines, and for
selection of information content.
The geographical window can be zoomed and panned, it can
also follow the vessel position automatically.
The real time gridding which takes place for the sounding data,
updates a multiple resolution grid, and the display resolution is
adjusted automatically to fit the scale. In this way one can view
large areas efficiently, and one can zoom in to a smaller area and
view the data with a high resolution.
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Grid models based upon previous surveys can be imported for
comparison purposes.
In 3D mode, the seafloor surface can be viewed from different
angles/resolutions, the light source can be shifted, and one can
rotate the surface in order to obtain the best view.
Screen dumps or just one display window can be copied to a
graphic printer. The resolution of the plot is then given by the
display resolution.

Multibeam echo sounder support
Licensed multibeam support gives access to:
• More QA views for the multibeam data
• System calibration
• Visualisation of high resolution seabed backscatter data
• Plotting of survey results with full plotter resolution
• Support for remote Helmsman Display, connected via

Ethernet

Real time data cleaning
SIS includes efficient algorithms for automatic flagging of
soundings which should be eliminated from the survey results.
The soundings are not physically removed from the data set, so
it is possible to reverse the decisions and apply a completely
new data cleaning during post processing. However, for the
majority of user needs, the real time data cleaning will be
satisfactory so that further processing is made either not
necessary or at least reduced substantially. The cleaning
algorithms are based on the Tukey algorithms.

Water column imaging
Some multibeam echo sounders, depending on model and
purchased options, have built-in support for imaging of acoustic
reflectors also in the water column. Such reflectors are for
example fish or other biomass, but can also be submerged
buoys, moorings or mines.
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1.5 SIS operational principles

General
Some parameters need starting values from the operator
depending on type of operation and water depth.
You may start by loading a predefined set of parameters, stored
in a database, and then modify some of the individual
parameters observing the effect on the displayed data. The
modified parameters, including all the remaining parameters,
can then be stored as a user specified set-up.
All parameters, as well as all the survey information, are stored
in a database. The raw data is stored to disk.
The experienced operator may wish to optimise system
performance by adjusting several of the parameters in the
system. When the results are as desired, the current parameters
set may be stored in a database for later retrieval.
The operators are assumed to have reasonable detailed
knowledge about Windows XP or Linux operating system(s)
and some familiarity in using them.

System interaction
All interactions between operator and the system take place
through the windows system on the Operator Station. The
following input tools are used:
• Keyboard
• Pointing device (by default an optical mouse with scroll

wheel)
Navigating in the menus, tabs and dialogue boxes is done with
the pointing device. The keyboard is used for entering numerical
and character strings into the parameter fields.

Survey handling
Every echo sounder logs data to a survey. If the user does not
create a survey, data will be logged to a predefined “fallback”
survey.
The user can define his own default surveys. A default survey
contains information about where to store the raw and processed
data on the disks, what projection to use, coastlines to display
etc.
When the user creates a new survey, he can use a default survey
as a template for the new survey. This may save a lot of
parameter definitions.
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1.6 SIS as a Controller

This manual also describes the use of SIS as an interface
between Kongsberg Maritime’s multibeam echo sounders and
third party data acquisition software packages. The two third
party software packages that has been tested and verified by
Kongsberg are at this moment Hypack ® and Qinsy ®. When
SIS is working as a controller, the full SIS functionality is not
needed.

An unlicensed version of SIS will work as a controller. The
purpose of this is as follows:

• Provide installation parameters needed by the Processing
Unit in real-time

• Provide run-time parameters (ping rate, coverage etc.)

• Operation and activation of the echo sounder

• Export of echo sounder datagrams to the third party software
package

• Data logging in Kongsberg format

The data logging above is only provided for testing and debug
in case of problems with the equipment. In this case all
installation settings have to be set correctly inside the controller.
In addition, position, gyro and attitude must be interfaced to the
processing unit. When SIS operates as a controller, the
following will not be a part of the controller and should be
provided by the third party software:

• Installation parameters to calculate the correct depths (not
needed by the sounder in real-time)

• Calibration

• Quality control of the data

• Data logging for daily operation

• Data cleaning and post-processing

• Creation of DTM, charts, printouts etc.

The installation values needed in the controller will only be the
one needed by the echo sounder itself to export quality data to
third party software. Example: If the echo sounder is roll
stabilized, it needs roll data, correct installation angles for
motion sensor and sonar head.
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Hypack ®
The Hypack software package will threat the echo sounder as a
separate sensor and provide the drivers for interfacing. The
motion data needed for correction of the echo sounder data is
read from the network (provided by the sounder) together with
the range data. The position is interfaced and logged by Hypack
in a standard way (read from serial line).

Note The motion data provided by the echo sounder is moved from
it’s initial position to the location of the echo sounder. This is
done inside the echo sounder Processing Unit.

Qinsy ®
Qinsy read the echo sounder range datagrams from the network
and all other sensors are interfaced by Qinsy directly. In other
words position and attitude data is interfaced to a serial line
directly on the Qinsy PC. To provide correct timing of depths
and attitude data the Qinsy PC and the Processing Unit need to
be synchronized. This is done by connecting a 1PPS cable from
the position system to the echo sounder Processing Unit as well
as the Qinsy PC itself. In addition ZDA clock datagrams has to
be provided to the two units. If the echo sounder is roll
stabilized then roll data has to be sent to the Processing Unit.
→ For detailed information on the setup of software from Hypack

or Qinsy, refer to the manufacturer’s documentation.

Note Data logged in the Kongsberg format has been timetagged in
the Processing Unit of the echosounder. This means that the time
tagging is accurate and reliable. If other logging systems are
used, the time tagging of the data is the responsibility of that
logging software if they bypass these files.
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1.7 Terminology and abbreviations
This list gives a short explanation on some of the application
components and the most common abbreviations.

Terminology

Application components

Combo box - A dialogue box option that is a text box with an
attached list box. The list can be visible or it can be a closed
version of a combo box with an arrow next to it. Clicking the
arrow opens the list. Users can either type or select their choice.
Check box - A square box that is selected or cleared to turn on
or off an option. More than one check box can be selected.
Dialogue box - Dialogue boxes contain command buttons and
various kinds of options through which users can carry out a
particular command or task. For example, in the “Save As”
dialogue box, the user must indicate in which folder and under
what name the document should be saved.
Tab - A parameter sheet that contains a labeled group of options
used for many similar kinds of settings.
Text box - A rectangular box in which the user can type text. If
the box already contains text, the user can select that default text
or delete it and type new text.

Transducer Array / Sonar Head

All multibeam echo sounder systems use transducer arrays but
in some models the transducers are integrated in sonar heads.
→ Refer to the installation manual to find out more about your

system .

Abbreviations
The following abbreviations are used in this document:
1PPS - One Pulse Per Second synchronixation signal
ABDC - Area Based Data Cleaning
APB - Autopilot format B sent by SIS/planning stations to
allow them to be used to control an autopilot unit
AUV - Autonomous Underwater Vehicle
BD - Bottom detection
BIST - Built-In Self Test
BS - Backscatter
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BSP - Beamforming and Signal Processing
CCU - Central Command Unit, the software unit that controls
all echo sounders
CMG - Course made good, course from beginning of planned
line
COG - Course over ground
CPU - Central Processing Unit
CUBE - Combined Uncertainty and Bathymetry Estimator
CW - Clockwise
CCW - Counterclockwise
DBS - Depth below surface
DBT - Depth below transducer
DDS - Data Distribution System, responsible for logging
datagrams
DPT - Depth
DST - Distance to end of line
DTK - Desired track, direction of planned line
DTM - Digital Terrain Model
DXF - Data Exchange File, a three-dimensional graphics file
format
EA - A type of singlebeam echo sounder
EM - A type of multibeam echo sounder
ETA - Estimated time of arrival
GGA - Global Positioning System Fix Data (time, position and
fix related data for a GPS receiver)
GGK - Position
GMT - Greenwich Mean Time
GPS - Global Positioning System (in this manual GPS includes
all kinds of positioning systems)
GUI - Graphical User Interface
HDDS - Handle Data Distribution System, read from disk the
data written by the DDS and process the data to xyz
HDM - Heading, magnetic
HDOP - Horizontal Dilution Of Precision
HDT - Heading, true
HWS 10 - Hydrographic Work Station
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IP - Internet Protocol
IRLS - Iterated Reweighted Least Squares
KSGPL - Kongsberg SIS Graphic Programming Language
LBDC - Line Based Data Cleaning
LOD - Level Of Detail
ODBC - Open DataBase Connectivity, a standard database
access method
OpenGL - A 3-D graphics language
PU - Processing Unit (for multibeam echo sounders with a
Transceiver Unit, the PU is included in the TRU)
RAM - Random access memory
RGB - Red, green and blue (primary colours on a computer
monitor)
ROV - Remotely Operated Vehicle
RTDC - Real Time Data Cleaning, the real time processing tool
in SIS
RTK - Real Time Kinematic
RX - Receiver
SCSI - Small Computer System Interface, a parallel interface
standard
SH - Sonar Head
SIS - Seafloor Information System, the new front-end for all
echo sounders
SISDB - SIS Database, the database used by SIS to store
parameters
SOG - Speed over ground
SQL - Structured Query Language, a standardized query
language for requesting information from a database
SSP - Sound speed input diagram
SV - Sound velocity sensor
SV&P - Sound velocity and depth (pressure) sensor
SV&T - Sound velocity and temperature sensor
TCP - Transmission Control Protocol
TRU - Transceiver Unit
TVG - Time Variable Gain
TVG FG - TVG Fixed Gain
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TVG NIB - TVG Normal Incidence Backscatter
TVG OB - TVG Oblique Backscatter
TVG RN - TVG Range To Normal Incidence
TX - Transmitter
UDP - User Datagram Protocol, a connectionless protocol
UPS - Universal Polar Stereographic
UTC - Universal Time Conversion
UTM - Universal Transverse Mercator
VRML - Virtual Reality Modeling Language, a specification for
displaying 3-D objects
WGS84 - World Geodetic System 1984
XTE - Cross track error, measured, distance to planned line
ZDA - UTC and local date/time data
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2 GRAPHICAL USER INTERFACE

2.1 The application window
All interactions with the system take place via a windows based
interface on the Operator Station.

The application window is divided into several frames that
display different types of information. Depending on what kind
of instrument you are using, different options will appear. A
principle drawing of the application window is displayed below.

Title and info bar
Main menu
Toolbar

(CD22003)

Frame # 1

Frame # 2

Frame # 3

Frame # 4

Frame # 5

Frame # 6

Frame # 7

Frame toolbar

Frame toolbar

Frame toolbar

Frame toolbar

Frame toolbar

Frame toolbar

Frame toolbar

Figure 3 Principle drawing - the application window

Brief descriptions of the various frames and menus are given
here:
→ Frame contents, page 66.
→ Menus, page 287.
→ Toolbar, page 339.
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SIS defines a screen layout with up to seven simultaneous
display windows (or frames). The boundaries between the
frames can be shifted so that the frame sizes are adjusted to the
user needs, but the system will make sure that no display frame
is ever hidden behind another one. The information contents of
each display frame can be changed according to the needs.
SIS has many windows, but there are always seven frames. The
operator can choose from a list of windows for each frame, and
he can save and read his own set up.
The frames are designed so that they will never overlap. This
makes it impossible to hide one window behind another. The
operator can change the size of the frames by moving the
slide-bars. The four frames on the left are separated by three
slide-bars which can be moved up and down, and the two
frames in the middle are also separated with a slide-bar. There is
also a slide-bar to the left of the four frames, and there is a
slide-bar at the frame to the right.
The menu bar at the top contains common actions such as
save/read settings, exit etc.
The next menu bar contains basic controls for all echo sounders.
There are dropdown lists for surveys and survey settings, and
for detected echo sounders and the echo sounder currently being
operated. There are also control buttons to rescan for echo
sounders, start/stop logging or pinging and line counting. Status
lamps indicates hardware status for multibeam echo sounders.
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2.2 SIS windows
The various windows available in the SIS display are:
• Geographical
• Beam intensity
• Cross track
• Seabed image
• Numerical display
• Message service
• Helmsman Display
• Colour coded depth
• New survey
• Survey administration
• Planning module
• Time series
• Waterfall
• Water column
• Sound velocity profile
• Scope display
• Stave display
• Installation parameters
• Runtime parameters
• Calibration

Note Not all windows are available for single beam echo sounders
and GPS-equipment.

→ An example of a SIS frame setup is displayed in figure 4.
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Figure 4 Example of SIS frame setup

Geographical
The Geographical window is used to display all geographical
data such as:
• C-MAP background maps
• DXF-files
• Terrain models generated form ASCII xyz-files
• Terrain models from surveys
• Geographical net (geographic and projection net)
• Other kinds of background data from ASCII-files.
It is possible to display several terrain models at the same time,
both the terrain model that is being generated by the current
survey and terrain models generated from previous surveys. If
the data is in ASCII xyz-files, a terrain model can be generated
and displayed as background data.
• Depth difference in each grid cell
• Number of points inside each grid cell
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The Geographical window use OpenGL for smooth rendering.
This means that all views are 3D-enabled and can be rotated in
any direction.
SIS uses projection coordinates to display the data. The
projection set-up is done in the New survey or Survey
administration tabs. The user can define his own projection or
choose from a wide range of predefined projections. A
7-parameter datum transformation is also available.
The Geographical window can display a lot of different
information. The operator can select from a long list of features
what to display.
Note that the terrain models can display a lot of features, such as
the distance from the sonar head to the seafloor (Z) and tide
corrected depth using a tide file (Zt). If Real Time Kinematic
GPS and a geoid model is available, the tide corrected depth
(Zv), the distance from the sea floor to the geoid (Zg) and the
distance from the sea floor to the ellipsoid (Zr) can also be
displayed.
For each grid cell the operator can choose if he wants to see the
minimum, median or maximum depth. Note that SIS calculates
the median depth, not the mean depth for each cell. The mean
depth is an artificial depth which has not been measured, but the
median is a real, quality controlled measured depth.

Beam intensity

The Beam intensity window shows the signal strength for each
beam. Blue means amplitude detection and red is phase
detection. Green indicates the quality for each measurement.

Cross track

The Cross track window shows the depth from each beam, and
the x-axis can either be meters or beams. Blue is amplitude
detection and red is phase detection.

Seabed image

The Seabed image window logs seabed image data. The
resolution in across direction depends upon the size of the
window, the width of the swath and the resolution of the sonar.
In the across direction a grid will be created to give the highest
possible resolution in the window, and then each and every ping
is stacked on top of each other.

Numerical display

The Numerical display window shows 26 different parameters at
any time. The operator can choose from a list which parameter
to display in any of the 26 fields.
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There is also some error indication in this window. If one
parameter goes beyond its limits, the background will change to
yellow (warning) or red (error). This makes it possible to see if
there is a problem with some parts of the equipment (i.e. if the
PPS is sometimes dropping out). Errors found in the Numerical
display window are logged in the Message service window.
Message service
All messages from SIS are stored in the SIS database, SISDB.
The operator can open the Message service window and see all
messages that have arrived, and when they arrived. One can
mask certain types of messages and write the messages to a file.
One can also choose which time frame to display the messages
between.
Helmsman Display
The Helmsman Display window is usually used together with
the Planning module.
When the operator has selected a planned line for surveying, the
Helmsman Display window will show status information to the
helmsman:
• Current position
• Speed over ground (SOG)
• Depth (DPT)
• Course over ground (COG)
• Direction of planned line (desired track, DTK)
• Course from beginning of planned line (Course Made Good,

CMG)
• Distance to planned line (crosstrack error, XTE)
• Estimated time to arrival (ETA)
• Distance to end of line (DST)
There is also a history of XTE and a graphic presentation of the
XTE and the operator can choose which of these parameters to
display.
Colour coded depth
The Colour coded depth window shows the depth from each
beam directly. The y-axis is always time and the x-axis is
always beam number.
New survey
In the New survey window the user creates a new survey. A new
survey can be of a predefined type which makes it easy to define
such things as the projection, background data and storage
location for the survey. Normally only the survey name and a
comment is required.



Seafloor Information System / Base version

20 850-164709 / E

Survey administration
In the Survey administration window the operator can define
survey types. A survey type define such things as projection,
background data to display and where the survey shall be stored
on disk. Normally the default set-up can be used, but the
operator is free to define any of these parameters at will.
Planning module
The operator can choose to set the Geographical window in
Planning mode. One can then create planned lines, create
parallel lines, define the survey area and fill it with parallel lines
etc. One can save the planned lines to a planned job, and read a
planned job from disk.
Time series
The Time series window is used to display different kinds of
time series. Normally heave, roll and pitch from the active
sensor is displayed. The following can also be displayed:
• Depths from four beams selected by the user
• Depth below the water surface for the most vertical beam.
• Depth of the centre beam
• Single beam and multibeam depths for comparison
• Height
• Heave, roll and pitch from active and/or inactive motion

sensor
Waterfall
The Waterfall window is fully implemented with 3D
capabilities. The operator can zoom, pan and rotate freely in 3D,
and the z-axis can be exaggerated to see small objects better.
Water column
The Water column window shows a graphical representation of
the beamformed data for the entire water column for each beam.
This window is only valid for echo sounders with water column
capabilities.
Sound velocity profile
SIS uses the depths generated in the Processing Unit. This
means that the depths have already been corrected for sound
speed profile. The current sound speed profile in use by the
Processing Unit is shown in the Sound velocity profile window.
Scope display
The Scope display window can be used to investigate the
receiver echo data, and is used mainly for test purposes. The
data is not logged. This window is valid for multibeam echo
sounders.
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Stave display

The Stave display window shows a graphical representation of
the signal level of all of the receiver elements (i.e. staves). This
can be helpful for debug and for performance checks (display of
interference signals, air bubbles, saturation, etc.) The data is not
logged. This window is valid for multibeam echo sounders with
stave display capabilities.

Installation parameters

The Installation parameters window is used to set constant
installation parameters such as the distance from the reference
point to the sonar head, motion reference unit and the position
sensors. These parameters are normally set only once, but may
need some calibration before they are found. The parameters
can not be modified during operation.

Runtime parameters

The Runtime parameter window contains parameters that can be
changed by the operator, such as mode, sound speed profile,
filter settings and so on.
In addition the operator may set the parameters employed by the
Real Time Data Cleaning module using the dialogue shown.

Calibration

In the Calibration window the operator will see a cross-section
of the data from the selected survey lines. The operator will set
the Geographical window in calibration mode, select the survey
lines to use (at least two), and then define the cross-section.
Then he can change the pitch, roll, heading and time offsets and
see the impact in the calibration window. The offsets must then
be put into the installation parameters.
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2.3 Keyboard and mouse operations
The Left mouse button is used to perform a selected operation in
the graphic window. The user selects what operation to perform
by selecting a pushbutton in the toolbar attached to the window.
The Right mouse button may also be used to perform operations
in some cases.
The operator has also direct access to operations by using the
mouse and keyboard as described in the table below:

Mouse and key-
board

Function Windows Operation

Left mouse button Zoom to region Geographical
Sound velocity
profile
Stave display
Water column

Press the Left mouse
button, drag the mouse
to a new area and then
release the mouse but-
ton.

Left mouse button
+ Ctrl key

Selection and
editing functions

Hold down the Ctrl key,
then click the Left
mouse button to select
or edit an object.

Right mouse
button

Quick menu Geographical
Calibration

Click the Right mouse
button to open a quick
menu.

Right mouse
button + Shift key

Rotation Waterfall Hold down the Shift
key, right click the grid
and drag the mouse.

Right mouse
button

Panning Geographical Right click in the grid,
hold down and drag the
mouse.

Right mouse
button + Alt key

Panning Waterfall Hold down the Alt key,
right click the grid and
drag the mouse.

Mouse wheel Zooming Geographical
Waterfall

Scroll the mouse wheel
forward to zoom the
view in, scroll backward
to zoom out.

Mouse wheel +
Ctrl key

Zooming Sound velocity
profile

Hold down the Ctrl key
and scroll the mouse
wheel forward to zoom
the view in, scroll back-
ward to zoom out.
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Mouse and key-
board

OperationWindowsFunction

Mouse wheel +
Alt key

Panning Sound velocity
profile

Hold down the Alt key
and scroll the mouse
wheel forward to pan
the view up, scroll back-
ward to pan down.

Ctrl key + S key Screen capture Complete SIS
application

Saved to file to the di-
rectory /sisdata/com-
mon/screendumps.
*.bmp for Windows and
*.png for Linux. Current
date and time is in-
cluded in the filename.
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3 OPERATIONAL PROCEDURES

3.1 Introduction
This chapter presents the most important operational procedures
required to operate the SIS software.

Note The SIS software is used by single beam or multibeam echo
sounders. When you run a survey, you can log data from more
than one system at a time. This implies that not all information
herein will be relevant for all systems. This is further explained
for each window.

SIS is operated in online or offline mode.
• The online mode is used during the survey. The application

is then used to control the (multibeam) echo sounder, to store
the data, and to present various views of the data for quality
assurance.

• The offline mode is used after the survey has been
completed, and the data is stored on disk. The application is
then used to view the results of the survey.

The standard SIS application will generate a full documentation
of the survey results, and provide output for survey statistics,
contour charts, illuminated plots etc. For some purposes this
may be sufficient, but normally the post-processing packages
available are used for data cleaning, image processing and final
chart production.
Main operational procedures on how to start and exit SIS, plan
and run a survey, set installation and runtime parameters etc. are
described in this chapter.
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3.2 Prepare for use

When you log in, two programs will start automatically:

• Licence server

• Web-server

The licence server connects to the dongle, and provides you
with the licenc(es) you have bought. The web-server called Jetty
is used by SIS. You can close these programs, but remember to
start them before you start SIS (normally done automatically).

The multibeam echo sounders broadcasts their existence on the
network. The single beam echo sounders and the sensors
transmitting NMEA datagrams must be set up manually in SIS.

The external sensors, connected directly to the HWS 10, as
sound velocity probe, heading and position sensors are
registered in the External sensors found on the Tools menu.
Single beam echo sounders and other isntruments transmitting
NMEA datagrams must also be registered manually. Use the
Add instruments combinations found on the Tools menu.
Afterwards they are handled the same way as echo sounders that
broadcast their existence on the network.

When the SIS program starts it will automatically scan the
network for connected echo sounders. This will normally take
approximately 10 seconds. The detected echo sounders will be
compared with a list of echo sounders detected on the previous
run. If new echo sounders are detected they will automatically
be configured in the SIS program according to a predefined
setup for each echo sounder type. This will take approximately
5-10 seconds for each new echo sounder. All echo sounders will
then be listed in the Current echo sounder combo box, used
for selection of an echo sounder for further configuration.

In addition, the same echo sounders may be listed in an Echo
sounder - not started combo box, depending on whether the
autostart mechanism is triggered or not. The autostart
mechanism will automatically start all detected echo sounders, if
they are exactly the same as on the previous run, that is, if no
echo sounders are missing and no new echo sounders are added
since the last run. Otherwise the Echo sounder - not started
combo box will be displayed and the echo sounders must be
started manually.

Choose which system you want to change the parameters for, by
selecting it from the Current echo sounder combo box.
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Since several types of echo sounders, with different purpose and
capabilities, are handled by the SIS software, the parameter
settings for the different types may also be different. For
example, not all settings for single beam echo sounders or GPS
equipment will be the same as for a multibeam echo sounder.

Note It is important that the default parameter settings for each echo
sounder is checked and/or modified according to the operational
and physical settings relevant for the current echo sounder.

Related topics

→ Instrument combinations, page 315.
→ Echo sounder - not started list, page 344.
→ Current echo sounder, page 345.
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3.3 Normal operational sequence
To start the SIS controlling and echo sounder, follow this
procedure:
1 Start SIS

→ Refer to page 28.

2 Check installation and runtime parameters
→ Refer to page 29.

3 Start the echo sounder
→ Refer to page 41.

4 Enter survey and operator parameters, set projection
→ Refer to page 42.

5 Import a Neptune grid (option)
→ Refer to page 43.

6 Start pinging
→ Refer to page 44.

7 Check sensor input
→ Refer to page 45.

8 Check echo sounder main functions
→ Refer to page 46.

9 Start and stop logging
→ Refer to page 47.

10 Perform a system calibration (option)
→ Refer to page 49.

11 Plan a survey (option)
→ Refer to page 59.

12 Run the survey
→ Refer to page 62.

13 Export data
→ Refer to page 63.

14 Operate Helmsman Display (option)
→ Refer to page 64.

15 Exit SIS
→ Refer to page 65.
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3.4 Start SIS

Power on

Observe the following procedure:
1 Power up the echo sounder units.
2 Power up the Operator Station peripherals.

- Your system may include a number of peripheral
devices. Consult the applicable manufacturer’s
documentation.

3 Configure the single beam echo sounder(s) - if you have
any.

4 Power up the SIS Operator Station.
When SIS starts, two background windows will be started:
• Licence server
• Web-server
The licence server connects to the hardware licence dongle and
provides the licences to the SIS program. The web-server is an
internal SIS component.
The dongle is connected to an USB port on the HWS 10. It is
required to run the advanced options of SIS.

Note Do not stop these applications, they must be running.

Software initialization and login

The operating system on the SIS Operator Station loads
automatically. When the boot process is finished, you can open
the SIS program. This is done by clicking on the SIS icon on the
desktop or by selecting the program from the Windowst start
menu.
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3.5 Check installation and runtime parameters

Installation and runtime parameters are associated with the echo
sounder and not with the survey. This means that the installation
and runtime parameters are configured separately for each
individual echo sounder and that these parameter settings will be
the same for that echo sounder, independent of which survey
that is run.

The parameter settings for each echo sounder will be stored in a
database. As explained in the chapter Preparing for use, when
an echo sounder is detected for the first time, all parameters will
be set to a default value, determined by the type of echo
sounder. It is important that the installation and runtime
parameters are checked and updated if necessary.

Note A list of the parameters and the used settings should be kept in a
safe and accessible place.

External sensors: The Communication parameters must be
configured connecting to any instrument. Heading and position
data can be transferred to one or several single beam echo
sounders.

Instrument combinations: Single beam echo sounders and
GPS must be registrered manually. When the instruments are
registered, the user can move on to the installation and runtime
parameters. (GPS does not have runtime parameters).

Note The Installation parameter window can be displayed at any
time, but parameters can only be modified when pinging and
logging is deactivated.
The Runtime parameter window can be displayed at any time,
independent of pinging and logging status.

Note If SIS has been left inactive for some time, the operating system
may have swapped the complete SIS process to disk. The
operating system must then read SIS into the RAM again. This
may take a few seconds, during which datagrams including
installation and runtime parameters should not be sent to the
Processing Unit.
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Related topics
→ Installation parameters for multibeam echo sounders, page 31.
→ Installation parameters for single beam echo sounders and

GPS equipment, page 35.
→ Runtime parameters for multibeam echo sounders, page 37.
→ Runtime parameters for single beam echo sounders and GPS

equipment, page 40.
→ External sensors, page 310.
→ Instrument combinations, page 315.
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Installation parameters for multibeam
echo sounders
The installation parameters are divided into three main groups:
• Communication setup parameters

The communication setup parameters define the input and
output settings for the serial - and network (Ethernet)
ports on the echo sounder Processing Unit. In addition this
parameter group also defines the type of information
(datagrams) that is received and/or sent on the individual
ports.
To be able to set these parameters correctly it is necessary
to know the type of equipment that is connected to each
individual PU port. Depending on the port type, the
connections are either direct, using a serial link, or remote
via the system network.
The equipment type and which port the different
equipment types may be connected to, is defined by a set
of rules/restrictions.
→ These restrictions are defined on page 163.

Note If the communication setup is not correct this may result in
loss or corrupted functionality - and in the worst case an
inoperable system.

• Sensor setup parameters
In order to measure correct depths the system must know
the physical positions, angles, offset values and delays for
all transducers and sensors. This information belongs in
the second main group of installation parameters - sensor
setup parameters.
Also, based on the set of equipment that is connected to
the echo sounder PU (Processing Unit), it may be
necessary to select what equipment to use as active units
when several alternatives are available.
If no selection is made, the system will automatically use
the sensor connected to the lowest numbered port when
two or more alternatives are available.

• BIST - self tests
The options available allows you to test individual
functions and hardware items.
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How to open the installation parameter interface

The installation parameters for the different echo sounders are
located in the Installation parameter window, but all external
sensors not connected to the PU (Processing Unit) but the HWS
10 Operator Station, are located in the External sensors
dialogue box found on the Tools drop-down menu.

In order to open the installation parameter interface perform the
following actions:

1 Select the echo sounder you want to change parameters
for in the Current echo sounder combo box.

2 Either:
- Use the Frame button to select Installation

parameters in the desired frame.

or
- Locate the Manage Windows selection from the View

menu.
- Select Installation parameters from one of the combo

boxes and press OK.

The “Installation parameters” window opens.

Select and modify

1 Select the first main tab, PU Communications Setup, if
not already opened. Three sub-tabs are displayed.

2 In turn, select and modify, as appropriate, the following
sub tabs:

Input Setup tab

In turn, select each port in the Input port combo box and
change the corresponding communication and input
format settings as appropriate.

Output Setup tab

In turn, select each port in UDP Host Port combo box and
change the Datagram subscriptions on the selected port as
appropriate.

The basic functionality is dependent on the default
settings.

- The Host UDP1 and UDP3 defines formats used
internally in the operator station and cannot be
changed.
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- The Host UDP2 defines datagrams logged to file
(.all files).

- The Host UDP4 is available for third party software.

Caution UDP1 to 3 should not be changed.

Clock Setup tab
The PU clock can be set to use the same time and date as
an external clock, the clock in the active positioning
system or the clock in the operator station. The clock drift
can be corrected by a one pulse per second signal (1PPS)
normally available from a GPS receiver.

3 Next, select the tab Sensor Setup. Five sub-tabs are
displayed.

4 In turn, select and modify, as appropriate, the following
sub tabs:
Settings tab
Select settings for position, heading and motion systems
on the different ports. Decide which sensors that should be
active by selecting the port where the relevant sensor is
connected.
Locations tab
Enter the measured position for the different sensors and
transducers. Note that if the vessel’s deplacement or trim
changes during a survey, the waterline value must be
updated accordingly.
Angular Offsets tab
Enter the measured angle offsets for the different sensors
and transducers.
System Parameters tab
Enter backscatter offsets and system related parameters.
ROV Specific tab
Only required if the transducers is mounted on a subsea
vehicle.

5 Next, select the tab PU BIST. It contains several tests you
can perform to check the operation of the echo sounder
system.

6 Press the OK button to save new settings or Cancel to
revert back to current settings.
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Related topics
→ External sensors, page 310.
→ Current echo sounder, page 345.
→ Installation parameters, page 160.
→ Input Setup, page 161.
→ Output Setup, page 165.
→ Clock Setup, page 167.
→ Settings, page 169.
→ Locations, page 173.
→ Angular Offsets, page 175.
→ ROV Specifics, page 178.
→ System Parameters, page 180.
→ PU BIST, page 186.
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Installation parameters for single beam
echo sounders and GPS equipment
Installation parameters for single beam echo sounder and GPS
equipment are divided into two main groups in the same way as
for the multibeam echo sounders:
However, the number of parameters is greatly reduced
compared to multibeam echo sounders.
• Communication setup parameters

The communication setup parameters define the input
settings for the serial- and network (Ethernet) ports on the
Operator Station (external sensors).
To be able to set these parameters correctly it is necessary
to know the type of equipment that is connected to each
individual port. Depending on the port type the
connections are either direct, using a serial link, or remote
via the system network.

Note If the communication setup is not correct this may result in
loss or corrupted functionality - and in the worst case an
inoperable system.

• Sensor setup parameters
In order to measure exact depths and their positions the
system must know the physical positions and delays for
transducers and sensors (positioning equipment). This
information belongs in the second group of installation
parameters - Sensor setup parameters.

How to open the installation parameter interface
The installation parameters are found on different places. Most
of them are located in the Installation parameter window but
all external sensors are gathered in the External sensors
dialogue box found on the Tools drop-down menu.
To open the installation parameter interface perform the
following actions:
1 Select the echo sounder you want to change parameters

for in the Current echo sounder combo box.
2 Either:

- Use the Frame button to select Installation
parameters in the desired frame.

or
- Locate the Manage Windows selection from the View

menu.
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- Select Installation parameters from one of the combo
boxes and press the OK button.

The “Installation parameters” window opens (Single beam
installation or GPS installation window).

Select and modify

1 In turn, select and modify, as appropriate, the following:
Sensor name
Use the combo boxes to select Heading and Position.
Serial/Ethernet connections (not for GPS)
Set the serial port parameters if a serial port is to be used
or select an Ethernet port and set corresponding IP and
port address.
Locations (m) (not for GPS)
Enter the measured position for the different sensors and
transducers (single beam only). Note that if the vessel’s
deplacement or trim changes during a survey, the
waterline value must be updated accordingly.

2 Press the OK button to save new settings or Cancel to
revert back to current settings.

Related topics
→ External sensors, page 310.
→ Current echo sounder, page 345.
→ Installation parameters, page 160.
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Runtime parameters for multibeam echo
sounders
Runtime parameters are divided into four main groups:
• Sounder Main parameters
• Sound Speed
• Filter and Gains
• Data Cleaning
The content of these groups may vary depending on echo
sounder type. Additional groups may also exist.

Sounder main

The sounder main settings concern the operational parameters
for the echo sounder including coverage, depth and swath
control.

Sound speed

Sound speed settings concerns selection and use of sound speed
profiles and sound speed at transducer settings.

Filter and gains

Filter and gains settings concern filtering to avoid erroneous
measurements, for example, false bottom detection. It also
includes settings for the bottom backscatter measurement and
seabed imaging.

Data Cleaning

Data Cleaning defines rule sets for how the gridding should be
performed. There are two parameter groups: Ping processing
rules and Grid processing rules.

How to open the runtime parameter interface

To open the runtime parameter interface perform the following
actions:
1 Select the echo sounder you want to change parameters

for in the Current echo sounder combo box.
2 Either:

- Use the Frame button to select Runtime parameters
in the desired frame.

or
- Locate the Manage Windows selection from the View

menu.
- Select Runtime parameters from one of the combo

boxes and press the OK button.
The Runtime Parameters window opens.
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Select and modify

1 In turn, select and modify, as appropriate, the following:

Sounder Main tab

- Set the sector coverage parameters: <set to match
local conditions>.

- Set the depth parameters: <set to match local
conditions>.
The Min and Max depth settings are used to guide
the echo sounder in tracking the bottom. Incorrect
settings may result in a failure to detect the bottom
and thus a disabled system. If the echo sounder has
problems detecting the bottom within the min-max
range use the Force Depth button with a measured
depth or a depth from a chart.

- Set the swath control parameters: <set to match local
conditions> if present.

- Set Pitch and Yaw stabilization: <set to match local
conditions>.

Sound Speed tab

This tab contains Sound Speed profile and Sound speed at
transducer.

In order to ensure accurate data, you must know the sound
speed profile in the survey area. The profile may change
with both time and position in the survey area. It may
therefore be necessary to measure the profile several times
during a survey. A profile is stored in a file and can be
found using the browse button (the button marked with
“…”). When found and selected, the profile is activated by
pressing the button marked “Use Sound Speed Profile”.

Set the Sound speed at transducer source:
i ) Manual: Sound speed value must be entered.

ii ) Profile: A value from the sound speed profile is used
(existing or interpolated).

iii ) Probe: Values from the probe is used. The offset value
must then be specified.

Filters and Gains tab

Three subgroups are present: Filtering, Absorption
Coefficient and Normal Incidence Sector.

- Set the Filtering parameters: <set to match local
conditions>.
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* It is recommended to change the filtering
parameters from the default setting only if the
occurrence of false detections is too high to be
acceptable.

- Set the Absorption Coefficient parameters: <set to
match local conditions>.
* A correct value for the absorption coefficient is

important with respect to the validity of the
bottom backscatter measurements.

- Set the Normal Incidence Sector parameters: <set to
match local conditions>.
* Degrees from nadir defines the angle at which the

bottom backscatter can be assumed to be
independent of the strong increase at normal
incidence. The value is dependent on bottom
type.

Data Cleaning tab
Here you can define rule sets for how the gridding should
be performed. There are two parameter groups: Ping
processing rules and Grid processing rules.
It is recommended that only experienced users should
change the processing parameters from the default values.

Related topics

→ Current echo sounder, page 345.
→ Runtime parameters, page 200.
→ Sounder Main, page 201.
→ Sound Speed, page 225.
→ Filter and Gains, page 232.
→ Data Cleaning, page 261.
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Runtime parameters for single beam echo
sounders
Processing defines rule sets for how the gridding should be
performed. There are two parameter groups: Ping processing
rules and Grid processing rules.
It is recommended that only experienced users should change
the processing parameters from the default values.
Related topics

→ Current echo sounder, page 345.
→ SB Runtime, page 278.
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3.6 Start the echo sounder
Before you start pinging, an echo sounder must be running. The
echo sounders are normally started automatically by the
autostart mechanism. If the autostart mechanism is not
triggered, the echo sounders must be started manually. This is
done by selecting the desired echo sounder from the “Echo
sounder - not started” combo box. The Logging, Pinging and
Line counter buttons will all be disabled until the echo sounder
is ready. When the echo sounder is ready, you can start to ping.
Single beam echo sounders must be set up and started manually
on its own Operator Station.
Related topics

→ Main toolbar, page 340.
→ Echo sounder - not started list, page 344.
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3.7 Enter survey and operator parameters, set
projection

In order to start a new survey you must identify the survey
parameters. This is done in the New survey window.
Related topics

→ New survey, page 134.
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3.8 Import a Neptune grid to SIS (option)
SIS requires that a projection file is stored in the same folder as
the gridded data. This applies both to Neptune and SIS grids. A
projection file can be created as follows:
1 Open the New survey window.
2 Select the Projection tab under the Advanced options tab.
3 Press the “Create new projection” button on the

Projections tab. This opens the Projections dialogue box.
4 Press the “Select projection in the database” button in the

Projections dialogue.
5 Select a projection from the list displayed and press OK.

The name of the selected projection is now shown in the
Projection definition field.

6 Press the “Write projection to file..” button.
7 Browse for the same folder as where the survey is stored.

This folder contains two sub-folders named Display and
Process, and two files named GridIndex.properties and
GridManager. properties.

8 Name the file sis_proj.txt and save it.
Now the grid can be imported to SIS using the Import/Export...
option accessible from the File menu.
If the desired projection is not stored in the database, a new
projection can be defined by pressing the “New” button in the
Projection definition field.
Related topics

→ New survey, page 134.
→ Projections, page 142.
→ Import/Export..., page 290.
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3.9 Start pinging
Pinging must be started manually after the echo sounder is
ready. When pinging is ON, the Waterfall, Cross track and
Beam intensity windows will become active.
1 In the Current echo sounder combo box, select the echo

sounder you want to ping with.
2 On the toolbar: Press the Pinging button. The button is

red when off and green when on.
- The selected echo sounder will now start transmitting.

Related topics

→ Main toolbar, page 340.
→ Current echo sounder, page 345.
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3.10 Check sensor input
Proper operation of the external sensors are vital for the SIS
operation. These are sensors connected to the PU (Processing
Unit) and not directly to the Operator Station.
Sound speed at transducer depth is connected directly to the
HWS 10 Operator Station (if present).
External sensors are continously monitored in SIS. The Time
series window display data from the motion sensor. Sensor data
is also displayed in the Numerical display window. Errors from
the sensors are reported in the Message service window.
Related topics

→ Numerical display, page 89.
→ Message service, page 93.
→ Time series, page 100.
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3.11 Check echo sounder main functions
Before you start logging, you are adviced to make sure that the
(echo sounder) system is locked on the bottom and that the
swath coverage is as expected.
This is shown in the ping display.
The Geographical window presents a real-time view of the
system(s) performance during on-line operation. The window
shows the raw data from the system(s) after corrections have
been applied for vessel attitude and sound speed.

Note The following information is only valid for multibeam echo
sounders. Single beam echo sounders and GPS equipment does
not have this option.

While pinging or logging, realtime depths can be displayed in
the Geographical window with the following setup:
1 Press the show/hide button for the Geographical window.
2 Select the Realtime depths selection.
3 Press OK.
Check the following windows for proper operation:
• Check the Waterfall window for a continuous bottom.
• Check the Cross track window to see the depths for all the

beams ping by ping.
• Check the Beam intensity window for reasonable

backscattering strengths for each individual beam.

• Check the sensor status in the Numerical display window.
Related topics

→ Geographical, page 67.
→ Beam intensity, page 78.
→ Cross track, page 81.
→ Numerical display, page 89.
→ Waterfall, page 105.
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3.12 Start and stop logging
Logging must be started manually after the echo sounder is
ready. In the Current echo sounder combo box, select the echo
sounder you want to ping with.

Note that if pinging is off when logging is turned on, pinging
will automatically be turned on. If logging is on and pinging is
turned off, logging will automatically be turned off.

Alternative 1

During the survey, the vessel navigates along the pre-planned
survey lines. Logging must be started at the beginning of each
line. Stop the logging at the end of each line and start it again at
the beginning of the next

At the start of every survey line:

1 Press the red “not logging” button on the toolbar.

- Logging starts and the button turns green.
2 Allow the vessel to navigate along the survey line.

3 Press the green “logging” button when the vessel has
reached the end of the line.

4 Transit to the next line.

5 Press the red “not logging” button when you start the new
line.

When the final survey line has been completed:

6 Press the green “logging” button.

Alternative 2

You can also start the logging at beginning of the first line and
let it run continuously, toggling survey line change as
appropriately.

At the start of the first survey line:

1 Press the red “not logging” button on the toolbar.

- Logging starts and the button turns green.
2 Press Line Cnt (xxxx) at the beginning of each survey

line.

- This assigns a new line number.
When the final survey line has been completed:

3 Press the green “logging” button.
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Saving data

When the echo sounder has started logging, data is
automatically saved to disk.
The Line counter button on the toolbar displays the line count
for the currently selected echo sounder.
To avoid very large log files the counter for all active echo
sounders are incremented automatically every 30 minutes (this
is configurable). This, however, only happens when the counter
has not been incremented by other means within the last 30
minutes. (This is done by pressing the line counter button or by
stopping and starting logging).
Disk usage and disk full warnings are reported by Windows XP.
When such warnings are received, the operator must copy the
surveyed data to an external storage device and delete the data
from the logging computer.
Related topics

→ Current echo sounder, page 345.
→ Line counter, page 346.
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3.13 Perform a system calibration (option)

Note This applies to multibeam echo sounders only.

Introduction

To ensure maximum reliability and accuracy from the system,
the system and externally connected sensors should be
calibrated before the start of a new survey.
The correct calibration of the vessel attitude sensors and the
time delay of the positioning system is vital to the quality of the
data collected by the multibeam echo sounder. While modern
motions sensors have little or no drift with time, they may fail.
The time delay of the positioning system may vary according to
system set-up. It is therefore important that the calibration
values are checked at regular intervals, say once every month, or
at the start of a new survey.
The built-in SIS utility is used to process data from a calibration
survey, usually consisting of one or more sets of overlapping
lines as described below. The data should be processed by the
SIS utility, and a depth profile displayed with data from only a
narrow corridor you define. This allows a comparison of the
data collected on the two lines. Offsets may be found entering
corrections into the system and reprocessing the lines to observe
the effect of the correction.

Determining a suitable calibration area

On a flat area only roll error will cause significant depth errors.
(Sound speed and echo sounder errors are not considered in this
discussion.) Thus if the survey is to be run in a reasonably flat
area, it may be sufficient to perform roll calibration only.
Usually, however, a full calibration is required, and the
calibration should then be done so that different sensor errors
have no influence on the echo sounder data, except for the one
which is to be determined. Note that the positioning accuracy is
vital for good calibration results, except for the roll error
calibration on a flat bottom. It should also be noted that
although heading calibration is in principle possible from echo
sounder data, it is recommended to calibrate the heading sensor
with the vessel lying along a quay using standard land surveying
methods.
The ideal calibration area is partly flat and partly a fairly steep
slope with little change in depth acrosstrack, and with a distinct
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feature such as a peak or hollow in the flat area. If the heading
and positioning errors are negligible, the flat area is not required
if the slope has a reasonably constant depth acrosstrack.
The slope used for pitch and time delay calibration should have
an appreciable relative change in depth from top to bottom, say
30%, if pitch offset and time delay are to be resolved accurately.
Note that the slope should not be too steep, say not more than
20_, otherwise the echo sounder could have problems in
maintaining good data quality.

Roll offset in the acrosstrack direction

Choose a horizontally flat area (at least acrosstrack). Survey a
sufficiently long line twice in opposite directions. Ensure that a
sufficient lead-in time to the line is used for the roll sensor to
stabilize.
→ Refer to figure 5.

The corridor used to compare data from the two survey data sets
should be placed orthogonally to the survey lines.
If there is a roll offset, there will be a depth difference between
the two data sets, increasing with acrosstrack distance from the
centre where it is zero.

Pitch offset and time delay

Choose an area with a continuous but not too steep slope
alongtrack. Survey a sufficiently long line twice in opposite
directions with the same vessel speed, and once with a
significantly lower speed. The direction is not important in the
last survey. Ensure that a sufficient lead-in time to the line is
used for the pitch sensor to stabilize.
→ Refer to figure 6.
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Figure 5 Roll offset calibration procedure
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Figure 6 Pitch offset and time delay
calibration procedure
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The corridor used to compare data from the survey data sets
should be placed parallel to the survey line on the vessel track.
Any alongtrack depth difference between the runs may be due to
four different factors:
• Pitch offset.
• Time delay between actual position and position when

position datagram is supposed to be valid.
• Multibeam echo sounders with transducers: Position distance

offset (either due to an error in the positioning system or an
error in entered locations).

• Tide difference.

Note that a depth error on a constant gradient slope, due to pitch
offset, increases with increasing depths, while that due to
position time delay increases with vessel speed, while that due
to distance offset is independent of depth and speed.
Comparing data from the two lines in the same direction, but
with different vessel speed, will thus allow the time delay to be
found. After the correction for any time delay error has been
applied to the data, the pitch offset can be determined from the
two lines run in opposite directions. Any distance offset must of
course first be removed.

Heading offset

Note The best check of the gyro is done with theodolite in the harbour.

Alternative 1

Run two parallel lines up or down a slope in the same direction,
separated, but with overlap in-between. The corridor used for
comparison should be placed alongtrack in-between the lines.
Any heading offset will give a depth difference between the two
lines.
→ Refer to figure 7.
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Figure 7 Heading offset calibration
procedure (alternative 1)
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Alternative 2

Find an easy recognizable point or feature on the bottom such as
a peak or a depression. This may be difficult!
Set up two survey lines well to opposite sides of this feature so
that the point will be in the outer part of the echo sounder swath.
Survey these two lines in same direction.
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The corridor used to compare data from the two survey data sets
should be placed so that it intersects the feature, and is parallel
to the survey lines. If there is a heading offset, you will have a
different location alongtrack in the two data sets. Note that
accurate positions and position time delays are required.
→ Refer to figure 8.
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Figure 8 Heading offset calibration procedure
(alternative 2)
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Sound speed control

The same procedure as used for the outer beam angle offset
calibration may be used as a check for sound speed corrections.
Provided that the roll offset and outer beam angle offsets are
correct, any depth deviation between the two lines in the two
calibration corridors are due to sound speed errors, either in the
used profile, and/or in the sound speed at transducer depth.

Sound speed quality inspection

Use one or more pairs of lines on a flat sea floor, where the lines
are perpendicular to each other. This means that the two lines in
the pair cross each other on a flat area of the sea floor with a
difference in the sailing direction of about 90 degrees. Compare
the depth in different points in the crossover region. Depth
differences along the two centre lines with respect to the outer
edges of the swath from the other line (i.e. points 2, 4, 6, 8) will
be due either to roll or sound speed errors. Note that the depth
error due to sound speed has the same sign, while those due to
roll changes sign across the centreline.

→ Refer to figure 9.

Outer beam angle offset calibration (for EM 1002
only)

Run two perpendicular survey lines on a relatively flat bottom.
The depth should be approximately 50 to 100 meters, and 150
degrees coverage should be used. In the crossover area of the
two lines, use the roll calibration utility. Set a calibration
corridor along each of the tracklines in the figure above. Any
angular error at the points 2, 4, 6 or 8 may be due to errors in:

• Outer beam angle offset

• Sound speed

• Roll offset

Note The outer beam angle offset is critically dependent upon correct
roll calibration and correct sound speed calibration. Ensuring
that these are correct before doing an outer beam angle offset, is
a sound principle.
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Figure 9 Offset beam angle calibration

If sound speed and roll offset are correct, determine angular
errors by changing the roll offset angle to make the outer beam
depths equal at 2, 4, 6 and 8, and take the average of these. If the
outer beams are too shallow compared to the centre beams, the
outer beam angle offset is positive, if they are too deep the
outer beam angle offset is negative. Add the outer beam angle
offset with sign to the outer beam angle offset already used in
the installation menu.

→ Refer to figure 9.
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Verification

After the calibration has been completed, we strongly advise
you to repeat the procedure for verification. This is especially
necessary if you initially had large errors (exceeding 0.1
degrees).

Automatic calibration

Perform an automatic calibration for test of system installation
and calibration. The automatic calibration is executed by the
SeaCal program.
Related topics

→ Calibration, page 282.
→ SeaCal, page 430.



Operational procedures

59850-164709 / E

3.14 Plan a survey
Introduction

As a general rule, the survey should be properly planned. The
plan can be based upon a chart where the planned survey lines
are plotted. General knowledge about the bottom conditions
may be useful.

• Communication

• Offset and location definitions

If any of these settings have changed, the system parameters
must be adjusted accordingly before the survey starts.

A survey is seldom performed without any planning being done
beforehand. A comprehensive plan would normally define the
following:

• The area to be surveyed

• The survey lines which the vessel must follow

• The direction and order in which the lines are to be run

• The lines required for system calibration

• The location and timing for sound speed profiles

The planned lines must take into account islands, coastlines,
shoals or other obstacles within the survey area which may
affect a safe and efficient survey. The achieveable coverage of
the multibeam echo sounder and the overlap required between
the neighboring lines is usually used to determine the line
spacing.

A fully comprehensive survey plan is most useful in areas of
deep waters or where the depth and hence coverage is fairly
constant. In shallow waters where the depth changes rapidly and
may not even be known well enough aforehand, a
comprehensive plan may not be as useful, especially if the
survey is to be run with a small and agile vessel. A defined
survey area boundary plus a few pre-planned lines for
calibration could then be enough, actual coverage as obtained on
the spot instead being used to determine what lines the vessel is
to run.

The Planning module allows a survey to be split into
sub-surveys or jobs. The survey area boundary may be defined
as a polygon with any number of corners, as may areas which
are not to be entered. Automatic line clipping at the polygon
boundaries and automatic generation of parallel lines is
supported.
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When the survey is run, planned lines may be activated to
generate steering information on the bridge and helmsman
displays. The purpose of the Planning module is thus to provide
help before and during the survey.

Factors to consider

A survey is normally planned taking into account

• Echo sounder coverage

• Seafloor topography

• Sound speed variations

• Current weather conditions.

The need for calibration of the positions (time delay), heading,
roll and pitch sensors should be considered, and how and where
to gather sound speed profiles.

Coverage capability determines line spacing, and as it varies
with bottom reflectivity, this must be estimated. Usually 10%
overlap between lines is sufficient, but if large variations in
bottom reflectivity is expected, or reflectivity is unknown, it
may be necessary to increase overlap. The overlap must also be
increased if the vessel’s roll is excessive.

If there are steep slopes on the bottom, it is strongly advised to
run along these slopes, not up or down them. This will be
beneficial in keeping coverage reasonably constant along survey
lines, thus making survey planning easier. However the main
reason for this advice is that the echo sounder performance will
usually be poorer when running up or down a slope rather than
along. This is because much less acoustic energy is reflected
back towards the transducer from steep slopes, causing less
detections and the possibility of false detections in sidelobes.
Sidelobe detections should however be very rare in the
Kongsberg multibeam echo sounders due to the advanced signal
processing implemented. Note that if circumstances require that
survey lines are run up or down a slope, reduction of vessel
speed may be required to allow the echo sounder to track the
bottom continuously.

Coverage capability is also affected by weather conditions and
possibly also by vessel speed. Heavy seas and possibly vessel
speed lead to increased noise level, and may also cause aeration
on the Sonar Head or the transducer array.
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Aeration is a function of sea state, but also of the heading with
respect to the wave direction and the vessel speed. It is strongly
advised that one builds a record of coverage and aeration
problems versus sea state, heading with respect to wave
direction, and vessel speed. This record could be very helpful in
ensuring that surveys can be performed efficiently with a
minimum of line rejections and corresponding reruns and infills.
Any drift rates of roll, pitch and heading offsets should also be
recorded to enable efficient planning of calibration intervals. If
calibration is required before a survey, a suitable calibration area
should be determined before reaching the survey area.
A sound speed profile should always be taken in the surveying
area and loaded into the SIS before the survey is started. In
some areas the profile will vary, mostly due to fresh water
inflows from rivers or currents from areas with different
salinity. Surface sound speed variation may be strongly affected
by solar warming. If variations can be expected, where and
when sound velocity profiles are to be taken should be planned
ahead, and the survey line schedule adjusted to take this into
account.
If the measured sound speed value at the Sonar Head depth or
the transducer array depth is continuously measured, it should
be compared with that measured by the profiling instrument to
evaluate the need for measuring a new profile.
Note that in some cases the coverage capability of the echo
sounder cannot be fully utilized, because errors in roll and
sound speed profile measurements, which are critical in
maintaining the accuracy of the outer beams, become too large
in relation to the accuracy requirements of the survey. The ray
bending effect (Snell’s law) might also reduce the online
coverage since the energy can bend inwards.
Related topics

→ Planning module, page 153.
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3.15 Run the survey

Retrieve a planned job

As previously described, a survey should be properly planned
before start.
Before the logging starts, you can retrieve a planned job.
1 Open both the Geographical and the Planning Module

windows.
2 In the Geographical display, activate the Show/Hide

button and select the Planning checkbox.
3 After closing the Show/Hide button, press the “P” button

on the Geographical toolbar to activate the Planning
module.

4 A shortcut to the above is to select “Planning” from tne
Settings combo box, and then press the “P” button.

5 Select the “Jobs” tab on the Planning module display.
6 Press the “Open Job” button to browse for the plan for the

current survey.

To monitor the progress

There are different ways to monitor the progress depending on
what kind of system you are running.

Status information

The logging and system status is observed, with additional data
available.
The following is a summary of the status information:
• On the right hand side of the toolbar there are three buttons.

They give you the status on logging, pinging and line
number.

• In the numerical display view you can select the sensor data
values you want to monitor.

• In the message survey display view you will be given
warnings, error reports and other information.

• Three status lamps on the main toolbar give status on
hardware units (multibeam echo sounders only).

Related topics

→ Numerical display, page 89.
→ Message service, page 93.
→ Planning module, page 153.
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3.16 Export data
If you want to export data use the Import/Export dialogue box
found on the File menu.
Related topics
→ Import/Export..., page 290.
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3.17 Operate Helmsman Display (option)
The Helmsman Display must be connected to the echo
sounder’s operator station (normally the HWS10). From the
HWS10 Operator Station the operator can control what surveys
shall be displayed on the remote Helmsman Display. The
operator at the HWS10 Operator Station imports the surveys he
wants to see, and from the Planning module he chooses
“Transfer grids”. The same grids (terrain models) will then be
displayed on the Helmsman Display.
Also, the operator on the HWS10 Operator Station can choose
to display all the currently planned lines on the Helmsman
Display. This is done when you choose “Transfer plan” in the
Planning module.
The currently active line will always be sent from the HWS10
Operator Station to the remote Helmsman Display. Here, the
operator can see the distance from the planned line to the
current position and some more status information about the
current line.
The operator at the Helmsman Display can then freely set his
own colors, shading, scale and area to display. He can choose to
see a completely different area than what is currently surveyed.
This makes it possible for the operator at the Helmsman Display
to do his own quality assesment of the surveyed data and to take
action if necessary.
If the logging stops for whatever reason, the Helmsman Display
will no longer update. This allows the operator at the Helmsman
Display to verify that the survey is progressing as planned.
Related topics

→ Helmsman Display, page 95.
→ Planning module, page 153.

Installation of a Helmsman Display is described in the SIS
Installation procedure document.
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3.18 Exit SIS

Software

You can either exit the SIS program by selecting Quit from the
File drop-down menu or you can press the “close” button up to
the right in the SIS program window.

Hardware units

Operator Station

The SIS Operator Station is powered down first.
1 Switch the power off.
2 Switch off all the peripherals.

Processor or Transceiver Unit

1 Open the door on the Processor/Transceiver Unit and
switch power off. Alternatively use the remote power
switch.
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4 FRAME CONTENTS

4.1 Introduction
This chapter describes the various windows shown by the SIS
program.

Seven frames can be displayed at the same time. The content of
each and every frame is decided in the Manage Windows or by
using the Frames button.

Note Not all windows are available for all instruments.

Monitoring windows

→ Geographical, page 67.
→ Beam intensity, page 78.
→ Cross track, page 81.
→ Seabed image, page 86.
→ Numerical display, page 89.
→ Message service, page 93.
→ Helmsman Display, page 95.
→ Color coded depth, page 98.
→ Time series, page 100.
→ Waterfall, page 105.
→ Water column, page 111.
→ Sound velocity profile, page 120.
→ Scope display, page 124.
→ Stave display, page 127.

Survey administration windows

→ New survey, page 134.
→ Survey administration, page 146.
→ Planning module, page 153.

Parameter setup windows

→ Installation parameters, page 160.
→ Runtime parameters, page 200.

Calibration window

→ Calibration, page 282.
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4.2 Geographical
The Geographical window is either accessed through the
Manage windows on the View drop-down menu or by selecting
it from the Frames button.

The main purpose of the Geographical window is to show
geographical data like surveys, shipstracks, coverage, planned
lines and so on. The window consists of one geographical region
with a toolbar on top. It can also be referred to as main window.

This window is valid for all instruments.

Zooming

In addition to using the zoom buttons (see descriptions below)
you can also:

• Zoom in or out on the data by using the mousewheel

• Zoom in on a specific region by pressing the left mouse
button, drag the mouse to a new location and then release the
mouse button

• Set the “camera” to view a given region by pressing the
Zoom to region button and enter the wanted scale and
position
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Hints on Geographical frame settings

To see a good model of the seafloor, use the Show/hide button
and choose Depth operations: Min. This will select the
minimum value in each grid cell and create a surface from them.
Noise will be hidden in this surface, but it will be the shallowest
surface drawn very smooth.
To look for artifacts in the data, use the Show/hide button and
choose Depth operations: Median. This will select the median
value in each grid cell and the result will be that artifacts can be
seen more easily. Also select Level of Detail from the GeoView
menu and choose a smaller level of detail. When looking at the
data in a small scale, artifacts can be seen. The operator should
not set level of detail to 0 to begin with, as this may overload
the system resources. Instead try to use an increasingly smaller
level of detail until a good picture is found. Then try to turn the
Static light source on and off selected from Geographical,
Light Source, from the main menu. When off, the light source
will follow the mouse cursor and make it easier to see shadows
from different angles. Also try to change the Depth scale factor
in the Show/hide button to see shadows even better.

Toolbar buttons

The toolbar holds the following buttons (from left to right):
• Show/hide
• Annotation colours
• Dynamic colours
• Print
• 2D/3D Toggle
• Position and distance measure
• Follow ship
• Zoom to ship
• Zoom to world
• Zoom to given region
• Zoom in
• Zoom out
• Background
• Information field (not a button)
• KSGPL edit mode (when selected in Show/hide)
• Planning edit mode (when selected in Show/hide)
• Calibration edit mode (when selected in Show/hide)
• C-Map manipulation mode (when selected in Show/hide).
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Show / Hide button

Position: Show or hide the position text fields
(latitude and longitude).

• DD.DD: Display position as decimal degrees.

• DD MM.MM: Display position as degrees and
decimal minutes.

• DD MM SS.SS: Display position as degrees,
minutes, and decimal seconds.

• Projection: Display position as projection
coordinates.

Survey ship: Show the survey ship or not.

Planning: This will enable the planning module in
the Geographical window. An Edit button will be
added to the Geographical window toolbar.

C-MAP background: Use C-MAP as Background
map. When the C-Map edit is enabled, clicking the
right mouse buton in the geographical view will
display additional C-Map objects information .

KSGPL: Turn KSGPL (Kongsberg SIS Graphic
Programming Language) on or off.

• Unchecked: No input/output is allowed. This will
also hide all the loaded KSGPL objects.

• Checked: Use predefined settings.

• Object types: Available object types.

- [0] - Generic objects (objects without an
object type)

- [1] - Coast
- [2] - Dryfall
- [3] - Riverbank
- [4] - Text

Surveys: Show surveys or not.

• Auto refresh: Select if the loaded surveys should be
auto-reloaded or not. Data will not be refreshed when you are
in 3D mode.

- Refresh rate: Set how often you want the data to be
reloaded in seconds.
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• Grid: Show grid(s) or not
- Grid transparency: Set grid transparency.

Choose values from 0 (not transparent) to 100
(maximum transparent).

• All points: All points in the given area are shown.
- Max points: This is the maximum number of

points allowed. If there are more points in the
area than this no points will be displayed.

- Point size: Point size in number of pixels.
• Depth Scale Factor: Factor by which to multiply

the depth. This has the effect of stretching the
grid along the depth axis (i.e. a depth scaling
factor of 2 stretches the waterfall grid to twice its
normal height). This can make it easier for
example to discover artefacts.
- x 1: No scaling.
- x 2: Scale the depth by 2.
- x 5: Scale the depth by 5.
- x 10: Scale the depth by 10.

• Color scheme: What kind of color scheme to be
used on the surveys.
- Single (Annotation) color: Use only one

colour on the loaded grid(s). The colour used
is selected in the Annotation colors dialogue.

- Depth: Dynamic colours by depth.
- Backscatter (dB): In grayscale.
- Points per cell: Dynamic colours by points per

cell.
- Depth diff. per cell: Dynamic colours by depth

difference per cell.
• SIS based survey(s):

- Realtime shipstrack: Show shipstrack current line or not.
- Stored shipstracks: Show the stored shipstrack or not. The

currently logged line/realtime shiptrack will be stored to
disk as a stored shipstrack whenever a new line is being
created.

- Realtime coverages: Show coverage from current line or
not.

- Stored coverages: Show the stored coverages or not. The
currently logged line/realtime coverages will be stored to
disk as a stored coverages whenever a new line is being
created.

- Realtime depths: Show realtime depths or not. All depths
can be shown as a tail behind the ship.
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* Dynamic colours: Show the realtime depths with
dynamic colours.

- Depth variables: Select depth variable to be displayed.
* Z: Depth, sea surface to sea bottom distance.
* Zt: Tide file corrected depth, vertical datum to seafloor

distance.
* Zv: Geoide and RTK corrected depth, vertical datum to

seafloor distance.
* Zg: Seafloor to geoide distance.
* Zr: Seafloor to ellipsoid distance.

- Depth operations: This is the value inside the cell.
* Min (minimum)
* Median
* Max (maximum)

• Neptune based survey(s): (This choice is only available if
you have imported Neptune based surveys).
- Color scheme: What kind of colour scheme to be used on

the surveys.
* Annotation/static colours: Use only one colour on the

loaded grid(s). The colour used is selected in the
Annoation Color dialogue box.

* Dynamic colours by depth
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Annotation colours button

Display Colors: You can change
the colours for Grid(s), All points,
Stored shipstrack(s), Realtime
shipstrack, Stored coverage(s),
Realtime coverage, Realtime
depths, Calibration corridor,
Planned survey lines, Planned
survey polygons, Ship symbol,
Projection net, Compass line, New
KSGPL point, New KSGPL line
and Background colour.
This is done by double-clicking in
the checkbox(es). The Color
Dialog window will appear. New
colours can be selected in a
number of different ways (using
the eye dropper tool, entering the
RGB colour code, using
predefined colours etc.).

Select the new colour and click Accept to apply. Cancel if you
do not want to change the colour.
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Dynamic colors button

Color map: Select which
objects to set the dynamic
colours (depth, points per
cell or depth difference per
cell).
Color wheel: Set the colour
representation of the
dynamic colours. Drag the
arrow to set the start and
stop limits.
Direction: Set the direction
of the arrow (CW or CCW).
Overflow: Choose a
overflow strategy for the
colours. (Clamp - lock to the
limits, wrap - restart when
reaching a limit, cut - do not
show data outside the limits.)
Only valid when fixed
scaling is selected.
Scaling: Select automatic or
fixed scaling.

Data Range: Manually set the range (max/min) for the selected
objects. The total range is found automatically from the data.

Intensity: Set the intensity of the colors in the color map. This
can be used to dim the color map for low light conditions.
Single Color Ranges: Click in the Enable check box to set a
range of data values to a single colour. For each set of depth
range a different colour can be chosen. Double-click in the right
checkbox to open the Color Dialog window.

Print button

Press this button to print the geographical view. The Print Setup
dialogue will open.
The following options are available:
Destination: Select if you want to send sounder data to a
postscript printer or directly to file. Files are saved in postscript
format (*.ps).
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Orientation: Select page orientation.
Paper Size: Select paper size.

Viewport: Select “Current Area”
to print the visible view.
Select “Keep Scale” to send a
larger area to the printer (set by the
“Zoom to region” dialogue”).
When selecting “Keep Scale”, the
centre of the view will correspond
to the centre of the printout.
Scaling: Select “Optimize to
Media” to print view with its
actual scale.
Select “Best Nice Value” to print
the view with rounded scale
values.
Annotation: Show the scale on
the printout or not.

Note Only postscript printers or plotters can be used.

2D/3D Toggle button

Press this button to enter the 3D mode. This will allow you to
pan, zoom and rotate the currently loaded grid(s) in 3
dimensions. Panning and zooming will work both in 2D and 3D.
Shift + Right mouse button will rotate the data. Note that no
new data will be reloaded in 3D mode.

Compass button

The compass button is used to extract position, distance and
heading information from the Geographical window.
Use Ctrl + Right mouse button inside the Geographical window
to open the Compass action short-cut menu. The following
options are available:
• Measure position: This is used to find position of a given

point in the view. Move the cursor inside the view. Position
information (lat/lon) is given at the cursor’s tip.
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• Measure distance and heading: This is used to measure
position, distance and heading between two points in the
view. Use Ctrl + Left mouse button to mark position 1. Draw
a line to position 2 and use Ctrl + Left mouse button to mark
this position. The requested information is given at the
cursor’s tip.

Follow ship button

This button is used to force the camera to follow the ship
wherever it moves in the world. It is possible to pan the ship to a
user defined location on the screen.

Zoom to ship button

When you press this button, the Geographical window will
zoom to wherever the ship is located in the world. It will find
the scale and coordinates automatically.
This button will be disabled if no vessel is present.

Zoom to world button

When you press this button, the Geographical window will
zoom out to the largest area possible. It will find the scale and
coordinates automatically.
Note that if the data areas are too small and too much spread out
the data may be more or less invisible to the operator.

Zoom to given region button

Any user-defined region can be zoomed up to fill the
geographical display view. To define the region, perform the
following:

1 Press the button and a new dialogue box shown will
appear. This dialogue box is called “Zoom to region”.

2 Fill in the desired scale and the centre coordinates.



Seafloor Information System / Base version

76 850-164709 / E

Zoom in button

When you press this button, the magnification of the
Geographical view will increase.

Zoom out button

When you press this button, the magnification of the
Geographical view will decrease.

Background button

Press this button to add background data to the Geographical
window. Data can be loaded from the current active survey or
you can browse for stored background files (*.bgksgpl).

Information field

This field gives you information about the scale
of the Geographical window and its position. The
monitor size is read from the database.

KSGPL edit mode button

Press this button to allow KSGPL manipulation. This button is
only made available if the KSGPL option is selected in the
Show/hide dialogue box.

Planning edit mode button

Press this button to allow Planning manipulation. This button is
only made available if the Planning option is selected in the
Show/hide dialogue box.

Calibration edit mode button

Press this button to allow Calibration manipulation. This button
is only made available if the Calibration window is opened in
one of the other frames.

C-Map manipulation mode button

Press this button to allow C-Map manipulation. This button is
only made available if the Calibration window is opened in one
of the other frames.

Note There can only be one edit button activated at a time.
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Quick menu

The Geographical window have a quick menu accessed by
clicking on the right mouse button inside the view.
• Menu bar

- Show / Hide
- Annotation colours
- Dynamic colours
- Print

• Icons
- Small icons
- Large icons

• Frames
- Empty
- All available display frames

• Activate/Deactivate - toggle between Activate/Deactivate
depending on the current mode of the Geographical window



Seafloor Information System / Base version

78 850-164709 / E

4.3 Beam intensity
The Beam intensity window is either accessed through the
Manage windows on the View drop-down menu or by selecting
it from the Frames button.
It gives a graphical description of the beam intensity and quality
factor.
This window is valid for multibeam echo sounders.

The window contains scales along the left and right vertical
axes, giving the signal strength in dB values (left side) for the
intensity bars, and the quality measure (right side) for the data
quality bars. The beam numbers are shown along the horizontal
axis. This number depends on the echo sounder model.
The window presents two bars for each individual beam. One
bar, which is either blue or red, shows the backscattering
strength of the bottom in dB. The values are corrected for
system parameters, but not for any dependence upon angle of
incidence.

Normally the backscattering strength will be highest straight
down, typically -15 dB, and lowest in the outer beams, typically
-35 dB. These figures will vary dependent upon bottom material
type and roughness (±15 dB or more). The bar colour indicates
type of bottom detection; blue for amplitude and red for phase.

The green bar shows a
data quality measure
for each beam. Small
values (on a scale from
0 to 64 or 128) convey
good data quality.
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Toolbar buttons

The toolbar holds the following buttons (from left to right):
• Show/hide
• Annotation colours

Show / Hide button

Active: Activate or decativate the
display. Deactivating the display
will minimize the CPU usage of
the display.
Axes: Show or hide the axes.
Grid Lines: Show or hide the grid
lines.
Legend: Show or hide the legend.
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Annotation colours button

Display Colors: You can change
the colours for Foreground,
Background, Margin and Grid
Lines, Amplitude Detection, Phase
Detection and Quality Factor.
This is done by double-clicking in
the checkbox(es). The Color
Dialog window will appear. New
colours can be selected in a
number of different ways (using
the eye dropper tool, entering the
RGB colour code, using
predefined colours etc.).
Select the new colour and click
Accept to apply. Cancel if you do
not want to change the colour.
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4.4 Cross track
The Cross track window is either accessed through the Manage
windows on the View drop-down menu or by selecting it from
the Frames button.
The cross track window shows the measured depths in all beams
from the last ping. The display is updated once per second.
This window is valid for multibeam echo sounders.

The display contains a depth scale along the left-hand (vertical)
axis and beam numbers or metres along the horizontal axis.
Different colours are used to show if a beam has a valid bottom
detection, and if so what type of detection has been used. Red is
used to show beams with phase detection, blue is used to show
beams with amplitude detection. Beams without any detection
are not shown.

Toolbar buttons

The toolbar holds the following buttons (from left to right):
• Show/hide
• Annotation colours
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Show / Hide button

Across Track Units: Select the units for the
horizontal axis.

• Beams: Units for the across track scale are
beams.

• Meters: Units for across track scale are meters.

Across Track Style: Select the line style for the
across track plot.

• Line: The across track plot is displayed as a
continuous line.

• Points: The across track plot is displayed as a
series of points.

• Point size: The size of each point in pixels when
the style is ’Points’. The line width in pixels
when the style is ’Line’.

Across Scaling mode: Options for controlling the
scaling mode for the across axis.

• Auto: Automatically adjust the start and stop
ranges to show the entire range of data each time
data is received.

• Auto Once: Automatically set the start and stop
ranges to show the entire data range once, then
switch to fixed range mode. This option provides
a quick way to set a fixed range that will show all
data.

• Fixed: Use the start and stop ranges entered in the
min and max text boxes.

- Min (m): “Fixed” start (min) range in meters.
- Max (m): “Fixed” stop (max) range in meters.

Keep Across Axis Symmetric: Keeps the across
axis symmetric. If this option is selected, the across
axis will be symmetric about 0 metres, even if the
coverage is not the same to both sides.

Depth Scaling mode: Options for controlling the
scaling mode for the depth axis.

• Auto: Automatically adjust the start and stop
ranges to show the entire range of data each time
data is received.
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• Auto Once: Automatically set the start and stop
ranges to show the entire data range once, then
switch to fixed range mode. This option provides
a quick way to set a fixed range that will show all
data.

• Fixed: Use the start and stop ranges entered in the
min and max text boxes.

- Min (m): “Fixed” start (min) range in meters.
- Max (m): “Fixed” stop (max) range in meters.

Depth Scaling Factor: Factor by which to
multiply the depth for auto scaling calculations.
This has the effect of stretching or compressing
the cross track plot along the depth axis (i.e. a
depth scaling factor of 0.25 compresses the cross
track plot to a quarter of its normal height). This
can make it easier for example to discover
artefacts.

• x .25: Scale the depth by 0.25.
• x .50: Scale the depth by 0.50.
• x 1: No scaling.
• x 2: Scale the depth by 2.
• x 4: Scale the depth by 4.
• x 8: Scale the depth by 8.
Compress Depth to Fit View: When this option is
selected, the data will not be stretched outside the
current view. In cases where the depth scaling factor
would cause the data to be stretched outside the
view, this option has the effect of overriding the
current depth scaling factor and using the next
largest factor that will allow the plot to remain
inside the current view. If the current depth scaling
factor would not otherwise stretch the data outside
the current view, then this setting has no effect.
Refresh Rate: Specify the rate at which the display
is updated (i.e. number of times per second).
• 1: Update the display once time each second.
• 3: Update the display three times each second.
• 10: Update the display ten times each second.

Active: Activate or decativate the display. Deactivating the
display will minimize the CPU usage of the display.
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Axes: Show or hide the axes.
Gridlines: Show or hide the gridlines.
Legend: Show or hide the legend.
Depth Re Water Line: Show the depth (referenced to the water
line) of the most vertical beam in the background of the cross
track display. The text showing the depth is scaled to fit the
background an is large enough to see at a distance.
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Annotation colours button

Display Colors: You can
change the colours for
Foreground, Background,
Margin, Grid Lines, Amplitude
Detected and Phase Detected.
This is done by double-clicking
in the checkbox(es). The Color
Dialog window will appear.
New colours can be selected in
a number of different ways
(using the eye dropper tool,
entering the RGB colour code,
using predefined colours etc.).

Select the new colour and click Accept to apply. Cancel if you
do not want to change the colour.
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4.5 Seabed image
The Seabed image window is accessed through the Manage
windows on the View drop-down menu or by selecting it from
the Frames button.
The Seabed image displays the seabed image data. For each
ping a straight line is plotted, this covers the swath width. The
darkness of the display at any point represents the reflectivity of
the bottom.

The horizontal distance between the outermost
crosses in the view is set by the swath width across
parameters (max and min). If these are selected to be
50 m respectively, the total distance is 100 m.
This can be used to make rough dimension estimates
of artefacts on the seabed.
This window is valid for multibeam echo sounders.

Toolbar button

The toolbar holds the following buttons:

• Show/hide
• Print
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Show / Hide button

Active: Activate or deactivate the display.
Deactivating the display will minimize the CPU
usage of the display.
Paused: Pause or continue the display. While
paused, the display is shown, but it is not updated
with new data.
Time Markers: Show or hide the time markers.
Swath Width: Options for setting the displayed
swath width.
• Across Min (m): Across track start (min) range in

meters.
• Across Max (m): Across track stop (max) range

in meters.
• Autoscaling is enabled by setting the Swath

Width to “Across Max(m): 1.0 m and Across
Min(m): -1.0 m.

Dynamic Range: Options for setting the amplitude
range used for colour mapping.
• Amplit. Min (dB): Miniumum expected

amplitude.
• Amplit. Max (dB): Maximum expected

amplitude.
Color Code: Options for setting the type of colour
coding used by the display.

• High Intensity is Dark: Darker colour (i.e. more
black) indicates higher intensity.

• High Intensity is Light: Lighter colour (i.e. more
white) indicates higher intensity.

Shade Model: Options for setting the shade model
used for displaying the data. Smooth shading may
provide slightly better results when the cell size is
set larger than 1 pixel.

• Flat: Each cell has a distinct colour.
• Smooth: Colours are smoothly interpolated

between cells.
Cell Size: Sets the cell size in pixels. Choosing a larger cell size
reduces the CPU usage of this display significantly.
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• 1 Pixel: Cell size is 1 pixel
• 2 Pixels: Cell size is 2 pixels
• 3 Pixels: Cell size is 3 pixels
• 4 Pixels: Cell size is 4 pixels

Print button

Press this button to print the seabed image view. The seabed
image will be sent to a high speed plotter.
Note that this is a toggle on/off button, so the image will print
continuously until the button is turned off.
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4.6 Numerical display
The Numerical display window is accessed through
the Manage windows on the View drop-down menu
or by selecting it from the Frames button.

This window allows you to monitor several
parameters but the parameters cannot be changed
here. Faults are indicated in red.
If you press the button next to the text, a list with
selectable parameters will appear. Choose the
parameter(s) you want to monitor.
This window is valid for all instruments.

Numerical display parameters

Note that all systems do not have all the parameters
given in this list.

North: Northing in meters in projection coordinates.
East: Easting in meters in projection coordinates.
North DD.DD: Northing in decimal degrees.
East DD.DD: Easting in decimal degrees.
North DDMM.MM: Northing in decimal minutes.
East DDMM.MM: Easting in decimal minutes.
Pos. qual: The position quality calculated from
information in the position telegrams. This is an
indicator of the relative accuracy of the current
position. Refer to the EM datagram manual.
Speed m/s: Speed over ground in meters/second.
Speed kn: Speed over ground in knots.

Heading: The heading from the position datagram. The heading
information itself is coming from the external heading sensor.
ROV depth: The current depth of the sonar head when used on
a ROV (normally from a depth sensor).

Depth: The current centre depth from the waterline to the
seafloor.

Across: Across distance between the outermost beams (same as
swath width).

Coverage: Coverage in degrees to port and starboard.

Beams: Beams received versus maximum available beams.
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Date: The date from the clock datagram. The datagram is
created by the PU (Processing Unit), but the date information
itself comes from an external input, either ZDA or Trimble
UTC.
Time: The time from the clock datagram.
PU-ZDA: Time difference between PU clock and ZDA clock
received in PU.
→ For more information, see Timing chapter on page 389.

PU-POS: Time difference between PU clock and time in
position datagram received in PU.
→ For more information, see Timing chapter on page 389.
Ping Hz: The ping rate (pings per second).
Pingno: The current ping number.
Roll: The current roll angle in degrees.
Pitch: The current pitch angle in degrees.
Heave: The current heave in meters.
Mode: The current mode used by the echo sounder. Refer to the
EM datagram manual.
Tr. svp: The sound velocity used by the echo sounder.
Tr. sensor: The filtered sound velocity from the real time
sensor. The filter length is set in the Runtime menu.
Height: The height from the depth pressure or height datagram.
No. sat.: The number of satellites from the position datagram.
PPS: The PPS status from the clock datagram.

- ON: PPS is connected
- OK: Normal operation
- OFF (and red colour): Failure
- UNUSED: No PPS is connected

Yaw. stab: Heading offset angle used by the Transmitter to
compensate for ship’s yaw.
TVG RN: TVG Range To Normal Incidence from the PU status
output datagram.
The strongest echo from the bottom is usually the first echo
which arrives from where the sound pulse hits the bottom
perpendicularly. The model uses two parameters to describe this
echo:

- Range (equal to depth on flat bottom) to normal incidence
- Normal incidence backscatter strength

This parameter will be used for the TVG calculations.
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TVG NIB: TVG Normal Incidence Backscatter from PU status
output datagram.
This parameter is used to define a value for the backscatter
strength at normal incidence and to estimate a fixed gain for the
next ping.
TVG OB: TVG Oblique Backscatter from the PU status output
datagram.
This parameter is used to set a value for the oblique backscatter
strength. As the incidence angle decreases, the echo strength
falls rapidly. From about 5 to 25 degrees (depending on bottom
type) it may be modelled by the geometry and a single
parameter: the oblique backscatter strength. The model used in
the system assumes the bottom backscatter strength to vary
linearly with incidence angle up to 25 degrees, and to decrease
in accordance with Lambert’s law for larger angles. In addition
the model assumes the bottom to be flat, and that the signal is
attenuated by spherical spreading and absorption loss in the
water column.
The estimated TVG is used in the next ping.
TVG FG: TVG Fixed Gain from the PU status output
datagram.
The preamplifier system normally has two independent gain
controls; a fixed gain consistent during each ping, and the TVG
setting implemented in the system software.
Tx. pow.: Transmit power level from the Runtime parameter
datagram.
PU load: PU (Processing Unit) load from the PU status output
datagram.
Tide: Tide used (predicted or real time).
Geo. und.: Geoid undulation used (the distance from the
ellipsoid to the geoid).
Geo vref.: Distance from geoid to vertical reference from geoid
model.
HDOP: GPS position HDOP indicator derived from the
position input GGA datagram.
Qfactor: GPS position quality indicator derived from the
position input GGA/GGK datagram.
Temp probe C: Real time temperature sensor data (in degrees
Celsius).
SVP probe: Raw unfiltered real time sensor data.
Port/Stb.: Across distance in meters of beams on port and
starboard side.
GSA HDOP: HDOP (Horizontal Dilution Of Precision) from
the NMEA GSA datagram.
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DGPS age: Age of differential GPS data in seconds from the
NMEA GGA datagram.
GST HSTD: HSTD (Horizontal Standard Deviation) derived
from the NMEA GST datagram.
Ref. st.: Name and Id of differential reference station derived
from NMEA GGA datagram and file containing reference
station names.
GGA time: UTC time from NMEA GGA datagram.
GGA height: Height derived from NMEA GGA datagram.
Beam. sp: Type of footprint/distribution of the beams on the
seafloor, for example equidistant or equiangular.
Satellites: Satellites in view. From NMEA GSV datagrams
(maximum 36 satellites). Each satellite is identified by:
• Satellite Id number
• Elevation, Elev., in degrees (maximum 90 deg.)
• Azimuth, Azim, in degrees True (000 to 359 deg.)
• Signal-to-noise ratio, SNR, in dB (0 to 99 dB)
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4.7 Message service
The Message service window is accessed through the Manage
windows in the View drop-down menu or by selecting it from
the Frames button.
This window is valid for all instruments.

You can display the messages you find relevant from a specific
time interval. Use the arrows next to the textfields or write the
desired values directly into them. The time is given by the PC
Clock (but will later be changed to use the PU Clock).
There are three types of messages:
• Info
• Warning
• Error
You can hide the messages you find irrelevant by checking the
check box(es).
A limit of 10000 messages in the database exists. When this
limit is exceeded the system will automatically write all
messages into a file and delete the messages in the database
afterwards. The filename is given by the system and will have
the following structure: <“current date”_“current
time”_msg.txt>.
Select the file by writing its name in the textfield or use the
browse button (three dots).
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Show: Displays the messages in the field below.
Print: The message(s) will be sent to file. The name of the file
is given in the File name text field.
Delete: Delete messages. When deleting messages all messages
are shown.
Help: This button provides on-line help.
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4.8 Helmsman Display
The Helmsman Display window is accessed through the
Manage windows on the View drop-down menu or by selecting
it from the Frames button.
This window is valid for all instruments.

A line may have several waypoints and the DTK, XTE, TTG,
DST and XTE deviation indicators all show their values to the
next waypoint or to the current line segment. The scale changes
automatically. Red and green arrows indicate that the helmsman
should steer port or starboard to relocate. Before the ship
reaches the start of the line, the indicator will form an arrow
pointing downwards.
When you reach the end of the line (or before you come to the
line) the Helmsman Display will continue to display the ship’s
position relative to the continuation of the last line segment of
the planned line.

Toolbar buttons
The toolbar holds the following buttons (from left to right):
• Show/hide
• Annotation colours
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Show / Hide button

Active: Activate or deactivate the display. Deactivating
the display will minimize the CPU usage of the display.
Position: Show or hide the position text fields (latitude
and longitude).
• DD.DD: Display position as decimal degrees.
• DD MM.MM: Display position as degrees and decimal

minutes.
• DD MM SS.SS: Display position as degrees, minutes,

and decimal seconds.
• Projection: Display position as projection coordinates.
DPT: Show or hide the water depth text field.
SOG: Show or hide the speed over ground text field.
• m/s: Display speed over ground in units of meters per

second.
• Knots: Display speed over ground in units of knots.
COG: Show or hide the course over ground text field.
DTK: Show or hide the desired track text field. This is the
heading of the current line segment.
BRG: Show or hide the course to waypoint text field.
This is the heading from the current position to the next
waypoint.
XTE: Show or hide the cross track error text field. This is
the shortest distance to the current line segment.
RNG: Show or hide the range to waypoint text field. This
is the distance from the current position to the next
waypoint.
ETW: Show or hide the estimated time to the next
waypoint text field. This is the estimated time of arrival at
the next waypoint.
ETA: Show or hide the estimated time of arrival text field.
This is the estimated time of arrival at the last point in the
current planned line.
XTE Plot: Show or hide the cross track error plot.
APB Output: Enable or disable output of the NMEA
APB message to the autopilot.

→ For the setup of the serial line see external sensor, page 310.
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Note NMEA APB datagrams contain information regarding the
vessel’s position with regard to the active survey line. The
correctness of this information is critically dependent on
positioning system input, correct setup of the system and user
definition of the survey. Using the APB datagrams as autopilot
input is possible as a help in steering the vessel during the
survey, but it cannot in any way relieve the vessel crew from the
responsibility in safe handling of the vessel. The APB output is
only available when the Helmsman Display window is open.

Annotation colours button

Display Colors: You can
change the colours for
Foreground, Background and
XTE Plot.
This is done by double-clicking
in the checkbox(es). The Color
Dialog window will appear.
New colours can be selected in
a number of different ways
(using the eye dropper tool,
entering the RGB colour code,
using predefined colours etc.).

Select the new colour and click Accept to apply. Cancel if you
do not want to change the colour.
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4.9 Color coded depth
The Color coded depth window is either accessed through the
Manage windows on the View drop-down menu or by selecting
it from the Frames button.
This window is valid for multibeam echo sounders.

The Color coded depth window shows the colour coded depth
per beam using a history buffer of varying size. The size of the
history buffer depends on the size of the display. One vertical
screen unit (pixel) is used per ping. Increasing the vertical size
of the display area increases the number of vertical screen units,
thus increasing the history buffer size.

Toolbar button

The toolbar holds the following button:
• Show/hide
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Show / Hide button

Active: Activate or decativate the display. Deactivating
the display will minimize the CPU usage of the display.
Shade Model: Options for setting the shade model used
for displaying the data.

- Flat: Each cell has a distinct colour.
- Smooth: Colours are smoothly interpolated between

cells.
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4.10 Time series
The Time series window is accessed through the Manage
Windows on the View drop-down menu or by selecting it from
the Frames button.
The Time Series window is used for displaying either external
interfaces or depth information. The information for one or
more sensors or beams are selectable.
The information displayed can indicate to the operator if a
sensor is performing incorrectly or the depth is calculated
incorrectly.

Toolbar buttons

The toolbar holds the following buttons (from left to right):
• Show/hide
• Annotation colours
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Show / Hide button

Active: Activate or deactivate the display.
Deactivating the display will minimize the CPU
usage of the display.
Axes: Makes the axes and/or legends visible.

• Show or hide axis Y1.
• Show or hide legend Y1.

• Show or hide axis Y2.
• Show or hide legend Y2.
Grid lines: Show or hide the grid lines.

Y1 Data Type: Select the data type to plot on the
Y1-axis.
• Depth (4 beams): Depth of four user selected

beams.
• Depth (below keel): Depth below the water

surface for the most vertical beam. The centre
beam is most likely not the most vertical beam
due to the roll of the vessel.

• Depth (center beam): Depth of the centre beam.
• Depth (EM and EA): Depth of the EA (single

beam echo sounder) compared to the depth of the
shallowest EM (multibeam echo sounder) beam
(in the ping) that lies within the footprint of the
EA sounder.

• Heave (active): Heave from the active motion
sensor. This is selected for graphical presentation.

• Heave (inactive): Heave from the inactive motion
sensor. This is logged onto the hard disk.

Y2 Data Type: Select the data type to plot on the
Y2-axis.

• Across (4 beams): Across track distance of four
user selected beams.

• Backscatter (4 beams): Backscatter strength of
four user selected beams.

• Backscatter (center beam): Backscatter strength
of the centre beam.

• Height: Height from the height sensor.
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• Pitch/Roll (active): Pitch and roll from the active motion
sensor. This is selected for graphical presentation.

• Pitch/Roll (inactive): Pitch and roll from the inactive motion
sensor. This is logged onto the hard disk.

X axis Range Mode: Mode used to set the X-axis (time axis)
range.
• Auto: Use the range of the longest displayed data series

(show all data).
• Sync: Use the longest range common to all the displayed data

series.
• Fixed: Set the range to a fixed number of seconds.

- Window: Range (time window) in seconds.
User Beams: The beams for the data types which require the
user to select four beams. This feature is used to compare
beams, normally on a flat seabed.
• Beam: First user selected beam.
• Beam: Second user selected beam.
• Beam: Third user selected beam.
• Beam: Fourth user selected beam.
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Annotation colours button

Display Colours: You can change
the colours for Foreground,
Background, Margin, Grid Lines,
Height, Heave, Pitch, Roll, Beams
etc.
This is done by double-clicking in
the checkbox(es). The Color
Dialog window will appear. New
colours can be selected in a
number of different ways (using
the eye dropper tool, entering the
RGB colour code, using
predefined colours etc.).
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Select the new colour and click Accept to apply. Cancel if you
do not want to change the colour.
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4.11 Waterfall
The Waterfall window is accessed through the Manage
Windows on the View drop-down menu or by selecting it from
the Frames button.
In the Waterfall window the depth profiles from a number of
pings are displayed as a function of acrosstrack horizontal
distance with a small vertical offset between each profile. This
gives a crude 3D representation of the most recently measured
bottom area.

The color coding applied to the profiles shows different depth
levels, not bottom detection type as in the other displays. The
deepest areas will be given a deep blue colour, shifting to lighter
blue as the depth decreases. In ranges of middle depths,
different shadings of green are used. The shallow areas are
represented as different shadings of red.
As the depth will usually change with position, the color codes
used initially may only be adequate for a limited time period.
Therefore, an automatic adjustment of the depth ranges
allocated to each color code will take place.
Inside the Waterfall presentation the operator can rotate, pan and
zoom using the mouse and keyboard combinations.

Rotation (Shift key + Right mouse button)
To rotate the waterfall grid using the mouse, hold down the
Shift key, right click on the waterfall grid, and drag the mouse.
To understand how to rotate the grid, it may be helpful to
visualize a “virtual trackball” in the center of the view. To rotate
the grid, click and drag the mouse as if you were trying to rotate
this “virtual trackball”. For example, if you click the mouse in
the center of the view (i.e. the center of the virtual trackball) and
drag straight up or down, the virtual trackball will rotate about
it’s horizontal axis (i.e. the x-axis). This results in the grid
rotating purely about the x-axis.
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If you click the mouse in the center of the view and drag straight
to the left or right, the virtual trackball will rotate about it’s
vertical axis (i.e. the y-axis). This results in the grid rotating
purely about the y-axis.
If you click the mouse at the edge of the view, and then drag the
mouse, the virtual trackball will rotate about an axis
perpendicular to the plane of the view (i.e. the z-axis). This
results in the grid rotating purely about the z-axis.

Panning (Alt key + Right mouse button)

To pan the waterfall grid using the mouse, hold down the Alt
key, right click on the waterfall grid, and drag the mouse.

Zooming (mouse wheel)

To zoom in or out on the waterfall grid using the mouse wheel,
rotate the wheel forward to zoom in, or backward to zoom out.

Toolbar buttons

The toolbar holds the following buttons (from left to right):
• Show/hide
• Annotation colours
• Dynamic Colors Button
• Reset View Button
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Show / Hide button

Active: Activate or decativate the display.
Deactivating the display will minimize the CPU
usage of the display.
Paused: Pause or continue the display of waterfall
data. While paused, the display is visible, but it is
not updated with new data.
Gray Scale: Display the Waterfall in grayscale. This
mode requires much less CPU than the full colour
mode.
Lighting: Enable or disable lightning (and 3D
shading). Useful in situations where the shape of the
grid is such that shading makes the grid (or portions
of the grid) difficult to see.
Color Scale: Show or hide the colour scale legend
(shown along the bottom of the grid).
Show All Pings: When selected, all pings are
displayed. When not selected, only the most recent
ping is displayed. Deselecting this options can
reduce the CPU load of this display significantly
(depending on the ping rate).
Across Track Units: Select the units for the
horizontal axis.
• Beams: Units for the across track scale are

beams.
• Meters: Units for across track scale are meters.

Depth Scale Factor: Factor by which to multiply
the depth. This has the effect of stretching the
waterfall grid along the depth axis (i.e. a depth
scaling factor of 2 stretches the waterfall grid to
twice its normal height). This can make it easier for
example to discover artefacts.
• x 1: No scaling.
• x 2: Scale the depth by 2.
• x 5: Scale the depth by 5.
• x 10: Scale the depth by 10.
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View Point: Set the point from where the grid is viewed
• Front Upper Left: Set the view point to the front upper left of

the grid.
• Front Upper Center: Set the view point to the front upper

center of the grid.
• Front Upper Right: Set the view point to the front upper right

of the grid.
• Back Upper Center: Set the view point to the back upper

center of the grid.
Light Position: Set the position of the light source.
• Front Upper Left: Position the light source at the front upper

left of the grid.
• Front Upper Center: Position the light source at the front

upper center of the grid.
• Front Upper Right: Position the light source at the front

upper right of the grid.
• Back Upper Center: Position the light source at the back

upper center of the grid.
Waterfall Style: Set the style in which the waterfall grid is
displayed.
• Filled: The grid is displayed as a surface.
• Lines: The grid is displayed as a triangle mesh.
• Points: The grid is displayed as a point set.
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Annotation colours button

Display Colors: You can change
the colours for Foreground and
Background.
This is done by double-clicking in
the checkbox(es). The Color
Dialog window will appear. New
colours can be selected in a
number of different ways (using
the eye dropper tool, entering the
RGB colour code, using
predefined colours etc.).

Select the new colour and click Accept to apply. Cancel if you
do not want to change the colour.
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Dynamic colours button

Map a range of colors to the range of depths displayed on the
Waterfall Display.

Color Wheel: Set the range of colors. Drag the lines to set the
start color and end color in the range.

Direction: Set the direction of traversal of the color map. This
determines if the coloer wheel is traversed in a clockwise or in a
counter clockwise direction when mapping colord to depths.

Overflow: The Overflow options are not enabled for this
display.
Intensity: Set the intensity of the colors in the color map.

Reset View Button

Reset pan, zoom, and rotation to default values.
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4.12 Water column
The Water column windows is accessed through the Manage
windows in the View drop-down menu or by selecting it from
the Frames button.

The Water Column display shows a graphical representation of
the beamformed data for the entire water column for each beam.
The display can be useful for debugging and for habitat
monitoring.

Note Sound velocity corrections and ray bending corrections are not
corrected for.

This window is valid for multibeam echo sounders with water
column capabilities (for example EM 710 and EM 3002).

The display shows the received amplitude of the entire water
column for each beam. The vertical scale on the left of the
display shows the depth in metres, and the horizontal scale
along the bottom of the display shows the across track distance
in metres. The seafloor is shown as a yellow or red band in the
data view.

The Water column window is associated with a status button for
water column logging - WCol. This button is located on the
toolbar between the logging and pinging buttons.
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The button reflects the status of water column logging. This is
set in the show/hide parameters and is visible even if the water
column window is closed.

Red WCol: indicates Not logging.

Green WCol: indicates Logging enabled.

Note Water column data is being logged only when water column
logging is enabled (green WCol button) and normal raw data
logging is on i.e green Logging On/Off button.

Zooming

It is possible to zoom in on a region of the grid by clicking the
left mouse button and dragging a rectangle around a region of
the grid. When the left mouse button is released, the region of
the grid to which you have zoomed will be displayed.

Note also, that the Zoom Reset button will
now be enabled (i.e. it is no longer dimmed).
It is possible to zoom in even further, by
clicking and dragging a rectangle inside the
zoomed region.

To reset the zoom, click the Zoom Reset
button. This will return the display to the
scaling mode that existed prior to the original
zoom operation. You can also reset the zoom
by selecting one of the auto range options
from the Show/Hide dialogue.

Toolbar buttons

The toolbar holds the following buttons (from left to right):

• Show/hide

• Annotation colours

• Dynamic colours

• Paused

• Zoom Reset
• Auto Scale

• Auto Scale Once

• Fixed Scale
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Show / Hide button

Active: Activate or deactivate the display.
Deactivating the display will minimize the CPU
usage of the display.
Logging: Select whether to log data to local hard
disk or not. The logged data amount is very large
and must be started separately from the normal
logging sequence. Typical datarate is 1 to 2 Gb per
hour.
Axes: Show or hide the axes.
Color Scale: Show or hide the colour scale legend
(shown along the bottom of the grid).
Detected Depth Curve: Show or hide a curve
showing the detected depth for all beams. The curve
is shown on top of the water column data
Paused: Pause or continue the display of water
column data. While paused, the display is visible,
but it is not updated with new data.
Stretch Data to Fill View: When this option is not
selected, the same scale is used for both x- and
y-axes. In this case, the data is displayed with
correct proportions, but this may result in a lot of
unused space in the view.
When this option is selected, the x-and y-axes are
scaled such that the data fills the display.
Head 1: Show or hide the data from sonar head 1.
• Max Angle Port: The maximum beam angle to

the port side for sonar head 1.
• Max Angle Stbd: The maximum beam angle to

the starboard side for sonar head 1.
Head 2: Show or hide the data from sonar head 2
(applicable for dual sonar head sounders only).
• Max Angle Port: The maximum beam angle to

the port side for sonar head 2.
• Max Angle Stbd: The maximum beam angle to

the starboard side for sonar head 2.

Overlap Mapping Mode: Options for controlling how the data
in the overlapped region is displayed (valid for dual sonar head
echo sounders only).
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• Cut: The data from each head is “cut” vertically at 0 meters
across.

• Blend 1: The overlap area is blended using alpha blending.
No saturation in the overlap area.

• Blend 2: The overlap area is blended using alpha
blending. Saturated in the overlap area.

• Head 1: The data from head 1 is displayed on top
of the data from head 2.

• Head 2: The data from head 2 is displayed on top
of the data from head 1.

Depth Start Range Mode: Options for
controlling the start range mode of the depth axis
scale.

• Auto: Automatically set the start range to match
the minimum range of the data each time data is
received.

• Auto Once: Automatically set the start range of
the depth axis to match the minimum range of the
data (once), then switch to fixed range mode.

• Fixed: Use the range entered in the Range (m)
text box.

- Range (m): “Fixed” start range (in metres).

Depth Stop Range Mode: Options for
controlling the stop range mode of the depth axis
scale.

• Auto: Automatically set the stop range of the
depth axis to match the maximum range of the
data each time data is received.

• Auto Once: Automatically set the stop range of
the depth axis to match the maximum range of
the data (one time), then keep this fixed range.

• Fixed: Use the range entered in the (Stop) Range
text box.

- Range (m): “Fixed” depth axis stop range (in
metres).

Across Start Range Mode: Options for controlling the start
range mode of the across axis scale:
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• Auto: Automatically set the start range of the across axis to
match the minimum range of the data each time data is
received.

• Auto Once: Automatically set the start range of the across
axis to match the minimum range of the data (once), then
switch to fixed range mode.

• Fixed: Use the range entered in the (Start) Range text box .
- Range (m): “Fixed” across axis start range (in metres).

Across Stop Range Mode: Options for controlling the stop
range mode of the across axis scale.
• Auto: Automatically set the stop range of the across axis to

match the minimum range of the data each time data is
received.

• Auto Once: Automatically set the stop range of the across
axis to match the minimum range of the data (once), then
keep this fixed range.

• Fixed: Use the range entered in the (Stop) Range text box .
- Range (m): “Fixed” across axis stop range (in metres).

Color Map Mode: Select the type of colour mapping to be used
by the display.
• Color: Map a range of colours to a range of data. The range

of colours and the data range to which the colours are
mapped are set via the Dynamic Colors dialogue.

• Grayscale: Map a grayscale range (i.e. black to white) to a
range of data. The grayscale range and the data range to
which the grayscale is mapped are set via the Dynamic
Colors dialogue.

Note Blending Type A and Blending Type B Overlap Mapping Mode
options are not enabled if the background color is any color
other then black. Although it is not possible to change the
background color using Water Column Display menus, The SIS
application does provide a means to change the background
color (via the Color Palette menu).
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Annotation colours button

Display Colours: You can change the colours for
Foreground and Detected Depth Curve.
This is done by double-clicking in the checkbox(es). The
Color Dialog window will appear. New colours can be
selected in a number of different ways (using the eye
dropper tool, entering the RGB colour code, using
predefined colours etc.).
Select the new colour and click Accept to apply. Cancel if
you do not want to change the colour.
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Dynamic colours button

Color map: Select which
objects to set the dynamic
colours.
Color wheel: Set the colour
representation of the
dynamic colours. Drag the
arrow to set the start and
stop limits.
Direction: Set the direction
of the arrow (CW or CCW).
Overflow: Choose a
overflow strategy for the
colours. (Clamp - lock to the
limits, wrap - restart when
reaching a limit, cut - do not
show data outside the limits.)
Only valid when fixed
scaling is selected.
Scaling: Select automatic or
fixed scaling.

Data Range: Manually set the range (max/min) for the selected
objects. The total range is found automatically from the data.
Single Color Ranges: Click in the Enable check box to set a
range of data values to a single colour. For each set of dB range
a different colour can be chosen. Double-click in the right
checkbox to open the Color Dialog window.
The dialogue can also be used to filter out all data below a
certain amplitude threshold. For example, this might be useful
for easily identifying targets within the water column.
The two figures below show the display before and after all of
the values below 25 dB have been filtered out.
Note that data range values must be entered in the Dynamic
colors dialogue in dB (not metres).

Paused button

Pause or continue the display of water column data. While
paused, the display is visible, but it is not updated with new
data.
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Zoom Reset button

Reset the display after a zoom operation. This button is only
active if the display has been “zoomed”. Clicking on this button
will reset the start and stop ranges and the start and stop range
modes.

Auto Scale button

Set both the Start Range Mode and the Stop Range Mode of
both the depth and across axes to Auto.
When the Start Range is set to Auto, the start range of the each
axis is automatically set to the minimum value in the data set
each time data is received. When the Stop Range is set to Auto,
the stop range of each axis is automatically set to the maximum
value in the data set each time data is received.
This button provides a quick and convenient way to set both the
start and stop ranges to Auto.
Pressing this button is equivalent to opening the Show/Hide
dialogue and selecting Start Range! Auto and Stop Range!
Auto for both the depth and across axes.

Auto Scale Once button
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Set both the Start Range Mode and the Stop Range Mode (of
both the depth and across axes) based on the values of the
current data set, then keep this range setting for the rest of the
data.
The fixed start and stop range values in the Show/Hide dialogue
will be updated with the new values. This is a quick and
convenient way to change to Fixed range mode and
simultaneously update the fixed start and stop ranges with
values appropriate for the current water column data.

Note Pressing this button will update the Fixed start range value and
the Fixed stop range value in the Show/Hide dialogue.

Fixed Scale button

Set both the Start Range Mode and the Stop Range Mode of
both the depth and across axes to Fixed. The start and stop
ranges will be set to the values that were last entered in the
respective Start/Stop Range text boxes in the Show/Hide
dialogue.
This button provides a quick and convenient way to set the start
and stop ranges of both axes to Fixed.
Pressing this button is equivalent to opening the Show/Hide
dialogue and selecting Start Range! Fixed and Stop Range!
Fixed.
Note that this is not equivalent to clicking on the Auto Scale
Once button because the Fixed Start/Stop Range values in the
Show/Hide dialogue are not updated in this case.
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4.13 Sound velocity profile
The Sound velocity profile window is accessed through the
Manage windows on the View drop-down menu or by selecting
it from the Frames button.
The Sound velocity profile window is used for displaying the
profile the multibeam echo sounder is using. It is not an editor.
→ SVP Editor, page 442.

The profile is a sequence of points. These have coordinates with
increasing depth values.

Toolbar buttons

The toolbar holds the following buttons (from left to right):
• Show/hide
• Annotation colours
• Zoom Reset
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Show / Hide button

Active: Activate or deactivate the
display. Deactivating the display
will minimize the CPU usage of
the display.
Axes: Show or hide the axes.
Grid Lines: Show or hide the grid
lines.
Data Points: Show the sound
velocity profile sample values on
the sound velocity profile plot.



Seafloor Information System / Base version

122 850-164709 / E

Annotation colours button

Display Colors: You can change
the colours for Foreground,
Background, Margin, Grid Lines
and SVP.

This is done by double-clicking in
the checkbox(es). The Color
Dialog window will appear. New
colours can be selected in a
number of different ways (using
the eye dropper tool, entering the
RGB colour code, using
predefined colours etc.).

Select the new colour and click Accept to apply. Cancel if you
do not want to change the colour.

Zoom Reset button

Reset the display after a zoom operation. This button is only
active while the display is “zoomed”. Clicking on this button
will reset the start and stop ranges.

Zooming

Using the Left mouse button: You can zoom to a region of the
sound velocity profile using the left mouse button. To zoom to a
region of the sound velocity profile, use the left mouse button to
drag a rectangle around the region of the plot to which you want
to zoom. Press the “Zoom Reset Button” to return the display to
the normal (un-zoomed) state.

The following figures display, from left to right, a sound
velocity profile before, during and after zooming respectively.
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Using the mouse wheel: You can zoom in or out on the
displayed region of the sound velocity profile using the mouse
wheel. To zoom in/out using the mouse wheel, hold down the
Ctrl key and spin the mouse wheel forward (to zoom in) or
backward (to zoom out). Press the “Zoom Reset Button” to
return the display to the normal (un-zoomed) state.

Panning

Using the mouse wheel: You can pan up or down on the
displayed region of the sound velocity profile using the mouse
wheel. To pan up or down using the mouse wheel, hold down
the Alt key and rotate the mouse wheel forward (to pan up) or
backward (to pan down). Note that you can not pan up or down,
unless you have previously zoomed in on a region of the sound
velocity profile.
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4.14 Scope display

The Scope display window is accessed through the Manage
windows on the View drop-down menu or by selecting it from
the Frames button.

The window can be used to investigate the receiver echo data,
and is used mainly for test purposes. The data is not logged.

This window is valid for multibeam echo sounders.

The data is shown with time on the horizontal x-axis and level
on the vertical y-axis. Beams close to the normal incidence will
have a short echo and a noisy split beam phase signal. The outer
beams will normally have a long echo and a well-defined phase
curve. The range for the bottom detection is indicated by a
vertical dotted line. A dark blue line indicates an amplitude
detection, and a red line indicates a phase detection.

Which beam to investigate is set in the Simulator tab on the
Runtime parameters window.

→ Simulator tab, page 273.

The example below shows a phase detection for beam number
50.
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Toolbar buttons

The toolbar holds the following buttons (from left to right):
• Show/hide
• Annotation colours

Show / Hide button

Active: Activate or deactivate the
display. Deactivating the display
will minimize the CPU usage of
the display.
Axes: Show or hide the axes.
Grid Lines: Show or hide the grid
lines.
Legend: Show or hide the legend.
Annotation: Show or hide the on
screen text annotation.
Data As Point: Show the data
series as a series of points, rather
than a solid line.
Amplitude: Show or hide the
amplitude plot. The amplitude of
the received echoes is plotted in a
dark blue colour.

Filtered Amplitude: Show or
hide the plot of the filtered
amplitude. The filtered amplitude
is plotted in a light blue colour.
Phase: Show or hide the plot of
the electrical phase difference
between the two so-called half
beams. This is also called the
interferometric, or split beam
phase signal. The phase is plotted
in a red color.
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Annotation colours button

Display Colors: You can change
the colours for Foreground,
Background, Margin and Grid
Lines.
This is done by double-clicking in
the checkbox(es). The Color
Dialog window will appear. New
colours can be selected in a
number of different ways (using
the eye dropper tool, entering the
RGB colour code, using
predefined colours etc.).

Select the new colour and click Accept to apply. Cancel if you
do not want to change the colour.
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4.15 Stave display
The Stave display window is accessed through the Manage
windows in the View drop-down menu or by selecting it from
the Frames button.
The Stave display window shows a graphical presentation of all
the receiver elements or staves in the multibeam. The number of
staves varies from multibeam to multibeam.
The Stave display can be helpful for debugging and
performance check of the system, establishing if there are
interference from other systems, if there are air bubbles etc. The
data is not logged.
This window is valid for multibeam echo sounders with stave
display capabilities (for example EM 710 and EM 3002).

The Stave display presents a grid in which each row of the grid
corresponds to one data sample, and each column in the grid
corresponds to one receive stave. Each grid cell shows the
received signal level for the corresponding sample and stave.

The scale along the left vertical axis shows the sample number,
the scale along the right vertical axis shows the range in meters,
and the scale along the horizontal axis at the bottom shows the
stave number.
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Zooming

It is possible to zoom in on a region of the grid by clicking the
left mouse button and dragging a rectangle around a region of
the grid.

When the left mouse button is released, the
region of the grid to which you have zoomed
will be displayed. Note also, that the Zoom
Reset button will now be enabled (i.e. it is no
longer dimmed). It is possible to zoom in even
further, by clicking and dragging a rectangle
inside the zoomed region.
To reset the zoom, click the Zoom Reset
button. This will return the display to the
scaling mode that existed prior to the original
zoom operation. You can also reset the zoom
by selecting one of the auto range options
from the Show/Hide dialogue.

Displaying cell information

It is possible to display the sample number, stave number, TVG,
and level for any grid cell. To display the cell information, hold
down the Ctrl key and left click the desired grid cell. Because
the size of the grid cells sometimes is very small (often there are
several cells per screen pixel), is it often necessary to first zoom
into a region of the grid before clicking on a cell.

The cell information will remain on the screen
(and will be updated in real time as stave data
is received) until the user left clicks
somewhere inside the grid.
The user can repeatedly display cell
information for several cells by holding down
the Ctrl key, and repeatedly left clicking on
different grid cells. In this case, it may be
helpful to pause the display first (otherwise the
data will continue to be updated in real time).

TVG curve

It is possible to display the TVG curve on top of the stave data.
The TVG curve can be shown or hidden from the Show/Hide
dialogue. A scale for the TVG curve is not shown, however it is
possible to determine the TVG at any location on the curve by
pressing the Ctrl key and left clicking at that location on the
curve.
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Toolbar buttons

The toolbar holds the following buttons (from left to right):
• Show/hide
• Annotation colours
• Dynamic colours
• Paused
• Zoom Reset
• Auto Scale

• Auto Scale Once
• Fixed Scale
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Show / Hide button

Active: Activate or decativate the display.
Deactivating the display will minimize the CPU
usage of the display.
Axes: Show or hide the axes.
• Axis Y1: Show or hide the Sample axis (the

vertical axis to the left of the grid).
• Axis Y2: Show or hide the Range axis (the

vertical axis to the right of the grid).
TVG Curve: Show or hide the TVG (time varying
gain) curve. When shown, the TVG curve is
displayed on top of the Stave data grid.
Color Scale: Show or hide the colour scale legend
(shown along the bottom of the grid).
Paused: Pause or continue the display of stave data.
While paused, the display is visible, but it is not
updated with new data. This may be useful for
example if you want to look at the cell information
of more than one cell in the grid for a single ping.
Start Range Mode: Options for controlling the start
range mode for the vertical scale(s).
• Auto: Automatically set the start range to match

the minimum range of the data each time data is
received.

• Auto 90: Automatically set the start range to be
90 percent of the range to normal incidence each
time data is received.

• Auto Once: Automatically set the start range
(once) to match the minimum range of the data,
then keep this fixed range.

• Fixed: Use the range entered in the Range
(samples) text box.
- Range (m): “Fixed” start range (in samples).

Stop Range Mode: Options for controlling the stop range mode
for the vertical scale(s).
• Auto: Automatically set the stop range to match the

maximum range of the data each time data is received.
• Auto Once: Automatically set the stop range (once) to match

the maximum range of the data, then keep this fixed range.
• Fixed: Use the range entered in the Range (samples) text box.

- Range (m): “Fixed” stop range (in samples).
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Annotation colours button

Display Colours: You can change
the colours for Foreground,
Margin and TVG Curve.
This is done by double-clicking in
the checkbox(es). The Color
Dialog window will appear. New
colours can be selected in a
number of different ways (using
the eye dropper tool, entering the
RGB colour code, using
predefined colours etc.).

Select the new colour and click Accept to apply. Cancel if you
do not want to change the colour.
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Dynamic colours button

Color map: Select which
objects to set the dynamic
colours.
Color wheel: Set the colour
representation of the
dynamic colours. Drag the
arrow to set the start and
stop limits.
Direction: Set the direction
of the arrow (CW or CCW).
Overflow: Choose a
overflow strategy for the
colours. (Clamp - lock to the
limits, wrap - restart when
reaching a limit, cut - do not
show data outside the limits.)
Only valid when fixed
scaling is selected.

Scaling: Select automatic or fixed scaling.
Data Range: Manually set the range (max/min) for the selected
objects. The total range is found automatically from the data.

Paused button

Pause or continue the display of stave data. While paused, the
display is visible, but it is not updated with new data. This may
be useful for example if you want to look at the cell information
of more than one cell in the grid for a single ping.

Zoom Reset button

Reset the display after a zoom operation. This button is only
active while the display is “zoomed”. Clicking on this button
will reset the start and stop ranges.
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Auto Scale button

Set both the Start Range Mode and the Stop Range Mode to
Auto.

When the Start Range is set to Auto, the start range of the
Sample (and Range) axis is automatically set to the minimum
value in the data set each time data is received. When the Stop
Range is set to Auto, the stop range of the Sample (and Range)
axis is automatically set to the maximum value in the data set
each time data is received.

This button provides a quick and convenient way to set both the
start and stop ranges to Auto.

Pressing this button is equivalent to opening the Show/Hide
dialogue and selecting Start Range! Auto and Stop Range!
Auto.

Auto Scale Once button

Set both the Start Range Mode and the Stop Range Mode based
on the values of the current data set, then keep this range setting
for the rest of the data.

The fixed start and stop range values in the Show/Hide dialogue
will be updated with the new values. This is a quick and
convenient way to switch to Fixed range mode and
simultaneously update the fixed start and stop ranges with
values appropriate for the current stave data.

Note Pressing this button will modify the Fixed start range value and
the Fixed stop range value in the Show/Hide dialogue.

Fixed Scale button

Set both the Start Range Mode and the Stop Range Mode to
Fixed. The start and stop ranges will be set to the values that
were last entered in the respective Start/Stop Range text boxes
in the Show/Hide dialogue.

This button provides a quick and convenient way to set both the
start and stop ranges to Fixed.

Pressing this button is equivalent to opening the Show/Hide
dialogue and selecting Start Range! Fixed and Stop Range!
Fixed.

Note that this is not equivalent to clicking on the Auto Scale
Once button because the Fixed Start/Stop Range values in the
Show/Hide dialogue are not updated in this case.
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4.16 New survey
The New survey window is accessed through the Manage
windows on the View drop-down menu or by selecting it from
the Frames button.
This window is valid for all instruments.
It contains the following tab-menus:
→ Basic Parameters, page 135.
→ Storage options, page 137.
→ Advanced options, page 139.
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Basic Parameters

The Basic parameters is located under the New survey display
view.

The user need only to enter a survey name and a comment when
creating a new survey. It is then required that the parameters for
the default surveys are maintained by the user.

Parameters

New Survey name: Enter the new survey name in the text field.

Select survey-template: Select a survey template for the
parameters for Storage options and Advanced options.

User: Select a user from the combo box. To add new user(s),
you must use the User handling.

→ User handling, page 147.

Existing Surveys: Select an existing survey from the combo
box. Press the Continue on existing survey button before the
survey can be changed.

Comment: Write your own comment for the survey in the text
field.
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Save new survey: Press this button to create the new survey.
All parameters stored under the Storage options tab and the
Advanced options tab are stored in the database for this new
survey.
→ Storage options, page 137.
→ Advanced options, page 139.
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Storage options

Storage options is located on the New survey display view and
under the Survey templates handling tab on the Survey
administration display view.

Parameters

Survey data storage location: The text field is used to identify
the preferred location of the Survey Data files. Enter the folder
identification directly, or use the browse-button to navigate.

Raw data root location: The text field is used to identify the
preferred location of the Raw Data files. Enter the folder
identification directly, or use the browse-button to navigate.
Press the “Apply to all default surveys” button to apply.

Current rawdata storage structure gives you a description of
the current structure. Press Use current structure if you want
to keep the current structure or press Clear new survey if you
want to create a new structure.

You can build a new storage structure by enabling the check
boxes of the parameters you want to use. The new structure will
appear in the text field behind New rawdata storage structure.
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Apply to all default surveys: This will update these parameters
for all the default surveys currently in the database.
If you want to store these parameters to a particular survey, you
must use the Basic Parameters.
→ Basic Parameters, page 135.
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Advanced options
Advanced options is located on the New survey display view
and under the Survey templates handling tab on the Survey
administration display view.
It contains three new tabs:
→ Background data, page 140.
→ Projections, page 142.
→ GridEngine Parameters, page 144.
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Background data
Background data is located under the Advanced options tab on
the New survey display view and under the Advanced options
tab under the Survey templates handling tab on the Survey
administration display view.
This connects the background data to a new survey.

Parameters
Path to Background data: Choose the path you want to use for
the background data. You can use the browse button to find a
path.
In the background data directory these files can be stored:
• Projection setup: proj.txt, used to define the geographic

projection for this survey.
• KSGPL background data: *.ksgpl, KSGPL-formatted files

with background data to be shown in the Geographical
display.

• Predicted tide: predictedtide.tide, predicted tide file.
• Geoid model: geoidmodel.geoid, geoid model.
Comment: Write your own comment for the background data.
Apply this path to Default survey: Press this button to apply
the path.
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If you want to store these parameters to a particular survey, you
must use the Basic parameters (New survey) or Basic
parameters (Survey administration) .
→ Basic Parameters (New survey), page 135.
→ Basic Parameters (Survey administration), page 151.
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Projections

Projections is located under the Advanced options tab on the
New survey display view and under the Advanced options tab
under the Survey templates handling tab on the Survey
administration display view.

When you define a survey or a survey template, you can define
what projection to use in that survey or survey template. New
projections can be created and tested using the Projection setup
application available from the Tools > Custom menu.

Parameters

Projection: Select a projection from the drop-down combo box.
→ The Projection component, page 406.

If a new survey has been stored, or pinging or logging is started,
the surveys held inside SIS is locked to this projection. Only
surveys with the same projection can be shown in the
Geographical view.

It is possible to change projection after a projection has been set.

Apply this projection to the Default survey: These projections
will be saved in the database for all default surveys.
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If you want to store these parameters to a particular survey, you
must use the Basic parameters (New survey) or Basic
parameters (Survey administration) .
→ Basic Parameters (New survey), page 135.
→ Basic Parameters (Survey administration), page 151.

Change projection

It is possible to change projection after a projection has been set.
Shut down SIS or perform the following procedure:
1 Stop pinging.
2 Close the Geographical and New survey windows (if

open).
3 Set the active survey to “None”.
4 Open the New survey window and access the Projections

tab. The Projection drop-down combo box is now enabled,
and you can select a new projection.

5 Open the Import/Export dialogue box from the File menu,
and remove the old survey. This can only be removed after
a new survey is established to the echo sounder.

6 Save the new survey.
7 Start pinging.
8 Open the Geographical window.
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GridEngine parameters
The GridEngine parameters is located under the Advanced
options tab on the New survey display view and under the
Advanced options tab under the Survey templates handling tab
on the Survey administration display view.
When you define a survey or a survey template, you can define
what parameters to use for the GridEngine in that survey or
survey template.

Parameters

Depth variable: Set the depth variable to be displayed.
• Z: Depth, sea surface to sea bottom distance.
• Zt: Tide file corrected depth, vertical datum to seafloor

distance.
• Zv: Geoide and RTK corrected depth, vertical datum to

seafloor distance.
• Zg: Seafloor to geoide distance.
• Zr: Seafloor to ellipsoid distance.
Number of cells: Set the number of cells in the processing grid.
• 16 x 16
• 32 x 32
• 64 x 64



Frame contents

145850-164709 / E

• 128 x 128
• 256 x 256
• 512 x 512
The terrain modelling module uses a Processing Grid internally.
Nine Processing Grids may be loaded into RAM simultaneously.
The Processing Grid is a square, and the size of one side should
be approximately the expected swath width.
The parameter Grid Cell Size multiplied with the number of
Grid Cells should then be approximately the expected swath
width. Reducing the Grid Cell Size will enable a more detailed
view of the terrain, but then the number of Grid Cells should be
increased as well.
If the computer has enough RAM, a small Grid Cell Size should
be selected, and the number of Grid Cells in the Processing Grid
should be increased.
Cell size (cm): Set the cell size (in cm). The selectable range is
from 10 to 50,000 cm.
Processing parameters: Press this button to set the Ping
processing and Grid processing rules. These rules are explained
under the Data Cleaning tab.
→ Data Cleaning, page 261.

Apply to all survey templates: This will update these
parameters for all the survey templates currently in the database.
If you want to store these parameters to a particular survey, you
must use the Basic parameters (New survey) or Basic
parameters (Survey administration) .
→ Basic Parameters (New survey), page 135.
→ Basic Parameters (Survey administration), page 151.
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4.17 Survey administration
The Survey administration window is accessed through the
Manage windows on the View drop-down menu or by selecting
it from the Frames button.
It contains the following tab-menus:
→ User handling, page 147.
→ Background data, page 148.
→ Survey templates handling, page 150.
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User handling

User handling is located under the Survey administration
display view.

Parameters - Add user / Change user information

User: Use the combo box to write the new user’s name.

The user parameter is logged in the raw survey format files
(.all-files). This makes it possible to recall who was responsible
for the survey.

User Info: Use the text field if you want to add information
about the user

Update: Apply your changes.

Parameters - Delete user

User: Select the user you want to delete from the combo box.

User Info: This text field displays information about the
selected user.

Delete: Delete the selected user.
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Background data
Background data is located under the Survey administration
display view.
This permits the user to add pathname and comments for the
background data in the database. Corresponding, the pathname
can be set from the database. Data can also be deleted here by
selecting the pathname.

Parameters - Add data

Pathname: Choose the path you want to use for the background
data.
In the background data directory these files can be stored:
• Projection setup: proj.txt, used to define the geographic

projection for this survey.
• KSGPL background data: *.ksgpl, KSGPL-formatted files

with background data to be shown in the Geographical
display.

• Predicted tide: predictedtide.tide, predicted tide file.
• Geoid model: geoidmodel.geoid, geoid model.
Comment: Write your own comment for the background data.
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Add: Add the selected path.
If you want to store these parameters to a particular survey, you
must use the Basic Parameters.
→ Basic Parameters, page 151.

Parameters - Delete data

Pathname: Select the path you want to delete from the combo
box.
Comment: This text field displays information about the
selected path.
Delete: Delete the selected path.
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Survey templates handling
The Survey templates handling is located on the Survey
administration display view.
It contains three new tabs:
→ Basic Parameters, page 151.
→ Storage options, page 137 (see note).
→ Advanced options, page 139 (see note).

Note The Storage options and Advanced options tab-menus are
identical with the corresponding items in the New survey
display view.
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Basic Parameters
The Basic parameters is located under the Survey templates
handling tab on the Survey administration display view.
The Survey template handling manages the default surveys used
as template.

Parameters - Add/Change survey template

New Survey name: Select the survey you want to add/change
from the combo box.
Select survey-template: Select a survey template for the
parameters for Storage options and Advanced options.
User: Select a user from the combo box. To add new user(s),
you must use the User handling.
→ User handling, page 147.
Comment: Write your own comment for the survey template in
the text field.
Update: Update the exisiting default survey or add a new
default survey to the database. This includes the parameters
stored under the Storage options tab and the Advanced options
tab.
→ Storage options, page 137.
→ Advanced options, page 139.
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Parameters - Delete survey template

Survey name: Select the survey you want to delete from the
combo box.
Delete: Delete the selected survey.

Parameters - Survey type as default

Default/Previous: Define which default survey is to appear in
the “Select survey-type” combo box.
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4.18 Planning module
The Planning module window is accessed through the Manage
windows in the View drop-down menu or by selecting it from
the Frames button.
Remember that you have to activate the Planning module
through the Geographical window before starting to use it. All
planning buttons are disabled until this is done.
This window is valid for all instruments.

Common interactions

All editing and manipulation in the Geographical window are
done by holding the Ctrl key down while using the mouse.
Most actions need to be either accepted or cancelled. This is
usually done by holding Ctrl key down while clicking on the
right mouse button. This will open the “Confirm changes”
dialogue.
Actions done directly by pressing a button will not require to be
confirmed. As an example, no confirmation is necessary when
deleting a selected object.
The current action is automatically cancelled if the current
option is changed, for example if pressing “New Polygon” while
creating a new line.
Selecting a line or a polygon is done by holding the Ctrl key
down while clicking on the object to be selected. Anonther
object already selected will be deselected.

Deselecting multiple objects can be done by holding the Ctrl
key down while clicking on the right mouse button. This will
open the “Selected objects” dialogue, where the user can choose
to deselect all selected lines, polygons or both.

Tabs

The Planning module has three elements:
• Jobs
• Remote
• Objects
Each element has a number of functions assigned to specific
buttons. Show or hide the buttons by clicking the +/- check
boxes.
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Jobs
These buttons are used to create and save a
new job, or to reactivate an existing job.
A “job” is a collection of planned lines and
possibly one or more polygons. Each job is
given a unique name. A job must first be
selected as the current job before any other
operations can be performed. The selected job
can either be new, or you can continue to work
on an existing job.
The following options are available:
New Job: Create a new job.
Open Job: Open an existing job.
Save Job: Save the current job.
Clear Job: Clear the current job from the
graphical display.
Remote
These buttons are used to transfer data to a
remote Helmsman Display.
→ Helmsman Display, page 95.
Whenever data is transferred to the remote
display it will replace whatever is already
there. All defined lines, polygons and grids
will automatically be transferred if Transfer
Plan or Transfer Grids is selected.

Transfer Plan: Transfers lines and polygons to the remote
display.
Remove Plan: Removes lines and polygons from the remote
display.
Transfer Grid: Transfers the terrain data to the remote display.
Remove Grid: Removes the terrain data from the remote
display.
Object
These buttons are used to create and manipulate lines and
polygons within an existing job.

Note Buttons may be disabled from time to time if the given action is
not allowed. As an example, a line must be activated in order to
be able to deactivate it.



Frame contents

155850-164709 / E

New Line: Create a new line by holding the Ctrl key down
while clicking the left mouse button for each new point. At the
end of the line, click the right mouse button to accept or cancel
the operation.
This option is active until the user changes to another option or
presses the button once more.
New Line From:
Extend Line: Any line can be extended in this option. First
select the line, then press the Extend Line button to show the
two end points of the line. Select which end you want to extend
by holding the Ctrl key down while clicking on it with the left
mouse button.
After adding the desired points, click the right mouse button to
accept or cancel the operation. When accepting, the object is
deselected.
This option is only allowed if one line only is selected.
Activate Line: First select the line, then press the Activate Line
button to make the line active. The activated line will have a
new colour and be deselected. This line will be sent to the
Helmsman display (if present).
This option is only allowed if one line only is selected.
Deactivate Line: First select the line, then press the Deactivate
Line button to make the line unactive. This line will be removed
from the Helmsman display (if present).
This option is only allowed if one line only is selected.
Reverse Line: Every line has a defined direction, shown by a
dot at the start of the line. Pressing the Reverse Line button will
reverse the direction of all selected lines. Accepting this action
will unselect the lines. Click the right mouse button to accept or
cancel the operation. When accepting, the object is deselected.
This option is only allowed if one or more lines are selected.
Any selected polygons are ignored.
Rename: Press the Rename button to open a dialogue where
you can change the object’s name. The object will remain
selected.
This option is only allowed if one object only is selected.



Seafloor Information System / Base version

156 850-164709 / E

Make Parallels: A user defined number of lines parallel to a
selected line can be created using this option. Select a line and
then press the button to open the “Parallel Lines” dialogue. This
dialogue allow you to define how many lines to create in both
directions (port and starboard). The distance and spacing
between the lines (in metres) can also be specified. Click the
right mouse button to accept or cancel the operation. When
accepting, the line is deselected.

This option is only allowed if one line only is selected. Any
selected polygons are ignored.

Make Turn: This option is used to create a turn between two
lines. Pressing the Make Turn button will create a turn by
adding a new line between the end point of the first line and the
start point of the second line.

This option is only allowed if two (and only two) lines are
selected.

Keep Lines Inside: This option is used to clip the parts of a line
lying outside the borders of a polygon. When accepting, the
objects are deselected. Multiple lines can be selected.

Keep Lines Outside: This option is used to clip the parts of a
line lying inside the borders of a polygon. When accepting, the
objects are deselected. Multiple lines can be selected.

New Polygon: Create a new polygon by holding the Ctrl key
down while clicking the left mouse button for each node in the
polygon. Note that a polygon must have at least three nodes.
After completing the polygon, click the right mouse button to
accept or cancel the operation.

This option is active until the user changes to another option or
presses the button once more.

New Object:
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Fill Polygon: This option is used to fill a polygon.
Select a polygon and then press the button to open the “Fill
Polygon” dialogue. This dialogue allow you to define the
distance and spacing between the parallel lines to be created
(both port and starboard directions). The lines will be clipped at
the polygon’s border. When accepting, the objects are
deselected.

This option is only allowed if one line and one polygon is
selected.
Move Point: Any point can be moved. Select a line or a
polygon and press the Move Point button to show all points of
the selected object. Select which point you want to move by
holding the Ctrl key down, pressing the left mouse button and
then moving the mouse. The point in question will move with
the mouse cursor until releasing the left mouse button. Pressing
the left mouse button again elsewhere in the view, will continue
moving the point with the mouse cursor until the mouse button
is released again. This action needs to be confirmed prior to
moving other points. When accepting, the line is deselected.

This option is only allowed if one object only is selected.

Note It may be difficult to hit a point on one object if the point is
directly on top of another object. Zooming in on the point can
help.

Insert Point: A point can be inserted to an existing line or
polygon. Select a line or a polygon and press the Insert Point
button to show all points of the selected object. Insert a point by
holding the Ctrl key down and clicking on one of the line
segments with the left mouse button. After inserting the desired
number of points, click the right mouse button to accept or
cancel the operation. When accepting, the object is deselected.

This option is only allowed if only one object only is selected.
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Note Inserting a point can be difficult on some systems. You can
increase a value in the SIS database if you experience this
problem.

The SIS database value can be increased the following way:

1 Get the current threshold value by calling:
“getParameter.bat

GEOVIEW_PLANNING_INSERT_VERTEX_THRESHOLD 1”

2 Increase this value by 20 and update the database by
calling:
“setParameter.bat

GEOVIEW_PLANNING_INSERT_VERTEX_THRESHOLD 1 N”

where ’N’ is the new value.

3 Open the Show/Hide button in the Geographical display,
deselect the “Planning” check box, press Apply, then
check “Planning” and press “OK”. If this did not help, try
to increase the value a bit more.

Delete Point: Any point can be deleted. Select a line or a
polygon and press the Delete Point button to show all points of
the selected object. Delete a point by holding the Ctrl key down
and clicking on it with the left mouse button. After deleting the
desired number of points, click the right mouse button to accept
or cancel the operation. When accepting, the object is
deselected.

Note that when deleting points, you must leave at least two
points on a line and three points on a polygon.

This option is only allowed if one object only is selected.

Note It may be difficult to delete a point on one object if the point is
directly on top of another object. Zooming in on the point can
help.

Edit Selected: This option is used for editing objects. Select an
object and press the button to open the “Planning Edit Module”
dialogue.

This dialogue allow you to change, delete or add points as well
as renaming the object. After updating, the object is deselected.
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This option is only allowed if one object only is selected.
Move Selected: Any object can be moved. Select one or more
objects and press the “Move Selected” button. Move the objects
by holding the Ctrl key down, pressing the left mouse button
and then moving the mouse. The objects in question will move
with the mouse cursor until releasing the left mouse button.
After moving the objects to the desired location, click the right
mouse button to accept or cancel the operation. When accepting,
the objects are deselected.
This option is only allowed if at least one object is selected.
Delete Selected: Press this button to remove all selected objects
from memory. No confirmation is required.
This option is only allowed if at least one object is selected.
Export Selected: Press this button to append all selected objects
to an already existing job (to file).
This option is only allowed if at least one object is selected.
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4.19 Installation parameters
The Installation parameters window is accessed through the
Manage windows on the View drop-down menu or by selecting
it from the Frames button.

The Installation parameters window is used to set parameters for
all navigation systems, motion sensors and sonar heads or
transducers connected to the hydrographic system. Such
parameters may typically be:

• Sensor locations (x, y, z)

• Angular offsets

• Waterline reference

• Navigation input system

• Clock reference

• PU input/output datagrams

Depending on which echo sounder you have choosen, different
tab-menus will appear:

Multibeam echo sounders

PU Communication Setup

→ Input Setup, page 161.
→ Output Setup, page 165.
→ Clock Setup, page 167.

Sensor Setup

→ Settings, page 169.
→ Locations, page 173.
→ Angular Offsets, page 175.
→ ROV Specific, page 178.

System Parameters

→ System Parameters, page 180.

Built-In Self Test (BIST)

→ PU BIST, page 186.

Singlebeam echo sounders

→ Single beam installation, page 197.

GPS equipment

→ GPS installation, page 199.
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Input Setup

Input Setup is located under the PU Communication Setup tab
on the Installation parameters display view.

Note When the Input Setup configuration is changed the Sensor. Setup
must be checked. Specifically it’s important to check the Active
Senors setting.

Parameters

Input port: This drop-down combo-box is used to select which
of the PU (Processing Unit) ports the dialogue box shall apply
to. Choose between the serial ports COM1 to COM4 or the
network port UDP2.

• COM1: Normally used for position, clock and depth input.

• COM2: Designated to input from a motion sensor.

• COM3: Optional (position, motion and heading input).

• COM4: Optional (position and heading input).

• UDP2: Position and depth input.



Seafloor Information System / Base version

162 850-164709 / E

Note If the UDP2 port is used, a network switch must be installed or
the Data Distribution program can be used..

→ Data Distribution program, page 424.

Figure 10 UDP input principles

(CD22008)

Position or depth input

HWS 10 
(Hydrographic
Work Station)

PU 
Rear I/O

Ethernet #1
Network
switch

UDP2
input

Note A switch is only recommended for a local net, not for the ship’s
main network, as this may overload the Processor Unit.

- The network adresses are as follows:
* EM 300/EM 120: 157.237.14.60
* EM 710: 157.237.2.71
* EM 1002: 157.237.15.60
* EM 2000/EM 3000: 157.237.2.58
* EM 3002: 157.237.2.61

- The UDP have the following port setting:
* UDP2: 2022

Baud rate: Define the baud rate for the currently selected serial
port.
Data bits: Select the number of data bits for the currently
selected serial port.
Stop bits: Select the number of stop bits for the currently
selected serial port.
Parity: Select the parity for the currently selected serial port.
Input Formats: This area allows you to define what type of
external sensor is connected to the serial or network port you
selected in the Input port combo box.
Inputs in the following formats are available:
• GGK Positions
• GGA Positions
• Simrad90 Positions
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• GGA_RTK Positions
• Simrad90 Positions
• Attitude
• ZDA Clock
• HDT Heading
• SKR82 Heading
• MK39 Heading
• DBS Depth (NMEA)
• DBT Depth (NMEA)
• EA500 Depth
• ROV Depth
• Height (special purpose only)
Refer to the Datagram Formats in the appropriate user
documentation for a description of these formats.

Restrictions to sensor input

A number of restrictions apply to the selection of the PU
(Processing Unit) input formats. These restrictions are
integrated into the user interface and will be reflected in the
enabling/disabling of check boxes for the different ports. The
restrictions are as follows:

- Only one positioning system is allowed on each port, with
a maximum of three.

- Positioning system 1 is by definition on COM1.
- Positioning system 2 is by definition on COM3.
- Positioning system 3 is by definition on COM4 or UDP2.

(AUV Processing Units do not have COM4).
- Only one motion sensor is allowed on each port, with a

maximum of two.
- Motion sensor 1 is by definition on COM2.
- Motion sensor 2 is by definition on COM3.
- A motion sensor cannot share a serial line (COM) with

other sensors.
- Only one stand alone heading sensor is allowed.
- The Sperry MK39 MOD2 motion sensor (roll, pitch,

heading) can only be used on serial line COM3.
- A stand alone heading sensor using SKR80/82 format can

only be used on a COM (serial line) port. This port cannot
be shared by others sensors when in use.
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- Only one clock input (normally ZDA) is allowed (plus a
single 1PPS clock sync. signal - see PU Clock Setup).
→ PU Clock Setup, page 167.

- Only one depth sensor is allowed (pressure sensor for
ROV).

- The EA500 format can only be used on UDP2.
External Trigger: When selected, an external trigger signal
causes the echo sounder to send a ping. The Pinging on/off
function must be on.
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Output Setup
Output Setup is located under the PU Communication Setup
tab on the Installation parameters display view.

Parameters

UDP host port: Select which of the interfaces the dialogue box
shall apply to.

- The “Host UDP1” port is used by the system to receive
PU (Processing Unit) status and response datagrams. The
settings for this link should normally not be changed. All
buttons are therefore disabled for user operation.

- The “Host UDP2” port is used by the system to receive
datagrams from the PU (Processing Unit) for logging and
retransmission. The buttons are available for user
operation, but care should be taken to avoid turning off
essential information (for example depth or position).

- The “Host UDP3” port is used by the system to receive
PU (Processing Unit) datagrams intended for the Ping
displays (Beam intensity, Cross track, Waterfall, Time
series etc.). These buttons are disabled for user operation.

- The “Host UDP4” port is user configurable, for example
when SIS is used as a controller.

Note Port number 2999 is reserved for internal use.
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Port address: Port address. NOT changeable.
PU broadcast enable: Tell the PU (Processing Unit) to
broadcast its presence on the network, using port 1999. The PU
will send out a broadcast datagram every second to port 1999.
Datagram subscription on the UDP port: The table below
gives datagram subscriptions available for various multibeam
echo sounders.

Echosounder
Datagram EM120 EM300 EM710 EM1002 EM2000 EM3000 EM3002

Depth x x x x x x x

Raw range and beam
angle

x x x x x x x

Seabed image x x x x x x x

Central beams x x

Position x x x x x x x

Attitude x x x x x x x

Heading x x x x x x x

Height x x x x x x x

Clock x x x x x x x

Single beam echo sounder
depth

x x x x x x x

Sound Speed Profile x x x x x x x

Runtime parameters x x x x x x x

Installation parameters x x x x x x x

BIST reply x x x x x x x

Status parameters x x x x x x x

PU broadcast x x x x x x x

Internal -- Scope data x x x x x x x

Internal -- Range data x x x x x x x

Stave display x x

Water column x x

Hull Unit x



Frame contents

167850-164709 / E

Clock Setup

Clock Setup is located under the PU Communication Setup tab
on the Installation parameters display view.

The echosounder system has an internal clock with 1
millisecond resolution. This clock is used to time stamp all
logged data. The clock will drift, typically some seconds per
day, unless it is synchronized to a 1PPS (pulse per second) input
signal. This signal will then determine the clock’s drift rate, and
in practice reduce it to zero using a GPS receiver as source.
The clock may be set in three situations:

1 When the PU is initialized during start-up of PU from SIS.

2 When the Clock Source is changed.

3 When a new survey is started.
A fully correct clock is only necessary if the output data are
later to be combined with other time critical data logged or
created by other systems, for example an accuracy of up to one
minute would be necessary to apply tidal changes.
If the timestamp supplied in the position input datagrams is to
be used, it is imperative that the system clock is correctly set
and that 1PPS synchronization is used.
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Parameters

Source: This selector is used to define the source for the
synchronization of date and time. The following options are
available:
• External clock (UTC time received in ZDA format)
• Active Positioning System
• Operator Station
• No sync.
Offset [sec]: This offset value is applied to the source time. Use
it to offset the source time to the local time or whatever time
zone you require.
1PPS Clock Sync: Click to turn on the 1 pulse per second
external clock synchronization.
1PPS input signal is normally “resting” at a high level. Each
second, a low going 100 mS-1000 mS pulse adjusts the second
counter in the PU (Processing Unit). Since 1PPS is a
TTL-signal, a high level at the input connector must be higher
than 2.7 Vdc (the margin is then 0.3 Vdc) and a low level
(during the pulse) must not exceed 0.6 Vdc (the margin is then
0.2 Vdc).
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Settings

Settings (of sensors) is located under the Sensor Setup tab on
the Installation parameters display view.

Note When the Input Setup configuration is changed the Settings must
be checked!

Positioning systems
You can connect three positioning systems to the multibeam
echo sounder, but only one can be active at any one time. One
positioning system may be connected on a network port (UDP2)
instead of a serial line.
Data from all positioning systems are logged, and may all be
used in post-processing. However, only the positioning system
selected as “active” will be used in the real-time displays. (See
Active sensors below).
For each of these positioning systems, you need to define certain
basic parameters.

Parameters - Positioning Systems Settings

Positioning System Ports: Use this drop-down combo box to
choose which positioning system you wish to set the parameters
for. The positioning system is thus not identified by its name,
but by the port it is connected to.
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The following ports are available:
- COM1 (positioning system 1)
- COM3 (positioning system 2)
- COM4 (positioning system 3)
- UDP2 (positioning system 3)

Time to use: Usually the system’s internal time should be used
during logging, since the clock reference then will be identical
for both positions and depths. Any time delay in the positioning
system and the data transmission from the sensor must be taken
into account. This is done by defining a fixed average position
delay (see below).
If this delay is not sufficiently constant - and provided that the
time stamp in the position datagram is the time when the
position was valid - the input datagram’s time stamp may be
used. However, it must then be assumed that the multibeam
echo sounder and the positioning system clock are both
synchronized with the 1PPS signal, and that any time difference
between the two clocks are entered as a position delay.
• Select Datagram or System:

- Datagram: This choice allows the use of the time stamp
in the input datagram when applying positions to the
realtime display.

- System: The multibeam echosounder will use its own
internal time stamp when applying positions to the real
time display.

Note Both time stamps are stored, hence the time reference can be
changed or corrected in post processing.

Enable position motion correction: When the vessel moves
due to roll, pitch and heave, the antenna on the positioning
system moves as well. This parameter allows the system to
compensate for this movement by adjusting the values from the
positioning system based on the current information from the
motion sensor(s).
Correct timing of the positions is very important if motion
correction is to improve position accuracy.

Position delay (sec): This parameter is used to define the “age”
of the position in the position datagrams.
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The relative timing of vessel position data and system depth
data is critical to the total achievable accuracy. The best solution
is if it can be assured that the position datagrams are always
received by the system with a fixed and sufficiently constant age
with respect to the time of validity of the enclosed positions.
This age is the position delay to be entered. Such a solution will
make the use of any clock synchronization of the system with
the positioning system unnecessary.

Datum: This parameter enables you to set the internal datum
identical to what the positioning system sends to the echo
sounder. This will also be logged onto the harddisk. The
projection reference in the survey module must also be set
accordingly.

Motion sensors

You can connect two motion systems to the multibeam echo
sounder, but only one can be active at any one time. Data from
both systems are to be logged. The motion system you have
selected will be used in the real time displays. For each of these
motion systems some basic parameters need to be set.

Parameters - Motion Sensors Settings

Motion Sensor Ports: Use this to choose which motion sensor
you wish to set the parameters for. The motion system is not
identified by name, but by the port it is connected to.

The following ports are available:

- COM2 (motion sensor 1)

- COM3 (motion sensor 2)

Roll reference plane: The roll reference plane is used to define
the reference plane against which the angle for roll is measured.

• Select Horizontal or Pitch/Roll Plane:

- Horizontal: Select this alternative if roll is measured
against the horizontal plane, i.e. against the plane normal
to the gravity vector. This is the convention used by the
Hippy 120, often emulated by other sensors.

- Pitch Roll axis plane: Select this alternative if roll is
measured against a plane defined as horizontal in the
acrosstrack direction, but following the vessel pitch in the
alongtrack direction, i.e. as a rotation around the forward
pointing axis of the vessel coordinate system. This is the
convention usually used by inertial systems such as the
POS/MV (the Tate-Bryant convention).
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Motion delay (msec): This parameter is used to define the
expected time delay of the motion data.
If the data from the attitude sensor are delayed with respect to
when they were valid, this may be corrected by the system
provided the delay is known. This delay may be due to filtering
and/or processing time in the sensor, and should be provided by
its manufacturer. Some sensors are able to compensate for such
delays by a prediction, but it is not advisable to use such a
feature.
Active sensors

Only one positioning system, one motion sensor and one
heading sensor can be active at any time.
The selection of which system/sensor to be active is performed
by selecting which input port the relevant equipment is
connected to. The available choices for each system/sensor is
dependant on the settings made in the Input Setup configuration
of the PU (Processing Unit).
→ Refer to page 161 for more information about the Input Setup.

There is a drop-down combo box for each of the system/sensor
types.

Note When the Input Setup configuration is changed the Active
Sensor setting must be checked.

Parameters - Active Sensors

Position: Select active positioning system.
Motion: Select active motion sensor.
Heading: Select active heading sensor.
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Locations

Locations (of sensors) is located under the Sensor Setup tab on
the Installation parameters display view.

Note The screen layout above is an example only. Some echo sounder
use “Transducer” instead of “Sonar head”.

In order to make accurate measurements, the system must know
the physical location of all the sensors and its own transducers.

These locations must be related to the vessel’s reference point.
The position of each system must therefore be given as a
forward (x), downward (z) and starboard (y) position relative to
the reference point. The coordinate system assumes that the
x-axis follows the vessel’s keel, and that the x-y plane is
horizontal while the vessel is in normal trim.

Parameters

Positioning systems (Pos): These settings are used to define the
physical location of the selected positioning system’s position
point, i.e. the point on the ship where the position is valid.

Note This point may be different from the antenna’s position,
depending on the positioning system.

The downward positions are required if RTK is to be used to
position the bottom with respect to a datum vertically.
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The position data you define here may however not necessarily
always be the physical location of the antenna. This is because
settings in the positioning system’s own software can redefine
the location of the antenna. The xy values of the soundings are
referred to the location of the active positioning system, and it is
this “virtual” position that you must enter.

Note The downward position will also be used if the positions are to
be corrected for vessel attitude. This requires that the actual
physical antenna position is entered and that the given position
is at the antenna.

Transducer array(s) / Sonar Head (s): Use these settings to
define the physical location of the centre of the face of the
respective transducer arrays or sonar heads.
Motion sensor (Attitude): The Motion Sensor parameters
allow you to define where the sensor is physically located, or
where its data are valid in case the motion sensor is programmed
to calculate heave at a different location than where it is actually
mounted.
Waterline: Enter the vessel’s waterline (in normal trim) related
to the vessel’s reference point. The value should be an average
of two measurements; one on each side of the vessel. The
measurement must be made at the same alongship location as
the physical location of the motion sensor.

Note If the vessel’s deplacement or trim changes during a survey, this
value must be updated accordingly.

Depth sensor: Position of depth sensor.
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Angular Offsets (not EM 710)
Angular Offsets (of sensors) is located under the Sensor Setup
tab on the Installation parameters display view.

Note The screen layout above is an example only. Some echo
sounders use “Transducer” instead of “Sonar head”.

In order to make accurate measurements, the system must know
the physical angles between the transducers, sensors and the
vessel coordinate system.
Parameters
Transducer array(s) / Sonar Head(s): Use these settings to
enter the installation angles. These settings are normally entered
once and for all, but if the vessel undergoes repair or
maintenance etc. and the array is moved, the installation
measurements must be repeated and new angles defined.
Motion sensors (Attitude): Use these settings to set a
correction offset for the corresponding values received from the
motion sensors. The settings are added to the values received
from the sensors.
Stand-alone Heading: Use this setting to set a correction offset
from the values received from the heading sensor. It is only
allowed to enter positive values. Example: If the offset is -0.15,
you must enter 359.85.
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Angular Offsets (for EM 710)
Angular Offsets (of sensors) is located under the Sensor Setup
tab on the Installation parameters display view.

In order to make accurate measurements, the system must know
the physical angles between the transducers, sensors and the
vessel coordinate system.
Parameters
Transducer array(s) / Sonar Head(s): Use these settings to
enter the installation angles. These settings are normally entered
once and for all, but if the vessel undergoes repair or
maintenance etc. and the array is moved, the installation
measurements must be repeated and new angles defined.
If mounting is in accordance with the default orientation, the
installation heading is the measured value coming from the
alignment.
If the TX array(s) is mounted with cables pointing to port side,
180 degrees must be added to the TX measured heading. In this
case the sign of the TX array installation roll and pitch angles
must also be inverted.
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If the RX array(s) is mounted with the cables pointing towards
the bow, 180 degrees must be added to the RX measured
heading. In this case the sign of the RX array installation roll
and pitch angles must also be inverted.
The exact roll, pitch and heading values for both RX and TX are
measured during the alignment procedure.

Figure 11 Orientation of TX and RX transducers default installation

Motion sensors (Attitude): Use these settings to set a
correction offset for the corresponding values received from the
motion sensors. The settings are added to the values received
from the sensors.
Stand-alone Heading: Use this setting to set a correction offset
from the values received from the heading sensor. It is only
allowed to enter positive values. Example: If the offset is -0.15,
you must enter 359.85.
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ROV Specific (EM 2000, EM 3000 and EM
3002 only)

ROV Specific is located under the Sensor Setup tab on the
Installation parameters display view.

Parameters

The parameters are available only if ROV depth is selected in
the Input Setup frame (page 161). Otherwise they are disabled.
Aslo note that when deselecting the ROVdepth selection in the
Input Setup frame these parameters vil be reset to default an
disabled.

Scaling: A depth sensor may not measure the depth of an
underwater vehicle from the surface, but for example the
absolute pressure. The scaling factor is used to convert actual
measurement values to meters. It is also applied to the depth
sensor offset.

Offset: If the depth sensor measures pressure, the atmospheric
pressure at sea level must be subtracted before converting the
measurements to meters below the surface.

Delay: This parameter is used to define the expected time delay
of the sensor data.
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Disable Heave Sensor: This should always be unchecked
unless the effect of heave is taken into account by another
sensor. An example would be the depth of an ROV measured by
a pressure sensor whose output also includes any heave effect
unless the depth is large.
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System parameters (for EM 120, EM 300
and EM 710)

System parameters is located on the Installation display view.

Parameters

BS (Backscatter) Offset (dB): The acoustic backscatter
strength of the bottom is calibrated in our factory, and have a
typical accuracy of ±1 dB.

However, this value may be offset from zero to serve as a
correction factor, for example if there is a change with the age
of the system, or if data from two different systems are merged
and there is a systematic offset between the two systems.

RX Opening angle: Specify the installed Rx array. Choose
between:

• 1, 2 or 4 degrees for EM 120 and EM 300

• 1 or 2 degrees for EM 710
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TX Opening angle: Specify the installed Tx array. Choose
between:
• 1 or 2 degrees for EM 120 and EM 300
• 0.5, 1 or 2 degrees for EM 710
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System parameters (for EM 1002)

System parameters is located on the Installation display view.

Parameters - Gain and Angle Correction

BS (Backscatter) Offset (dB): The acoustic backscatter
strength of the bottom is calibrated in our factory, and have a
typical accuracy of ±1 dB.

However, this value may be offset from zero to serve as a
correction factor, for example if there is a change with the age
of the system, or if data from two different systems shall be
merged and the data from them show a systematic offset.

HiLo Freq. Gain Diff (dB) (HI / LO Frequency Gain
Difference): The system uses three sectors with a higher
frequency (98 kHz) in the middle and a lower in the outer two
(93 kHz). Depending on the actual transducer, this may result in
a gain difference in the backscatter measurements. The HI / LO
Frequency Gain Difference parameter will allow you to
compensate for this difference.



Frame contents

183850-164709 / E

Outer beam Angle Offsets (deg): The pointing angles of the
outer beams of the EM 1002 depend on the sound speed of the
transducer coating material. This parameter will allow you to
add a correction for this effect. The value may need changing
with transducer aging and sea temperature (a compensation for
temperature is built into the system software, but it may not be
100% effective). The actual parameter value must be found by
estimating the beampointing angle error in degrees by
comparing the depths measured in +75_ beam pointing angle
with that measured with the vertical beam. This is most easily
done by running two lines perpendicularly and using the roll
calibration application to find the angle offset.

Parameters - Hull Unit Options

Hull Unit included: The EM 1002 may be supplied with a Hull
Unit with mechanical pitch compensation. This information is
obtained from the Transceiver Unit and the parameter is not
changeable.
Hull Unit Tilt Offsets (deg): This setting is used to compensate
for a fixed tilt setting of the Hull Unit. It is only enabled for
update if a Hull Unit is present.
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System parameters (for EM 3000 and EM
3002)

System parameters is located on the Installation display view.

Parameters

BS (Backscatter) Offset (dB): The acoustic backscatter
strength of the bottom is calibrated in our factory, and have a
typical accuracy of ±1 dB.

However, this value may be offset from zero to serve as a
correction factor, for example if there is a change with the age
of the system, or if data from two different systems shall be
merged and the data from them show a systematic offset.

TX Freq. (kHz): When you use two sonar heads, choose
operational frequencies to avoid interference.
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300 kHz should normally be used when only one EM 3000/EM
3002 Sonar Head is connected to the system. On a dual system,
the frequency on each sonar head is selectable, for example 293
kHz for Sonar Head 1 (main) and 307 kHz for Sonar Head 2
(secondary).

Note The entries for Sonar Head 2 will be disabled when only one
head is detected (available) at start-up.
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BIST (for EM 120 and EM 300)
BIST is located on the Installation parameters display view.
The BIST (Built-In Self Test) options provide a number of
automatic tests that may be started to check the operation of the
echo sounder system.
The results are presented in the “PU BIST Result” area.

Clear all: Press to clear results of previous BIST tests.
Run all BISTs: Press to run all available BIST tests.

Parameters - PU BIST Setup

Select Head / Transceiver Unit: Select the sonar head or
Transceiver Unit you want to run test(s) for.
BIST test: Select the test(s) you want to run from the
drop-down list..

Note The test is executed when selected.
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Refer to the echo sounder’s maintenance manual for detailed
BIST descriptions.
BIST test buttons: Alternatively singular BIST tests can be run
by pressing the corresponding test buttons. The button turns
green if the test was successfully accomplished, otherwise the
button turns red.
The following tests are available:
0 BSP Test
1 SPTX Test
2 SPRX Test
3 TRU Power Test
4 TX Power
5 SPRX/BSP Link
6 RX Channels
7 RX Noise Level
8 TX Ram/fuse
9 Sensors
10 TX via RX
15 Software Date/Version
17 Reboot BSP Cards

Parameters - PU BIST Result

Save: The results of the BIST tests may be saved to file. Press
Save to set file name and storage location.
PU BIST Result area: The results are presented in this area
with the following information for each test:

• Date: Date when the test was run.
• Time: Time when the test was run.

• Ser. No: Serial number of the transducer.
• BIST: The number of the BIST test that has been run.

• Result: The overall result of the test.
• Description: A description of the test returned from the PU

(Processing Unit).
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BIST (for EM 710)
BIST is located on the Installation parameters display view.
The BIST (Built-In Self Test) options provide a number of
automatic tests that may be started to check the operation of the
echo sounder system.
The results are presented in the “PU BIST Result” area.

Clear all: Press to clear results of previous BIST tests.
Run all BISTs: Press to run all available BIST tests.

Parameters - PU BIST Setup

Select Head / Transceiver Unit: Select the sonar head or
Transceiver Unit you want to run test(s) for.
BIST test: Select the test(s) you want to run from the
drop-down list..

Note The test is executed when selected.
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Refer to the echo sounder’s maintenance manual for detailed
BIST descriptions.
BIST test buttons: Alternatively singular BIST tests can be run
by pressing the corresponding test buttons. The button turns
green if the test was successfully accomplished, otherwise the
button turns red.
The following tests are available:
0 BSP Test
1 TX 36 Test
2 RX 32 Test
3 TRU Power Test
5 RX 32-BSP Link
6 RX Channels
7 TX Channels
8 RX Noise Level
9 RX Noise Spectrum
15 Software Date/Version

Parameters - PU BIST Result

Save: The results of the BIST tests may be saved to file. Press
Save to set file name and storage location.
PU BIST Result area: The results are presented in this area
with the following information for each test:
• Date: Date when the test was run.

• Time: Time when the test was run.
• Ser. No: Serial number of the transducer.

• BIST: The number of the BIST test that has been run.
• Result: The overall result of the test.

• Description: A description of the test returned from the PU
(Processing Unit).
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BIST (for EM 1002)
BIST is located on the Installation parameters display view.
The BIST (Built-In Self Test) options provide a number of
automatic tests that may be started to check the operation of the
echo sounder system.
The results are presented in the “PU BIST Result” area.

Clear all: Press to clear results of previous BIST tests.
Run all BISTs: Press to run all available BIST tests.

Parameters - PU BIST Setup

Select Head / Transceiver Unit: Select the sonar head or
Transceiver Unit you want to run test(s) for.
BIST test: Select the test(s) you want to run from the
drop-down list..

Note The test is executed when selected.
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Refer to the echo sounder’s maintenance manual for detailed
BIST descriptions.

BIST test buttons: Alternatively singular BIST tests can be run
by pressing the corresponding test buttons. The button turns
green if the test was successfully accomplished, otherwise the
button turns red.

The following tests are available:

0 BSP Test

2 SPRX Test

3 TRX Power Test

4 TX Power

5 SPRX/BSP Link

6 RX Channels

7 RX Noise Level

8 TX Ram

10 TX via RX

11 Calibration offsets

15 Software Date/Version

17 Reboot BSP Cards

20 Hull Unit

21 Hull Unit MOSINT

22 Hull Unit servo

Parameters - PU BIST Result

Save: The results of the BIST tests may be saved to file. Press
Save to set file name and storage location.

PU BIST Result area: The results are presented in this area
with the following information for each test:

• Date: Date when the test was run.

• Time: Time when the test was run.

• Ser. No: Serial number of the transducer.

• BIST: The number of the BIST test that has been run.

• Result: The overall result of the test.

• Description: A description of the test returned from the PU
(Processing Unit).
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BIST (for EM 2000)
BIST is located on the Installation parameters display view.
The BIST (Built-In Self Test) options provide a number of
automatic tests that may be started to check the operation of the
echo sounder system.
The results are presented in the “PU BIST Result” area.

Clear all: Press to clear results of previous BIST tests.
Run all BISTs: Press to run all available BIST tests.

Parameters - PU BIST Setup

BIST test: Select the test(s) you want to run from the
drop-down list..

Note The test is executed when selected.

Refer to the echo sounder’s maintenance manual for detailed
BIST descriptions.
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BIST test buttons: Alternatively singular BIST tests can be run
by pressing the corresponding test buttons. The button turns
green if the test was successfully accomplished, otherwise the
button turns red.
The following tests are available:
1 Sonar Head HCT PCB
2 Sonar Head Power
3 Taxi Link
4 TVG Voltage
5 Sonar Head Temp
6 TX Channels
7 Sonar Head Serial No.
8 RX Channels
9 Noise Test
12 BSP Test
14 Software Date/Version
17 Reboot BSP Cards

Parameters - PU BIST Result

Save: The results of the BIST tests may be saved to file. Press
Save to set file name and storage location.
PU BIST Result area: The results are presented in this area
with the following information for each test:
• Date: Date when the test was run.
• Time: Time when the test was run.
• Ser. No: Serial number of the head where the test was run.

(As indicated, a test may only be executed on one head at a
time).

• BIST: The number of the BIST test that has been run.
• Result: The overall result of the test.
• Description: A description of the test returned from the PU

(Processing Unit).
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BIST (EM 3000 and EM 3002)

BIST is located on the Installation parameters display view.

The BIST (Built-In Self Test) options provide a number of
automatic tests that may be started to check the operation of the
echo sounder system.

The results are presented in the “PU BIST Result” area.

Clear all: Press to clear results of previous BIST tests.

Run all BISTs: Press to run all available BIST tests.

Parameters - PU BIST Setup

Select Head / Transceiver Unit: Select the sonar head you
want to run test(s) for.

Note that Head 2 will be unavailable if only one head is
available.

BIST test: Select the test(s) you want to run from the
drop-down list..
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Note The test is executed when selected.

Refer to the echo sounder’s maintenance manual for detailed
BIST descriptions.
BIST test buttons: Alternatively singular BIST tests can be run
by pressing the corresponding test buttons. The button turns
green if the test was successfully accomplished, otherwise the
button turns red.
The following tests are available:
1 Sonar Head HCT PCB
2 Sonar Head Power
3 Taxi Link
4 TVG Voltage
5 Sonar Head Temp
6 TX Channels
7 Sonar Head Serial No.
8 RX Channels
9 Noise Test
12 BSP Test
13 BIF/BSP (EM 3000 only)
14 Software Date/Version
30 Reboot BSP Cards
31 Update Sonar Head SW (EM 3002 only)

Parameters - PU BIST Result

Save: The results of the BIST tests may be saved to file. Press
Save to set file name and storage location.
PU BIST Result area: The results are presented in this area
with the following information for each test:
• Date: Date when the test was run.
• Time: Time when the test was run.
• Ser. No: Serial number of the head where the test was run.

(As indicated, a test may only be executed on one head at a
time).

• BIST: The number of the BIST test that has been run.
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• Result: The overall result of the test.
• Description: A description of the test returned from the PU

(Processing Unit).
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Single beam installation

The Single beam installation window is accessed through the
Manage windows on the View drop-down menu or by selecting
it from the Frames button.

This parameter sheet is only available for single beam echo
sounders. If you have not already chosen a single beam system,
select one from the current system combo box.

→ Refer to page 345 for more information about the “system
combo box”.

The single beam echosounder equipment can be read with either
a serial line or an Ethernet connection.

Heading and position

Heading and Position: You can choose between the sensors
already defined in the External sensors under the Tools
drop-down menu.

Parameters - Serial/Ethernet connections

Depth: First you have to decide whether to use a serial port or
Ethernet.

- If you choose a serial port, mark the check box under
“Serial” and select the port you want to use by selecting
them from the combo box under “Port”. The
communication parameter is set with the respectively
combo box.

- If you want to use an Ethernet connection, mark the check
box under “Ethernet”. The IP address and the port to send
data to is displayed in the text field to the right.



Seafloor Information System / Base version

198 850-164709 / E

Parameters - Serial line

The following parameters are for serial line(s) only:
Port: Choose the port you want to use.
Baud rate: Choose the desired baud rate.
Data bits: 7 or 8.
Stop bits: 1 or 2.
Parity: NONE, ODD or EVEN.

Parameters - Locations

Transducer: Use the text fields to enter the transducer’s
position.
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GPS installation
The GPS installation window is accessed through the Manage
windows on the View drop-down menu or by selecting it from
the Frames button.
This parameter sheet is only available for GPS equipment. If
you have not already chosen a GPS system, select one from the
current system combo box.
→ Refer to page 345 for more information about the “system

combo box”.

Parameters

Heading and Position: You can choose between the ports
already defined in the External sensors under the Tools
drop-down menu.
→ External sensors, page 310.
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4.20 Runtime parameters
The Runtime parameters window is accessed through the
Manage windows on the View drop-down menu or by selecting
it from the Frames button.
The window will differ, depending on what kind of echo
sounder is currently chosen.
Equipment with a Processing Unit (multibeam echo sounders)
contains the following tab-menus:
→ Sounder Main, page 201.
→ Sound Speed, page 225.
→ Filter and Gains, page 232.
→ Data Cleaning, page 261.
→ Simulator, page 273.

Single beam echo sounders contains the following window:
→ SB Runtime, page 278.

In addition to the fall Runtime parameters window described
above a scaled down window with only a set of essential
parameters are also defined. This reduced runtime parameters
window will occupy very little space while allowing the
operator easy access to basic runtime settings:
→ Runtime parameters Mini, page 280.
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Sounder Main (for EM 120 and EM 300)
Sounder Main is located on the Runtime parameters display
view.

These parameters allow you to:
• Define the pingmode, the desired swath coverage and the

beam spacing
• Define maximum port and starboard coverage
• Define the maximum and minimum depth for the echo

sounder
• Force a desired depth
• Select stabilisation (pitch, yaw)

Parameters - Sector Coverage

Max angle (deg), port / starboard: These parameters allow
you to define the maximum swath width by setting the
maximum port and starboard angles. The values are entered in
degrees.

Max coverage (m), port / starboard: These parameters allow
you to define the maximum swath width to each side by
selecting values in meters. The port and starboard angles (as
defined above) will then be adjusted accordingly by the system.
To make use of these settings, you must set Angular Coverage
mode to Auto.

Angular Coverage mode: Choose between Manual and Auto.

• Manual: If Angular Coverage is set to manual, the values
defined as Max port and starboard angle above (in degrees)
are used directly. The Max coverage port and starboard
settings (in meters) are not used in this case. Be aware that
the outermost beams may be lost if the angular coverage set
is larger than the coverage capability at the current depth.
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• Auto: If Angular Coverage is set to Auto, the maximum
coverages (in meters) and the maximum angles will set the
swathwidth limit. The most limiting of the two criteria will
be used. If the system is not able to fulfil the above, it will
reduce the swath width further and as a consequence nearly
all the beams will be valid. You may observe this in the
Numerical display, as the numbers of beams accepted should
almost equal to the number of beams available.

→ Numerical display, page 89.

Beam spacing: Depending on the purpose of the survey, you
may define the distribution of the beams on the seafloor.

• Equidistant: This setting gives a uniform distribution of
soundings on the seafloor, and it is the normal mode for a
bathymetric survey.

• Equiangle: The beams are distributed with an equal angular
spacing based on the angular coverage used. This gives many
soundings close to the centre of the survey line, and few on
the edge of the swath.

• In-between: The in-between spacing is intended for surveys
with high priority on seabed image data. Compared to
equidistant spacing, this mode gives higher density of
soundings in the central part (near equiangle) of the swath,
and maintains an acceptable density in the outmost parts
(near equidistant).

Parameters - Depth Settings

Force depth (m): If there is a lot of acoustic interference or if
the water is very aerated, the echo sounder may not find the
correct depths. In order to help, you can then enter the
approximate depth. This depth may be taken from your
navigational charts, or from a navigation sounder elsewhere on
the vessel. Forcing the depth will cause the system to set its gain
and range windows accordingly, and ignore its own findings
about where the bottom is.

Min. / Max. depth (m): These parameters define the
operational depth range. This range should normally be wide
enough to cover all depths encountered during the survey, as
only depths within this range will be accepted by the system.

A narrow range will help the system in bottom tracking under
difficult conditions. In some cases it may be necessary to
temporarily narrow the range to assist the system in bottom
tracking. However, you must then monitor the actual depth
closely, and adjust the depth window as often as required.
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Note It is very important that valid depths are entered here when the
echo sounder starts “pinging”. If the bottom depth exceeds the
limits with more than 10%, the sounder will not lock. It may
therefore be useful to enter larger values in the beginning to
accept a more dynamic depth, even though this may slow down
the initial bottom detection when the system is started.

If the bottom depth exceeds the limits given here it will simply
loose track. The true depth should therefore be monitored and
compared with the settings during the survey.

- Minimum depth (m): Set the minimum limit of the depth
range.

- Maximum depth (m): Set the maximum limit of the
depth range.

Ping Mode: This parameter defines the operational mode of the
multibeam echo sounder. You can select any of the following
settings:
• Auto
• Very shallow
• Shallow
• Medium
• Deep
• Very deep
• Extra deep (EM 300 only)

During normal operating conditions, you are advised to set the
ping mode to Auto. The system will then automatically use the
most appropriate mode, and - if necessary - switch between the
modes to obtain maximum coverage.

If you wish to select mode manually, note the following
specifications and recommended depth ranges:

EM 120

Very shallow Shallow Medium Deep Very deep

Pulse
length (ms) 2 2 5 15 15

Minimum
beamwidth 4 deg 2 deg 1 deg 1 deg 1 deg

Minimum
depth (m) 10 50 300 800 6000

Maximum
depth (m) 100 600 1400 9000 12000
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EM 300

Very shallow Shallow Medium Deep Very deep Extra
Deep

Pulse
length
(ms)

0.7 0.7 2 5 5 15

Minimum
beam-
width

4 deg 2 deg 1 deg 1 deg 1 deg 1 deg

Minimum
depth (m) 5 30 100 500 1000 3000

Maximum
depth (m) 50 300 1000 3000 6000 6000

Note Extra deep is limited to maximum +/- 18 degrees coverage sector!

Parameters - Stabilization

Pitch stabilization: At open sea, the swath area on the bottom
will move back and forth following the vessel pitch. This would
lead to loss of sampling regularity, and thus also limit the vessel
speed at which 100% bottom coverage is possible. To counter
this effect the system’s transmit angle may be set to vary with
the pitch in order to stabilize the direction of the emitted vertical
transmit fan. This option should thus normally be ON.

The maximum electronic tilt is limited to ±10 degrees. The
ships attitude and the applied transmitter tilt is always used to
calculate the x, y and z parameters for each bottom detection.
This assures that the x, y and z values are correctly calculated,
even if more tilting was needed to do a full pitch stabilization.

Yaw stabilization: The yaw stabilization creates even alongship
sounding spacings when the vessel’s course is variable. The
parameter is implemented with variable tilt angles on the
individual transmitter beams. The echo sounder operates most
efficiently when the transmission angle is as close to 0 degrees
as possible relative to the vessel’s heading.

The maximum electronic tilt is limited to ±10 degrees. The
ships attitude and the applied transmitter tilt is always used to
calculate the x, y and z parameters for each bottom detection.
This assures that the x, y and z values are correctly calculated,
even if more tilting was needed to do a full yaw stabilization.
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Figure 12 The forces acting on the vessel
during the survey

Mode: Three stabilization modes are available.
• Off: No heading stabilizationn takes place. The transmitter

sector follows the current heading of the vessel. Unless the
vessel’s heading is 100% straight you may experience “blind
zones” on the survey coverage when you operate in deeper
waters (exceeding 300 to 500 meters).

• Manual: The transmit fan is placed perpendicular to a
manually selected course. This course is selected with the
Yaw Compensation parameter described below. The setting
should only be used on long and straight survey lines, but it
is also useful if you need to compensate for a crab angle
caused by current or wind.

• Rel. mean heading: This setting places the transmitter sector
perpendicular to a filtered course corresponding to the the
vessel’s current mean heading. The course input is then taken
from the course gyro, and filtered with the Heading Filter
parameter described below.

Heading: Allows you to enter the vessel’s heading manually.
Heading filter: This parameter specifies the level of filtering of
the heading.
Applying this filter will even out minor course adjustments due
to wind, sea or current. The filter strength required depends
upon the vessel properties, and how well the vessel is steered.
The heading filter controls how fast the filtered heading used
during logging will follow the actual heading of the vessel.
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Sounder Main (for EM 710)
Sounder Main is located on the Runtime parameters display
view.
These parameters allow you to:
• Define the pingmode, the desired swath coverage and the

beam spacing
• Define maximum port and starboard coverage
• Define the maximum and minimum depth for the echo

sounder
• Force a desired depth
• Select stabilisation (pitch, yaw)

Parameters - Sector Coverage

Max angle (deg), port / starboard: These parameters allow
you to define the maximum swath width by setting the
maximum port and starboard angles. The values are entered in
degrees.
Max coverage (m), port / starboard: These parameters allow
you to define the maximum swath width to each side by
selecting values in meters. The port and starboard angles (as
defined above) will then be adjusted accordingly by the system.
To make use of these settings, you must set Angular Coverage
mode to Auto.
Angular Coverage mode: Choose between Manual and Auto.
• Manual: If Angular Coverage is set to manual, the values

defined as Max port and starboard angle above (in degrees)
are used directly. The Max coverage port and starboard
settings (in meters) are not used in this case. Be aware that
the outermost beams may be lost if the angular coverage set
is larger than the coverage capability at the current depth.



Frame contents

207850-164709 / E

• Auto: If Angular Coverage is set to Auto, the maximum
coverages (in meters) and the maximum angles will set the
swathwidth limit. The most limiting of the two criteria will
be used. If the system is not able to fulfil the above, it will
reduce the swath width further and as a consequence nearly
all the beams will be valid. You may observe this in the
Numerical display, as the numbers of beams accepted should
almost equal to the number of beams available.

→ Numerical display, page 89.

Beam spacing: Depending on the purpose of the survey, you
may define the distribution of the beams on the seafloor.

• Equidistant: This setting gives a uniform distribution of
soundings on the seafloor, and it is the normal mode for a
bathymetric survey.

• Equiangle: The beams are distributed with an equal angular
spacing based on the angular coverage used. This gives many
soundings close to the centre of the survey line, and few on
the edge of the swath.

• High density: In this mode the number of soundings are
increased. This is achieved by directing some of the beams
closer to the centre of the survey line and performing several
soundings per beam on the edge of the swath. This results in
an equidistant distribution of the soundings.

Parameters - Depth Settings

Force depth (m): If there is a lot of acoustic interference or if
the water is very aerated, the echo sounder may not find the
correct depths. In order to help, you can then enter the
approximate depth. This depth may be taken from your
navigational charts, or from a navigation sounder elsewhere on
the vessel. Forcing the depth will cause the system to set its gain
and range windows accordingly, and ignore its own findings
about where the bottom is.

Min. / Max. depth (m): These parameters allow define the
operational depth range. This range should normally be wide
enough to cover all depths encountered during the survey, as
only depths within this range will be accepted by the system.

A narrow range will help the system in bottom tracking under
difficult conditions. In some cases it may be necessary to
temporarily narrow the range to assist the system in bottom
tracking. However, you must then monitor the actual depth
closely, and adjust the depth window as often as required.
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Note It is very important that valid depths are entered here when the
echo sounder starts “pinging”. If the bottom depth exceeds the
limits with more than 10%, the sounder will not lock. It may
therefore be useful to enter larger values in the beginning to
accept a more dynamic depth, even though this may slow down
the initial bottom detection when the system is started.

If the bottom depth exceeds the limits given here it will simply
loose track. The true depth should therefore be monitored and
compared with the settings during the survey.

- Minimum depth (m): Set the minimum limit of the depth
range.

- Maximum depth (m): Set the maximum limit of the
depth range.

Ping Mode: This parameter defines the operational mode of the
multibeam echo sounder. You can select any of the following
settings:
• Auto
• Very shallow
• Shallow
• Medium
• Deep
• Very deep
• Extra deep

During normal operating conditions, you are advised to set the
ping mode to Auto. The system will then automatically use the
most appropriate mode, and - if necessary - switch between the
modes to obtain maximum coverage.

Note The actual ping modes available are dependent on the licensing
of this feature.

Max. Ping Freq. (Hz): This parameter defines the maximum
ping frequency of the multibeam echo sounder. You can select
any value in the range from 0.1 to 50 Hz.
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Parameters - Stabilization

Pitch stabilization: At open sea, the swath area on the bottom
will move back and forth following the vessel pitch. This would
lead to loss of sampling regularity, and thus also limit the vessel
speed at which 100% bottom coverage is possible. To counter
this effect the system’s transmit angle may be set to vary with
the pitch in order to stabilize the direction of the emitted vertical
transmit fan. This option should thus normally be ON.

The maximum electronic tilt is limited to ±10 degrees. The
ships attitude and the applied transmitter tilt is always used to
calculate the x, y and z parameters for each bottom detection.
This assures that the x, y and z values are correctly calculated,
even if more tilting was needed to do a full pitch stabilization.

Yaw stabilization: The yaw stabilization creates even alongship
sounding spacings when the vessel’s course is variable. The
parameter is implemented with variable tilt angles on the
individual transmitter beams. The echo sounder operates most
efficiently when the transmission angle is as close to 0 degrees
as possible relative to the vessel’s heading.

The maximum electronic tilt is limited to ±10 degrees. The
ships attitude and the applied transmitter tilt is always used to
calculate the x, y and z parameters for each bottom detection.
This assures that the x, y and z values are correctly calculated,
even if more tilting was needed to do a full yaw stabilization.

Mode: Three stabilization modes are available.
• Off: No heading stabilizationn takes place. The transmitter

sector follows the current heading of the vessel. Unless the
vessel’s heading is 100% straight you may experience “blind
zones” on the survey coverage when you operate in deeper
waters (exceeding 300 to 500 meters).

• Manual: The transmit fan is placed perpendicular to a
manually selected course. This course is selected with the
Yaw Compensation parameter described below. The setting
should only be used on long and straight survey lines, but it
is also useful if you need to compensate for a crab angle
caused by current or wind.

• Rel. mean heading: This setting places the transmitter sector
perpendicular to a filtered course corresponding to the the
vessel’s current mean heading. The course input is then taken
from the course gyro, and filtered with the Heading Filter
parameter described below.

Heading: Allows you to enter the vessel’s heading manually.
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Heading filter: This parameter specifies the level of filtering of
the heading.
Applying this filter will even out minor course adjustments due
to wind, sea or current. The filter strength required depends
upon the vessel properties, and how well the vessel is steered.
The heading filter controls how fast the filtered heading used
during logging will follow the actual heading of the vessel.
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Sounder Main (for EM 1002)
Sounder Main is located on the Runtime parameters display
view.
These parameters allow you to:
• Define the pingmode, the desired swath coverage and the

beam spacing
• Define maximum port and starboard coverage
• Define the maximum and minimum depth for the echo

sounder
• Force a desired depth

Parameters - Sector Coverage

Max angle (deg), port / starboard: These parameters allow
you to define the maximum swath width by setting the
maximum port and starboard angles. The values are entered in
degrees.
Max coverage (m), port / starboard: These parameters allow
you to define the maximum swath width to each side by
selecting values in meters. The port and starboard angles (as
defined above) will then be adjusted accordingly by the system.
To make use of these settings, you must set Angular Coverage
mode to Auto.
Angular Coverage mode: Choose between Manual and Auto.
• Manual: If Angular Coverage is set tomanual, the values

defined as Max port and starboard angle above (in degrees)
are used directly. The Max coverage port and starboard
settings (in meters) are not used in this case. Be aware that
the outermost beams may be lost if the angular coverage set
is larger than the coverage capability at the current depth.
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• Auto: If Angular Coverage is set to Auto, the maximum
coverages (in meters) and the maximum angles will set the
swathwidth limit. The most limiting of the two criteria will
be used. If the system is not able to fulfil the above, it will
reduce the swath width further and as a consequence nearly
all the beams will be valid. You may observe this in the
Numerical display, as the numbers of beams accepted should
almost equal to the number of beams available.

→ Numerical display, page 89.

Beam spacing: Depending on the purpose of the survey, you
may define the distribution of the beams on the seafloor.

• Equidistant: This setting gives a uniform distribution of
soundings on the seafloor, and it is the normal mode for a
bathymetric survey.

• Equiangle: The beams are distributed with an equal angular
spacing based on the angular coverage used. This gives many
soundings close to the centre of the survey line, and fewon
the edge of the swath.

• In-between: The in-between spacing is intended for surveys
with high priority on seabed image data. Compared to
equidistant spacing, this mode gives higher density of
soundings in the central part (near equiangle) of the swath,
and maintains an acceptable density in the outmost parts
(near equidistant).

Parameters - Depth Settings

Force depth (m): If there is a lot of acoustic interference or if
the water is very aerated, the echo sounder may not find the
correct depths. In order to help, you can then enter the
approximate depth. This depth may be taken from your
navigational charts, or from a navigation sounder elsewhere on
the vessel. Forcing the depth will cause the system to set its gain
and range windows accordingly, and ignore its own findings
about where the bottom is.

Min. / Max. depth (m): These parameters allow you to define
the operational depth range. This range should normally be wide
enough to cover all depths encountered during the survey, as
only depths within this range will be accepted by the system.

A narrow range will help the system in bottom tracking under
difficult conditions. Exceptionally, it may be necessary to
temporarily narrow the range to assist the system in bottom
tracking. However, you must then monitor the actual depth
closely, and adjust the depth window as often as required.
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Note It is very important that valid depths are entered here when the
echo sounder starts “pinging”. If the bottom depth exceeds the
limits with more than 10%, the sounder will not lock. It may
therefore be useful to enter larger values in the beginning to
accept a more dynamic depth, even though this may slow down
the initial bottom detection when the system is started.

If the bottom depth exceeds the limits given here it will simply
loose track. The true depth should therefore be monitored
closely, and compared with the settings here during the survey.

- Minimum depth (m): Set the minimum limit of the depth
range.

- Maximum depth (m): Set the maximum limit of the
depth range.

Ping Mode: This parameter defines the operational mode of the
multibeam echo sounder. You can select any of the following
settings:
• Auto
• Shallow
• Medium
• Deep
During normal operating conditions, you are advised to set the
ping mode to Auto. The system will then automatically use the
most appropriate mode, and - if necessary - switch between the
modes to obtain maximum coverage.

Parameters - Stabilization

Pitch stabilization: This setting is only available if a Hull Unit
is installed. When pitch stabilization is selected (i.e. ON), the
transducer array is mechanically stabilized to compensate for the
vessel’s pitch movement.
At open sea, the swath area on the bottom will move back and
forth following the vessel pitch. This would lead to loss of
sampling regularity, and thus also limit the vessel speed at
which 100% bottom coverage is possible. To counter this effect
the Hull Unit may be set to compensate for the pitch in order to
stabilize the direction of the emitted vertical transmit fan. This
option should thus normally be ON.
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Sounder Main (for EM 2000)
Sounder Main is located on the Runtime parameters display
view.

These parameters allow you to:
• Define the pingmode, the desired swath coverage and the

beam spacing
• Define maximum port and starboard coverage
• Define the maximum and minimum depth for the echo

sounder
• Force a desired depth
• Limit the ping frequency

Parameters - Sector Coverage

Max angle (deg), port / starboard: These parameters allow
you to define the maximum swath width by setting the
maximum port and starboard angles. The values are entered in
degrees.

Max coverage (m), port / starboard: These parameters allow
you to define the maximum swath width to each side by
selecting values in meters. The port and starboard angles (as
defined above) will then be adjusted accordingly by the system.
To make use of these settings, you must set Angular Coverage
mode to Auto.

Angular Coverage mode: Choose between Manual and Auto:

• Manual: If Angular Coverage is set to manual, the values
defined as Max port and starboard angle above (in degrees)
are used directly. The Max coverage port and starboard
settings (in meters) are not used in this case. Be aware that
the outermost beams may be lost if the angular coverage set
is larger than the coverage capability at the current depth.
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• Auto: If Angular Coverage is set to Auto, the maximum
coverages (in meters) and the maximum angles will set the
swathwidth limit. The most limiting of the two criteria will
be used. If the system is not able to fulfil the above, it will
reduce the swath width further and as a consequence nearly
all the beams will be valid. You may observe this in the
Numerical display, as the numbers of beams accepted should
almost equal to the number of beams available.

→ Numerical display, page 89.

Beam spacing: Depending on the purpose of the survey, you
may define the distribution of the beams on the seafloor.

• Equidistant: This setting gives a uniform distribution of
soundings on the seafloor, and it is the normal mode for a
bathymetric survey.

• Equiangle: The beams are distributed with an equal angular
spacing based on the angular coverage used. This gives many
soundings close to the centre of the survey line, and few on
the edge of the swath.

• In-between: The in-between spacing is intended for surveys
with high priority on seabed image data. Compared to
equidistant spacing, this mode gives higher density of
soundings in the central part (near equiangle) of the swath,
and maintains an acceptable density in the outmost parts
(near equidistant).

Parameters - Depth Settings

Force depth (m): If there is a lot of acoustic interference or if
the water is very aerated, the echo sounder may not find the
correct depths. In order to help, you can then enter the
approximate depth. This depth may be taken from your
navigational charts, or from a navigation sounder elsewhere on
the vessel. Forcing the depth will cause the system to set its gain
and range windows accordingly, and ignore its own findings
about where the bottom is.

Min. / Max. depth (m): These parameters define the
operational depth range. This range should normally be wide
enough to cover all depths encountered during the survey, as
only depths within this range will be accepted by the system.

A narrow range will help the system in bottom tracking under
difficult conditions. In some cases it may be necessary to
temporarily narrow the range to assist the system in bottom
tracking. However, you must then monitor the actual depth
closely, and adjust the depth window as often as required.
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Note It is very important that valid depths are entered here when the
echo sounder starts “pinging”. If the bottom depth exceeds the
limits with more than 10%, the sounder will not lock. It may
therefore be useful to enter larger values in the beginning to
accept a more dynamic depth, even though this may slow down
the initial bottom detection when the system is started.

If the bottom depth exceeds the limits given here it will simply
loose track. The true depth should therefore be monitored and
compared with the settings during the survey.

- Minimum depth (m): Set the minimum limit of the depth
range.

- Maximum depth (m): Set the maximum limit of the
depth range.

Ping Mode: This parameter defines the operational mode of the
multibeam echo sounder. You can select any of the following
settings:
• Auto
• Shallow
• Deep
During normal operating conditions, you are advised to set the
ping mode to Auto. The system will then automatically use the
most appropriate mode, and - if necessary - switch between the
modes to obtain maximum coverage.
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Sounder Main (for EM 3000)
Sounder Main is located on the Runtime parameters display
view.
These parameters allow you to:
• Define the desired swath coverage and the beam spacing
• Define maximum port and starboard coverage
• Define the maximum and minimum depth for the echo

sounder
• Force a desired depth
• Limit the ping frequency

Parameters - Sector Coverage

Port < - > Starboard: This button allows the settings for the
port and starboard sector coverage parameters to be swapped.
This is convenient when logging along a shoreline and the
vessel is turning around.
Sonar Head angle (deg): Allows you to define the minimum
and maximum swath width by setting the minimum and
maximum port and starboard angles. The values are entered in
degrees. The values are relative to the vertical.
Coverage (m): Allows you to define the minimum and
maximum swath width to each side by selecting values in
meters. The port and starboard angles (as defined above) will
then be adjusted accordingly by the system.
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Parameters - Depth Settings

Force depth (m): If there is a lot of acoustic interference or if
the water is very aerated, the echo sounder may not find the
correct depths. In order to help, you can then enter the
approximate depth. This depth may be taken from your
navigational charts, or from a navigation sounder elsewhere on
the vessel. Forcing the depth will cause the system to set its gain
and range windows accordingly, and ignore its own findings
about where the bottom is.

Min. / Max. depth (m): Allows you to define the operational
depth range.

This range should normally be wide enough to cover all depths
encountered during the survey, as only depths within this range
will be accepted by the system.

A narrow range will help the system in bottom tracking under
difficult conditions. In some cases it may be necessary to
temporarily narrow the range to assist the system in bottom
tracking. However, you must then monitor the actual depth
closely, and adjust the depth window as often as required.

Note It is very important that valid depths are entered when the echo
sounder starts “pinging”. If the bottom depth exceeds the limits
with more than 10%, the sounder will not lock. It may therefore
be useful to enter larger values in the beginning to accept a
more dynamic depth, even though this may slow down the initial
bottom detection when the system is started.

If the bottom depth exceeds the limits given here it will simply
loose track. The true depth should therefore be monitored
closely, and compared with the settings here during the survey.

Parameters - Transmit Control

Beam width: This function is used to set the beamwidths the
system shall use.

Choose between Auto, Normal, Nearfield or Tracking.

With the standard beamforming algorithm, the resolution
(physical width or footprint) of a beam is at ranges larger than
about 7 m determined by the range multiplied by the beamwidth
(1.5°). At lesser ranges the achievable resolution will not follow
this law, but will remain fairly constant at about the transducer
size, i.e. 20 cm.
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Furthermore, the returned echo strength will fluctuate at ranges
less than about 4 m, making accurate backscatter measurements
impossible at very shallow depths. To overcome these
limitations, which are due to physics, the system has a nearfield
beamforming algorithm which, when used, will improve the
resolution for ranges less than 3 m, with at best a 10 cm
resolution, and also to allow valid backscatter measurements to
less than 1 m depths.
The options have the following consequences:
• Auto: With this option the system switches automatically

between normal and nearfield beamforming as the depth
changes from shallow to deep or vice versa. The switch
depths are 2 and 4 m respectively to avoid to frequently
changes of beamforming algorithm. This option should be
used when the depth is variable with a significant part of the
bottom having depths less then 2 m.

• Normal: With this option the normal beamforming algorithm
is always used. This option should normally be selected.

• Nearfield: With this option the nearfield beamforming
algorithm is always used. This option should be used if most
of the bottom has depths less than 2 m and there are no
depths larger than about 4 m. The opening angle for both
transmission and reception is 4 degrees.

• Tracking: This mode sets the opening angle for transmission
and reception to 4 degrees and 1.5 degrees respectively. This
should increase the number of pings on defined objects, and
increase the detection possibility. The alongship footprint
size will also increase.

Transmit angle (deg): This setting allows you to determine in
which direction the system is to measure, that is how to tilt the
narrow transmit fan forwards or backwards. The amount of
tilting that can be applied is ±20°with respect to the Sonar Head.
The displayed angle is the angular sector possible with respect
to the vertical taking into account the pitch installation angle of
the sonar head.
For seabed mapping, the transmit fan should be directed to point
vertically. This is the default setting of the transmit angle. In
very shallow waters the coverage may be increased somewhat
by tilting the fan away from the vertical as much as possible.
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Because the tilt is applied electronically on the transmit pulse -
which is common to all beams - the effective tilt angle will vary
with the beam angle. The outer beams will effectively be tilted
much more than the central beams, and the result is a curved
swath with a hyperbolic shape. To counter this effect, and thus
to minimize the deviations from a straight line swath, the
applied electronic tilt angle is less than that derived from the
entered transmit angle: A 30% reduction for a single head
system and 45% for the dual head system. This reduction will in
the future become adaptable according to actual coverage and
installation parameters.
Max. Ping Freq (Hz): This setting is used to limit the ping rate
and hence the data storage rate of the system.
The time it takes for a sound pulse to reach the bottom and
return to the Sonar Head will normally limit the ping frequency
of the sonar head up to a maximum of 40 Hz. 100% coverage of
the bottom is thus possible at vessel speeds up to about 12 knots
(130 degree sector). If the vessel speed is slower, or 100%
coverage of the bottom is not required, the amount of stored
data from a survey may be reduced by lowering the maximum
ping frequency.
The table below shows the typical data rate in Mbytes per hour
at maximum ping rate for a single head system.

Depth below
transducer

Bathymetry Seabed image Sector width

5 m 300 100 65 deg.

10 m 200 85 65 deg.

25 m 100 70 65 deg.

Pitch stabilization: At open sea, the swath area on the bottom
will move back and forth following the vessel pitch. This would
lead to loss of sampling regularity, and thus also limit the vessel
speed at which 100% bottom coverage is possible. To counter
this effect the system’s transmit angle may be set to varywith
the pitch in order to stabilize the direction of the emitted vertical
transmit fan. This option should thus normally be ON.
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Sounder Main (for EM 3002)
Sounder Main is located on the Runtime parameters display
view.
These parameters allow you to:
• Define the desired swath coverage and the beam spacing
• Define maximum port and starboard coverage
• Define the maximum and minimum depth for the echo

sounder
• Force a desired depth
• Limit the ping frequency

Parameters - Sector Coverage
Port < - > Starboard: This button allows the settings for the
port and starboard sector coverage parameters to be swapped.
This is convenient when logging along a shoreline and the
vessel is turning around.
Sonar Head angle (deg): Allows you to define the minimum
and maximum swath width by setting the minimum and
maximum port and starboard angles. The values are entered in
degrees. The values are relative to the vertical.
Coverage (m): Allows you to define the minimum and
maximum swath width to each side by selecting values in
meters. The port and starboard angles (as defined above) will
then be adjusted accordingly by the system.
AngularCoverage mode: Select between Manual and Auto.
• Manual: If Angular Coverage is set to manual, the values

defined as Max port and starboard angle above (in degrees)
are used directly. The Max coverage port and starboard
settings (in meters) are not used in this case. Be aware that
the outermost beams may be lost if the angular coverage set
is larger than the coverage capability at the current depth.
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• Auto: If Angular Coverage is set to Auto, the maximum
coverages (in meters) and the maximum angles will set the
swathwidth limit. The most limiting of the two criteria will
be used. If the system is not able to fulfil the above, it will
reduce the swath width further and as a consequence nearly
all the beams will be valid. You may observe this in the
Numerical display, as the numbers of beams accepted should
almost equal to the number of beams available.

→ Numerical display, page 89.
Beam Spacing: Depending on the purpose of the survey, you
may define the distribution of the beams on the seafloor.
• Equidistant: This setting gives a uniform distribution of

soundings on the seafloor, and it is the normal mode for a
bathymetric survey. The number of beams is 160.

• Equiangle: The beams are distributed with an equal angular
spacing based on the angular coverage used. This gives many
soundings close to the centre of the survey line, and few on
the edge of the swath. The number of beams is 160.

• High density: In this mode the number of soundings are
increased to 254 per sonar head (i.e. 508 for EM 3002 dual
head). This is achieved by directing some of the beams closer
to the centre of the survey line and performing several
soundings per beam on the edge of the swath. This results in
an equidistant distribution of the soundings.

Parameters - Depth Settings

Force depth (m): If there is a lot of acoustic interference or if
the water is very aerated, the echo sounder may not find the
correct depths. In order to help, you can then enter the
approximate depth. This depth may be taken from your
navigational charts, or from a navigation sounder elsewhere on
the vessel. Forcing the depth will cause the system to set its gain
and range windows accordingly, and ignore its own findings
about where the bottom is.
Min. / Max. depth (m): Allows you to define the operational
depth range.
This range should normally be wide enough to cover all depths
encountered during the survey, as only depths within this range
will be accepted by the system.
A narrow range will help the system in bottom tracking under
difficult conditions. In some cases it may be necessary to
temporarily narrow the range to assist the system in bottom
tracking. However, you must then monitor the actual depth
closely, and adjust the depth window as often as required.
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Note It is very important that valid depths are entered here when the
echo sounder starts “pinging”. If the bottom depth exceeds the
limits with more than 10%, the sounder will not lock. It may
therefore be useful to enter larger values in the beginning to
accept a more dynamic depth, even though this may slow down
the initial bottom detection when the system is started.

Parameters - Transmit Control

Beam width: This function is used to set the transmitter beam
widths of the system. Choose between Normal (1.5_) and Wide
(4_). To compensate for nearfield effects, the EM 3002 receiver
is dynamically focused.
The options have the following consequences:
• Normal: This mode sets the opening angle for transmission

to 1.5 degrees. This option should normally be selected.
• Wide: This mode sets the opening angle for transmission to 4

degrees. This can be used to compensate for nearfield effects
at very shallow depths (less than 2 to 4 m), and for target
detection. This should increase the number of pings on
defined objects, and increase the detection possibility. The
alongship footprint will also increase.

Along Direction (deg): This setting allows you to determine in
which direction the system is to measure, that is how to tilt the
narrow transmit fan forwards or backwards. The amount of
tilting that can be applied is ±15°with respect to the Sonar Head.
The displayed angle is the angular sector possible with respect
to the vertical taking into account the pitch installation angle of
the sonar head.
For seabed mapping, the transmit fan should be directed to point
vertically. This is the default setting of the transmit angle. It is
equal to the pitch installation angle, but with opposite sign. In
very shallow waters the coverage may be increased somewhat
by tilting the fan away from the vertical as much as possible.
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Because the tilt is applied electronically on the transmit pulse -
which is common to all beams - the effective tilt angle will vary
with the beam angle. The outer beams will effectively be tilted
muchmore than the central beams, and the result is a curved
swath with a hyperbolic shape. To counter this effect, and thus
to minimize the deviations from a straight line swath, the
applied electronic tilt angle is less than that derived from the
entered transmit angle: a 30% reduction for a single head system
and 45% for the dual head system. This reduction will in the
future become adaptable according to actual coverage and
installation parameters.
Max. Ping Freq (Hz): This setting is used to limit the ping rate
and hence the data storage rate of the system.
The time it takes for a sound pulse to reach the bottom and
return to the Sonar Head will normally limit the ping frequency
of the sonar head up to a maximum of 50 Hz. 100% coverage of
the bottom is thus possible at vessel speeds up to about 12 knots.
If the vessel speed is slower, or 100% coverage of the bottom is
not required, the amount of stored data from a survey may be
reduced by lowering the maximum ping frequency.
The table below shows the typical data rate in Mbytes per hour
at maximum ping rate for a single head system.

Depth
below

transducer

Bathymetry Seabed
image

Water
column

Sector
width

5 m 800 200 1500 65 deg.

10 m 500 150 1650 65 deg.

25 m 250 100 1900 65 deg.

Pitch stabilization: This setting is used to turn pitch
stabilization on and off. Pitch movements within ±10 degrees
are automatically compensated by the software, and will not
affect the survey results. Larger pitch values can not be fully
compensated, but the system will provide correct values for the
x, y and z movements anyway.
At open sea, the swath area on the bottom will move back and
forth following the vessel pitch. This would lead to loss of
sampling regularity, and thus also limit the vessel speed at
which 100% bottom coverage is possible. To counter this effect
the system’s transmit anglemay be set to varywith the pitch in
order to stabilize the direction of the emitted vertical transmit
fan. This option should thus normally be ON.
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Sound Speed (for EM 120, EM 300, EM 710
EM 2000, EM 3000 and EM 3002)

Sound Speed is located on the Runtime parameters display
view.

Parameters - Sound Speed Profile

Use Sound Speed Profile: The Sound Speed Profile parameter
allows you to select the sound speed profile to be used in the
echo sounder’s depth calculations. These calculations are based
upon ray bending theory, and the importance of a correct sound
speed profile can not be underrated.

The accuracy of the depth data obtained from the system is
usually critically dependent upon the use of a correct sound
speed profile. You must ascertain that the applied profile always
corresponds to the real conditions. On the average errors in the
sound speed profile should not be larger than about 0.5 m/s.

If you want to use a different profile, click the browse-button on
the right-hand side (button with three dots). When the desired
profile is selected, press Use Sound Speed Profile.

Absorption coefficient files: When selecting a new sound
speed profile, this will affect the absorption coefficient settings
in the system. Each sound speed profile is associated with a set
of absorption coefficient files which already exist or which are
made at the moment on the basis of the selected sound speed
profile and related implementation of absorption coefficients.
→ Absorption coefficient parameters, page 240.
→ Implementation of absorption coefficients, page 398.
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The associated absorption coefficient file set is either of type
salinity based or CTD based. As a result of the selection, one of
the two following text fields is changed to reflect the selection:

• Abs. coeff. files, salinity

• Abs. coeff. files, CTD

Note A user provided sound velocity profile (with a user defined
name) does not normally have a set of associated absorption
coefficient files initially. The files will therefore be generated
automatically based on the current salinity value. The name of
the files will contain salinity as a part of the file name, and this
will show up in the salinity text field. In this case the Sound
Speed Profile text field will show the original user selection.

Note If a datagram of format S00, S01, S02, S03, S04 or S05 is
received this implies that the data should be used immediately.
The Absorption coefficient files field are updated automatically.
The Use Sound Speed Profile text field will be updated with the
name of the new sound velocity profile. In the case of a S00
datagram it will contain salinity as part of the name.

→ For more information see Handling of SSP datagrams,
page 395.

Parameters - Sound Speed at Transducer

Note When the surface sound speed varies much with time and
position and especially with tilted sonar head(s), it is
recommended to install a sound speed sensor close to the
transducer face!

Sound velocity probe not used: Select this option if you want
to stop using the sound velocity probe.

If Probe is changed to not used, the Probe option will be
removed from the Source selection (see below). If Source is set
to Probe - and sound velocity probe is changed to not used -
Profile will be set as new Source. This Source selection may
subsequently be changed by the operator.

If the probe delivers no samples within the set filter length due
to an error the operator will be notified by pop-up warnings. To
avoid these pop-up warnings, set sound velocity probe to “not
used” until the problem has been corrected.
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If the sound speed value at the transducer derived from the
sound speed profile deviates too much from the probe or manual
values this will be indicated in the Numerical display (Tr. svp
and Tr. sensor).
Source: Select the source for the Sound Speed at Transducer.
Choose between Manual, Profile and Probe.
• Sensor: The system will use a filtered sound speed value

derived from the sound speed sensor at the transducer. The
filter is configured as described below. This option will only
be available if the sound velocity probe is used.

• Manual: The echo sounder system will use the sound speed
you define.

Caution The manual setting is intended for experienced
operators only!

• Profile: The system will use the sound speed profile to
derive the sound speed near the transducer/sonar head. If no
matching depth is found in the profile, an interpolated value
is used.

Sound Speed (m/s): Set the sound speed at transducer directly
to a fixed value. This function is only available if Manual is
selected.
Sensor Offset (m/s): This parameter is used to set a correction
offset if the Source is set to Probe. The offset will be added to
the used sound speed values.

Note When a new profile is taken into use, always set the offset so
that the sensor value is the same as that in the profile at the
transducer depth. This is most easily done using the values from
Numerical display.

→ Numerical display, page 89.

Filter(s): The length of the filtering of the sound speed sensor
data can be selected. This also sets the update rate i.e. how often
a new sound speed value derived from the filter is set. The filter
is a median filter. Values outside 1300 to 1800 m/s are removed
before the filter is run.
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Sound Speed (for EM 1002)
Sound Speed is located on the Runtime parameters display
view.

Parameters - Sound Speed Profile

Use Sound Speed Profile: The Sound Speed Profile parameter
allows you to select the sound speed profile to be used in the
echo sounder’s depth calculations. These calculations are based
upon ray bending theory, and the importance of a correct sound
speed profile can not be underrated.
The accuracy of the depth data obtained from the system is
usually critically dependent upon the use of a correct sound
speed profile. You must ascertain that the applied profile always
corresponds to the real conditions. On the average errors in the
sound speed profile should not be larger than about 0.5 m/s.
If you want to use a different profile, click the browse-button on
the right-hand side (button with three dots). When the desired
profile is selected, press Use Sound Speed Profile.
Absorption coefficient files: When selecting a new sound
speed profile, this will affect the absorption coefficient settings
in the system. Each sound speed profile is associated with a set
of absorption coefficient files which already exist or which are
made at the moment on the basis of the selected sound speed
profile and related implementation of absorption coefficients.
→ Absorption coefficient parameters, page 240.
→ Implementation of absorption coefficients, page 398.
The associated absorption coefficient file set is either of type
salinity based or CTD based. As a result of the selection, one of
the two following text fields is changed to reflect the selection:
• Abs. coeff. files, salinity
• Abs. coeff. files, CTD



Frame contents

229850-164709 / E

Note A user provided sound velocity profile (with a user defined
name) does not normally have a set of associated absorption
coefficient files initially. The files will therefore be generated
automatically based on the current salinity value. The name of
the files will contain salinity as a part of the file name, and this
will show up in the salinity text field. In this case the Sound
Speed Profile text field will show the original user selection.

Note If a datagram of format S00, S01, S02, S03, S04 or S05 is
received this implies that the data should be used immediately.
The Absorption coefficient files field are updated automatically.
The Use Sound Speed Profile text field will be updated with the
name of the new sound velocity profile. In the case of a S00
datagram it will contain salinity as part of the name.

For more information see Handling of SSP datagrams,
page 395.
Parameters - Sound Speed at Transducer

Note When the surface sound speed varies much with time and
position and especially with tilted sonar head(s), it is
recommended to install a sound speed sensor close to the
transducer face!

Sound velocity probe not used: Select this option if you want
to stop using the sound velocity probe.
If the probe is changed to not used, the Probe option will be
removed from the Source selection (see below). If Source is set
to Probe - and sound velocity probe is changed to not used -
Profile will be set as new Source. This Source selection may
subsequently be changed by the operator.
If the probe delivers no samples within the set filter length due
to an error the operator will be notified by pop-up warnings. To
avoid these pop-up warnings, set sound velocity probe to “not
used” until the problem has been corrected.
If the sound speed value at the transducer derived from the
sound speed profile deviates too much from the probe or manual
values this will be indicated in the Numerical display (Tr. svp
and Tr. sensor).
Source: Select the source for the Sound Speed at Transducer.
Choose between Manual, Profile and Probe.
• Manual: The echo sounder system will use the sound speed

you define.
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Caution The manual setting is intended for experienced
operators only!

• Profile: The system will use the sound speed profile to
derive the sound speed near the transducer/sonar head. If no
matching depth is found in the profile, an interpolated value
is used.

• Probe: The system will use a filtered sound speed value
derived from the sound speed sensor at the transducer. The
filter is configured as described below. This option will only
be available if the sound velocity probe is used.

Sound Speed (m/s): Set the sound speed at transducer directly
to a fixed value. This function is only available if Manual is
selected.
Sensor Offset (m/s): This parameter is used to set a correction
offset if the Source is set to Probe. The offset will be added to
the used sound speed values.

Note When a new profile is taken into use, always set the offset so
that the sensor value is the same as that in the profile at the
transducer depth. This is most easily done using the values from
the Numerical display.

→ Numerical display, page 89.

Filter(s): The length of the filtering of the sound speed sensor
data can be selected. This also sets the update rate. i.e. how
often a new sound speed value derived from the filter is set.
The filter is a median filter. Sound speed values outside 1300 to
1800 m/s and temperature sensor values outside -5_C to +45_C
are removed before the filter is run.
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Parameters - Sea temperature at transducer

The transducer has a coating with a sound speed which differs
significantly from water sound speed. As electronic
beam-steering is used for all beam angles larger than 50°, outer
beam pointing angle accuracy is dependent on the coating sound
speed being known to the system. As this sound speed is
temperature dependent, the coating temperature must be known
to the system. To give the system the coating temperature, a
sound speed probe at the transducer depth may be equipped with
an additional temperature sensor. The temperature sensor may
otherwise be manually set or alternatively be derived from the
sound speed if the salinity is known. The latter is recommended
in open water where salinity does not vary, otherwise the use of
a combined sound speed/temperature probe is recommended.
Source: Select the source you want temperatures from.
• Sensor: The read-out from the temperature sensor is used.
• Salinity: When Source is set to “Salinity”, the salinity value

you enter here will be used together with sound speed at
transducer to calculate temperature.

• Manual: The sea temperature you enter will be used.
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Filter and Gains (for EM 120 and EM 300)
Filter and Gains is located on the Runtime parameters display
view.

Note The frequency for EM 120 is 12.0 kHz and the frequency for EM
300 is 31.5 kHz.

Parameters - Filtering

There is always a small risk of false detections in a multibeam
echo sounder. This is due to external factors such as fish shoals,
acoustical interference from other systems, passing over vessel
wakes, etc. According to bottom conditions, you can apply the
included filters to assist the system in discriminating against
erroneous measurements. It is recommended to use different
filter settings than those recommended only if the occurrence of
false detections is too high to be acceptable.
The recommended settings are:
• Spike Filter Strength: Medium
• Range gate: Normal
• Slope: On
• Aeration: Off
• Sector Tracking: On
• Interference: Off

The bottom detection is performed in two passes in each ping.
Filtering is performed after every pass.
• The first pass is done on all beams individually.
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• The second pass is done only on beams which lack valid
detection. However, the system then uses relaxed acceptance
criteria within range windows derived from neighbouring
beams with accepted detection.

It is always beneficial to eliminate erroneous measurements
before postprocessing. In addition, if a false detection in a beam
is eliminated in the first pass, a valid detection may be acquired
in the second pass.
Spike Filter Strength: Choose between OFF, WEAK,
MEDIUM and STRONG.
This is used to define to what degree a non-smooth bottom is to
be accepted. The filter remove beams with depths that deviate
too much from a smoothed bottom profile as derived from the
detected beams. The stronger filtering, the less deviation is
accepted.
If you select OFF, no filtering will takes place.
Range Gate: Choose between SMALL, NORMAL and
LARGE.
When the system detects the bottom, it will perform the search
within a predefined depth window, where the depth limits are
based on the information from the previous pings. The range
gate setting is used to determine the size of this window.
If the depth varies considerably (more than 10%) it may be
useful to select a large range gate, but this may also increase the
chance for false echoes from side lobes, interference or other
noise sources.
Selecting a large range gate may reduce the ping rate slightly
when operating in shallow waters.

Slope: With this filter enabled, the system checks for bottom
slopes that tilt inwards. These slant towards the vessel, and they
are removed because the filter requires that the athwartships
distance increases for every beam from the centre. Such
detections are normally false, and after removal a new bottom
detection is performed searching for a value with increased
range.
The slope filter should normally be enabled.
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Erroneous detection

The detection should be
on the right side of this
vertical line.
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Figure 13 Slope filter principles

Aeration: If the transducer installation suffers from air bubbles
close to the transducer, the system may have problems with
bottom tracking. Activating this filter will force the system to
keep tracking the same depth for a longer period. If you have
aeration problems in areas with relatively constant depths, this
filter will increase the performance of the system. However, if
the bottom depth varies considerably, the filter may have an
adverse effect.
Sector tracking: The transmitter operates with three or nine
pulses within each ping. Each pulse covers different sectors of
the total swath. This setting will turn on an automatic gain
compensation to avoid amplitude offsets between these sectors.
During normal operations, the Sector Tracking should be on.
However, if the survey specifications demand a fully calibrated
system for sidescan image, this function should be turned off.
This setting does not affect the depth measurements, only the
backscatter strengths.
Interference: If the vessel is equipped with other echo sounders
on sonars operating on frequencies close to the echo sounder,
you may experience interference. The best solution is to
synchronize the operation of the different systems. If
synchronization is not possible, this filter may reduce
interference problems.
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Parameters - Absorption Coefficient
The absorption coefficient depends upon depth, water
temperature, salinity and frequency. A correct value is important
with respect to the validity of the bottom backscatter data
measured by the system.
The absorption coefficient as a function of the depth must
therefore be calculated for the frequency used by the
echosounder.
Source: There are three alternatives for the operator; absorption
coefficient based on salinity input (Salinity), absorption
coefficient based on profile input (CTD Profile) and manually
selected absorption coefficient (Manual):
• Salinity: If the source is set to salinity, the average

absorption coefficient is calculated using the current sound
profile (to find the temperature profile), the depth based on
the previous pings and the specified average salinity. The
average absorption coefficient will then be calculated by SIS
for the relevant frequency and it will be updated and
displayed with changing depths. If the salinity in the water is
constant, this is the recommended setting.

• CTD Profile: The absorption coefficient can be calculated
from a sound speed profile that includes information
necessary to calculate an absorption profile.
The sound speed input datagram (SSP) must be used. When
using a CTD profile from an SSP datagram, the absorption
coefficient profile will automatically be calculated by SIS for
the required frequencies.
It is also possible to specify the absorption coefficient
directly in the SSP datagram, but then one datagram must be
made for each frequency used by the echosounders (i.e. the
full range of 12, 31.5, 60, 70, 80, 90, 95, 100, 200 and 300
kHz), and the frequency must be specified in each datagram.
These datagrams must have the same acquisition date and
time and must be sent with no more than 10 seconds interval.
Using this CTD Profile option, which will increase the
accuracy of the bottom reflectivity data; SIS will calculate
the average absorption coefficient through the water column.
The absorption coefficient values displayed will change
continuously depending upon the depth.

• Manual: It is possible to manually specify the absorption
coefficient for the relevant frequency. This must be the
average absorption coefficient for the water column.

Salinity (parts per thousand): If the source is set to Salinity,
the average salinity can be entered in this field.
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<frequency> kHz: If the source is set to Manual, the operator
may supply an absorption coefficient for the stated frequency.
This frequency is as follows for the different echosounders:

EM 120 12.0 kHz

EM 300 31.5 kHz

EM 1002 95.0 kHz

EM 2000 200.0 kHz

EM 3000 300.0 kHz

EM 3002 300.0 kHz

If the source is set to Salinity or CTD, the frequency field is
disabled (greyed), but it will show the current value of the
absorption coefficient (dB/km) used for the frequency.

Related topics

→ Handling of SSP datagrams, page 395.
→ Implementation of absorption coefficients, page 398.
→ The absorption coefficient equation, page 404.

Parameters - Normal incidence sector

Angle from nadir [deg.]: This value is used to define the angle
at which the bottom backscatter can be assumed to not be
affected by the strong increase at normal incidence. The
optimum crossover angle will vary with the bottom type.
For seabed imaging, it is important to adjust this angle so that a
minimum of angle-dependent amplitude variation is seen. This
is to give best use of its dynamic range. The bottom backscatter
strengths in the ping display are not affected by this setting.
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Filter and Gains (for EM 710)
Filter and Gains is located on the Runtime parameters display
view.

Parameters - Filtering

There is always a small risk of false detections in a multibeam
echo sounder. This is due to external factors such as fish shoals,
acoustical interference from other systems, passing over vessel
wakes, etc. According to bottom conditions, you can apply the
included filters to assist the system in discriminating against
erroneous measurements. It is recommended to use different
filter settings than those recommended only if the occurrence of
false detections is too high to be acceptable.
The recommended settings are:
• Spike Filter Strength: Medium
• Range gate: Normal
• Slope: On
• Aeration: Off
• Sector Tracking: On
• Interference: Off

The bottom detection is performed in two passes in each ping.
Filtering is performed after every pass.
• The first pass is done on all beams individually.
• The second pass is done only on beams which lack valid

detection. However, the system then uses relaxed acceptance
criteria within range windows derived from neighbouring
beams with accepted detection.
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It is always beneficial to eliminate erroneous measurements
before postprocessing. In addition, if a false detection in a beam
is eliminated in the first pass, a valid detection may be acquired
in the second pass.
Spike Filter Strength: Choose between OFF, WEAK,
MEDIUM and STRONG.
This is used to define to what degree a non-smooth bottom is to
be accepted. The filter remove beams with depths that deviate
too much from a smoothed bottom profile as derived from the
detected beams. The stronger filtering, the less deviation is
accepted.
If you select OFF, no filtering will takes place.
Range Gate: Choose between SMALL, NORMAL and
LARGE.
When the system detects the bottom, it will perform the search
within a predefined depth window, where the depth limits are
based on the information from the previous pings. The range
gate setting is used to determine the size of this window.
If the depth varies considerably (more than 10%) it may be
useful to select a large range gate, but this may also increase the
chance for false echoes from side lobes, interference or other
noise sources.
Selecting a large range gate may reduce the ping rate slightly
when operating in shallow waters.
Slope: With this filter enabled, the system checks for bottom
slopes that tilt inwards. These slant towards the vessel, and they
are removed because the filter requires that the athwartships
distance increases for every beam from the centre. Such
detections are normally false, and after removal a new bottom
detection is performed searching for a value with increased
range.
The slope filter should normally be enabled.
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Figure 14 Slope filter principles

Aeration: For current version this button is used to enable a
penetration filter.
Sector tracking: The transmitter operates with several pulses
within each ping. Each pulse covers different sectors of the total
swath. This setting will turn on an automatic gain compensation
to avoid amplitude offsets between these sectors. During normal
operations, the Sector Tracking should be on. However, if the
survey specifications demand a fully calibrated system for
sidescan image, this function should be turned off.

This setting does not affect the depth measurements, only the
backscatter strengths.
Interference: If the vessel is equipped with other echo sounders
on sonars operating on frequencies close to the echo sounder,
you may experience interference. The best solution is to
synchronize the operation of the different systems. If
synchronization is not possible, this filter may reduce
interference problems.



Seafloor Information System / Base version

240 850-164709 / E

Parameters - Absorption Coefficient

The absorption coefficient depends upon depth, water
temperature, salinity and frequency. A correct value is important
with respect to the validity of the bottom backscatter data
measured by the system.

The EM 710 uses a wide bandwidth. To correct for the
absorption in the water, the absorption coefficient as a function
of the depth must be calculated for a set of frequencies.

Source: There are three alternatives for the operator; absorption
coefficient based on salinity input (Salinity), absorption
coefficient based on profile input (CTD Profile) and manually
selected absorption coefficient (Manual).

• Salinity: If the source is set to salinity, the average
absorption coefficient is calculated using the current sound
profile (to find the temperature profile), the depth based on
the previous pings and the specified average salinity. The
average absorption coefficient will then be calculated by SIS
for each frequency and will be updated and displayed with
changing depths. If the salinity in the water is constant, this is
the recommended setting.

• CTD Profile: The absorption coefficient can be calculated
from a sound speed profile that includes information
necessary to calculate an absorption profile.

The sound speed input datagram (SSP) must be used. When
using a CTD profile from an SSP datagram, the absorption
coefficient profile will automatically be calculated by SIS for
the different frequencies. It is also possible to specify the
absorption coefficient directly in the SSP datagram, but then
one datagram must be made for each frequency used by the
echosounders (ie. the full range of 12, 31.5, 60, 70, 80, 90,
95, 100, 200 and 300 kHz), and the frequency must be
specified in the datagram. These datagrams must have the
same acquisition date and time and must be sent with no
more than 10 seconds interval.

Using the C10 profile, which will increase the accuracy of
the bottom reflectivity data, SIS will calculate the average
absorption coefficient through the water column. The
absorption coefficient values displayed will change
continuously depending upon the depth.

• Manual: It is possible to manually specify the absorption
coefficient for each frequency. This must be the average
absorption coefficient for the water column.
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Salinity (parts per thousand): If the source is set to Salinity,
the average salinity can be entered in this field.
60.0 / 70.0 / 80.0 / 90.0 / 100.0 kHz: If the source is set to
Manual, the manual or calculated absorption coefficient for each
frequency from 60.0 to 100.0 kHz (in steps of 10 kHz) can be
entered in these fields.
If the source is set to Salinity or CTD, these fields are disabled
(grayed), but they will show the current value of the absorption
coefficient used for each frequency.

Related topics
→ SSP datagrams, page 395.
→ Implementation of absorption coefficients, page 398.
→ The absorption coefficient equation, page 404.

Parameters - Normal incidence sector

Angle from nadir [deg.]: This value is used to define the angle
at which the bottom backscatter can be assumed to not be
affected by the strong increase at normal incidence. The
optimum crossover angle will vary with the bottom type.
For seabed imaging, it is important to adjust this angle so that a
minimum of angle-dependent amplitude variation is seen. This
is to give best use of its dynamic range. The bottom backscatter
strengths in the ping display are not affected by this setting.
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Filter and Gains (for EM 1002)
Filter and Gains is located on the Runtime parameters display
view.

Parameters - Filtering

There is always a small risk of false detections in a multibeam
echo sounder. This is due to external factors such as fish shoals,
acoustical interference from other systems, passing over vessel
wakes, etc. According to bottom conditions, you can apply the
included filters to assist the system in discriminating against
erroneous measurements. It is recommended to use different
filter settings than those recommended only if the occurrence of
false detections is too high to be acceptable.
The recommended settings are:
• Spike Filter Strength: Medium
• Range gate: Normal
• Slope: On

The bottom detection is performed in two passes in each ping.
Filtering is performed after every pass.
• The first pass is done on all beams individually.
• The second pass is done only on beams which lack valid

detection. However, the system then uses relaxed acceptance
criteria within range windows derived from neighbouring
beams with accepted detection.

It is always beneficial to eliminate erroneous measurements
before postprocessing. In addition, if a false detection in a beam
is eliminated in the first pass, a valid detection may be acquired
in the second pass.
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Spike Filter Strength: Choose between OFF, WEAK,
MEDIUM and STRONG.
This is used to define to what degree a non-smooth bottom is to
be accepted. The filter remove beams with depths that deviate
too much from a smoothed bottom profile as derived from the
detected beams. The stronger filtering, the less deviation is
accepted.
If you select OFF, no filtering will takes place.
Range Gate: Choose between SMALL, NORMAL and
LARGE.
When the system detects the bottom, it will perform the search
within a predefined depth window, where the depth limits are
based on the information from the previous pings. The range
gate setting is used to determine the size of this window.
If the depth varies considerably (more than 10%) it may be
useful to select a large range gate, but this may also increase the
chance for false echoes from side lobes, interference or other
noise sources.
Selecting a large range gate may reduce the ping rate slightly
when operating in shallow waters.
Slope: With this filter enabled, the system checks for bottom
slopes that tilt inwards. These slant towards the vessel, and they
are removed because the filter requires that the athwartships
distance increases for every beam from the centre. Such
detections are normally false, and after removal a new bottom
detection is performed searching for a value with increased
range.
The slope filter should normally be enabled.
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Figure 15 Slope filter principles

Parameters - Absorption Coefficient

The absorption coefficient depends upon depth, water
temperature, salinity and frequency. A correct value is important
with respect to the validity of the bottom backscatter data
measured by the system.

The absorption coefficient as a function of the depth must
therefore be calculated for the frequency used by the
echosounder.

Source: There are three alternatives for the operator; absorption
coefficient based on salinity input (Salinity), absorption
coefficient based on profile input (CTD Profile) and manually
selected absorption coefficient (Manual):

• Salinity: If the source is set to salinity, the average
absorption coefficient is calculated using the current sound
profile (to find the temperature profile), the depth based on
the previous pings and the specified average salinity. The
average absorption coefficient will then be calculated by SIS
for the relevant frequency and it will be updated and
displayed with changing depths. If the salinity in the water is
constant, this is the recommended setting.

• CTD Profile: The absorption coefficient can be calculated
from a sound speed profile that includes information
necessary to calculate an absorption profile.
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The sound speed input datagram (SSP) must be used. When
using a CTD profile from an SSP datagram, the absorption
coefficient profile will automatically be calculated by SIS for
the required frequencies.

It is also possible to specify the absorption coefficient
directly in the SSP datagram, but then one datagram must be
made for each frequency used by the echosounders (i.e. the
full range of 12, 31.5, 60, 70, 80, 90, 95, 100, 200 and 300
kHz), and the frequency must be specified in each datagram.
These datagrams must have the same acquisition date and
time and must be sent with no more than 10 seconds interval.

Using this CTD Profile option, which will increase the
accuracy of the bottom reflectivity data; SIS will calculate
the average absorption coefficient through the water column.
The absorption coefficient values displayed will change
continuously depending upon the depth.

• Manual: It is possible to manually specify the absorption
coefficient for the relevant frequency. This must be the
average absorption coefficient for the water column.

Salinity (parts per thousand): If the source is set to Salinity,
the average salinity can be entered in this field.

<frequency> kHz: If the source is set to Manual, the operator
may supply an absorption coefficient for the stated frequency.
This frequency is as follows for the different echosounders:

EM 120 12.0 kHz

EM 300 31.5 kHz

EM 1002 95.0 kHz

EM 2000 200.0 kHz

EM 3000 300.0 kHz

EM 3002 300.0 kHz

If the source is set to Salinity or CTD, the frequency field is
disabled (greyed), but it will show the current value of the
absorption coefficient (dB/km) used for the frequency.

HiLo Freq. Ratio: Because the EM 1002 uses two different
frequencies (93 and 98 kHz), the absorption coefficient will
vary slightly (for example 30 dB/km for 93 kHz, 31.2 db/km for
98 kHz). The ratio of the HI/LO frequencies is to be set in this
field
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Related topics

→ Handling of SSP datagrams, page 395.
→ Implementation of absorption coefficients, page 398.
→ The absorption coefficient equation, page 404.

Parameters - Normal incidence sector

Angle from nadir [deg.]: This value is used to define the angle
at which the bottom backscatter can be assumed to not be
affected by the strong increase at normal incidence. The
optimum crossover angle will vary with the bottom type.
For seabed imaging, it is important to adjust this angle so that a
minimum of angle-dependent amplitude variation is seen. This
is to give best use of its dynamic range. The bottom backscatter
strengths in the ping display are not affected by this setting.
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Filter and Gains (for EM 2000)
Filter and Gains is located on the Runtime parameters display
view.

Parameters - Filtering

There is always a small risk of false detections in a multibeam
echo sounder. This is due to external factors such as fish shoals,
acoustical interference from other systems, passing over vessel
wakes, etc. According to bottom conditions, you can apply the
included filters to assist the system in discriminating against
erroneous measurements. It is recommended to use different
filter settings than those recommended only if the occurrence of
false detections is too high to be acceptable.
The recommended settings are:
• Spike Filter Strength: Medium
• Range gate: Normal
• Slope: On

The bottom detection is performed in two passes in each ping.
Filtering is performed after every pass.
• The first pass is done on all beams individually.
• The second pass is done only on beams which lack valid

detection. However, the system then uses relaxed acceptance
criteria within range windows derived from neighbouring
beams with accepted detection.

It is always beneficial to eliminate erroneous measurements
before postprocessing. In addition, if a false detection in a beam
is eliminated in the first pass, a valid detection may be acquired
in the second pass.
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Spike Filter Strength: Choose between OFF, WEAK,
MEDIUM and STRONG.
This is used to define to what degree a non-smooth bottom is to
be accepted. The filter remove beams with depths that deviate
too much from a smoothed bottom profile as derived from the
detected beams. The stronger filtering, the less deviation is
accepted.
If you select OFF, no filtering will takes place.
Range Gate: Choose between SMALL, NORMAL and
LARGE.
When the system detects the bottom, it will perform the search
within a predefined depth window, where the depth limits are
based on the information from the previous pings. The range
gate setting is used to determine the size of this window.
If the depth varies considerably (more than 10%) it may be
useful to select a large range gate, but this may also increase the
chance for false echoes from side lobes, interference or other
noise sources.
Selecting a large range gate may reduce the ping rate slightly
when operating in shallow waters.
Slope: With this filter enabled, the system checks for bottom
slopes that tilt inwards. These slant towards the vessel, and they
are removed because the filter requires that the athwartships
distance increases for every beam from the centre. Such
detections are normally false, and after removal a new bottom
detection is performed searching for a value with increased
range.
The slope filter should normally be enabled.
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Figure 16 Slope filter principles

Parameters - Absorption Coefficient

The absorption coefficient depends upon depth, water
temperature, salinity and frequency. A correct value is important
with respect to the validity of the bottom backscatter data
measured by the system.

The absorption coefficient as a function of the depth must
therefore be calculated for the frequency used by the
echosounder.

Source: There are three alternatives for the operator; absorption
coefficient based on salinity input (Salinity), absorption
coefficient based on profile input (CTD Profile) and manually
selected absorption coefficient (Manual):

• Salinity: If the source is set to salinity, the average
absorption coefficient is calculated using the current sound
profile (to find the temperature profile), the depth based on
the previous pings and the specified average salinity. The
average absorption coefficient will then be calculated by SIS
for the relevant frequency and it will be updated and
displayed with changing depths. If the salinity in the water is
constant, this is the recommended setting.

• CTD Profile: The absorption coefficient can be calculated
from a sound speed profile that includes information
necessary to calculate an absorption profile.
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The sound speed input datagram (SSP) must be used. When
using a CTD profile from an SSP datagram, the absorption
coefficient profile will automatically be calculated by SIS for
the required frequencies.
It is also possible to specify the absorption coefficient
directly in the SSP datagram, but then one datagram must be
made for each frequency used by the echosounders (i.e. the
full range of 12, 31.5, 60, 70, 80, 90, 95, 100, 200 and 300
kHz), and the frequency must be specified in each datagram.
These datagrams must have the same acquisition date and
time and must be sent with no more than 10 seconds interval.
Using this CTD Profile option, which will increase the
accuracy of the bottom reflectivity data; SIS will calculate
the average absorption coefficient through the water column.
The absorption coefficient values displayed will change
continuously depending upon the depth.

• Manual: It is possible to manually specify the absorption
coefficient for the relevant frequency. This must be the
average absorption coefficient for the water column.

Salinity (parts per thousand): If the source is set to Salinity,
the average salinity can be entered in this field.
<frequency> kHz: If the source is set to Manual, the operator
may supply an absorption coefficient for the stated frequency.
This frequency is as follows for the different echosounders:

EM 120 12.0 kHz

EM 300 31.5 kHz

EM 1002 95.0 kHz

EM 2000 200.0 kHz

EM 3000 300.0 kHz

EM 3002 300.0 kHz

If the source is set to Salinity or CTD, the frequency field is
disabled (greyed), but it will show the current value of the
absorption coefficient (dB/km) used for the frequency.
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Related topics

→ Handling of SSP datagrams, page 395.
→ Implementation of absorption coefficients, page 398.
→ The absorption coefficient equation, page 404.

Parameters - Normal incidence sector

Angle from nadir [deg.]: This value is used to define the angle
at which the bottom backscatter can be assumed to not be
affected by the strong increase at normal incidence. The
optimum crossover angle will vary with the bottom type.
For seabed imaging, it is important to adjust this angle so that a
minimum of angle-dependent amplitude variation is seen. This
is to give best use of its dynamic range. The bottom backscatter
strengths in the ping display are not affected by this setting.
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Filter and Gains (for EM 3000)
Filter and Gains is located on the Runtime parameters display
view.

Parameters - Filtering

There is always a small risk of false detections in a multibeam
echo sounder. This is due to external factors such as fish shoals,
acoustical interference from other systems, passing over vessel
wakes, etc. According to bottom conditions, you can apply the
included filters to assist the system in discriminating against
erroneous measurements. It is recommended to use different
filter settings than those recommended only if the occurrence of
false detections is too high to be acceptable.

The recommended settings are:
• Spike Filter Strength: Medium

• Special TVG: Off

• Slope: On

• Sidelobe suppression: Off
• Robust (slow) BD: On

• Range gate: Normal

The bottom detection is performed in two passes in each ping.
Filtering is performed after every pass.
• The first pass is done on all beams individually.

• The second pass is done only on beams which lack valid
detection. However, the system then uses relaxed acceptance
criteria within range windows derived from neighbouring
beams with accepted detection.
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It is always beneficial to eliminate erroneous measurements
before postprocessing. In addition, if a false detection in a beam
is eliminated in the first pass, a valid detection may be acquired
in the second pass.

Spike Filter Strength: Choose between OFF, WEAK,
MEDIUM and STRONG.

This is used to define to what degree a non-smooth bottom is to
be accepted. The filter remove beams with depths that deviate
too much from a smoothed bottom profile as derived from the
detected beams. The stronger filtering, the less deviation is
accepted.

If you select OFF, no filtering will takes place.

Range Gate: Choose between NORMAL and LARGE.

When the system detects the bottom, it will perform the search
within a predefined depth window, where the depth limits are
based on the information from the previous pings. The range
gate setting is used to determine the size of this window.

If the depth varies considerably (more than 10%) it may be
useful to select a large range gate, but this may also increase the
chance for false echoes from side lobes, interference or other
noise sources.

Selecting a large range gate may reduce the ping rate slightly
when operating in shallow waters.

Special TVG (Time Varying Gain): A normal TVG assumes a
flat bottom, and will work well almost anywhere. However,
bottoms with two distinct depths such as around manmade
trenches, better results may be obtained by enabling the special
TVG. The special TVG is similar to the TVG for single beam
echo sounders ( 20 log R). Normally set to OFF.

Note The special TVG is not taken into account in the backscatter
processing!

Slope: With this filter enabled, the system checks for bottom
slopes that tilt inwards. These slant towards the vessel, and they
are removed because the filter requires that the athwartships
distance increases for every beam from the centre. Such
detections are normally false, and after removal a new bottom
detection is performed searching for a value with increased
range.

The slope filter should normally be enabled.
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Figure 17 Slope filter principles

Sidelobe suppression: To be used to exclude data from
sidelobes. This might be useful for example when surveying in
waters with steep seabottom changes where sidelobe data could
be stronger or in areas with a very strong echo at the normal
incidence. The pingrate may be reduced with this feature
enabled.
Robust (slow) BD: To improve bottom detection on rough or
unusual bottoms, a new bottom detection algorithm has been
implemented. Several acceptable detections per ping may be
found ( up to 7) and the new algorithm uses comparison with
previous pings and neighbouring beams to select the ’correct’
one. The algorithm will usually decrease false detections in
shallow waters and on bottoms with strong reflections.

The new algorithm is very time consuming, and hence the old
algorithm is still available for use when a higher ping rate is
required than is possible with the new algorithm.
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Parameters - Absorption Coefficient

The absorption coefficient depends upon depth, water
temperature, salinity and frequency. A correct value is important
with respect to the validity of the bottom backscatter data
measured by the system.

The absorption coefficient as a function of the depth must
therefore be calculated for the frequency used by the
echosounder.

EM3000 and EM3002 may actually use three frequencies.
However, these frequencies are in a range where there is very
little variation in the absorption coefficients values due to
frequency variation. By supplying the absorption coefficient for
the middle frequency the two other absorption coefficient values
may be deduced locally in the PU.

Source: There are three alternatives for the operator; absorption
coefficient based on salinity input (Salinity), absorption
coefficient based on profile input (CTD Profile) and manually
selected absorption coefficient (Manual):

• Salinity: If the source is set to salinity, the average
absorption coefficient is calculated using the current sound
profile (to find the temperature profile), the depth based on
the previous pings and the specified average salinity. The
average absorption coefficient will then be calculated by SIS
for the relevant frequency and it will be updated and
displayed with changing depths. If the salinity in the water is
constant, this is the recommended setting.

• CTD Profile: The absorption coefficient can be calculated
from a sound speed profile that includes information
necessary to calculate an absorption profile.

The sound speed input datagram (SSP) must be used. When
using a CTD profile from an SSP datagram, the absorption
coefficient profile will automatically be calculated by SIS for
the required frequencies.

It is also possible to specify the absorption coefficient
directly in the SSP datagram, but then one datagram must be
made for each frequency used by the echosounders (i.e. the
full range of 12, 31.5, 60, 70, 80, 90, 95, 100, 200 and 300
kHz), and the frequency must be specified in each datagram.
These datagrams must have the same acquisition date and
time and must be sent with no more than 10 seconds interval.
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Using this CTD Profile option, which will increase the
accuracy of the bottom reflectivity data; SIS will calculate
the average absorption coefficient through the water column.
The absorption coefficient values displayed will change
continuously depending upon the depth.

• Manual: It is possible to manually specify the absorption
coefficient for the relevant frequency. This must be the
average absorption coefficient for the water column.

Salinity (parts per thousand): If the source is set to Salinity,
the average salinity can be entered in this field.
<frequency> kHz: If the source is set to Manual, the operator
may supply an absorption coefficient for the stated frequency.
This frequency is as follows for the different echosounders:

EM 120 12.0 kHz

EM 300 31.5 kHz

EM 1002 95.0 kHz

EM 2000 200.0 kHz

EM 3000 300.0 kHz

EM 3002 300.0 kHz

If the source is set to Salinity or CTD, the frequency field is
disabled (greyed), but it will show the current value of the
absorption coefficient (dB/km) used for the frequency.

Related topics

→ Handling of SSP datagrams, page 395.
→ Implementation of absorption coefficients, page 398.
→ The absorption coefficient equation, page 404.

Parameters - Normal incidence sector

Angle from nadir [deg.]: This value is used to define the angle
at which the bottom backscatter can be assumed to not be
affected by the strong increase at normal incidence. The
optimum crossover angle will vary with the bottom type.
For seabed imaging, it is important to adjust this angle so that a
minimum of angle-dependent amplitude variation is seen. This
is to give best use of its dynamic range. The bottom backscatter
strengths in the ping display are not affected by this setting.
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Filter and Gains (for EM 3002)
Filter and Gains is located on the Runtime parameters display
view.

Parameters - Filtering
There is always a small risk of false detections in a multibeam
echo sounder. This is due to external factors such as fish shoals,
acoustical interference from other systems, passing over vessel
wakes, etc. According to bottom conditions, you can apply the
included filters to assist the system in discriminating against
erroneous measurements. It is recommended to use different
filter settings than those recommended only if the occurrence of
false detections is too high to be acceptable.
The recommended settings are:
• Spike Filter Strength: Medium
• Range gate: Normal

Spike Filter Strength: Choose between OFF, WEAK,
MEDIUM and STRONG.
This is used to define to what degree a non-smooth bottom is to
be accepted. The filter remove beams with depths that deviate
too much from a smoothed bottom profile as derived from the
detected beams. The stronger filtering, the less deviation is
accepted.
If you select OFF, no filtering will takes place.
For detection of objects in the water column, like free spans on
a pipe line, it might be best to reduce the spike filter strength.
Different settings, including spike filter off, should be evaluated
by the operator.
Range Gate: Choose between SMALL, NORMAL and
LARGE.



Seafloor Information System / Base version

258 850-164709 / E

When the system detects the bottom, it will perform the search
within a predefined depth window, where the depth limits are
based on the information from the previous pings. The range
gate setting is used to determine the size of this window.
If the depth varies considerably (more than 10%) it may be
useful to select a large range gate, but this may also increase the
chance for false echoes from side lobes, interference or other
noise sources.
Selecting a large range gate may reduce the ping rate slightly
when operating in shallow waters.

Parameters - Absorption Coefficient

The absorption coefficient depends upon depth, water
temperature, salinity and frequency. A correct value is important
with respect to the validity of the bottom backscatter data
measured by the system.
The absorption coefficient as a function of the depth must
therefore be calculated for the frequency used by the
echosounder.
EM3000 and EM3002 may actually use three frequencies.
However, these frequencies are in a range where there is very
little variation in the absorption coefficients values due to
frequency variation. By supplying the absorption coefficient for
the middle frequency the two other absorption coefficient values
may be deduced locally in the PU.
Source: There are three alternatives for the operator; absorption
coefficient based on salinity input (Salinity), absorption
coefficient based on profile input (CTD Profile) and manually
selected absorption coefficient (Manual):
• Salinity: If the source is set to salinity, the average

absorption coefficient is calculated using the current sound
profile (to find the temperature profile), the depth based on
the previous pings and the specified average salinity. The
average absorption coefficient will then be calculated by SIS
for the relevant frequency and it will be updated and
displayed with changing depths. If the salinity in the water is
constant, this is the recommended setting.

• CTD Profile: The absorption coefficient can be calculated
from a sound speed profile that includes information
necessary to calculate an absorption profile.
The sound speed input datagram (SSP) must be used. When
using a CTD profile from an SSP datagram, the absorption
coefficient profile will automatically be calculated by SIS for
the required frequencies.
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It is also possible to specify the absorption coefficient
directly in the SSP datagram, but then one datagram must be
made for each frequency used by the echosounders (i.e. the
full range of 12, 31.5, 60, 70, 80, 90, 95, 100, 200 and 300
kHz), and the frequency must be specified in each datagram.
These datagrams must have the same acquisition date and
time and must be sent with no more than 10 seconds interval.

Using this CTD Profile option, which will increase the
accuracy of the bottom reflectivity data; SIS will calculate
the average absorption coefficient through the water column.
The absorption coefficient values displayed will change
continuously depending upon the depth.

• Manual: It is possible to manually specify the absorption
coefficient for the relevant frequency. This must be the
average absorption coefficient for the water column.

Salinity (parts per thousand): If the source is set to Salinity,
the average salinity can be entered in this field.

<frequency> kHz: If the source is set to Manual, the operator
may supply an absorption coefficient for the stated frequency.
This frequency is as follows for the different echosounders:

EM 120 12.0 kHz

EM 300 31.5 kHz

EM 1002 95.0 kHz

EM 2000 200.0 kHz

EM 3000 300.0 kHz

EM 3002 300.0 kHz

If the source is set to Salinity or CTD, the frequency field is
disabled (greyed), but it will show the current value of the
absorption coefficient (dB/km) used for the frequency.

Related topics

→ Handling of SSP datagrams, page 395.

→ Implementation of absorption coefficients, page 398.

→ The absorption coefficient equation, page 404.

Parameters - Normal incidence sector

Angle from nadir [deg.]: This value is used to define the angle
at which the bottom backscatter can be assumed to not be
affected by the strong increase at normal incidence. The
optimum crossover angle will vary with the bottom type.
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For seabed imaging, it is important to adjust this angle so that a
minimum of angle-dependent amplitude variation is seen. This
is to give best use of its dynamic range. The bottom backscatter
strengths in the ping display are not affected by this setting.
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Data Cleaning
Data Cleaning tab is located under the Runtime parameters
display view.

The RTDC (Real Time Data Cleaning), uses rules to process the
data. A rule is a set of parameters that controls the algorithms
used in the processing.

Note The RTDC module does not delete any depths, but flags that the
depths are invalid. The operator has full control of this
processing at all times.

• Rules set: The combo box lists all selectable rule sets. When
opening the Data Cleaning tab for the first time, only one
standard rule set is available. This is a rule set with default
parameter settings defined by Kongsberg Maritime.

• Save and use: To start using a rule set, select it from the
Rules set combo box. Any modifications to the selected rule
set is activated by pressing the Save and use button. Note
that it is not allowed to modify the standard rule set. Any
such modifications must be saved as a new rule set (see the
Save as and use button).

• Delete: Delete a rule set by selecting it from the Rules set
combo box, then press the Delete button. Note that the
standard rule set and the currently active rule set can not be
deleted.

• Cancel: Press this button to cancel any modifications made
to a rule set before saving.

• Save as and use: If it is required to save modifications to an
existing rule set as a new rule set, type a name for this rule
set in the text box, then press the Save as and use button.
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• Used set: This box displays the currently active rule set.
• Help: Press this button to open on-line help.
The RTDC module processes the data in real time using two
different kinds of processing, ping-based and grid-based
processing. Ping-based processing uses a buffer of the last pings
to process the current ping (also known as line-based
processing) while grid-based processing uses all the points from
all lines (current and all previous) to process the data in one grid
cell. Various parameters are set to control these processing
types.

Ping processing rules

Ping-based processing, flags wrong depths as early as possible
in the processing chain. Ping processing is performed right after
the depths arrive into the RTDC module.

The Time rule and the Overhang rule use the current ping only,
but the Median rule and the Quantile rule use several pings
stored in a buffer.
The number of pings in this buffer is defined by the parameters;
Max. pings in buffer, Radius factor and Median factor. The
minimum number of pings is the largest number of pings
defined by either Radius factor or Median factor.
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Grid processing rules

The grid processing rules are applied to all depths in each grid
cell. A grid cell defines an area, and all depths in this area are
processed together regardless of which survey line they belong
to. Every time a new depth is added to the grid cell, all depths
(old and new) in the grid cell are reprocessed. Previous flagged
out depths may then be set to valid and vice versa.

The first thing to do is to define the grid cell size. When the
gridding starts, the operator has already defined the minimum
grid cell size for the processing grid. However, the RTDC
module checks if it needs to redefine this grid. It can do so by
collapsing several grid cells into larger grid cells. How many
cells to process together is dependent on the median depth of the
cells and the parameter Split factor.
The parameter Min. no. points defines how many points a grid
cell should have. If a cell has fewer than this number of depths,
all depths can be flagged out if the checkbutton Remove cells is
enabled.



Seafloor Information System / Base version

264 850-164709 / E

A process grid split into processing units could then look like
this:

Figure 18 Process grid split into processing units

Empty

(CD6942)

Too few
points
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Then a best fit curved surface is created in each Cell Processing
Unit, which may be more than one grid cell). This surface is a
polynomial surface and the polynomial order is set by the
parameter Polynomial order. The polynomial surface is then
created so that it fits as good as possible to most of the point in
the Cell Processing Unit.

Figure 19 Best fit surface
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The algorithm for creating the best-fit surface is known as the
Tukey algorithm and it works like this:
Each point is considered to be equally important to begin with.
The algorithm assigns a weight to each point and they all get the
same weight. Then a polynomial surface is created. The distance
from each depth to this surface is called the residual. Then the
sum of all the residuals is calculated. Since all points have the
same weight, this sum is only the sum of the residuals.
Now the Tukey estimator kicks in. Rather than giving each point
the same weight, each point gets a new weight based on how far
away from the surface it is. Points far away from the surface get
lower weight than the ones close to the surface. The parameter
Tukey constant controls how fast points loose their weight.
Below are some examples:
Note that the r in the figure below is the median residue in the
Cell Processing Unit. As the c (Tukey constant) changes, we see
that the curve gets “broader” as c increases and “narrower” as c
decreases. This means that points loose weight faster when the
Tukey constant is small. The effect of loosing weight fast is that
points are not used in the construction of the surface the next
time the algorithm tries.

Figure 20 Tukey algorithm
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This algorithm will run several times and every time new
weights are given to each point. There are two ways this
algorithm will stop: Either it has tried Max. iterations times to
create a surface, or the change between this and the previous run
is very small. If this happens, the algorithm is said to converge,
which means that the best possible result has been found. The
parameter Conv. criterion controls when the algorithm
converges.
To sum this up:
The algorithm for the Iterated Reweighted Least Squares (IRLS)
method is given as follows:
1 Start with equal weights for all points.
2 Loop until convergence or maximum iterations

a Fit the surface using weighted least squares.
b Calculate residuals.
c Check for convergence.
d Adjust the Tukey estimator.
e Evaluate new weights.

When the polynomial surface has been successfully created,
various rules can be applied to flag out depths.
The distance from the created surface to the depth is called the
residue. Four rules can be set to flag out depths based on the
residue.
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Seabed Image Processing

These parameters apply to the Seabed Image processing in the
Grid Engine used by SIS. The Grid Engine is very resource
demanding (both CPU and file I/O) and it is desirable to be able
to turn off functionality that is not required at all times.

Parameters - Ping processing rules

Radius factor and Median factor defines the minimum number
of pings in the buffer.

Buffer size: Defines the maximum number of pings in the
buffer. The buffer will contain maximum two times the
parameter given plus one ping.

Radius factor: Calculates the minimum number of pings in the
buffer.The depth from the center beam is multiplied with this
factor, and the result is a distance in the alongship direction. All
pings within this distance from the current ping are always in
the buffer.

Median factor: Calculates the minimum number of pings in the
buffer. The median distance between the last 10 pings is
calculated and then multiplied with this factor. Again the result
is a distance in the alongship direction and all pings within this
distance from the current ping are always in the buffer.

Beam radius: This parameter defines how many beams to
either side of the current beam to use in the Median rule and
Quantile rule. The number of beams used will be two times the
parameter given plus one.
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Enough points: If the algorithm finds this many points close to
the current one, it will stop looking any further. In the example
rule above 40 points are said to be enough. These 40 points will
then be the ones closest to the current point.

neighbourhood type: Choose between Elliptical, Rectangular
and Circular neighbourhood.

When looking for points closest to the current point, the
algorithm can use three different methods for finding the nearest
points to the current point. Circular neighbourhood uses Radius
factor and Median factor to find all points within a horizontal
radius of the current point. Points in the same ping are excluded.
Elliptical neighbourhood uses two half axis, one in the
alongship direction and one in the across-ship direction. To
maintain approximately the same number of points in the
neighbourhood independent of the beam number, this method
adapts the half-axis in the across-ship direction so that it
includes at least a specified number of beams (but not much
more). Beam radius is used to define this half-axis. In the
alongship direction the half-axis is the same as for the Circular
neighbourhood. Points in the same ping are excluded.
Rectangular neighbourhood consists of all points in the
rectangle defined in the alongship direction by the number of
pings in the buffer and in the across-ship direction by Beam
radius. Again points in the same ping are excluded.

Time rule: This rule flags out beams where the time range is
bigger than the time difference between two pings as illustrated
in the figure below.

Figure 21 Time rule
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If the rightmost beam has a traveltime longer than the time
difference between the current (n+1) ping and the previous, that
beam is flagged out.

Overhang rule: This rule flags beams that create an overhang
situation, illustrated in the figure below.
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Figure 22 Overhang rule

(CD6940b)

It is not uniquely determined which beams should be flagged to
remove the overhang. In the figure, it is for example possible to
flag either the dotted beam or the beam to the left of the dotted
beam. The strategy implemented is to consider the alternatives
that imply flagging the fewest number of beams, and to keep the
points that are most likely to define the ground by minimizing
the length of the distances between the depths in the ping. If
necessary, more than one beam is flagged to remove the
overhang.

Median rule: First we calculate the depth differences between
the point and all its neighbours. Then the median of these depth
differences is found. Then we compare this median to the depth
of the point. If this median depth difference is bigger than the
depth multiplied with the scaling factor, the depth is flagged out.
Also the minimum number of points in the neighbourhood for
this rule to apply is set.

Figure 23 Median rule
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The parti-coloured point is the point to be investigated. The red
(one-coloured) points are the points in the neighbourhood. The
median of the depth differences is 4.1, so if the depth multiplied
with Factor is larger than 4.1, the blue point is flagged as
invalid.
Quantile rule: First we find the median depth among the depths
in the neighbourhood. Then we find the two quantiles defined
by the parameter Quantile. If i.e. the quantile is defined to be
0.1, we find the depth in the neighbourhood where 90% of the
depths are shallower and 10% are deeper, and this depth is then
quantileDepthMax. We also find the other depth where 10% of
the depths in the neighbourhood are shallower and 90% are
deeper, and this is then quantileDepthMin. Then we define two
limits like this: median depth - Factor * (median depth -
quantileDepthMax) and ditto for quantileDepthMin. If the depth
of the point is outside these limits, it is flagged out.

Depths
10.1
10.4 Lower quantile
10.5 Point to investigate
10.8 Median depth
11.1
12.4 Upper quantile
13.2
Lower limit: 10.8 + factor * (12.4 - 10.8)
Upper limit: 10.8 - factor * (10.8 - 10.4)

Parameters - Grid processing rules
Min. no. points: Defines how many points a grid cell should
have.
Split factor: Defines how many cells to process together. (This
is also dependent on the median depth of the cells.)
Remove cells: The parameter Min. no. points defines how many
points a grid cell should have. If a cell has fewer points than the
minimum number defined, all depths can be flagged out if this
checkbutton is enabled.
Surface fitting: Sets parameters for a best fit plane. Note that
these parameters are discussed in detail in the Grid Processing
paragraph above.
• Polynomial order: This parameter controls the shape of the

surface. This parameter should normally be 1, but 2 may give
a better surface but it requires much more processing power.
3 may be used in very difficult terrain.
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• Tukey constant: This parameter controls the weight each
point will be given. Increasing this value means that more
points will be given a weight and considered into the
solution, but the process will be slower.

• Max. iterations: This parameter controls how many times
the Tukey algorithm will try to find a solution. 1 means that
there will be only one pass, but after 3 passes the surface is
normally well defined. The search for a solution will stop
when the algorithm has tried Max. iterations times.

• Conv. criterion: This parameter will stop the Tukey
algorithm when the change in the results from the current and
the previous run is very small. Only points with weight are
considered, so the Tukey constant will have an influence on
this.

Residue depth rule: Each depth in the Cell Processing Unit is
multiplied with a Factor. The result is a limit, and if the residue
is larger than this limit, the point is flagged out.This rule will
adapt to changing depths so that the factor should be
approximately the accuracy of the echosounder.
Residue vertical error rule: Each depth has a vertical error
estimate. This error estimate is multiplied with Factor and the
result is a limit. If the residue is larger than this limit, the point
is flagged out. This rule is also adaptive because the vertical
error will change with the range and beam pointing angle.
Residue vertical avg. error rule: In each cell the avereage
vertical error is calculated, and the average vertical error for the
Cell Processing Unit is then calculated. Then a limit is
calculated from this average vertical error in the Cell Processing
Unit multiplied with Factor. If the residue is larger than this
limit, the point is flagged out. Note that it is the average vertical
error for the Cell Processing Unit that is used, not the cell’s
value.
Residue std. rule: The standard deviation of the residues is also
calculated. This is the standard deviation in the Cell Processing
Unit, not the cell. A limit is then set by multiplying Factor to
this standard deviation. Residues larger than this limit are
flagged out.
Grazing angle rule: For each depth the angle between the beam
and the bottom surface is calculated. Then the parameter Min.
angle can be set and all depths where the angle is less than this
limit are flagged out.

Parameters - Seabed Image Processing

To be defined.
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Javad and Trimble
Javad and Trimble are located on the Runtime parameters
display frame.

Parameters - Javad and Trimble setup
Use logged files directory: This parameter allows you to select
where the raw data files logged by Javad or Trimble should be
stored. To specify the directory, use the browse button […] to
find or make the relevant directory. When the directory has been
specified it can be set by using the ’Use logged files directory’
button whereby the Javad/Trimple system is informed.

Note Note that the Javad/Trimble directory initially has a default
setting (it is initially displayed in the text field and it is also
highlighted in the directory structure when the browse button is
pressed).

Logging on: This tick button is used to turn Javad or Trimble
logging on or off. Logging is on when ticked.
Height on: This tick button is used to turn fixed height on or
off. Fixed height is on when ticked.

Note The “Use logged files directory“ operation also transmits the
’Logging on’ status to Javad/Trimble. In the same way the
’Logging on’ operation transmits the directory information. The
“Height on“ works independently of the other two operations.

→ For more information on Javad and Trimbel, see page 458.
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Simulator (for EM 120, EM 300, EM 1002
and EM 3002)

Simulator is located under the Runtime parameters display
view.

Parameters - Simulation setup

Enable Simulation: Select this parameter to enable simulation
mode in the echo sounder.
Simulator min. depth (m): Set the minimum depth for
simulation.
Simulator max. depth (m): Set the maximum depth for
simulation.

Note The simulation generates range samples only. All other inputs to
the PU (Processing Rack in the Transceiver Unit) must be
supplied via the normal PU input ports. Most important is the
position data and roll, pitch and heave (i.e. attitude data).
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Step along (%): The change in depth between each ping given
in percent. The depth will vary within the set min/max range.

Figure 24 Step along
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Slant across (deg.): The tilt of the sea bottom across track in
degrees.

Figure 25 Slant across
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Parameters - Beam no. for Scope Display

Beam no.: Set beam number to be displayed in the Scope
Display.
Set beam number to zero (0) if you want to turn off this feature.
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Simulator (for EM 710)

Simulator is located under the Runtime parameters display
view.

Parameters - Simulation setup

Enable Simulation: Select this parameter to enable simulation
mode in the echo sounder.
Simulator min. depth (m): Set the minimum depth for
simulation.
Simulator max. depth (m): Set the maximum depth for
simulation.

Note The simulation generates range samples only. All other inputs to
the PU (Processing Rack in the Transceiver Unit) must be
supplied via the normal PU input ports. Most important is the
position data and roll, pitch and heave (i.e. attitude data).
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Step along (%): The change in depth between each ping given
in percent. The depth will vary within the set min/max range.

Figure 26 Step along
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Slant across (deg.): The tilt of the sea bottom across track in
degrees.

Figure 27 Slant across
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Parameters - Beam no. for Scope Display

Beam no.: Set beam number to be displayed in the Scope
Display.
Set beam number to zero (0) if you want to turn off this feature.
Swath no.: Set which swath to be displayed. This feature is
only available for an EM 710 configuration with a 0.5º transmit
and 1º receive transducer, as this system can generate two
separate alongtrack swaths per ping.
Set swath number to zero (0) if you want to display the foremost
swath.
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Simulator (for EM 3000)

Simulator is located under the Runtime parameters display
view.

Parameters - Simulation setup

Enable Simulation: Select this parameter to enable simulation
mode in the echo sounder.
Simulator depth (m): Set the simulated depth (used for the
simulation).

Note The simulation generates range samples only. All other inputs to
the PU (Processing Unit) must be supplied via the normal PU
input ports. Most important is the position data and roll, pitch
and heave (i.e. attitude data).

Note The (simulated) ping frequency will be reduced as the
processing capacity in the Sonar Head will be used to generate
depth data. Keep the depth small, the defalut value of 5 meters
is recommended.
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Singlebeam Runtime

The Singlebeam Runtime tab is found under Runtime
parameters display view for single beam echo sounders.

The RTDC (Real Time Data Cleaning), uses rules to process the
data. A rule is a set of parameters that controls the algorithms
used in the processing.

Note The RTDC module does not delete any depths, but flags that the
depths are invalid. The operator has full control of this
processing at all times.

• Rules set: The combo box lists all selectable rule sets. When
opening the Data Cleaning tab for the first time, only one
standard rule set is available. This is a rule set with default
parameter settings defined by Kongsberg Maritime.

• Save and use: To start using a rule set, select it from the
Rules set combo box. Any modifications to the selected rule
set is activated by pressing the Save and use button. Note
that it is not allowed to modify the standard rule set. Any
such modifications must be saved as a new rule set (see the
Save as and use button).

• Delete: Delete a rule set by selecting it from the Rules set
combo box, then press the Delete button. Note that the
standard rule set and the currently active rule set can not be
deleted.

• Cancel: Press this button to cancel any modifications made
to a rule set before saving.
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• Save as and use: If it is required to save modifications to an
existing rule set as a new rule set, type a name for this rule
set in the text box, then press the Save as and use button.

• Used set: This box displays the currently active rule set.
• Help: Press this button to open on-line help.
The RTDC module processes the data in real time using two
different kinds of processing, ping-based and grid-based
processing. Ping-based processing uses a buffer of the last pings
to process the current ping (also known as line-based
processing) while grid-based processing uses all the points from
all lines (current and all previous) to process the data in one grid
cell. Various parameters are set to control these processing
types.

Ping processing rules

→ Refer to page 262.

Grid processing rules

→ Refer to page 263.

Parameters - Ping processing rules

→ Refer to page 267.

Note that the Time rule and the Overhang rule are not used by
single beam echo sounders.

Parameters - Grid processing rules

→ Refer to page 270.
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4.21 Runtime parameters Mini
The Runtime param. Mini window is either accessed through
the Manage windows on the View drop-down menu or by
selecting it from the Frames button.

Upp/down buttons
The up/down buttons have two modes: single press or
continuous. By pressing and releasing the button once, the
associated parameter is incremented/decremented by one, as
expected. By pressing and holding the button, the associated
parameter will be continuously updated.
When the parameters are changed, the background is marked
using yellow colour. Press enter on the keyboard, or make a
selection in a combo box, to confirm and send the parameters to
the echo sounder (PU).

Note when using the buttons in continuous mode no range checking
will be made on the changed parameter values. The parameters
can therefore be set outside legal bounds. However, when the
button is released and the operator presses enter to confirm or
does a single press on the same button or starts editing another
parameter, an error message will pop up, if required.
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Mini and full Runtime parameters frame
synchronization
The mini window can be displayed together with the full
Runtime parameters window. If a change is made and confirmed
in one window the other window will be updated automatically,
keeping the windows synchronised.

Parameters

The parameters displayed in the mini window are from the
Sounder Main tab in the full Runtime parameters window.
→ Sounder Main on page 201.
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4.22 Calibration
The Calibration window is either accessed through the Manage
windows on the View drop-down menu or by selecting it from
the Frames button.
The Calibration window is intended for analysis of data from a
calibration survey. Depths from different survey lines may be
compared, and it is possible to apply different roll, pitch,
heading and time offsets to see the consequences on the
computed depth values. It can be used during online and offline
operations.
→ Calibration survey, page 49.

Remember that you have to activate the Calibration window
through the Geographical window before starting to use it. Press
the Show/Hide button for the Geographical frame and select
Calibration. A button with the letter C will turn up on the frame
toolbar. Press the C button to activate the Calibration window.
This window is valid for multibeam echo sounders only.

Calibration will only work with two or more selected lines in a
survey. These lines have to be selected in the survey display
before the Calibration window is opened.
To select lines, first ensure that the Stored Shipstracks is turned
on and that the C button on the Geographical toolbar is pressed.
If more than one Survey is loaded, select from the Survey List
box which survey to use. Hold in the Ctrl key and left click the
lines to select them.
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You must define a calibration corridor. Data from two or more
lines inside this corridor will be analyzed. To create a corridor
hold down the Control key and left click where you want the
corridor to start and release the button. Move the cursor to the
end of the corridor and hold down the Control key and left click
to mark the end of the corridor. Remenber to select lines before
you create a corridor.
When a corridor has been selected, the calibration module will
read in raw data and display the data in a diagram. The attitude
offsets in the selected files are shown, not the current ones in the
Installation parameters. Take care to check that the lines used
for calibration have been run with the same parameters as the
current ones in the Installation parameters.
The system will use data within the corridor, which represents
all points within a specified distance from a calibration line. The
data will be displayed using a two-dimensional diagram with the
horizontal axis representing the distance along the line, and
depth along the vertical axis. Data from two different survey
lines will be shown in the same diagram, each with its own
colour.
In the Calibration window you can change the relevant sensor
offset and see its effect on the depths shown. The offset value
that gives the best fit between the depths on the two calibration
lines is to be entered in the corresponding sensor field in the
system’s installation menu. The actual value should be a mean
of the values determined in several calibration corridors placed
at difference positions along the calibration lines.

To change an offset, enter a value in the appropriate field or
press the spin buttons, then press “Apply” to calculate and
display the data points.

To change the corridor width, enter a new value and press “Set”.
If you select a new corridor, the previously used offsets will be
applied and corrected data will be displayed in the diagram.
When you are satisfied with the calibration results, press the
“Store” button to save the new offsets in the database. You must
reapply the Installation parameters from the Installation
parameters window to use the new settings.
Calibration is designed for determination of sensor offsets. It is
NOT intended for determining the angular orientation of the
system transducers, these must be determined through
measurements as described in the installation manual. The
reason for this is that it is not possible to do a linear addition of
sensor offsets and transducer orientation angles.
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The only exception to this is if the transducers are oriented such
that they have zero heading and pitch installation angles, i.e.
that they lie horizontal when the pitch is zero and are mounted
parallel to the keel, in which case receive transducer roll
installation angle and sensor roll offset act as a linear sum. This
may be exploited in temporary installations where it may be
very difficult to measure roll installation angles with sufficient
accuracy.

Parameters

The following calibration parameters may be set:

• Depth Value to use: Choose between Depth, Tide Corr.
Depth, Depth ref. vref.

• Corridor width (m): Use the slidebar or the textfield to give
a new value. Press Set to activate.

• Roll MRU (deg): Use the slidebar or the textfield to give a
new value. Press Apply to activate.

• Pitch MRU (deg): Use the slidebar or the textfield to give a
new value. Press Apply to activate.

• Heading MRU (deg): Use the slidebar or the textfield to
give a new value. Press Apply to activate.

• Time (ms): Use the slidebar or the textfield to give a new
value. Press Apply to activate.

Note The Current offsets fields cannot be changed and are used to
display the offset values used when the data was logged.

Buttons

• Head 1 / Head 2 / Both heads: Select the sonar head(s) to
be calibrated.

• Set: Apply changes to the corridor width.

• Apply: Calculate and display the data points after setting
new offsets.

• Store: Save the new offsets in the database.

• Advanced...: This button is reserved for future use.

• Auto Calib: If licensed this button brings up the dialogue to
enter parameters to be used by SeaCal.

→ SeaCal, page 430.
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The following Auto Calib parameters
can be entered:

- Roll
- Pitch
- Heading
- X0 (translation alongships)
- Y0 (translation athwartships)
- Roll Scale
- Y-Scale
- Relative tide
- Beam sector
- Maximum sea depth

For each parameter to be used, the
corresponding On/Off button must be
checked.

Resolution: The resolution of the grid model applied in the
calculation affects the computing time. The “Auto” option asks
SeaCal to compute the resolution, but you can also define the
resolution manually.

Max Iterations: Usually, SeaCal needs two or more iterations
to compute the calibration. You can define the maximum
number of iterations manually, or you select “Auto”, i.e., SeaCal
iterates until the solution is stable.
Type of computation: It is also possible to select calibration
with or without a reliability test. It is recommended to run this
test, as it gives a comprehensive control of the calibration.

Toolbar button

The toolbar holds the following button:
• Show/hide
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Show / Hide button

Show grid: Show or hide the grid.
Show legend: Show or hide the
legend.
White background: Make the
background white.
Depth Scaling mode: Options for
controlling the scaling mode for
the depth axis.
• Auto - Automatically adjust the

start and stop ranges to show
the entire range of data each
time data is received.

• Fixed - Use the start and stop
ranges entered in the min and
max text boxes.
- Min (m): “Fixed” start (min)

range in meters.
- Max (m): “Fixed” stop

(max) range in meters.

Quick menu

The Calibration window have a quick menu accessed by
clicking on the right mouse button inside the view.
• Select shiptracks - First select two lines using Ctrl + Left

mouse button.
• Create corridor - Then create a corridor using Ctrl + Left

mouse button.
The system will now calculate and display the two lines from
raw data. For a dual system one head at a time must be
calibrated.
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5 MENU SYSTEM

5.1 Introduction
The menu system of the SIS program is designed the same way
as most Windowst compatible software. The main menu on the
top of the application window provides access to a number of
drop-down menus.
Parameters are accessed through different parameter sheets and
tab areas.
→ Main menu, page 288
→ Toolbars, page 339
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5.2 Main menu
The main menu is located on the top. It provides the following
choices:
→ File menu, page 289
→ View menu, page 303
→ Tools menu, page 309
→ Help menu, page 328
→ Geographical menu, page 333 (for Geographical window only)
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5.3 File drop-down menu
The File drop-down menu gives you the following choices:
→ Import/Export..., page 290.
→ Save Settings, page 296.
→ Save Settings As..., page 297.
→ Delete Setting, page 298.
→ Print Setup..., page 299.
→ Save PU parameters, page 300.
→ Import PU parameters, page 301.
→ Quit, page 302.
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Import/Export...
The Import/Export... is accessed from the File drop-down
menu.

The following options are available in the Import/Export
dialogue:
• Datatypes: The following datatypes can be imported:

- 3D Models: The user can import AutoCAD (*.dxf),
Inventor (*.iv) or VRML (*.wrl).

- Surveys: The user can import either raw data files or
already gridded data.

Note It is possible to reprocess data based on user defined rules if
importing raw data files.

- KSGPL: The user can import background KSGPL files
(*.bgksgpl).

- Background Images: Imports background images.
• Import...: Press this button to import data (more details

below).
• Raw Data Files: Check this box to import raw data files.
• Export Selected: Press this button to export data (more

details below).
• Remove Selected: Loaded or ’set to be loaded’ data can be

unloaded by selecting the listed data items to the right and
clicking this button.
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Note No files will be deleted on disk even if e.g. a survey has been
reprocessed.

Note KSGPL background data can not be unloaded!

• Undo All: Undo actions.

Note No files will be deleted on disk even if e.g. a survey has been
reprocessed.

• Delete Processing Data: A gridded survey consist of many
different file types. One of these are called Processing Files
and are used internally when crating a new grid or adding to
an existing one. These files may use a lot of memory and
hard-disk space, but are generally not needed if the survey is
“closed” and used for visualisation only. Thus the Processing
Data can be deleted. This is done by selecting the loaded
surveys to be handled and pressing the “Delete Processing
Data” button.

• Background Images: Background images can be imported
by selecting the “Background Images” radio button and
pressing the “Import” button. This will launch a dialog box
where you can import a GeoTIFF file. This is an ordinary
TIFF image file with the goreference information in the TIFF
file header, and will be shown on the screen.

Note A background image can only be imported when a suvey is
loaded.

Note The Delete Processing Data and the Background Images will
only be enabled if at least one of the given surveys is linked to
Processing Data.

Press Ok to apply.
Press Cancel to abort.

Import of the different datatypes

Pressing the Import... button will launch the corresponding
import dialogue box.
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• 3D Models: Browse for the wanted 3D model file(s). Please
wait some time to allow the 3D model to be processed. This
may take a while dependent on the size of the file. The
imported 3D model(s) will be listed to the right if
successfully processed/loaded.

• Surveys (already gridded): Browse for the directory where
the already gridded survey is located.

Note The grid may fail to be loaded if the GridEngine is not up
running or if a valid license is not present.

Press Ok to apply.
Press Cancel to abort.
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• Surveys (Raw Data files): Raw data files can be
reprocessed/gridded with different settings.

- Import Raw Data Files field

* Survey name: Name of the
survey to be gridded.

* Comment: Write your own
comment for the survey in
the text field.

* Survey path: Browse for a
directory with raw data files
to be processed. These files
will be listed in the list box
further down. Raw data files
can also be added one by one
by pressing the Add raw
data files button.

* Tide File: Browse for tide
file to be used, if any.

* Geoid File: Browse for
geoid file to be used, if any.

* Grid Folder: Browse for
single raw data files to be
processed. Raw data files can
also be added by pressing the
Survey path button.

* User: Select a user from the
combo box. To add new
user(s), you must use the
User handling.
→ User handling, page 147.

* Projection: Select a
projection from the
drop-down combo box. If a
projection already has been
set in the New survey display
view, this field is greyed out.
→ New survey, page 134.

- GridEngine Parameters field

* Depth variable: Which depth value to be processed.

* Number of cells: Number of cells in one sub grid used
by the GridEngine. The numbers of cells must be a
power of 2 and between 16 and 512.
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* Cell size (cm): Size of each cell in the lowest (the most
detailed) level of detail. Min = 10 cm, max = 50,000
cm.

* Processing parameters: See the Data Cleaning
chapter.
→ Data Cleaning, page 261.

Press Ok to apply.
Press Cancel to abort.

• KSGPL: Browse for the wanted KSGPL background file.

Note One KSGPL file may override any other currently loaded
KSGPL data.
KSGPL background data can not be unloaded!

Export of the selected data files
First select the survey data to be exported. Then pressing the
Export... button will launch the Export Survey dialogue box.

Survey name: Name of the survey to be exported.
Raw Data Location: Browse for the disk location where the
raws data files (.all files) are stored for the current survey. This
is only needed for export of a Neptune Rule file.
Output Type field: Select output type of the data to be exported
to file. The options are:
• Little Endian: Binary PC format file. See the Export formats

chapter.
→ Export formats, page 380.
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• Big Endian: Binary Unix format file. See the Export formats
chapter.

→ Export formats, page 380.

• ASCII: Format details are written into the file itself.

• Neptune Rule: Create a rule file to be imported into Neptune
post-processing. This setting overrides the Point Set and
Variable settings.

• DAF Geo. coord: Creates a ASCII file with geographical
coordinates in DAF format.

• DAF Contours: Creates at an ASCII file with contour lines
in DAF format.

Note When exptorting DAF formats the only available Point Set
choices are Min, Max or Median.

Point Set field: Select if all, valid or invalid points will be
exported.

Variable field: Select which Depth value will be exported. See
the Depth settings in the Geographical window and the Geoid
chapter.
→ Geographical, page 67.
→ Geoid, page 409.

Press Ok to apply.

Press Cancel to abort.

DAF Export

When exporting either of the DAF format, three additional Point
Set variables are enabled. Select one of these to create the file.
Also one can select which LOD to read data from.

When selecting DAF Contours, you must select how to create
the contours. Select from the depth list or edit or create a new
set.

For instance, one can select to create contours at 1, 5,10 and 15
meters, every 2 meters, every 5 meters and so on. The
predefined sets can be altered or new ones can be added by
editing the right-most Depth List field and pressing New or
Save. Pressing Delete removes the selected set.

DAF contours can be displayed in Neptune and other
applications that supports the DAF format.
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Save Settings
The Save Settings is accessed from the File drop-down menu. It
will automatically save the current survey settings.
If the current survey settings cannot be saved under the chosen
name, you are prompted to use the Save settings as... option.
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Save Settings As...
The Save Settings As... is accessed from the File drop-down
menu.

You can choose to save different survey setting combinations
by giving them different names.
Press Accept to add the new survey setting.
Press Cancel to abort.
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Delete Setting
The Delete Settings is accessed from the File drop-down menu.
This is used to delete one of your predefined survey setting
combinations.
Setting Name: Select the survey setting to be deleted.

Press Accept to delete the selected survey setting.
Press Cancel to abort.
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Print Setup...
The Print Setup... dialogue box is accessed from the File menu.

A standard print dialogue is opened. The following options are
available:
Print Destination: Select if you want to send sounder data to
printer or directly to file. Files are saved in postscript format
(*.ps).
Pages: Select which pages to print.
Colors: Select printing in colours or black and white.
Copies: Select the number of copies to print.
Collate Order: Select which page to print first.
Layout: Select page orientation.
Paper Size: Select paper size.

Note Only postscript printers or plotters can be used.
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Save PU parameters
The Save PU parameters operation is accessed from the File
drop-down menu.
It is used to save the Installation and Runtime parameters for the
current echo sounder to file in an ASCII readable format.
The file may later be imported whereby the saved settings are
restored.
The file name and storage location can be specified in the
pop-up window displayed when Save PU parameters is
selected. A default storage location for such files is defined by
SIS, but the operator is free to choose another location.

Note The operator is encouraged to save the parameters for an echo
sounder as soon as the initial configuration (i.e. installation and
runtime parameters) has been completed and stored in the
database.

Note The saved parameters file can be edited. However, this is not
recommended and should only be performed by users with
intimate knowledge of SIS.

Related topics

→ Current echosounder on page 345.
→ Import PU parameters on page 301.
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Import PU parameters
The Import PU parameters operation is accessed from the File
drop-down menu.
It is used to read a previously saved parameters file for a
specific echo sounder and restore the parameter settings for this
echo sounder to the same status as when the file was saved.
The import operation can be performed without consideration of
which echo sounder is currently set as active or whether the
relevant echo sounder is started or even detected on the network.

Note The echo sounder will not be automatically updated with
imported settings. Only the database (SISDB) will be updated.
It is therefore necessary to manually initiate an update of the
echo sounder (PU) by starting it (if not previously started) or by
using the Installation Parameters - or the Runtime parameters
frame.

The file name and storage location of the required file can be
specified in the pop-up window displayed when Import PU
parameters is selected.
The Import PU parameters operation is typically used to avoid
having to enter all set-up parameters manually after reinstalling
SIS and the database.

Related topics

→ Current echosounder on page 345.
→ Save PU parameters on page 300.
→ Installation parameters on page 160.
→ Runtime parameters on page 200.
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Quit
Quit is accessed from the File drop-down menu.
This will shut down the SIS program without any further
confirmation of your choice.
The SIS program can also be shut down by using the Close
button on the right hand side of the SIS title and info bar (i.e.
upper right corner of the SIS application window).

Note Closing down may take some seconds. Do not try to restart SIS
until the SIS application window has disappeared.
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5.4 View drop-down menu
The View drop-down menu gives you the following choices:
→ Manage Windows, page 304.
→ Icons, page 305.
→ C-MAP Scale Level, page 306.
→ Color Palette, page 307.
→ Status bar, page 308.
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Manage Windows
Manage Windows is accessed from the View drop-down menu.
There are seven frames in the application. If you have to change
the content of more than one frame, it can be adviseable to use
this procedure instead of using the Frame button.
Also, if you select a window that is already in use, you have to
use Manage windows to apply new content to the frame.

Choose the content of the frame(s) by selecting from
the combo-boxes.
Remember to save your new settings. This is done
with the Save settings or the Save settings as from
the File drop-down menu.

The frames are designated from #1 to #7 as displayed below.
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Icons
Icons is accessed from the View drop-down menu.

Choose between:
• Small Icons: This will make all the frame toolbar buttons

smaller.
• Large Icons: This will make all the frame toolbar buttons

larger.
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C-MAP detail level
The C-MAP detail level is accessed from the View menu.

Choose between the following display levels:
• Basic
• Standard
• Full
Related topics

→ C-MAP, page 437.
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Color palette
The Color palette is accessed from the View menu.
Choose between the following color palettes:
• Day: Bright day.
• Day Blackback: Day with black background.
• Day Whiteback: Day with white background.
• Dusk: Dusk.
• Night: Night.
Each of these palettes use a color scheme of 64 colours with
different RGB value for each palette. If used together with
“Palette Controller” all Windows colors will be set as well. To
set all colors, Windows Choice style must be used in Display
Properties - Appearance.
Running on Windows XP. If used together with
PaletteController, selecting a palette will also change the color
change the color of all other application and Windows
components. To change all Windows components, like the Title
bars and the Start bar, “Windows Classic” style must be selected
in “Display Properties - Appearance”
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Status bar
The Status bar is accessed from the View menu.
This lists four of the most useful transducer parameters. By
ticking the check box for each parameter, the current parameter
value will be constantly displayed on the Status bar.

The following parameters can be displayed:
• Mode
• Depth
• Swath width
• Sound speed
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5.5 Tools drop-down menu
The Tools drop-down menu gives you the following choices:
→ External sensors, page 310.
→ Instrument combinations, page 315.
→ Remove Equipment, page 316.
→ SeaCal Results, page 317.
→ Custom..., page 318.
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External sensors
External sensors can be accessed from the Tools drop-down
menu.
This is where you add the external sensors. These are sensors
attached directly to the HWS10 computer or sensors sending
their data on Ethernet to the HWS10 computer.

Note You have to add the external sensors before you adjust the
installation parameters.
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Sonar Head

External sensors

SIS software
(Heading and

position)

The echo sounders may use 
the same position 

and heading sensor

Sonar Head

Processing Unit, 
Single beam 
echo sounder #1

Processing Unit, 
Single beam 
echo sounder #2

Object registration

Sound velocity probe

(C
D

22
00

0C
)

Real time tide (serial line or UDP port)

Autopilot

Dyn Pos

Depth below keel

Sound Velocity Probe parameters
To prepare and use an external sound velocity sensor the
following steps should be followed:
1 Make sure that the external sensor is powered up and

connected to an HWS 10 input port (i.e. COM port).
Alternatively, in the case where SIS should receive
external sound velocity datagrams via UDP the datagrams
must be available on the network.

2 Next, select the type of sensor or input to use as source
for the sound velocity samples:
a Tick the ’Probe available’ box to signify that a sound

velocity sensor or external sound velocity datagrams
should be used.

b The ’Probe type’ combo box is now enabled. Select the
specific type of sound velocity probe to be used. The
following choices are available:
- SV (C) - only sound velocity
- SV&T (C+T) - sound velocity and temperature
- SV&P (C+P) - sound velocity and pressure

(pressure not significant)
- Ext. datagrams (C+T) - sound velocity and

temperature
c If one of the three sensors is selected (i.e. ’Ext.

datagrams’ not selected) the port where this sensor is
connected must be set in the ’Port’ combo box.
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Note If ’Ext. datagrams’ is selected the port combo box is disabled as
UDP is used.
There is no need to set communication settings for the selected
input COM ports. (Auto detect or fixed 9600 baud is assumed).

3 The final step is to configure the ’Sound speed’
parameters in the Runtime settings.
See ’Sound Speed’ in the ’Runtime parameters’ setup for
the individual echo sounders for more information.

External datagram format
The format of the external UDP datagram used with the’ Ext.
datagrams (C+T)’ sensor selection is as follows:
$KSSIS,80,c.c,t.t,\n\r
where
• $KSSIS specifies that this is a Kongsberg proprietary

datagram format
• 80 is the datagram number indicates that this is an external

sound speed sample.
• c.c is the sound speed at transducer represented as an ASCII

text string e.g. 1460.95
• t.t is the temperature at transducer represented as an ASCII

text string e.g. 19.25
• \n\r is the closing sequence (linefeed, carriage return)
This datagram should be sent to port 4001 on the HWS10 PC.
Sound speed sample frequency rate
The sample rate expected from the sound velocity sensors (SV,
SV&T, SV&P) is 10 Hz. The sample rate of the external
datagrams is 1 Hz.
These rates are used in the sound speed filtering. For more
details on filtering see the ’Sound Speed’ entry in the ’Runtime
parameters’ setup.
Real time tide

SIS can receive real time tide information of serial line. Select
Realtime Tide available and set the communication parameters
for the selectee line.
Heading and Position parameters

Write a name in the Sensor name combo box. The name given
here will be the one that comes up in the installation parameters
for GPS and single beam echo sounders.
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Choose either serial line or ethernet connection. Press Add for
each sensor.

- If you choose a serial port, mark the check box under
“Serial” and select the port you want to use for heading
and/or position by selecting it from the combo boxes
under “Port”. The communication parameter is set with
the respectively combo box.

- If you want to use an Ethernet connection, mark the check
box under “Ethernet”. The IP address and the port data is
to be send to is displayed in the text field to the right.

- If serial line communication is chosen a small program
starts automatically when the equipment is started. It will
place a small icon on the toolbar. This program receives
data on RS-232 and forwards the data on UDP. The
program will close down automatically.

Compass deviation file: Use the browse button (three dots) to
find the desired file.
Position delay (sec): Enter the desired position delay.
The accuracy of the position sensor is vital for the data
accuracy, and it is therefore important that the relative timing of
vessel position data and system depth data is correct. To define
the duration of life of the positioning system input data, you can
enter a position delay.
Locations (m): Use the text fields to enter the location. These
settings are used to define the physical location of the selected
positioning system’s antenna. The downward positions are
required if RTK is to be used to position the bottom with respect
to a datum vertically.

Note Note: The downward position will also be used if the positions
are to be corrected for vessel attitude. This requires that the
actual physical antenna position is entered and that the given
position is at the antenna.

The position data you define here may however not necessarily
always be the physical location of the antenna. This is because
settings in the positioning system’s own software can redefine
the location of the antenna. The xy-values of the soundings are
referred to the location of the active positioning system, and it is
this “virtual” position that you must enter.

Auto Pilot parameters

Select Auto Pilot available if you want data to be sent to the
auto pilot and choose a serial line from the combo box.
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Enabling or disabling of NMEA APB output is done in the
Show/Hide menu in the Helmsman display.
→ See page 96.

Dyn Pos parameters
Select Dyn. Pos. available if you want data to be sent to the
dynamic positioning system and choose a serial line from the
combo box.
Depth below keel
The Centre depth output is always sent as a NMEA DPT
datagram on UDP to port number 4310. The NMEA depth
output from SIS is coded. The two aa’s in the string $aaDPT are
set according to sounder type, see table below.

Echo Sounder Model NMEA String

EM 2000 $DADPT

EM 3000 $DBDPT

EM 3002 $DCDPT

EM 1002 $DDDPT

EM 710 $DEDPT

EM 300 $DFDPT

EM 120 $DGDPT

If depth below keel is selected in the External sensor user
interface the NMEAdatagram is sent out to the selected serial
line.

Other parameters
Port: Choose the port you want to use.
Baud rate: Choose the desired baud rate.
Data bits: 7 or 8.
Stop bits: 1 or 2.
Parity: None, Odd or Even.
Waterline: Use the text field to enter the vessel’s waterline
vertical location (in normal trim) in the vessel’s reference
coordinate system. The value should be an average of two
measurements; one on each side of the vessel. The measurement
must be made at the same alongship location as the physical
location of the motion sensor.

Note If the vessel’s deplacement or trim changes during a survey, this
value must be updated accordingly.
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Instrument combinations

Instrument combinations can be accessed from the Tools
drop-down menu.

This is where you add instruments and give them an
identification. The instruments you add are equipment that does
not have a PU (Processing Unit/Rack) and does not broadcast on
the Ethernet.

The user gives the instrument an ID number. This number must
be unique for each type of equipment. This ID number is treated
the same way as the serial number for equipment with a PU
(Processing Unit).

After the instruments are registered here they appear in the Not
Started combo box and the Current echo sounder combo box
on the main toolbar.

If you want to remove any of the equipment, use the Remove
equipment.

→ Refer to page 316.

Add equipment parameters

GPS + Compass: Give the new equipment a name and an ID
number.

SBES + GPS + Compass: Give the new equipment a name and
an ID number.

Existing equipment: A list of the equipment that already exists.
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Remove Instruments
The Remove Instruments is accessed from the Tools
drop-down menu.
Select the equipment you want to remove, and press OK.
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SeaCal Results
The SeaCal Results is accessed from the Tools drop-down
menu.
Use this option to browse for and open SeaCal result files
(*.res).
→ SeaCal, page 430.



Seafloor Information System / Base version

318 850-164709 / E

Custom...
The Custom... sub-menu is accessed from the View menu. This
menu is used to access various applications. It is also possible to
manage or add new applications.

Choose between the following options:
• SVP Editor
→ Refer to page 442.

• Set parameters
→ Refer to page 371.

• Datagram distribution
→ Refer to page 415.

• Projection setup
→ Refer to page 319.

• Create grid from ascii files
→ Refer to page 378.

• Licence information
- The log file to the license server, running on the local

computer, is opened in a text editor.
• Configure...
→ Refer to page 326.
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Create new projection

When creating a new projection, the Projections window opens.
This window contains two tabs:

• The Define projections tab is where you define the
projection.

• The Test selected projection tab allow you to test the
selected projection.

“Select file from disk” opens a file selection box where the user
selects the file in PROJ.4 format where projections are stored.

“Select projection in file” is then used to select the projection in
the selected file. The name of the selected projection appears
below.

A projection from the file can be put into the database by
pressing “Put projection into database”. The database tables are
updated. It is not possible to change a projection if it is used by
any surveys unless the user specifies it.

You can also select a projection from the database. It is not
allowed to change a projection used by a survey unless the user
specifies it.

The command line switch -n turns off file selection. The
database connection is automatically removed it the database is
not present.

You can create a new projection, edit a projection and delete a
projection from this tab.
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OK: Press this button to exit the application.

Help: Press this button to open online help.

The “Test selected projection” allow you to test the selected
projection. You can choose the format of the geographical
coordinates to decimal degrees, decimal minutes or decimal
seconds. You can then input geographical coordinates and press
“Calculate” in that window to see the projection coordinates in
the window below, or vice versa.

When you select a projection from the projection file, the Select
projection dialogue opens. Here you can see all the names of the
projections in the file.
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When your press “New...” in the Define projections tab, the
New projections dialogue opens. Here you must give the new
projection a unique name and select the projection type: UTM,
UPS, Mercator, transverse Mercator, user defined or PROJ.4.
Press “OK” to open the Datum information dialogue.

The Datum information dialogue is used to define the datum
transformation and the ellipsoid of the projection. The datum
transformation may be active or not (default is off). You MUST
choose an ellipsoid for the projection by pressing the button
“Choose ellipsoid” in the window named “Ellipsoid”. You can
also define a 7-parameter datum transformation. First choose the
ellipsoid to convert from by pressing “Choose ellipsoid”. Then
define the rotation units, decimal degrees or decimal radians.
Then define the transformation.
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When you choose an ellipsoid, the
Choose ellipsoid dialogue is
opened. Each ellipsoid has a
unique identifier, a name and the
parameters a (major axis) and rf
(reverse flattening). If there are
comments attached to an ellipsoid,
they are shown in this window.

The following ellipsoids can be selected:

MERIT a=6378137.0 rf=298.257 MERIT 1983

SGS85 a=6378136.0 rf=298.257 Soviet Geodetic Sys-
tem 85

GRS80 a=6378137.0 rf=298.257222101 GRS 1980(IUGG,
1980)

IAU76 a=6378140.0 rf=298.257 IAU 1976

airy a=6377563.396 b=6356256.910 Airy 1830

APL4.9 a=6378137.0 rf=298.25 Appl. Physics. 1965

NWL9D a=6378145.0 rf=298.25 Naval Weapons Lab.,
1965

mod_airy a=6377340.189 b=6356034.446 Modified Airy

andrae a=6377104.43 rf=300.0 Andrae 1876 (Den.,
Iclnd.)

aust_SA a=6378160.0 rf=298.25 Australian Natl & S.
Amer. 1969

GRS67 a=6378160.0 rf=298.2471674270 GRS 67(IUGG 1967)

bessel a=6377397.155 rf=299.1528128 Bessel 1841
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bess_nam a=6377483.865 rf=299.1528128 Bessel 1841
(Namibia)

clrk66 a=6378206.4 b=6356583.8 Clarke 1866

clrk80 a=6378249.145 rf=293.4663 Clarke 1880 mod.

CPM a=6375738.7 rf=334.29 Comm. des Poids et
Mesures 1799

delmbr a=6376428 rf=311.5 Delambre 1810 (Bel-
gium)

engelis a=6378136.05 rf=298.2566 Engelis 1985

evrst30 a=6377276.345 rf=300.8017 Everest 1830

evrst48 a=6377304.063 rf=300.8017 Everest 1948

evrst56 a=6377301.243 rf=300.8017 Everest 1956

evrst69 a=6377295.664 rf=300.8017 Everest 1969

evrstSS a=6377298.556 rf=300.8017 Everest (Sabah &
Sarawak)

fschr60 a=6378166 rf=298.3 Fischer (Mercury
Datum) 1960

fschr60m a=6378155 rf=298.3 Modified Fischer
1960

fschr68 a=6378150 rf=298.3 Fischer 1968

helmert a=6378200 rf=298.3 Helmert 1906

hough a=6378270.0 rf=297 Hough

intl a=6378388.0 rf=297 International 1909
(Hayford)

krass a=6378245.0 rf=298.3 Krassovsky, 1942

kaula a=6378163 rf=298.24 Kaula 1961

lerch a=6378139 rf=298.257 Lerch 1979

mprts a=6397300 rf=191 Maupertius 1738

new_intl a=6378157.5 b=6356772.2 New International
1967

plessis a=6376523 b=6355863 Plessis 1817 (France)

SEasia a=6378155.0 b=6356773.3205 Southeast Asia

walbeck a=6376896.0 b=6355834.8467 Walbeck

WGS60 a=6378165.0 rf=298.3 WGS60

WGS66 a=6378145.0 rf=298.25 WGS66

WGS72 a=6378135.0 rf=298.26 WGS72

WGS84 a=6378137.0 rf=298.257223563 WGS84
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When defining the rest of the projection, you are presented with
a different dialogue depending on what type of projection you
have chosen.

The dialogues below show the UTM and the UPS projection
setup. If UTM projection is chosen, select UTM-zone and if it is
on the northern or southern hemisphere. If UPS projection is
chosen, select if it is on the north or south pole.

The dialogues below are used to define Mercator/transverse
Mercator projections respectively.

A user’s own projection may be found in the static and dynamic
libraries. These projections are identified by a unique number
known to the user. You can choose this number in the User’s
projection dialogue. If this number is not implemented, the
program will exit because an invalid projection is regarded a
very severe error and then nothing works.
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You may also input a projection PROJ.4-style directly in the
PROJ.4 setup dialogue. This must be entered like this:
+init=my_file_with_proj4_projections:my_projection

You can also enter the input like this:
+init=\mydir\somefile.txt:my_projection

This will fail::
+init=c:\mydir\myfile.txt:my_projection

because the first : is not allowed. This means that your
projection file MUST be on the same disk.
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Configure...
The Configure... item is accessed from the Custom sub-menu.
The Configure dialogue box is used to manage existing
applications. It is possible to hide or delete applications, or
change the sequence in which they appear in the Custom
sub-menu. Note that it is not possible to delete any of the
factory defined applications.

A new application is added by pressing the ’Add’ button in the
dialogue box. Fill in all text fields marked in yellow.
Press the ’Apply’ button to add the new application to the
Custom sub-menu.
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Program arguments can be added, i.e. a text file if the
application is a text editor.
Click the ’Hide application’ box to hide a console application
when starting SIS. The application will then only be visible in
the Task Manager.

Press the ’OK’ button to store changes.
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5.6 Help drop-down men
The Help drop-down menu gives you the following choices:
→ Help, page 329.
→ Build Info, page 330.
→ OpenGL Settings, page 331.
→ About SIS..., page 332.
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Help
Help is accessed from the Help drop-down menu.
It will open the online-help system.
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Build Info
The Build Info messsage box is accessed from the Help
drop-down menu.
It contains information about the current SIS software build.
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OpenGL Settings
The OpenGL Settings messsage box is accessed from the Help
drop-down menu.
It provides the following information about the OpenGL
settings:
• Driver information
• Display mode
• Available extensions
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About SIS...
The About SIS messsage box is accessed from the Help
drop-down menu.
It contains limited information about the SIS software.

This message box can also be accessed by pressing the SIS icon
far right on the status bar.
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5.7 Geographical drop-down menu
The Geographical drop-down menu gives you the following
choices:
→ Light Source, page
→ Grid Drawstyle, page 335.
→ Grid Shading, page 336.
→ Level Of Detail, page 337.

This menu is only valid for the Geographical frame.
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Light Source
The light source can be moved around in a horizontal plane
above the underlying data. Choose between Dynamic, Lower
Left Corner, Lower Right Corner, Upper Left Corner or Upper
Right Corner:
• Dynamic: You can manually move the light source around

using the pointing device (usually a mouse).
• Lower Left Corner: Position the light source at the lower left

corner of the grid.
• Lower Right Corner: Position the light source at the lower

right corner of the grid.
• Upper Left Corner: Position the light source at the upper left

corner of the grid.
• Upper right corner: Position the light source at the upper

right corner of the gird.
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Grid Drawstyle
The Grid Drawstyle is accessed from the Geographical menu.

Choose between the following styles:
• Points: Each point is displayed as a single point in the

Geographical display.
• Triangle: The points are displayed as triangles.
• Filled: The points are displayed as a continuous surface.
• Text: The depth values are displayed as text.
• Text Overlay: The depth values are displayed as text

overlaid the continuous surface.
SIS organizes the data in grids. Each grid cell contains all depth
points from the area defined by this grid cell. The minimum,
maximum and median depths inside each grid cell will be used
to draw the terrain. The exact locations of these depths are kept
in each grid cell.
When the grid is drawn, a triangle is created from three
neighbouring grid cells. Each point in the triangle will then
come from the correct geographical location of the selected
depth (minimum, maximum or median). The triangle model will
thus be irregular to fit to the terrain as good as possible.
The operator can then choose to display the triangles either as
points (without lines or filling), as lines (lines between the depth
points without filling) or as filled triangles.
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Grid Shading
The Grid Shading is accessed from the GeoView menu.

This gives options for setting the shade model used for
displaying the data.
Choose between the following shadings:
• Flat: Each cell has a distinct colour.
• Smooth: Colours are smoothly interpolated between cells.
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Level Of Detail
The Level Of Detail is accessed from the GeoView menu.

Data may be displayed in the Geographical window with
various levels of details, based on the current map scale selected
by the operator.
The gridding system use two types of grids:
• Processing grid
• Display grid
The processing grid is used for processing depth data and the
display grid is used for displaying data. Data is transferred from
the processing grid to the display grid and from the display grid
with a lower level of detail to the display grid with a higher
level of detail.
The number of levels of details depends of the number of cells
in the processing grid. A processing grid with 64x64 cells will
have 6 levels of detail, in other words log2(64).
The organization of process grids and display grids may look
shown in the figure below.

Figure 28 Orgaization of process grids and display grids (example)

Processing grid Display grid
level 0

Display grid
level 1

Display grid
level 2

(CD 6898)

When looking at a small area it can be convenient to select
LOD0, as all processed data then will be displayed. In a larger
scale a higher LOD should be used.
Choose between the following levels:
• LOD 0
• LOD 1
• LOD 2
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• LOD 3
• LOD 4
• LOD 5
• LOD auto
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5.8 Toolbars
SIS has two types of toolbars. The Main toolbar is common for
all frames. Each frame also has its own individual toolbar.
→ Main toolbar, page 340
→ Frame toolbars, page 343
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Main toolbar
The Main toolbar is located right under the Main menu. It
contains several buttons and combo boxes.

Figure 29 Main toolbar

(CD22007)

Settings

Echo sounders - 
not started

Active
survey

Current
echo sounder

Status
lamps

LoggingRescan

Water
column

Pinging Line counter

Current
survey

Settings: You can select different display settings from this
combo box. Choose between standard settings or create your
own by selecting Save Settings As... in the File menu.

Active survey: Select the active survey. All surveys are listed,
both the surveys you log on and the ones imported. You can
only calibrate the active survey.

Rescan: If for some reason contact with the echo sounder is
lost, it is not necessary to shut down and restart SIS. Press the
Rescan button, and the program will scan for available echo
sounders.

Echo sounders - not started: This combo box displays all the
echo sounders SIS has detected on the network at start-up time.
All multibeam echo sounders announce themselves on the
network when they are active, and then SIS can detect them
automatically. Select the echo sounder you want to start from
this list.

→ More information on page 344.

Current echo sounder: This combo box displays which echo
sounder is currently being operated. The operator must choose
one at the time when setting the installation and runtime
parameters for the echo sounder. Select the echo sounder you
want to change parameters for from this list.

→ More information on page 345.

Logging: Press this button to start and stop logging. Start
logging to write data to disk. The colour of the button is green
while logging and red when logging is off.
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If pinging is off when logging is turned on, pinging will
automatically be turned on.
If logging is on and pinging is turned off, logging will
automatically be turned off.

WCol: The WCol button shows if logging of Water column data
is on or off. This button can not be clicked, but only shows the
logging status. The On/Off control is located on the Water
column frame’s show/hide menu.
This button is always displayed, but is only active for echo
sounders with water column capabilities (for example EM 710
and EM 3002).

Pinging: Press this button to start and stop pinging. Start
pinging to activate the echo sounder (i.e. sending sound into the
water). The colour of the button is green while pinging and red
when pinging is off.

Line counter: The text field displays the line count for the
currently selected echo sounder. The line count is cyclic
between 1 and 9999. It is possible to enter a line number
manually.
If logging is off the line count is for the next line started. If
logging is on the count is for the current line.
The button is used to create a new line without stopping the
logging and then starting it again. The line count is incremented
by one when button is pressed.
→ More information on page 346.

Current survey: This combo box displays the current survey
name. The operator can select all surveys for the current echo
sounder from this combo box. When selecting another survey,
SIS will change to that survey and start logging to that survey
when this is enabled.
This combo box is disabled when SIS is logging.

Status lamps: These lamps are for multibeam echo sounders
only.
• Lamp 1: PU/TRU status (Processing Unit/Transceiver Unit)
• Lamp 2: BSP status (Beamforming and Signal Processing)
• Lamp 3: SH status (Sonar Head)
While logging, the lamps will be frequently updated.
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Green Orange Red Grey

OK Warning Error Connected hard-
ware is not in use
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Frame toolbars
All frames have their own toolbar. On this toolbar there can be
several buttons or just the Frames button. The most frequent
buttons are described below:

Frames: Press this button to select the content you want in that
specific window frame.

Show/hide: Press this button to open the Show / hide dialogue
box.

Annotation colours: Press this button to open the Annotation
colours dialogue box.

Dynamic colours: Press this button to open the Dynamic
colours dialogue box. The dialogue box will only be launched if
at least one or more surveys are loaded.
Several frames hold special buttons. These are described in the
Frame contents chapter for the frames in question.
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Echo sounder - not started list
The “not started” list will be displayed in a combo box found on
the right hand side of the toolbar.
The list contains all non-started echo sounders detected by SIS
on the network.
The list is linked to the autostart mechanism.
→ The autostart mechanism is explained on page 25.

The combo box will only be displayed in two instances:
1 When echo sounders are detected by the system for the

first time.
2 When the detected echo sounders differs from the set of

echo sounders started in the previous SIS session. That is,
if echo sounders have been added or removed from the
network.

I any other circumstance the autostart mechanism will start the
echo sounders automatically and the combo box will not be
visible.
When you select an echo sounder from the list, you start the
echo sounder and it will disappear from the list.

Note If for any reason an echo sounder fails during start (BIST,
Built-In Self Test, 99 failure) the echo sounder will remain in the
list and the combo box will still be visible. The reason for this is
to allow the operator to correct the problem and try a rescan.

If the licencing allows for only one started echo sounder, the
combo box will be removed as soon as the start has been
performed with a positive result.

If the licencing allows for several started echo sounders, the
combo box will be removed only when the list is empty, i.e.
when all echo sounders has been started.
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Current echosounder (or other
instruments)
The combo box is found on the right hand side of the toolbar.
It gives you a list of the all the echo sounders and other
instruments that are connected to the SIS software, but only the
current echo sounder is visible in the text field. Press the arrow
to see the entire list or click in the text field.
Select an echo sounder from the list. This echo sounder is now
available for configuration. Each echo sounder is identified by
name and serial number and all displyed frames will be updated
to show the information from this unit, if applicable. Only one
echosounder can be selected as current at any given instance, i.e.
you can configure only one echosounder at a time and you can
see data (for example beam intensity, cross track, numerical data
etc.) only from this current unit.
If you want to add instruments without a PU (Processsing
Unit/Rack) to the list, use the External sensors and Instrument
combinations found on the Tools drop-down menu.
→ Refer to pages 310 and 315 for a description.

If you want to remove instruments without a PU (Processing
Unit/Rack) from the list, use the Remove instruments found on
the Tools drop-down menu.
→ Refer to page 316 for a description.
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Line counter toolbar set
The Line counter button and Line counter textfield are found
on the toolbar.
The Line counter textfield displays the line for the currently
selected echo sounder. The count is cyclic between 1 and 9999.
→ Refer to page 345 for a description of current echo sounder.

When the Line counter button is pressed, the line count is
incremented by one for all active, logging echo sounders and
not only for the current echo sounder.
Note that if the current echo sounder is not actively logging,
nothing happens when the line counter button is pressed.
The line count for an echo sounder can also be incremented by
three other mechanisms in addition to using the line counter
button:
1 The line count is incremented each time logging stops

showing the next line to be logged. Only the count for the
handled (current) echo sounder is affected.

2 To avoid very large log files (.all-files) the counter for all
active echo sounders are incremented automatically every
30 minutes. (This can be configured in the Main menu;
Tools > Custom... > Set parameters.). This, however, only
happens when the counter has not been incremented by
other means within the last 30 minutes. (This is done by
pressing the line counter button or by stopping and
starting logging).

3 The line counter may be manually edited, when not
logging. The edited value is for the next logged line.

Note If several echosenders are used and the line count initially is the
same for all, it’s important to notice that the counts may deviate
after a while. This is due to the above described behaviour.
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6 CUBE

6.1 About the implementation of CUBE in SIS
The CUBE (Combined Uncertainty and Bathymetry Estimator)
algorithm is developed at The Center for Coastal and Ocean
Mapping (C-COM)/Joint Hydrographic Center (JHC) at
University of New Hampshire. The algorithm is available as a
library and is used inside one separate module in SIS. The
CUBE algorithm can be used as an alternative data gridding and
data cleaning method in SIS. The gridding and data cleaning is
default done by the GridEngine.
Cube is not available when loging data. Cube grids are created
by importing raw data files in the Kongsberg Maritime
all-format. Already gridded surveys can be reimported at a later
time.
The CUBE module in SIS receives ping data on UDP where
depth and angle gate are applied to the data. The horizontal and
vertical error estimate for each beam is calculated using the
Kongsberg Maritime error model and not the error models
included in CUBE. The default processing parameters for the
CUBE algorithm are used.
The GridEngine holds both a processing grid and a display grid.
The display grid is split up in six levels of details, LOD, to
speed up the display in the geographical view when features as
automatic update or ship in center are turned on. In CUBE it is
the processing grid that is displayed and an automatic update or
ship in center can give slow response when updating the
geographical view.

The implementation of LOD in the GridEngine also results in
less sensitivity to the grid cell size when displaying grids - see
the next four figures. With a small grid cell size a lot of nodes
get no depth value assign.
SIS must chose between ether Grid Ingine or CUBE grids. This
selection is don from the Tools main menu, Custum, Set
paramenters.
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Figure 30 GridEngine, LOD3

Figure 31 GridEngine, LOD1
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Figure 32 CUBE, grid cell size 10 m

Figure 33 CUBE, grid cell size 2.5 m

CUBE also need some amount of data density to do the
gridding. The grid in the next figure is from one survey line.
The grid width is measured to 19 metres. With one more survey
line the same distance is measured to 32 metres.
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Figure 34 Grid width 19 m

Figure 35 Grid width 32 m

In SIS only depth are extracted from the CUBE processed data.
In addition to the depth, CUBE can returns uncertainty, number
of hypothesis and hypothesis strength in each grid node.
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6.2 User interface differences when CUBE is used
Only the differences in the user interface between CUBE and
the GridEngine is treated hereafter.

Import raw data

In the window at the bottom of the user interface, the
parameters for the gridding is entered. CUBE needs to know the
geographical coordinates of the survey area before any
processing can start. The center location for the grid, width,
height and cell size must be given. Western or southern values
have to be entered as a negative value.

Figure 36 GridEngine (left) and CUBE (right) dialogues

A large survey area requires a coarser grid cell size. The
operator is notified if the grid size is too small for the requested
survey area. In this case the grid size has to be increased or the
survey area has to be reduced.
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Export Survey data
GridEngine surveys can be exported to ASCII-files, which can
be imported in Neptune. This feature is not supported for CUBE
generated grids.
The CUBE grids are however stored as GUTM-files on disc.
See
http://www.ccom.unh.edu/vislab/GeoZui3D/
FileFormats.html#GUTM

for a specification for the file format.

Figure 37 GridEngine (left) and CUBE (right) dialogues

Geographical window
Level of detail
The GridEngine has six levels of details, LOD, in its display
grid. For CUBE only the processing grid is available for display
and the choice is removed from the user interface.

Figure 38 GridEngine (left) and CUBE (right) dialogues

Dynamic colors
For CUBE grids, only depth can be used as a colour map for the
dynamic colours.
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Figure 39 GridEngine (left) and CUBE (right) dialogues
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The Show/hide menu

The Show/hide menu has less options since CUBE grids support
less features than the GridEngine grids.

Figure 40 GridEngine (left) and CUBE (right) dialogues
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6.3 Other functions not supported by CUBE

Calibration

This is not available when using CUBE. The GridEngine must
be run to calibrate the echosounder.

Projection

CUBE grids in SIS can only hold UTM projected data.
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7 TECHNICAL REFERENCES

7.1 Introduction
This chapter provides basic reference information useful to
understand settings and parameters used throughout the SIS
system. In order to understand some of the information, you
may need to have a more technical background than the average
SIS user.
The chapter is intended for users who would like a deeper
knowledge of the technical background for and the data flow
inside SIS.
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7.2 SIS architecture

SIS processes
The figure below shows the main architecture of how SIS
operates.

Network

CCU

HandleDDS

PU

DDS

GUI

UDP

UDP

UDP
UDP

UDP

ODBC

ODBC

BROADCAST

SISDB

BROADCAST

ODBC

0..*

0..*0..*

1
1

1

1

1

1

1

1

ODBC

1

Figure 41 SIS processing line

SIS contains six main processes. This is the start-up sequence:
1 The GUI is the main application, and is started first.
2 The CCU is started by the GUI. When the power is turned

on the EM Processing Unit, it starts sending broadcast
messages on the network. The CCU will pick up these
messages and display the EM in a list in the main GUI.

3 The operator will choose which echo sounders to start
from the list in the main GUI.

4 The CCU will be informed which echo sounders to start,
and then launch one DDS and one HDDS for each of the
echo sounders.
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- The DDS reads datagrams received from the
Processing Unit from socket and stores them as raw
data on disk.

- The HDDS reads raw data from disk and generates xyz
data that is sent to the GridEngine.

5 The GridEngine starts to receive xyz-data from the HDDS
and generates a real time terrain model from them.

6 The main GUI with the Geographical Display will now
start to receive xyz-points from all echo sounders, and it
will ask the GridEngine for a terrain model to display.

Main GUI

The main application is called SIS and contains the main
graphical user interface (GUI).

There are three main tasks for the main GUI:

1 To display the terrain models with quality information and
provide a geographical view of the surveyed data

2 To display status information about the echo sounder

3 To control the echo sounder

The Geographical window gets xyz-data from the HDDS
process. It will then display all these xyz-depths as they come
in, but only the last pings will be drawn. They will then appear
as a tail of soundings behind the ship.

The Geographical window also reads the terrain models
generated by the GridEngine. The GridEngine will contain five
depths for each measured depth.

The user can choose which reference level to see. The
GridEngine also generates several levels of detail so that the
Geographical window will always choose the right level of
detail based on the current scale.

Note that everything the HDDS process gives out, comes from
data it has read from the disk. This means that the data the
operator sees in the Geographical window has been safely stored
on disk by the DDS process.

The Status windows get data directly from the echo sounders.
This means that Status windows such as the Beam intensity
window and Sound speed profile window all get the data
directly. Hence the Status windows will be active when the echo
sounder is active, and can always be used to monitor the current
status of the echo sounder.
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Control of the echo sounder is done in the Installation parameter
window and in the Runtime parameter window. Also Pinging,
Logging and LineCnt will invoke the control of the echo
sounder. Messages are not sent from the main GUI directly, but
to the CCU process. The CCU is then responsible for sending
them to the right echo sounder (remember that the CCU can
control several echo sounders).
Messages concerining the system operation (errors, warnings,
information) are stored in SISDB, and the main GUI provides a
window where the operator can see all messages as they arrive.

CCU
The CCU process is responsible for detecting all echo sounders
on the network, and to make sure that the communication is
established between the different processes. Also, if a new echo
sounder is found during rescan, the GUI will be informed.

DDS
The DDS process is responsible for logging all the datagrams
the echo sounder sends out. The CCU will tell the DDS where
to store the data (complete filename). The DDS can also
distribute datagrams to other processes on the network, both to
SIS processes and to external processes. In SISDB the operator
can define what datagrams he wants to receive from the DDS
process, and when to receive them (every time they come or
with a certain time interval between).

HDDS
The HDDS process is informed by the CCU process where the
DDS process stores its files. Then the HDDS will read the raw
data files and create xyz-data from them. For every depth the
HDDS process will try to generate five depths:
• The depth measured by the echo sounder (waterline to

seabed).
• If a tide file is available, look up the tide in that file and

create a tide corrected depth.
• If heights are available from a Real Time Kinematic GPS,

and a geoid model is available, then the distance from the
vertical reference to the sea floor will be generated. In
addition, the distance from the sea floor to the geoid and the
distance from the sea floor to the ellipsoid will be generated.

All these depths will be sent to the GridEngine. The HDDS will
also read all the sidescan data from the echo sounder and make
geo-referenced sidescan data (x, y, reflectivity). All of this is
also sent to the GridEngine.
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The HDDS process will also do wild point editing of the
positions (remove position jumps). Every position is converted
from geographical coordinates to projection coordinates before
it is sent to the GridEngine.

GridEngine

The GridEngine will receive data from both single beam echo
sounders (EA) and multibeam echo sounders (EM). The
dataformat is different in these cases. EA data is strictly xyz.
This makes it possible for the GridEngine to read many kinds of
xyz-data, and they may be from different sources such as
ASCII-files. EM data is five depths for each measured depth,
and optional sidescan data.

The GridEngine uses two different grids, one called Processing
grid and the other is called Display grid. The Processing grid
has a user defined resolution of its grid cells, and the user must
define how many cells to keep in memory at one time. This is
done by specifying the number of grid cells in x and y direction
for the Processing grid. A maximum of four Processing grids
are then stored in memory at any time.

The Processing grid will contain a lot of data: all the xyz-points
and every xyz consists of five z-values. It will also contain all
the sidescan data for all lines in that area, and it will keep track
of which lines have data inside the area.

The Display grid is what the user actually sees. The Display grid
is organized in a hierarchical tree structure called levels. The
grid cell size of Level 0 of the Display grid is the same as the
grid cell size of the Processing grid, so Level 0 Display grid will
display everything from the Processing grid.

Level 1 in the Display grid is computed from four grid cells of
Level 0, Level 2 is created form four cells of Level 1 and so on.
All this is taken care of by the GridEngine.

The Processing grid will then be used in the Real Time Data
Cleaning module, and the results will be an updated Display
grid. The Geographical window will calculate the maximum
resolution necessary to display the data, based on the current
map scale selected by the operator. In a very small scale Display
grid Level 0 will be used, and in a higher scale a higher Level of
Detail will be used.
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This means that the Geographical window will need to display
only the necessary amount of data at any time, which again
means that the rendering will be faster. The zoom and pan
operations will also be very fast because the Geographical
window will always get a pre-processed dataset to display. The
GridEngine is written entirely in Java and is run as a servlet
inside the Jetty webserver.

SISDB
To store parameter settings used in SIS a database called SISDB
is created. The database server is Microsoft Desktop Engine (a
lightweight version of SQL Server) or PostgreSQL on Linux.
Logged data is not stored in the database, only parameters
settings and system messages..
This makes it possible to exchange data between different
applications which use a database, and to use standard
applications and tools to browse the contents of the database.
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7.3 Real time data cleaning
When data arrives into the GridEngine, it may be cleaned in real
time. Depths may be flagged out, but never deleted. Their status
can always be changed if necessary. The Real Time Data
Cleaning (RTDC) module operates in two steps:
• As the data arrives, it will be organized as pings in an array.

Then some processing will be done on these pings in the
array. This is known as Line Based Data Cleaning (LBDC)
because the processing only looks at data from the current
line. Naturally LBDC is not sufficient for proper data
cleaning because errors caused by i.e. sound speed profiles
will not be found. However, LBDC can be used for flagging
out obvious errors (spikes).

• After LBDC the data will be put into the Processing grid.
When we later comes back into the same area, the data from
the previous lines will be read back and reprocessed together
with the new data. This is called Area Based Data Cleaning
(ABDC) because all data from the same area is processed
together. ABDC gives us the possibility to find errors in i.e.
sound speed profiles and installation angles.

Before we start the ABDC routine, the GridEngine will try to
split and merge the processing cells into processing units, and it
is actually a processing unit that is used to create a surface. If a
processing grid cell has very few points, we try to merge it with
its neighbours to create a bigger area with enough points. If that
is too many, we split it again. In the figure below we see cells
that are empty and cells that contain enough points. On the edge
of the processing area there are some cells with not enough
points to do a good processing. The user can choose to
automatically delete all points inside such cells.
The first thing to do in ABDC is to create a most likely
reference surface in each processing unit. Traditionally this has
been simply the mean depth value for the cell which means that
the reference surface would always be a flat surface. In SIS we
prefer to let the GridEngine construct a much more reliable
surface that will model the terrain much better. The surface is a
curved surface constructed by using a first, second or third
degree polynome.



Technical references

363850-164709 / E

Figure 42 Process grid split into processing units

Empty

(CD6942)

Too few
points

Processed

The method used to construct the reference surface is called
Iterated Reweighted Least Squares (IRLS). We try to construct a
surface that will be as close as possible to most of the points.
Each point is then given a weight depended upon how far away
from the surface it is. Points close to the surface is given more
weight then the points further away.

• To begin with all points are given the same weight (which
means that the first run is the same as a least squares
method).

• Then we start the loop and run until we either reach a
maximum number of iterations or until the difference
between the current and the previous surface is very small:

- Fit the surface using the current weights.
- Calculate the residuals (distance from surface to point) for

each point.
- Check for convergence.
- Adjust the Tukey estimator.
- Evaluate new weights.
- The Tukey estimator is found from a predefined function

like the one shown in the figure.
The Tukey estimator constructs a curve for how much weight a
point shall have based on how far away from the surface it is. In
the figure we see that the red curve is a Tukey factor of 1 which
means that the weight drops very fast when the residue
increases. A Tukey factor of 3 means that the weight is not
reduced that fast.
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The operator can set the polynome order and the Tukey factor
himself.
When the surface has been constructed for each processing unit,
we can flag out points based on the result:
• Remove depths inside processing units that has too few

points to construct a surface
• Residue depth rule: Each depth in the Cell Processing Unit

is multiplied with a factor. The result is a limit, and if the
residue is larger than this limit, the point is flagged out. This
rule will adapt to changing depths so that the factor should be
approximately the accuracy of the echo sounder.

• Residue vertical error rule: Each depth has a vertical error
estimate. This error estimate is multiplied with factor and the
result is a limit. If the residue is larger than this limit, the
point is flagged out. This rule is also adaptive because the
vertical error will change with the range and beam pointing
angle.

• Residue vertical average. error rule: In each cell the
average vertical error is calculated, and the average vertical
error for the Cell Processing Unit is then calculated. Then a
limit is calculated from this average vertical error in the Cell
Processing Unit multiplied with factor. If the residue is larger
than this limit, the point is flagged out. Note that it is the
average vertical error for the Cell Processing Unit that is
used, not the cell’s value.

• Residue std. rule: The standard deviation of the residues is
also calculated. This is the standard deviation in the Cell
Processing Unit, not the cell. A limit is then set by
multiplying factor to this standard deviation. Residues larger
than this limit are flagged out.

• Angle of incidence rule: For each depth the angle between
the beam and the bottom surface is calculated. Then the
parameter Min. angle can be set and all depths where the
angle is less than this limit are flagged out.
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7.4 KSGPL

Overview
The Kongsberg SIS Graphical Programming Language
(KSGPL) is a powerful extension to SIS allowing the user to use
the Geographical window to display geographical information.
The KSGPL protocol defines a set of ASCII datagrams that is
sent between a user programmed application and the
Geographical window in SIS. The user application opens a
network connection (UDP) to the Geographical window and
writes ASCII text string to this connection. These KSGPL
strings can be used to send lines, points and pictures to the
Geographical window, and to define the position to an earlier
defined object such as a ship. Theses objects will then be drawn
in the Geographical window. A lot of attributes can be set by the
operator and the user application to control these objects, both at
the time they are sent to the Geographical window and
afterwards.
The operator may edit objects sent to the Geographical window.
He can split, join, add, delete and move lines, add, delete and
move points. The user’s actions are sent back to the user
application, which then can decide what to do next.
The user application is responsible for storing the data. This
allows the programmer to decide where the data is stored, in a
file or in any database system already in use. The user
application can also decide to add its own user interface so that
more information can be added to the objects added by the
operator. KSGPL is used to add background data to the
Geographical window. This background data can then not be
edited.
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KSGPL language reference
These datagrams are sent from the outside to the Geographical
window.

OBJECT <id>

POSITIONTYPE <GEO| SCREEN | RELATIVE>

[TYPE <number>]

[INFO <text>]

[LINE [ [WIDTH <number>] [SOLID|DOTTED] [COLOR <number>] [TRANS <0-100>] ]

<POS2D|POS3D> <positions>]

[POLYGON [ [BORDERWIDTH <number>] [SOLIDBORDER|DOTTEDBORDER]

[BORDERCOLOR <number>][BODYCOLOR <number>]

[SHOWBORDER|NOSHOWBORDER] [SHOWBODY|NOSHOWBODY]

[TRANS <0-100>] ] <POS2D|POS3D> <positions>]

[POINT [ [SIZE <size>] [COLOR <number>] [TRANS <0-100>] ]

<POS2D|POS3D> <position>]

[TEXT <text> [ [SIZE <number>] [COLOR <number>]

[ORIENTATION <0.0-360.0>] [TRANS <0-100>] ] <POS2D|POS3D> <position>]

[IMAGE <file> [ [GRAVITYPOINT<0-100> <0-100>]]

<POS2D|POS3D> <position>]

OBJECT_END

OBJECT <id> DELETE OBJECT_END

The two tables below shows the internal datagram descriptions:
Datagram Description Required

POSITIONTYPE <GEO> Use geographical coordinates. Yes, either GEO,
SCREEN or RELA

POSITIONTYPE <SCREEN> Centimeters on the screen (float) relative
to the lower left corner of the Geographi-
cal window. This object will always stay
in its position on the screen.

SCREEN or RELA-
TIVE.

POSITIONTYPE <RELATIVE> Meters relative to origo (0.0m, 0.0m) in
the world.

INFO <text> Name or description of this object. No.

TYPE <number> The id of the type this object belongs to. No.

LINE [[WIDTH <number>]] Width of the line in pixels. No. Default is 1.

LINE [[SOLID|DOTTED]] Solid or dotted line. No. Default is
SOLID.

LINE [[COLOR <number>]] Colour of the line. No. Default is
black.

POLYGON [[BORDERWIDTH
<number>]]

Width of the border in pixels. No. Default is 1.

POLYGON [[SOLIDBORDER|DOTTED-
BORDER]]

Solid or dotted border. No. Default is SO-
LIDBORDER.

POLYGON [[BORDERCOLOR
<number>]]

Colour of the border. No. Default is
black.

POLYGON [[BODYCOLOR <number>]] Colour of the polygon border. No. Default is red.

POLYGON [[SHOWBORDER|NO-
SHOWBORDER]]

Show the border or not. No. Default is
SHOWBORDER.
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Datagram RequiredDescription

POLYGON [[SHOWBODY|NOSHOW-
BODY]]

Show the body of the polygon or not. No. Default is NO-
SHOWBODY.

POINT [[SIZE <number>]] Size of the point in pixels. No. Default is 1.

POINT [[COLOR <number>]] Colour of the point. No. Default is red.

TEXT [[SIZE <number>]] * Font size. No. Default is 9.

TEXT [[COLOR <number>]] Colour of the text. No. Default is red.

TEXT [[ORIENTATION<0.0---360.0>]] * Orientation of the screen aligned text in
degrees. Positive value is counter clock-
wise.

No. Default is hori-
zontally aligned.

IMAGE [[GRAVITYPOINT <0---100>
<0---100>]] *

Gravity point of the picture in percent (i.e.
where on the picture the coordinate is
given). Horizontal and vertical values.

No. Default is lower
left corner.

Datagram common for all objects Description Required

OBJECT <id> A unique identifier. The old object will be
deleted if the corresponding identifier al-
ready exists in the system.

Yes.

<TYPE> <id> What kind of type this object is. No.

<POS2D|POS3D> <position> Position(s) of the object.
POS2D = (x,y)
POS3D = (x,y,z)

Yes.

[[TRANS <0---100>]] Transparency of the object. No, Default is 0.
(No transparency
at all.)
The polygon bor-
der will not be af-
fected by the trans-
parency setting.
Note: Trans-
parency is disabled
for images.

OBJECT_END Datagram end. Yes.

Note * - Not yet supported.
If the object sent into the system is missing required fields, the
object is disregarded. No output is given.
An object has always an identifier that must be unique within
the application. If an object with the same id exists in the
Geographical window, that object is deleted (no message given
as output) and the new object is put in. The object may consist
of one or more instances of lines, polygons, points, texts and
images.
A position has either two or three floating-point numbers and is
enclosed in parentheses like: (1.1 2.2 3.3). Comma and
semi-colon may be used to separate the tokens, i.e.:
(1.1;2.2;3.3;t) to make the file more readable.
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An object may be of a type. Object without types will be entered
into the system in a default container. An object of a nonexistent
type (if given) will be ignored.
Objects may be deleted from the Geographical window by the
DELETE datagram. The corresponding id will be deleted.

KSGPL output from the Geographical
window
The Geographical window will have line and point editing
capabilities on objects that consists of one line only or one point
only. Composite objects consisting of several lines and/or points
cannot be edited. When the user has edited data that have been
put in via KSGPL, the Geographical window will output these
KSGPL datagrams:

ACK <status> ACK_END

OBJECT <id> MARKED OBJECT_END

OBJECT <id> MARKED OBJECT_END

OBJECT <id> DELETED OBJECT_END

OBJECT <id> CREATED OTYPE <type_id> POINT <POS2DT|POS3DT> <position> OBJECT_END

OBJECT <id> CREATED OTYPE <type_id> LINE <POS2DT|POS3DT> <positions> OBJECT_END

OBJECT <id> EDITED POINT <POS2DT|POS3DT> <position> OBJECT_END

OBJECT <id> EDITED LINE <POS2DT|POS3DT> <positions> OBJECT_END

OBJECT <id> JOINED_LINES <second_line_id> <POS2D|POS3D> <positions>

<POS2D|POS3D> <positions> OBJECT_END

OBJECT <id> SPLIT_LINES <POS2D|POS3D> <positions> <POS2D|POS3D> <positions>

OBJECT_END

The table below shows the external datagram descriptions:
Datagram Description

ACK <status> ACK_END An acknowledge message sent whenever a data-
gram has been received by the Internal KSGPL
Handler.
’status’ is an integer informing about status of the
datagram just received.
---1 = Datagram failed to be recognized.
0 = Reserved.
1 = Datagram successfully recognized.

OBJECT <id> A unique identifier. This will be 0 for new
(CREATED) objects.

POS2D <position(s)>
POS3D <position(s)>
POS2DT <position(s)>
POS3DT <position(s)>

Position(s) of the object.
POS2D = (x,y)
POS3D = (x,y,z)
POS2DT = (x,y,t)
POS3DT = (x,y,z,t)

MARKED The object has been ’marked’ by the user. No
changes are done to the graphics. The External
KSGPL Handler can now take proper customized
action(s).
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Datagram Description

DELETED The object has been deleted by the user and re-
moved from the scene.

CREATED OTYPE <type_id> <POINT|LINE> The user has created a new point or line of a given
type. The object has been removed from the scene.

EDITED <POINT|LINE> The user has edited the given point or line.
The object has been removed from the scene.

JOINED_LINES <second_line_id>
<POS2D|POS3D> <positions_of_line_one>
<POS2D|POS3D> <positions_of_line_two>

The user has joined two lines into one.
The preceding ’OBJECT <id>’ is the ID of the first
line. <second_line_id> is the ID of the second line.
The lines are connected together between the last
vertex in the first line and the first vertex in the sec-
ond line.

SPLIT_LINE
<POS2D|POS3D> <positions_of_line_one>
<POS2D|POS3D> <positions_of_line_two>

The user has split an existing line into two line seg-
ments. The preceding ’OBJECT <id>’ is the ID of
the original line before being split.
Note: The user has removed one vertex in the orig-
inal line (and not only deleted a sub line segment).

OBJECT_END Datagram end.

A position has either two or three floating-point numbers and a
time field enclosed in parentheses like: (1.1 2.2 3.3). POS2DT
or POS3DT positions also have a time-field ’t’ which is given in
the format: yyyyMMddhhmmSS.sss. (Year, month, day, hour,
minute, seconds and decimal seconds.) POS2DT or POS3DT
are only used when the user has EDITED or CREATED
something in the scene. If the user has EDITED e.g. an existing
POS2D line by moving one of the vertices, the unmoved
vertices will have the time-field set to ’00000000000000.000’
when sent out. POS3D(T) are only sent if the original object
was inserted into the system using POS3D coordinates.
Respectively the same with POS2D(T).
Objects are assumed to be sent to an external program and
deleted from the Geographical window as soon as they are
CREATED or EDITED and then sent back to the Geographical
window. After that, line objects may be split (SPLIT_LINES) or
joined (JOINED_LINES). These operations are then only
allowed on lines that have been put into the Geographical
window from an external source.
Selected objects remain in the Geographical window, but
CREATED, EDITED, JOINED_LINES and SPLIT_LINE are
deleted from the Geographical window when these datagrams
have been written to socket. It is assumed that the receiving
program will handle the necessary storage of the changed items
and then send them back to the Geographical window to be
redrawn in a new state. This will assure the user that the data
have been successfully stored.
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For an edited line or point the position(s) are the new, changed
position(s). A line may also get new vertices inserted into the
line (both at the ends of the line and between vertices in the
line) and have vertices deleted. The output will be written when
the user has completed the editing of the line, not while he is
editing.
New objects will have id=0. For a split line the id will be the id
of the original line.
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7.5 Set parameters in SIS
Parameters can be set to change the behaviour of SIS. Normally
SIS must be restarted for these parameters to take effect.

Figure 43 Set parameters in SIS

Click on the branch in the tree to the left and the window to the
right will expand.

Figure 44 Ship parameters

• Length of spear in cm: This is the length of the line drawn
from the bow of the ship.

• The next four parameters define the distances from the
reference point to the edge of the ship.
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Figure 45 Set position parameters

• Max age for ROV depth datagram (sec.). Time before a
missing ROV depth input datagram to the echo sounder (PU)
should be flagged in the numerical display. Should never be
set to 0.

• Dead reckoning on or off. (off=0, on=1). If position input
stops the dead reckoning feature will calculate predicted
positions for a preset time interval before stopping. The
predicted positions are based on the two last positions
received and the (still) incoming heading, if available. If not
the last heading will be used.

• Position jump filter on or of. (off=0, on=1) . This filter is
used to remove single spikes in the position input. If a
position spike occur this position is disregarded and a
predicted position used instead. This predicted position is
based on the two previous (legal) positions and the heading.
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• Time difference too big (sec): If the time difference between
the timestamp and the time in the clock datagram is bigger
than this value, an error is generated.

• Change in time difference too big (millisec): There is always
a time difference between the timestamp and the time in the
clock datagram. However, this time difference should
normally be almost constant. If there is a sudden change in
this difference, an error is generated.

• Position quality too low (error) (cm): Lowest acceptable limit
for the computed position quality (see position datagram
output in the corresponding echo sounder manual).

• Position quality too low (warning) (cm): Warning limit for
the position quality.

• Too few satellites: Lowest acceptable number of satellites
(error limit).

• Few satellites: Low number of satellites (warning limit).
• Error position jump (m/s): Highest possible speed of the ship.

This is used to generate error messages for position jumps.
• Suspicious position jump (m/s): Warning about possible

position jump.

Figure 46 Set turn parameters

These parameters are used to control how the planning module
in SIS shall generate turns from one planned line to the next.
• Lead in: Add these meters to the end of each planned line to

allow the ship to become stable before entering the survey
line.

• Turn radius: The minimum turn radius in meters that the ship
can do.
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Figure 47 Set passwords

These parameters control the use of passwords in SIS.

• Password for installation menu, valid as long as the frame is
shown:

• Password for installation menu, valid once:

• If 1: Installation menu is password protected: Set this
parameter to 1 to enable the use of passwords, 0 to disable.

Figure 48 Set display parameters

• Minimum size of grid cell in screen (0.1 - 1.0 mm): This
parameter defines when the Level of Detail in the
Geographical Window shall change. Setting this value to, say
0.3, will tell SIS to keep a higher Level of Detail when the
map scale decreases. This will give “sharper” images, but use
more RAM and increases response time for updates.

• Max number of pings in realtime depth. The length of the
realtime depth tail behind the ship in the geographical view.

• Default Font Size in the Helmsman Display. Control the font
size in the Helmsman Display, both the display in SIS and the
display in the Remote Helmsman application.
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Figure 49 Set logging parameters

• Indicate if SeaBec is in use (1=on, 0=off): Normally set this
to 0. This can be used to turn on Single Beam Seafloor
classification if a license is found.

• Gives current data cleaning method, 1=GridEngine,
2=CUBE: This parameter controls if SIS shall use
GridEngine or CUBE to generate terrain models.

• Interval for line counter in sec.: Control when new survey
lines shall be generated automatically.

Figure 50 Autopilot parameters

• XTE factor: the XTE value in the NMEA APB sentence is
multiplied with this factor. This can cause the autopilot to
react more quickly, but it can make the ship oscillate along
the line. This factor must be used with care.
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Figure 51 Sound speed parameters
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Set network licence.

Figure 52 Network licence.
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7.6 Create terrain models in SIS from ASCII-files
This tool can be used to create terrain models in SIS from
ASCII files.

Figure 53 Create terrain models in SIS from ASCII files

The format of the ascii-file is like this:
*** Neptune Ascii file from Kongsberg Simrad
A/S ***
Survey name: EM710_Blucher_2005_02_23
Processing operator name: tp
Datum: WGS84
Half axis: 6378137.0000000
Flattening: 1/298.25722356300
Coordinate system: Lat/Long
Latitude min.: 59.66354720
Longitude min.: 10.59076500
Latitude max.: 59.70350375
Longitude max.: 10.62006250
Latitude cell size: 5.00 meter
Longitude cell size: 5.00 meter
Median depth of each cell

10.6148669 59.6635847 40.14
10.6149773 59.6635844 45.31
10.6150679 59.6635841 50.54
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The first lines are the header. The first empty line ends the
header, and the header must always be present. This means that
the data in latitude, longitude, depth must follow after an empty
line. Latitude and longitude are in decimal degrees and the
depth is in meters.
This format is written by Neptune (BinStat), geographic
coordinates in ascii format. Normally the median value for the
grid cell is written in this format, which makes it faster to
generate the grid in SIS. If the grid cell size in BinStat is, say 2
meters, use 400 cm as the grid cell size in SIS.
“Select existing projection in directory…” opens up a directory
selection box where the operator chooses which projection file
to use. This projection file must be found in the selected
directory. Normally select the directory where the recent survey
is located. This will ensure that the projections are the same in
the new survey and the created grid.
“Grid size in centimeters” should normally be twice as big as
the grid cell size in BinStat if median files are used.
“Number of cells in processing grid” should normally be the
same as the number used in new surveys.
“Select grid output directory” selects the directory where the
grid shall be stored. Note that this directory must exist and be
writeable (common error on Linux).
“Grid name” is the name of the grid.
“Select ascii input files” opens a file selection dialog where the
operator can choose which files to use as import.
“Remove files in list” removes the selected files from the list.
“OK” runs the process.
Note that the GridEngine must be running for this program to
work.
Also note that there are many errors that can occur in this
process, and they may kill the GridEngine process. If such an
error occurs, this program may have to be killed from the
process manager, and the GridEngine must be restarted.
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7.7 Export formats
When data is exported from SIS, the user can choose different
export formats.
The ASCII output contains a line describing what the file
contains. Note that positions are in projection coordinates and in
centimeters, depths are also in centimeters. Time is in
milliseconds since epoch (0 UTC 1 January 1970).
The binary output also contains this information. Here is an
example of how to read the binary files:

//h+/////////////////////////////////////////////////////////////////////////
/*!
// \file readSISBinaryOutput
//
// \brief Example of how to read the binary output from SIS
// \author Terje Pedersen
//
// \date 10-OCT-2003
//
// \par Copyright:
//
// Copyright by Kongsberg Simrad
//
//
// \par Revision History:
//
// \par 01 10-OCT-2003 tp
//
// Original Version.
//
//
*/
//h-/////////////////////////////////////////////////////////////////////////

#include <stdio.h>
#include <stdlib.h>
#include <time.h>
#include <string.h>

//! Little endian cell data
#ifdef WIN32
typedef __int64 i64;
#else
typedef long long i64;
#endif
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typedef struct {
int m_lEastCm, m_lNorthCm;
int m_iDepthCm;
int m_iFlag;
int m_iResidualCm;

}SLittleEPointRec, *SLittleEPointPnt;

typedef struct {
int m_lEastCm, m_lNorthCm;
i64 m_lDate;// millisec. since epoch
int m_iPingno, m_iBeamno;
int m_iDepthCm;
int m_iFlag;
int m_iResidualCm;

}SLittleEPointExtraRec, *SLittleEPointExtraPnt;

//f+/////////////////////////////////////////////////////////////////////////
//
/*!
// \brief Convert milliseconds since epoch to date
//
// \param mtime, milliseconds since epoch
// \param year, month, day, hour, min, sec, millisec
//
// \return void
//
// \author Terje Pedersen
//
// \date 10-OCT-2003
//
// \note
*/
//f-/////////////////////////////////////////////////////////////////////////
void convertMsecToDate(i64 mtime, int *year, int *month, int
*day, int *hour, int *min, int *sec, int *msec)
{

i64 t;
time_t nt;
struct tm stm, *ptm;
if (year == NULL || month == NULL || day == NULL || hour
== NULL || min == NULL || sec == NULL || msec ==
NULL) return;
t = mtime/1000;
*msec = (int)(mtime - (t*1000));
nt = (time_t)t;
ptm = localtime(&nt);
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if (ptm == NULL) return;
memcpy(&stm,ptm,sizeof(stm));
*year = stm.tm_year+1900;
*month = stm.tm_mon+1;
*day = stm.tm_mday;
*hour = stm.tm_hour;
*min = stm.tm_min;
*sec = stm.tm_min;

}

//f+/////////////////////////////////////////////////////////////////////////
//
/*!
// \brief Read the binary output from SIS
//
// \param type, what type of file to read
// \param filename, name of file to read
//
// \return void
//
// \author Terje Pedersen
//
// \date 10-OCT-2003
//
// \note
*/
//f-/////////////////////////////////////////////////////////////////////////
int readSISBinaryOutput(int type, char *filename)
{

FILE *fd;
SLittleEPointRec le;
SLittleEPointExtraRec lex;

if (type < 1 || type > 2) return -1;
//printf(”%d %d\n”,sizeof(le),sizeof(lex));

fd = fopen(filename,”rb”);
if (fd == NULL){

fprintf(stderr,”Cannot open file: %s\n”,filename);
return -1;

}

if (type == 1){// Little endian point data
while(fread(&le,1,sizeof(le),fd)){
printf(”East %d cm, North %d cm, Depth %d cm, Flag
%d, Residual %d cm\n”,le.m_lEastCm, le.m_lNorthCm,
le.m_iDepthCm, le.m_iFlag, le.m_iResidualCm);
}//while
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}//if type == 1
if (type == 2){// Little endian point data with extras

int year, month, day, hour, min, sec, msec;
while(fread(&lex,1,sizeof(lex),fd)){

convertMsecToDate(lex.m_lDate, &year, &month,
&day, &hour, &min, &sec, &msec);
printf(”East %d cm, North %d cm, Date %I64d
%04d%02d%02d %02d%02d%02d.%d, Ping no. %d,
Beam no. %d, Depth %d cm, Flag %d, Residual %d
cm\n”, lex.m_lEastCm, lex.m_lNorthCm, lex.m_lDate,
year, month, day, hour, min, sec, msec, lex.m_iPingno,
lex.m_iBeamno, lex.m_iDepthCm, lex.m_iFlag,
lex.m_iResidualCm);

}//while
}//if type == 2
return 0;

}

int main(int argc, char *argv[])
{

if (argc != 3){
printf(”\n\nUsage: %s <type> <filename>\n\n”,argv[0]);
printf(”Types:\n”);
printf(”1: little endian point data without time.\n”);
printf(”2: little endian point data with time.\n”);
printf(”Long must be 8 bytes, it is %d
bytes\n”,sizeof(i64));
printf(”\n\n”);

}//if

return readSISBinaryOutput(atoi(argv[1]), argv[2]);
}
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7.8 Survey plan file format
The survey plan file can be stored as a binary file with extension
*.sisplan or as ASCII files in the existing Neptune format.
The first line gives information about the Latitude / Longitude
format used in the file. There are four different options:
DEG - Degrees,decimal degrees
MIN - Degrees,minutes and decimal minutes
SEC - Degrees,minutes and seconds
PROJECTION - Projection coordinates
The next line is a comment or text that follows the job.
The next to lines is an example of a planned line. The format of
a planned line is:
_LINE <Line Name> <Line Number> <Time of
creaton><Flag><N><E><N><E>’<Comment>

The time of creation is the Work Station time given in the
following format:
YYYYMMDDhhmmss

where:
• YYYY - The Year
• MM - The month of the year
• DD - The day of the month
• hh - The our of the day
• mm - The minutes in the hour
• ss - The seconds of the minute
The polygon has a similar format except:
• Starts with _POLYGON.
• The name is always polygon.
• The line number is always 0.
• The flag is always 0.
• It is not possible to attach information to a polygon.
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7.9 PU: EM Simulator and playback

What it does

The PU program is a playback program of logged data from EM
multibeams. It can be used together with the Seafloor
Information System to act as an EM simulator or playback of
logged data. The program is located where you installed SIS.

How it works
PU is launched in the background and then waits for command
signals.

“Hostname” is the hostname of the machine where PU is
running.

The button “Start” pops up a directory selection box where the
operator selects the directory where the .all raw data files are
located. This directory is written in the textfield next to the
button.

PU will then read all the .all files in the directory over and over
again, and send out the datagrams as if they came from an EM.
However, there are some differences:

• The time in the header of all datagrams will be set to the
current time in GMT. Also the time in the GGA text string in
the position datagrams will be set to this time.

• PU will not send broadcast datagrams to SIS before it has
received the information about which directory to read from.
Therefore SIS must be started after pressing the Start in PU.

• Other data in the datagrams will not change. This means that
the Numerical display in SIS will display the time
information from the original information datagrams.
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How to do it
1 The network must be operational. You must be connected

to a network or you must use the loopback plug.
2 Edit the file SIS.bat. Type REM in front of the lines kill

java.exe, kill PU.exe and start startJetty.bat.
3 Start the program in Start -> All Programs ->

Kongsberg Maritime -> SIS -> StartJetty.
4 Open a command window and change directory to where

you installed SIS, typically c:\program files\Kongsberg
Maritime\SIS\bin. Then type: perl runsim.pl.

5 Press the “Start” button and select the directory where the
.all files are located. You will then see in the command
window running the PU process that broadcasts are being
sent to the network.

6 Start SIS from the desktop icon.
7 Choose to start echo sounder 888.
8 You can now operate SIS as you would with any other

echo sounder, except that changing the Installation and
Runtime parameters have no effect.

9 If you have a slow computer, you can press “Pause” to
allow SIS to catch up.

10 You can control the speed of the simulator by reducing the
playback rate.

11 Press “Stop” to stop the simulator.
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7.10 The vessel coordinate system
A main function of the parameters required for system
installation is to inform the system of the relative positions
between the various sensors and the angular orientation of the
sensors with respect to the vessel. A reference point somewhere
on the vessel has to be selected, and a Cartesian right-handed
coordinate system - as shown in the figure below - must be
defined with its origin in the reference point. The location of
this reference point has no physical significance - it may be
anywhere on the vessel. The placement of the various
instruments must be identified with forward, starboard and
downward coordinates in this coordinate system.

Figure 54 The Vessel Coordinate system

Starboard (+Y)

(-Y)

Downward (+Z)

Reference point (origo)

(-Z)

(CD3274)

Forward (+X)

(-X)

The forward axis (X) must be parallel to the vessel keel, and the
downward axis (Z) must be vertical when the vessel is trimmed
normally. The plane defined by the forward and starboard axes
will then be horizontal, and the attitude sensor should then, if
properly installed and calibrated, measure zero roll and pitch
with a normally trimmed vessel lying still.
Forward position (X)

Forward position is defined on the X-axis (refer to the
illustration below). Locations further forward than the
reference point are positive.

Downward position (Z)

Downward position is defined on the Z-axis (refer to the
illustration above). Locations below the reference point are
positive.

Starboard position (Y)

If a sensor location is on the starboard side of the reference
point, the value will be positive.
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(CD3514B)

Water line

Transducer
(+Z, +X)

Motion sensor
(-X, -Z)

Draft (+Z)

Reference point
Z-axis (+Z)

Z-axis (-Z)

GPS Antenna
(-Z, -X)

X-axis
(+X)

(-X)

Figure 55 Sensor locations (example)



Technical references

389850-164709 / E

7.11 Timing

Introduction

Time synchronization between the echo sounder, the motion
sensors and the positioning system is vital in order to achieve
the best possible accuracy. The required time synchronization
accuracy is better than 5 ms for attitude with roll being the most
critical parameter. For the positioning, the required timing
accuracy depends upon required position accuracy and the
vessel’s speed.

Example: With a vessel speed of 10 knots or 5 m/s, 100 ms
timing accuracy is required for 0.5 m position accuracy.

Internal clock

An internal clock in the Transceiver Unit is used to time stamp
all time critical data. It is a software clock with 1 millisecond
resolution, and it is synchronized to an internal hardware
counter. An interrupt is generated in the Transceiver Unit at
each ping as a reference for the time of ping, and the clock is
read at the reception of external sensor data. The internal clock
is stable and jitter free, excepting a long-term drift of the
hardware counter (typically a few seconds per 24 hours), and
possible 1-2 millisecond jumps due to the internal counter not
operating at exactly 1 kHz.

The software clock may be synchronized to an external 1PPS
(pulse per second) signal. This signal is normally available from
a GPS receiver, and this is the preferred method to synchronize
the echo sounder to an external clock. At the reception of a
1PPS pulse the millisecond field of the internal clock is set to
zero. If it was larger than 200 ms, the second is incremented
(with a possible incrementation of time and date if required).
Note that this method of synchronization implies that loss of a
few 1PPS pulses has no significance. However, spurious noise
recognized as 1PPS pulses will offset the clock forward, 1
second for every spurious signal accepted.

The internal clock’s time and date is adjustable to that given by
an external clock, the positioning system or the operator station.
However, this is only possible if the system is not logging data.
Adjustment of the internal clock during data logging is not
allowed as it would cause loss of synchronization between depth
and attitude data.
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If an external clock is connected on a serial line the input data is
time stamped and logged as any other external sensor data. This
allows a continuous estimation of any drifts between the two
clocks. The setting of the internal clock will be to the time and
date from the source, including milliseconds as available. Note
that the GGA positioning datagram does not contain any date
entry. Setting from the operator station allows a manual setting
of the clock.

Time stamping
For each datagram of attitudes (roll, pitch, heave and possibly
heading), a time stamp is generated at the reception of the first
byte of the datagram. As the attitude data may be delayed due to
processing time in the motion sensor, an adjustable time delay
may be applied. The attitude data are applied to the acquired
ranges and beam angles to derive xyz coordinates of the
soundings after bottom detection.
The only significant uncertainty in the time synchronization of
attitude and depths will thus be due to possible variations in the
time delay or a wrong estimation of it. However, with most
motion sensors the risk of errors is small. The manufacturer’s
estimate of delay should be used, and a possible prediction
facility in the sensor should not be employed. As the attitude
data may be logged as a continuous time record, it is possible to
postprocess the data to determine and correct for any error in
applied time delay.
As for the attitude data, a time stamp is generated at the
reception of the first byte of each position datagram, and an
adjustable time delay may be applied to this time stamp. If the
real variation in this time delay is sufficiently small with respect
to the position accuracy and vessel speed, the internal time
stamp will give sufficiently accurate time synchronization. Time
delay must of course be determined to a sufficient accuracy
which is done by comparing data from survey lines run at
different vessel speeds in the same direction up or down bottom
slopes or over significantly distinctive bottom features. Any
necessary correction of the applied time delay may be done in
the postprocessing.
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If the variation in the time delay of the positions is too large
with respect to the desired accuracy, even after position filtering
during postprocessing, an alternative satisfactory solution will
require two things: that the positioning system’s own time stamp
in the position datagram has a sufficient accuracy; and that the
clocks of the echo sounder and the positioning system are
synchronized. When postprocessing the positioning system’s
time stamp must be used which is possible as both time stamps
are retained in the logged data. If the positioning time stamp is
not good enough, the positions will have to be filtered during
postprocessing to diminish the effect of the variable timing. The
inertia of the vessel will set the limit of accuracy achievable by
such filtering.

The absolute setting of time in the echo sounder is usually not
critical with respect to other sensors. However it would be
advisable to synchronize the echo sounder to a 1PPS signal if it
is available, and not to reset the echo sounder clock except at the
start of a survey. This will ensure that any time delays remain
constant during a survey. If an external clock is additionally
connected on serial line and logged, this will allow a check of
clock consistency during postprocessing, but this would usually
not be worth the effort.

The conclusion and recommendations are as follows:

• The delay in the data from the motion sensor must be
constant and known to within 5 ms.

• If the delay in the position data is known within an accuracy
commensurate with the position accuracy and vessel speed,
no synchronization of clocks is required, but it is
recommended to synchronize the echo sounder to a 1PPS
signal if it is available.

• If the delay in the position data is variable and cannot be
filtered to a sufficient accuracy in postprocessing or the
positioning is required to also be accurate for real-time
displays, the echo sounder and positioning system clocks
must be synchronized:
The synchronization of the two clocks should be done from a
common 1PPS signal (which may be contained in the
positioning system). The echo sounder should be set up to
use the positioning system time stamp (datagram time) to
which any position time delay will be applied. The
postprocessing system must also be set up to use the
positioning system time stamp (a time delay may have to be
applied to either the position or depth data).
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Time difference PU-ZDA and PU-POS
indications
The color indications used in the Numerical display for
PU-ZDA and PU-POS time difference are based on the 1PPS
setting, the Time to use setting and the clock Source selection.
All these parameters are set in the Installation parameter frame.
→ See page 160.

The standard legal time difference in most situations are +/- 1
sec., but with 1PPS off and time tag from the system the legal
time difference is considerably larger.
The legal time delays are system parameters and can not be
changed by the operator.



Technical references

393850-164709 / E

7.12 Sound speed formulas

The echo sounder computes bottom depth, taking full account of
the raybending caused by the variation of sound speed in the
water column. The Sound speed profile is entered manually,
automatically from a sound speed profile probe, from an
external computer, or by a combination of these methods.

If measured sound speed values are not available, they may be
derived from tables, or, if the temperature and salinity profiles
are known or estimated, calculated from a formula. While many
formulae exist, the one from UNESCO Technical Paper in
Marine Science, No. 44, is usually regarded as being
authoritative. However, it is cumbersome and recent
experiments showed that it has errors in the 1000-4000 m depth
range. Therefore, a simpler formula with adequate accuracy is
as follows (from Coppens, JASA March 1981, with a modified
very deep water correction which follows the recent
experimental data).

• For the surface:

c(0,T, S)= 1449.05+ T(4.57− T(0.0521− 0.00023T))

+ (1.333− T(0.0126− 0.00009T)(S− 35)

where: T is temperature in _C
S is salinity in ppt

• For depths to 200 m in fresh water and 1000 m in the ocean:

c(Z,T,S)= c(0,T,S)+ 16.5Z

where: T is temperature in _C
S is salinity in ppt
Z is depth in km

• For depths to 2000 m in fresh water and to 11000 m in the
ocean (assuming that the water is very cold at great depths):

c(Z,T,S)= c(0,T,S)+ Z(16.3+ Z(0.22− 0.003Z T+ 2 ))

where: T is temperature in _C
S is salinity in ppt
Z is depth in km
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• For depths greater than 5000 m, a latitude correction should
be applied:

c(Z,T,S)= c(0,T,S)+ Z′(16.3+ Z(0.22− 0.003Z T+ 2 ))

where: Z’ = Z(1 - 0.0026 cos2φ)
φ is latitude in degrees
T is temperature in _C
S is salinity in ppt
Z is depth in km
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7.13 Handling of SSP datagrams

Overview
The SSP datagram format is used for input of depth or pressure
profiles containing:
• Sound speed (m/s)
• Temperature (_C)
• Salinity (parts per thousand)
• Absorption coefficient
SSP datagrams are sent to the Operator Station on port 4001.
The SSP format is a generic format and the actual type of
information conveyed is defined by an identifier. Currently the
following are defined:

Identifier Input data Data to be used Comment

S00 D,c D,c Used immediately

S01 D,c,T,S D,c,a(D,T,S,L) Same as S12, but used
immidiately

S02 D,T,S D,c(D,T,S,L), a(D,T,S,L) Same as S22, but used
immidiately

S03 D,T,C D,c(D,T,C,L), a(D,T,S,L) Same as S32, but used
immidiately

S04 P,T,S D(P,T,S,L), c(P,T,S,L), a(P,T,S,L) Same as S42, but used
immidiately

S05 P,T,C D(P,T,C,L), c(P,T,C,L), a(P,T,C,L) Same as S52, but used
immidiately

S10 D,c D,c

S11 D,c,a D,c,a

S12 D,c,T,S D,c,a(D,T,S,L)

S13 D,c,a,f D,c,a Frequency dependent

S20 D,T,S D,c(D,T,S,L)

S21 D,T,S,a D,c(D,T,S,L),a

S22 D,T,S D,c(D,T,S,L),a(D,T,S,L)

S23 D,T,S,a,f D,c(D,T,S,L),a Frequency dependent

S30 D,T,C D,c(D,T,C,L)

S31 D,T,C,a D,c(D,T,C,L),a

S32 D,T,C D,c(D,T,C,L),a(D,T,C,L)

S33 D,T,C,a,f D,c(D,T,C,L),a Frequency dependent

S40 P,T,S D(P,T,S,L),c(P,T,S,L)
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S41 P,T,S,a D(P,T,S,L),c(P,T,S,L),a

S42 P,T,S D(P,T,S,L),c(P,T,S,L),a(P,T,S,L)

S43 P,T,S,a,f D(P,T,S,L),c(P,T,S,L),a Frequency dependent

S50 P,T,C D(P,T,C,L),c(P,T,C,L)

S51 P,T,C,a D(P,T,C,L),c(P,T,C,L),a

S52 P,T,C D(P,T,C,L),c(P,T,C,L),a(P,T,C,L)

S53 P,T,C,a,f D(P,T,C,L),c(P,T,C,L),a Frequency dependent

Legend:

a Absorption coefficient
c Sound speed
C Conductivity
D Depth
f frequency
P Pressure
L Latitude (always present)
S Salinity
T Temperature
The notation ’a(D,T,S,L)’ means that the absorption coefficient
is calculated from depth, temperature, salinity and latitude.

Usage
The use of absorption coefficients from SSP datagrams are now
available for all types of echo sounders..
SIS will receive the SSP datagrams over the network on port
4001. Upon reception, SIS will always generate a sound
velocity profile file (.asvp), either directly (e.g. if S00, S11 is
received) or by performing the necessary calculations from the
supplied data.
An absorption coefficient profile file (.abs), based on the
supplied data, will also be generated for all frequencies used by
the echo sounders.
There is a special case for the SSP datagrams S13, S23, S33,
S43 and S53. These datagrams has been extended to also
include a frequency for which the contained data is valid. This
makes it possible to specifically set all absorption coefficients to
be used for the relevant frequency. Note that when one of these
particular datagrams are used SIS will require one datagram for
each of the frequencies used by the echo sounders (i.e. 12, 31.5,
60, 70, 80, 90, 95, 100, 200 and 300 kHz). They must be sent
within 10 sec. (currently) of each other and have the same
acquisition date and time.
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A subset off the SSP datagrams, specifically S00, S01, S02,
S03, S04 and S05, will be used immediately. That is the
corresponding sound velocity profile and absorption coefficients
will be sent to the PU(s) and the Runtime parameters frame, if
present, will be updated with the new file set information.
When SSP datagrams are received by SIS, the SVP Editor will
always be informed of the new .asvp and .abs files. A warning
will be given if the SVP Editor is not running.
Using the SVP editor the user may edit the .asvp and .abs files
and store the edited files. The user can select to use these files
by selecting the .asvp file, i.e. sound profile, from the Runtime
parameter’s Sound Speed’ tab.
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7.14 Implementation of absorption coefficients

Overview
The absorption coefficients in SIS may be set using three
different sources:
• Salinity
• CTD profile
• Manual
In principle SIS can handle several echo-sounders each with its
own source setting.
As a consequence SIS must maintain and control two different
sets of profiles: One based on the currently set salinity value and
one based on the CTD (Conductivity, Temperature and Depth)
information received in an SSP datagram. The third alternative,
Manual, results in the user entered absorption coefficient values
being used immediately.
→ Absorption coefficient parameters, page 240.
→ SSP datagrams, page 395.

Absorption coefficients are dependent on the used frequency.
All profile sets should therefore contain one absorption
coefficient file for each frequency used by the multibeam
echo-sounders employing this absorption coefficient
implementation.
(Today the required range of frequencies for the complete
multibeam range of echo-sounders are 12, 32, 60, 70, 80, 90,
95, 100, 200 and 300* kHz. (* used to calculate for 297 and 307
kHz internally in EM 3000 and EM 3002 Processing Units).

Salinity based absorption coefficient
profiles
This type of absorption coefficient profiles are based on a ’depth
and sound speed profile’ and the currently set salinity value.
The ’depth and sound speed’ profiles can be obtained from two
sources:

1 Reception of a SSP datagram of format S00 or S10 from
the network.

2 The operator may select an ordinary SVP using the
runtime parameter ’Sound Speed Profile’ interface.

→ SSP datagrams, page 395.
→ Runtime parameters for multibeam, echo sounders, page 37.
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In both cases a set of absorption coefficient files is generated.
All files in a set use the same naming convention: In case of a
SSP datagram (S00 or S10) the date and time contained in the
datagram becomes first part of the file name. In case of an
operator selected SVP file the original file name is used instead.
Next, the currently set salinity is included together with the
frequency for which the file is valid. See example sets below.
Note that there is an .asvp -file in each file set containing the
depth and sound speed data used in the calculations. This file is
named the same as the rest in the set except that the frequency
part is absent. This file is constructed based on the SSP input
(S00/S10) or the user selected SVP. In the latter case the file
contains exactly the same data as the original SVP file used (e.g.
’Horten20050304.asvp’ and
’Horten20050304_salinity_03900.asvp’ contains exactly the
same data, see example below). The duplication and renaming
of the original user selected ’.asvp’ file is done so that it shall be
simple to retrieve a complete file set including the ’.asvp’ file
using only the basic file name as key.

Note The absorption coefficient file with frequency 32 kHz is actually
for the 31.5 kHz system (EM 300).

Example of salinity file set based on S00 or S10:
20051230_183344_salinity_03900.asvp
20051230_183344_salinity_03900_12kHz.abs
20051230_183344_salinity_03900_32kHz.abs
20051230_183344_salinity_03900_60kHz.abs
20051230_183344_salinity_03900_70kHz.abs
20051230_183344_salinity_03900_80kHz.abs
20051230_183344_salinity_03900_90kHz.abs
20051230_183344_salinity_03900_95kHz.abs
20051230_183344_salinity_03900_100kHz.abs
20051230_183344_salinity_03900_200kHz.abs
20051230_183344_salinity_03900_300kHz.abs
Example of salinity file set based on user selected SVP called
’Horten20050304.asvp’:
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Horten20050304_salinity_03900.asvp
Horten20050304_salinity_03900_12kHz.abs
Horten20050304_salinity_03900_32kHz.abs
Horten20050304_salinity_03900_60kHz.abs
Horten20050304_salinity_03900_70kHz.abs
Horten20050304_salinity_03900_80kHz.abs
Horten20050304_salinity_03900_90kHz.abs
Horten20050304_salinity_03900_95kHz.abs
Horten20050304_salinity_03900_100kHz.abs
Horten20050304_salinity_03900_200kHz.abs
Horten20050304_salinity_03900_300kHz.abs

A new salinity based absorption coefficient file set is generated
in the following instances:

• When a new S00 or S10 datagram is received from the
network.

• When the user selects a new SVP from the runtime parameter
’Sound Speed Profile’ interface.

• When the Source is Salinity and the salinity value is changed
and no existing file set is found for the new salinity.

• When the user selects Salinity as Source and no existing file
set is found for the currently set salinity value.

CTD based absorption coefficient profiles

CTD based absorption coefficient profiles are only generated
based on SSP datagrams with formats other than S00 and S10.
These other datagrams may contain the absorption coefficient
directly (with appropriate frequency listed) or they contain the
necessary CTD data to calculate the absorption coefficient
profiles for all frequencies.
→ SSP datagrams, page 395.

Note that when the SSP datagram contains the absorption
coefficient directly (datagrams S13, S23, S33, S43, S53) this
datagram is valid for one frequency only. To be able to generate
a full set of absorption coefficient files one SSP datagram of the
same type for each used frequency must be received. The
interval between the reception of individual datagrams must be
max 10 sec. (currently). The internal date and time in the SSP
datatagrams must be the same for all in the received set.

Note again that the requirement is that one such SPP datagram
must be received for each of the frequencies 12, 32, 60, 70, 80
90, 95, 100, 200 and 300 kHz.
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When received by SIS, the SSP datagrams S01, S02, S03, S04
and S05 will result in an automatic and immediate use of the
confined information. Therefore it’s not necessary for the
operator to make a manual selection for the associated SVP.

The name of CTD based absorption coefficient file sets is
constructed in the same way as for S00/S10 based sets without
the salinity part.

Example of a CTD file set, based on SSP datagrams different
from S00 and S10:

20051230_183344_03900.asvp
20051230_183344_12kHz.abs
20051230_183344_32kHz.abs
20051230_183344_60kHz.abs
20051230_183344_70kHz.abs
20051230_183344_80kHz.abs
20051230_183344_90kHz.abs
20051230_183344_95kHz.abs
20051230_183344_100kHz.abs
20051230_183344_200kHz.abs
20051230_183344_300kHz.abs

The CTD file set also contains an ’.asvp’ file. This file is
generated (directly or calculated) based on the contents in the
SSP datagrams.

Note that when selecting a SVP from the runtime parameter
’Sound Speed Profile’ interface it is regarded as a CTD file set
only if the file name does not contain ’salinity’ and all
frequency files are present.

In all circumstances a new salinity based file set is also
generated from the selected SVP and current salinity. That is
when a CTD based file set is selected,also a corresponding file
set for the currently selected salinity is made.

Modus operandi

When the system is initialized the first time a system provided
default file set is used both for the salinity based and the CTD
based absorption coefficients. It is therefore important that
realistic file sets are generated and selected as soon as possible
when using SIS. However the current salinity and CTD based
file sets will always be remembered and used e.g. after a restart.
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When new file sets are generated upon reception of SSP
datagrams the information about the new file set is sent to the
SVP editor. This editor may be used to modify the data contents
of the file set (e.g. thinning). The operator may subsequently
select the modified file set using the runtime parameter ’Sound
Speed Profile’ interface.
→ SVP Editor, page 442.

A file set that has been thinned, using the SVP editor, will
contain ’thinned’ in the file name, e.g.

20051230_183344_thinned_03900.asvp
20051230_183344_thinned_12kHz.abs
20051230_183344_thinned_32kHz.abs
20051230_183344_thinned_60kHz.abs
20051230_183344_thinned_70kHz.abs
20051230_183344_thinned_80kHz.abs
20051230_183344_thinned_90kHz.abs
20051230_183344_thinned_95kHz.abs
20051230_183344_thinned_100kHz.abs
20051230_183344_thinned_200kHz.abs
20051230_183344_thinned_300kHz.abs

The Processing Units are updated with new absorption
coefficients according to the following principles:

• Every 15 sec. (currently) the depth measured by each
echosounder is received by the CCU (which handles the core
functionality of the absorption coefficient system).

• If the current selected Source is Salinity or CTD-profile an
absorption coefficient deviation value is calculated for each
frequency used by the echosounder. This deviation value is
based on the previous and current absorption coefficient for
each frequency and a max range estimated from the received
depth. If the found deviation for any frequency is greater
than a preset limit (currently 0.2 dB) the new absorption
coefficient for each frequency are sent to the Processing Unit.

• When calculating the absorption coefficients the current
Source selection determines if the Salinity based file set or
the CTD based file set is used.

In any case, when a new set of absorption coefficients are sent
to the PU the values for each frequency are displayed in the
runtime parameter’s ’Filter and Gains’ frame.

Also, the currently used salinity and CTD-based absorption
coefficient file sets are displayed in the runtime parameter
’Sound Speed Profile’ interface.
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Note Initially SIS is configured to use and store the Salinity and CTD
based absorption coefficient file sets in one pre-defined
directory. This can be changed by selecting a Salinity or CTD
based file set from another location by using the runtime
parameter ’Sound Speed Profile’ interface. All new (i.e.
generated) file sets of the specific type selected above (Salinity
or CTD) will be stored in this new location. Thus, Salinity and
CTD based file sets can be stored in different locations.

Note SIS will never remove any absorption coefficient file set from it’s
storage location(s). If any clean-up/removal is performed by the
operator care should be taken not to remove the currently used
Salinity or CTD based file set as listed in the display.

Note The system provided default absorption coefficient file set,
called ’default’ should never be deleted or moved from its
original position.
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7.15 The absorption coefficient equation
The mean absorption coefficient of the water column is used in
the gain setting in the receiver.
The absorption coefficient is important in determining the
correct backscattering strength of the seabed used in the seabed
imaging. Setting a correct value is therefore always
recommended if the backscatter data are to be used, especially if
the results are to be compared with those from other areas.
The absorption coefficient α is given by the following equation:

α = A1 f1 f2

f2 + f21
+ A2 P2 f2 f2

f2 + f22
+ A3 P3 f2

where

A1 =
8.86 ⋅ 10 ( 0.78 pH − 5 )

c

A2 =
21.44 S (1 + 0.025T)

c

A3= 4.937 ⋅ 10−4− T(2.59 ⋅ 10−5− T(9.11 ⋅ 10−7− 1.5 ⋅ 10−8 ⋅ T)),T ≤ 20˚C

A3= 3.964 ⋅ 10−4− T(1.146 ⋅ 10−5− T(1.45 ⋅ 10−7− 6.5 ⋅ 10−10 ⋅ T)),T ≥ 20˚C

P2 = 1 − Z(0.137 − 0.0062 Z)

P3 = 1 − Z(0.0383 − 4.9 ⋅ 10−4 Z)

f1 = 2.8 S
35
 ⋅ 10

4 − 1245
273 + T


f2 =
8.17 ⋅ 10

8 − 1990
273 + T


1 + 0.0018(S − 35)

Here, α is given in dB/km, the sound speed c in m/s, the
temperature T in _C, the depth Z in km, the salinity S in ppt, and
the frequency f in kHz. The pH of the ocean is in the order of
7.6-8.2.
The mean values are the mean absorption coefficient from the
surface to the depth indicated, and is the value to be entered in
the menu.
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The absorption coefficient equation is from R. E. Francois and G.
R. Garrison, “Sound absorption based on ocean measurements:
Part II: Boric acid contribution and equation for total
absorption,” J. of Acoust. Soc. Am. 72(6), Dec. 1982, p 1886.
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7.16 Projections

Scope

This chapter gives in-depth information on the Projection
component. The purpose with the chapter is to describe how to
program a projection and how a projection can be defined using
the projection library.

Programming a projection

On the Installation CD there is a directory called UserSrc. This
directory contains a template for programming your own
projections. On a Windows system use usersrc.dsp and program
the projection in Microsoft Studio. On a Linux system, simply
program the projection and compile using the Makefile.

On a Windows PC the output is a dynamic link library,
userProj.dll. Copy this file to the location where SIS is installed
and replace the existing file.

On a Linux system, the output is a shared library libuserproj.so.
Copy this file to the location where SIS is installed and replace
the existing file.

You create your own projection in the file userProj.cpp. Follow
the example in the file:

1 Create the routines you want to use. You have to define
three routines, one for initialization of the projection, one
for the projection and one for the inverse projection. It is
important that the parameters are correct, see the example.

2 Edit the routine InitUserProjection. In the
switch-statement add a number and call your initialization
routine. The number is important. You must choose a
number larger than 1000 as SIS is already using the
numbers below 1000. Each projection must have an
unique number.

3 Edit the routine ForwardProjection. In the
switch-statement call your forward projection.

4 Edit the routine InverseProjection. In the switch-statement
call your inverse projection.

5 Compile and install the shared library.

6 Start SIS. Open the “Survey templates” window and find
the tab where you define the projection. Then choose
“Create new projection” and this program starts.
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7 Choose “New...” and give the new projection a proper
name. Next choose the projection type to be “User
defined”, and the number you put in must be the same as
the one you just programmed.

8 Make sure to test your projection before you start using it.
You have now created your own projection.

Note If you later reinstall SIS, this projection will be gone. You have
to save the shared library file and install it after you install or
upgrade SIS.

Using PROJ.4
You can also define a projection using the projection library
PROJ.4. A 7-parameter datum transformation is already
available in SIS.
The following text file defines a PROJ.4 projection:
<MyProjection>
ellps=WGS84
proj=utm
zone=32
units=cm

The parameter ellps must be defined, and units=cm must be
used.
To add a 7-parameter datum transformation, the setup is like
this:
<MyProjection>
ellps_from=Bessel
rotXrad=0.0000001
rotYrad=0.0000002
rotZrad=0.0000003
dXm=150.0
dYm=160.0
dZm=170.0
scale=0.9998
ellps=WGS84
proj=utm
zone=32
units=cm

Note that rotXrad, rotYrad and rotZrad are expressed in radians,
and that dXm, dYm and dZm are expressed in meters. The
primary ellipsoid is defined after ellps_from and the secondary
ellipsoid will be befined by ellps.
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The to and from definition of the ellipsoids are the names of the
ellipsoids found in the list of ellipsoids. You see this list when
you define the projection.
The transformation parameters themselves must be put in by the
operator.
The operator should save this setup in a textfile. He can then
define a PROJ.4 projection as described above. In the text field
where he types the PROJ.4 projection, type something like this:
+init=/mydir/somefile.txt:my_projection

This means that the projection is named my_projection and is
defined in the file \mydir\somefile.txt.
For PROJ.4 details see the doc - dirctory
Windows:
C:\Program Files\Kongsberg Maritime\SIS\doc
Linux:
use/local/SIS/doc
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7.17 Geoid
If heights are extracted from the positioning system, geoid
models can be used.
In this case the geoidmodel.geoid file must be put together with
the background data, see New Survey.
→ New survey, page 134.
The figure below shows the various distances used in the geoid
calculations.

Figure 56 The RTK/geoid model

Water surface

RTK

EM
B C A D E

F

H
I

G

(CD22010)

Vertical reference
Seafloor

Geoid

Ellipsoid

A: Distance from the echo sounder to the seafloor.
B: Distance from the antenna to the ellipsoid.
C: Motion corrected distance (depth) from water surface to
seafloor.
D: Motion corrected distance (height) from water surface to
ellipsoid.
E: Distance from the sea surface to the vertical reference (tide).
F: Distance from the ellipsoid to the geoid (geoid undulation),
positive if the geoid is above the the ellipsoid.
G: Distance from the geoid to the vertical reference, positive if
the vertical reference is above the geoid.
A is the measured distance from the echosounder to the seafloor.
This distance is corrected using the installation parameters and
the motion sensor to C which is then the distance from the
watersurface to the seafloor.
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Because the heave sensor only reacts to fast changes, the
watersurface is really defined by the 0-level of the heave sensor.
The RTK-system gives the distance from the antenna to the
ellipsoid (B). This distance is corrected using the installation
parameters and the motion sensor to D, which is the distance
from the sea surface to the ellipsoid.
Note that both the EM and the RTK is now referred to the same
vertical level, the sea surface.
The geoid model contains the distance from the ellipsoid to the
geoid (geoid undulation) and the distance from the geoid to the
vertical reference.
The tide E is then computed like this: E = D - F - G.
H is the distance from the vertical reference to the seafloor and
can now be computed like this: H = C - E.
I is the distance from the seafloor to the geoid and is computed
like this: I = G - H.
The next figure shows the layout of the geoid file. This layout is
chosen to fit to rivers where the geoid undulation and vertical
reference is known at crossprofiles along the river (the vertical
lines are then the riverbanks). It is then possible to define
several “rivers” in one file thus allowing general areas to be
defined. The file format is then like this:

Figure 57 Layout of the RTK/geoid model

(C
D

22
01

0)

1 latitude(degrees) longitude(degrees) F(meters) G(meters)
2 latitude(degrees) longitude(degrees) F(meters) G(meters)
3 latitude(degrees) longitude(degrees) F(meters) G(meters)
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The line starting with 2 is optional. The crossprofile may be
defined using two or three points, the first point has the id 1 and
the last point the id 3. If there is a middle point, it has the id 2.
Latitude and longitude are positive north of the Equator and east
of Greenwich, negative on the other side.
An area is defined between two crossprofiles. A model (“river”)
must always have at least two crossprofiles. Several models
(“rivers”) in the same file shall be separated by an empty line.
The geoid undulation F and the vertical reference G is
interpolated using straight lines between crossprofiles.
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7.18 Tide
Tide input to SIS can be either real time tide on an UDP socket
from serial line or predicted tide in a file.
Realtime tide:
Datagrams like this can be sent on UDP to port 4001:
$ATIDE,20040512073406,1.74*00

The header is always $ATIDE. Then comes the time
YYYYMMDDttmmss, and then the tide in meters.
The checksum is currently not used, but must be present.
Note that the tide is ADDED to the depths.
Predicted tide:
A tide file with the name predictedtide.tide can be stored
together witht the background data for the survey, see New
survey.
The format is like this:
(Tide)

20040512073655 1.74

20040512073755 3.42

20040512073855 5.00

20040512073955 6.43

20040512074055 7.66

20040512074155 8.66

20040512074255 9.39

20040512074355 9.85

20040512074455 10.00

20040512074555 9.85

20040512074655 9.40

20040512074755 8.67

20040512074855 7.67

20040512074955 6.44

20040512075055 5.01

20040512075155 3.43

20040512075255 1.75

20040512075355 0.02

20040512075455 -1.72

20040512075555 -3.40

20040512075655 -4.98

20040512075755 -6.41

20040512075855 -7.65

20040512075955 -8.65

20040512080055 -9.39

20040512080155 -9.84

20040512080255 -10.00

20040512080355 -9.85

20040512080455 -9.41

20040512080555 -8.67
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The first line is a header enclosed in parenthesis. The first word
must be Tide.
Then comes the tide data. The time format is
YYYYMMDDhhmmss and the tide is in meters.
Note that the tide is ADDED to the depths.
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7.19 Changing the behaviour of messages
Messages generated in SIS are defined in a file found in the
directory where SIS is installed. For Windows, typically:
• C:\Program Files\Kongsberg Maritime\sis\bin
and for Linux:
• /use/local/sis/Database
There is a file for Windows called:
• messages_R_Sy.uni
and for Linux:
• pmess.sql
which defines all messages and the behavior in SIS when they
occur.
This file is in UNICODE and must be edited in an editor that
supports UNICODE, like WordPad in Windows or Kate on
Linux. Here the operator can change both the text message and
the type of the message.
The header of this file describes the valid types. Each message
has a type-field which can be set to the operator’s preferences.
Simply change the type-field for the messages you want and
save the file. Make sure you save it as UNICODE.
Then open a terminal window in the directory where you saved
this file. Issue this command in Windows:
osql -Usisuser -Psimrad0 -imessages_R_Sy.uni

and on Linux:
SIS will now react to the messages as described in the file.
psql -d sis -U sisuser - f pmess.sql

Note These settings may be lost when SIS is updated or reinstalled. If
you want to make sure you always have these settings, save this
file somewhere on your system and reapply it when SIS is
reinstalled or updated.
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7.20 Request datagrams from an echo sounder
When an echo sounder is registred on the network in SIS,
datagrams can be routed from the echo sounder to another UDP
port on the network.
First connect the echo sounder to the network and start SIS.
Select the echo sounder and configure it. Then start the Request
datagrams program from the Tools menu in SIS.

Figure 58 Request datagrams from an echo sounder
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The echo sounder shall now be selected in the first pulldown
menu. Then select which datagram you want from the second
pulldown menu. The third pulldown menu lists the options for
sending out the datagram, either all datagrams that arrives or
only some datagrams at regular intervals. Fill out the textfield
IP:Port with IP-address and UDP port number where the
datagram shall be sent to. Remember: between the address and
the port number.
Now press ’Subscribe’. The next time SIS starts the echo
sounder, the requested datagram type will be sent to the
requested address at the specified interval.
To stop sending datagrams, select the datagram from the list and
press ’Unsubscribe’.
Never try to ’Unsubscribe’ to the factory defined datagrams.
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7.21 Subscription of datagrams from DDS

Note This chapter is intended for advanced users only. It is simpler to
subscribe on datagrams by selecting Tools > Custom >
Datagram subscription. See page 415.

Overview
The subscription setup of datagrams from the DDS can be
performed in two ways:
1 By using a provided utility (see note above) specifying the

relevant echo sounder, datagram and subscriber IP
address. These entries are semi permanent i.e. valid until
the database is completely rebuilt.

2 By updating the database tables manually. These changes
will be permanent. Currently this option requires that the
database is completely rebuilt.
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Manual update of database tables
The SIS DDS has the ability to distribute (i.e. retransmit)
datagrams received from the Processing Unit (and other
sources) out to external recipients. This distribution is done
according to settings in the SIS database. Therefore, in order for
an external receipient to subscribe to a particular datagram, the
SIS database must be updated to distribute the datagram.
Note that SIS contains several DDS applications of different
types. Each type is adapted to handle a specific type of
Processing Unit or equipment. Currently three DDS types are of
interest:
1 A generic multibeam type (EM 3000, EM 3002, EM 2000,

EM 1002, EM 710, EM 300, EM 120)
2 A generic NMEA single beam type (receiving NMEA

DPT or NMEA DBT, NMEA GGA, NMEA HDT or
NMEA HDM)

3 A type for GPS and compass (receiving NMEA GGA,
NMEA HDT or NMEA HDM)

The SIS Database

The SIS database contains several tables which defines the
datagram distribution setup in DDS. These tables can be divided
into four categories:
1 A category with one table defining the datagrams and the

distribution parameters.
2 A category with one table defining sockets used for

sending datagrams.
3 A category with one table linking the two, i.e. defining

which datagram to be sent on which socket.
4 A category with several tables organizing datagrams and

sockets according to type of DDS process.

Table ’dds_datagrams_send’ (category 1)

This table is used to define all datagrams which can be
distributed by a DDS. Each entry (i.e. row) is identified by a
datagram id (’id_datagram’) which must be unique.
The ’dds_datagrams_send’ table normally only needs to be
updated when new datagrams are defined or new DDS types are
added. However, when a datagram subscription is defined it is
necessary to know the correct ’id_datagram’ value as this value
is used in other tables.
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Figure 59 Relevant SIS database tables for subscription configuration
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processname
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’id_datagram’

Note that the datagram identifiers are organized in ranges or
sets, one for each type of DDS (i.e. PU or equipment type) - see
’user_pid’ below. The generic EM multibeam set currently has
an ’id_datagram’ range from 36 to 302 (with some holes).
NMEA singlebeam has a range from 400 to 475 and the GPS
compass type has a range from 500 to 575.

’datagram_type’

The ’datagram_type’ parameter defines the type of datagram
(e.g. Depth =’D’ = 68) associated with the specific datagram id.
The same datagram type may be used in all ranges, if relevant,
but only once in each range.

’interval’
’seconds’

These parameters are used to define how the associated
datagram should be distributed.
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The ’interval’ parameter may have the following values:
0 - Distribute signal when received.
1 - Distribute signal repeatedly with a set interval defined by the
’seconds’ parameter.
2 - Distribute signal when received and repeat, as above.
3 - Distribute signal only upon request (currently not
implemented).

’user_pid’

This parameter identifies the DDS type associated with the
’id_datagram’ parameter.
The correct ’user_pid’ value is found in the ’process’ table as
the ’pid’ parameter (marked with bold in entries below):
1 DDS generic multibeam type (EM 3000, EM 3002, EM

2000, EM 1002, EM 710, EM 300, EM 120) is entry:
(10,’DDS_GENERIC_EM’)

2 Generic NMEA single beam type is entry:
(14,’DDS_GENERIC_SINGLEBEAM_NMEA’)

3 For GPS and compass is entry:
(13,’DDS_GENERIC_GPS’)

The range scheme and the use of the same datagram type in
several ranges allow datagrams to be handled differently for
each DDS type (i.e. PU/equipment type).

Table ’dds_periodic_datagrams’ (category 4)

This table defines which datagrams, (defined in
’dds_parameters_send’) belong to which DDS type. Each entry
(i.e. row) defines such a relation.
The ’dds_periodic_datagrams’ table normally only needs to be
updated when new datagrams are defined or new DDS types are
added.

’id_dds’

This parameter identifies the DDS type. The correct value is
found in the ’process’ table as the ’pid’ parameter (marked with
bold in entries below):
1 DDS generic multibeam type (EM 3000, EM 3002, EM

2000, EM 1002, EM 710, EM 300, EM 120) is entry:
(10,’DDS_GENERIC_EM’)

2 Generic NMEA single beam type is entry:
(14,’DDS_GENERIC_SINGLEBEAM_NMEA’)

3 For GPS and compass is entry:
(13,’DDS_GENERIC_GPS’)
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’id_datagram’

Id of datagram from the correct range in the
’dds_datagrams_send’ table according to DDS type.

Table ’sockets (category 2)

This table defines all sockets in the SIS system including all
sockets used by DDS.
If a subscription is added or changed it may be necessary to
define a new socket or change an existing socket. The socket
will be used by DDS for sending the subscribed datagrams to
the recipient.

’id’

Each socket in SIS should have an unique id. This is an integer
number. Before selecting an id for the socket make sure it is
below 1000 and not already used (make a search in the
SISDB_v3.sql and any other SISDB_vX.sql file with a higher
version than X=3).

’port’
’ip’

This is the net address for the recipient of the subscribed
datagram(s).

’udp_tcp’

0 = UDP, 1 = TCP
The UDP protocol should always be used. This setting
should therefore be 0.
’server_client’

0=server, 1=client, 2=unused.
SIS is a server. This setting should therefore be 0.

’read_write’

0=read, 1=write, 2=read and write.
The socket is always write. This setting should therefore be 1.

’pid’

This parameter gives an id to the recipient on the other side of
the link. For the purpose of distributing datagram from the DDS
to an external recipient the pid-value must be set to 76 -
NOTE this value.

Table ’process_socket’ (category 4)

This table defines which sockets, (defined in ’sockets’) that
belong to which process. Each entry (i.e. row) defines such a
relation.
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The ’process_socket’ table needs to be updated when new
datagrams are defined or new DDS types are added.

’process_id’

This parameter identifies the process using the socket; in this
case that is a DDS type. The correct value is found in the
’process’ table as the ’pid’ parameter (marked with bold in
entries below):
1 DDS generic multibeam type (EM 3000, EM 3002, EM

2000, EM 1002, EM 710, EM 300, EM 120) is entry:
(10,’DDS_GENERIC_EM’)

2 Generic NMEA single beam type is entry:
(14,’DDS_GENERIC_SINGLEBEAM_NMEA’)

3 For GPS and compass is entry:
(13,’DDS_GENERIC_GPS’)

’socket_id’

Id of the socket used to distribute datagrams to the recipient.
The ’socket_id’ is found in the ’sockets’ table as the ’id’ (see
above) of the relevant socket definition.

Table ’dds_socket_send’ (category 3)

The table is used to connect datagrams with sockets, i.e. it tells
which datagrams (identified by ’id_datagram’) that should be
sent out on which socket.
This is the essential routing information necessary to be able to
distribute the datagrams to the correct recipient.

In essence, all the other tables are only help tables necessary to
define the datagrams and sockets (and who they belong to)
whereas the routing information in ’dds_socket_send’ is what
we really want to specify.

’id_datagram’

A defined datagram id belonging to a DDS type which is the
same as for ’id_socket’ below.

’id_socket’

A defined socket id belonging to a DDS type which is the same
as for ’id_datagram’ above.
When making entries in this table, care must be taken to
pair only datagrams and sockets associated with the same
DDS type (identified by ’process_id’ in ’the ’process_socket’
table and ’id_dds’ in the ’dds_periodic_datagrams’ table
respectively).



Technical references

423850-164709 / E

Procedure for setting up a datagram subscription

The tables to be modified are located in the ’SISDB_v3.sql’
file.
1 Check if the datagram to be subscribed exist in

’dds_datagram_send’ table for the relevant DDS type. If
not define it. Remember the ’id_datagram’ value.

2 Check if the datagram exist in the
’dds_periodic_datagrams’ table for the correct DDS type.
If not define it.

3 Make a socket for the recipient, in the ’sockets’ table
using correct IP address. Remember the ’id_socket’ value.

4 Make an entry in the ’process_socket’ table with the new
’id_socket’ value and the relevant DDS type.

5 Make an entry in the ’dds_socket_send’table with the
correct combination of ’id_datagram’ and ’id_socket’.
Note that a socket can be used for several datagrams.

6 The SIS database must be re-built and SIS restarted.

Important notes and restrictions

• All entries in the tables described above are currently done
with reference to three DDS types. These types are regarded
as templates used to instantiate database entries for new echo
sounders detected on the network. Instantiation is necessary
due to the fact that several echo sounders can not use the
same data and the same objects (e.g. sockets.) Each echo
sounder will therefore get a separate set of sockets and
datagram ids, which mean that the specific values entered in
the tables above, are not actually used for any echo sounder.

• However, the IP address for the recipient of a datagram is a
value that can not be instantiated. This implies that the
DDSes for e.g. EM 3000, EM 3002, EM 2000, EM 1002,
EM 710, EM 300, EM 120 will send a datagram to the same
recipient if they are detected in the same SIS system.

• When the changes in the SIS database are performed the
database must be re-built and SIS restarted.

• The settings will be semi permanent, i.e. they will be in
effect until the database is completely rebuilt.

• Currently no facilities for removal or listing of subscribed
datagrams are available.
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7.22 Data Distribution
The DataDistrib program is included with SIS. This is a
Windows application that can be used to route or distribute UDP
datagrams to various destinations on the local PC or to other
networked PCs.
The application has a graphical user interface where you can set
up distribution of data from up to 10 different sources. In a grid
you set up the incoming sockets from where to listen to data and
up to four different destinations for each source. It also possible
to store incoming data to a file and later replay that file. If you
want to replay data, a file name is entered instead of a source
port.
Make sure that you enter a Source port that is not used by any
other applications, e.g. rstoudp, as two application cannot use
the same port simultanously.
Only the DataDistrib.exe file must be installed on the PCs where
the application should run. Settings are stored in DataDistrib.ini.

Figure 60 DataDistribution user interface
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7.23 Remote datagrams
These datagrams allow external systems a minimal amount of
control of SIS. The datagrams are received by SIS from the
connected network using the UDP protocol.

Datagram Received on port Description

R00 4002 SIS to stop pingning (and logging if on).
R10 4002 SIS to stop all logging, but continue or start pinging.
R10 4002 SIS to start logging on new line

R20 4001 Echosounder to send installation, runtime and sound
speed profile (I, R and U) datagrams.

Note The Rxx datagrams must always contain the sounder type i.e.
EMX=dddd, . This is currently the only parameter in the Rxx
datagrams that is used.

Currently SIS has support for the following remote datagrams:

R00, R10 og R12
R00, R10 and R12 closely mimic the use of the logging and
ping buttons. There are no restrictions on the sequence in which
these datagrams can be sent. The following is typical:
• To start pinging: R10.
• To start logging: R12 (Note that it is not necessary to start

pinging with R10 first).
• To stop logging: R10 or R00. (Note R00 also stops pinging).
• To stop pinging: R00.

When the remote Rxx datagrams are received the sounder type
indicated in the datagram is made current. The SIS GUI is
updated accordingly so that the ping and logging buttons will
show the correct status.
→ See Main Toolbar on page 340.

Note The relevant echo sounder must have been started for the R00,
R10 and R12 datagrams to have any effect. SIS will behave as if
the ping and logging buttons have been used, including line
counter increment.
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R20
R20 is used to get an echo sounder (PU) to transmit the setup
parameters currently used. These parameters are normally
distributed by the PU, to the external system(s), using its UDP4
port.
→ See Main Toolbar on page 165.)

Note The relevant echo sounder must have been started for the R20
datagram to have any effect.
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7.24 Global Event Marker
The Global Event Marker system consists of two programs:
• One server that runs on an Operator Station (for example the

HWS 10) connected to a multibeam echo sounder (EM)
Processing Unit (PU)

• One or more clients on Windows PCs in the network
The Global Event Marker Server (GEMS) needs two inputs;
position datagrams from an EM PU, and events from Global
Event Marker clients on the network.
Note that the PU will send position datagrams to GEMS even
when the EM is not pinging.
GEMS will send events to other SIS installations on the
network, including Helmsman Displays. The IP addresses of
these installations must be set in GEMS.
GEMS will also send CS datagrams to single beam
echosounders (EA). CS datagrams are sent as broadcasts on the
network, so only the UDP port must be set in GEMS.

All events are logged to a file, normally
events.ksgpl. In the File menu the operator can
open any file. When the file is opened, all
events in that file is sent to all SIS
installations.

The operator can also at any time resend all events to all SIS
installations from the View menu.
The last event is displayed in the textfield together with the
IP-address of the sender.

Options in GEMS are found in the File menu. The first lines set
the UDP port where events arrive. This port number must be the
same as the port number in the file Events.ini used by the
Global Event Marker clients (see below).
Events are sent to a list of SIS programs. The format of this list
is xxx.xxx.xxx.xxx:nn,xxx.xxx.xxx.xxx:nn,...
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xxx.xxx.xxx.xxx is the IP address and nn is the UDP port
number, normally 4012. Remember to use a comma (,) to
separate the addresses.
Positions are read from a UDP port. This must be the same port
number that the EM PU sends datagrams to.
EAs listen for CS datagrams on a port, normally 10183.
The last event is also sent as broadcast to all Global Event
Marker Clients (GEMC). All of them will then display the time
the event arrived and the associated text.

The GEMC can be installed on any Windows PC in the network.
Simply copy the files Events.exe and Events.ini to a directory
and run Events.exe from that directory. The file Events.ini can
be used to set the parameters and texts for this window. Note
that the IP-address in Events.ini is the IP address of the PC
running GEMS.
The operator can then send an event to GEMS simply by
pressing the button. A text is optional and can be sent together
with the event.
The last event on the network is displayed in the textfield below,
together with the IP-address of the sender and the time the event
occured.
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7.25 Connect to license server
Unless a multibeam echo sounder is present in the network, SIS
must connect to a licence server. At least one licence server
must be available.
You can change the settings so that a different licence server is
used:
1 Use the Network License menu under Set parameter for

seting up another License Server. SIS has to be restarted to
change license server.

→ See Set network licence on page 377

2 The web-server must be restarted to change the licence
server for the GridEngine.
- If no licence server is present, SIS may still be

operational if a Kongsberg multibeam echosounder is
found on the network. This will allow you to perform
basic logging fuctions.
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7.26 SeaCal

What it does
SeaCal is a program used to compute the calibration values of
the multibeam echo sounder. Reliable data from the multibeam
echo sounder can only be acquired after proper calibration of the
static offsets in system parameters such as roll, pitch, heading,
eccentricity of the transducer relative the antenna of the
positioning system in x and y etc.
This calibration method is based on global match of the
calibration lines. It does not presume that we have information
about the true relief of the seafloor. The method computes the
calibration parameters from least squares adjustment, and it
offers a broad range of static offset parameters to be computed
and the derivation of the correlation between them. The
program computes calibration parameters from parallel or
crossing lines. The calibration lines must follow straight lines,
i.e., curved calibration lines are not allowed. The number and
the length of the lines are limited by the amount of computer
memory and the speed of the computer processor. The figure
below shows the coordinate axes used.

Figure 61 Definition of the coordinate axes
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Calibration parameters
SeaCal is able to compute several kinds of calibration
parameters. The two main groups of parameters are those
common and individual for the lines. The following calibration
parameters are defined:

Symbol Definition
• Roll Δφ φ′ = Δφ+ φ

• Pitch Δω ω′ = Δω+ ω

• Heading ΔÀ À′ = ΔÀ+ À

• Translation in x Δx x0′ = Δx+ x0

• Translation in y Δy y0′ = Δy+ y0

• Relative tide correction Δh0 h0′ = Δh+ h0

• Roll scale factor mφ φ′ = mφφ

• Horizontal scale factor my y′ = myy

x is measured along the line and y is perpendicular to x, so y is
measured in the swath direction.
Factor mφ is a kind of parameter related to the inner calibration
of the multibeam echo sounder, but it can also be explained by
uncertain computation of the refraction of the beams, i.e., the
accuracy of the sound speed profile. Parameter my is a horizontal
scale factor in the swath direction. It is motivated from the
influence of errors in the sound speed.

Design of the calibration lines
The accuracy of the calibration depends on the topography of
the seafloor, and the configuration of the calibration lines.
Therefore, the calibration lines should be located in an area with
satisfactory relief and they should follow a certain pattern, i.e., a
configuration that allows the computation of the parameters.
The Effect of offset figure below illustrates the effect of offsets
in the calibration parameters. From the figure we observe that
calibration for heading and the two scale factors require lines
with parallel displacement. Offsets in roll, pitch, x and y are best
computed from lines in opposite directions which overlap each
other 100 %.
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Figure 62 Effect of offsets in the
calibration parameters

Roll and roll-scale have a vertical and a horizontal component.
Their vertical component makes it possible to calibrate them
even in a flat area.
The horizontal component of Δφ has very similar influence on
the measured depth values as Δy. This correlation is not a
problem in field calibration, since the vertical component of Δφ
separates it from Δy.
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Offsets in pitch and x have also very similar error patterns.
Therefore, the two parameters are often highly correlated. Their
separation depends on the relief of the seafloor. They can be
separated if the seafloor has satisfactory depth variation.
Pitch, heading and x calibration require that the lines run in the
direction of the terrain slope, whereas y and Y-scale calibration
require terrain slope across the run direction.
Based on the geometric interpretation of the Effect of offset
figure above, we can conclude that we need at least three
calibration lines in order to compute all the parameters, i.e., two
100 % overlapping lines for the computation of Δφ, Δω, Δx and
Δy, and a third line for ΔÀ, mφ and my.
Since the random measurement errors of the multibeam echo
sounder and the relief of the seafloor have great impact on the
accuracy of the parameters, calibration lines in addition to the
minimum required will strengthen the calibration. For example,
we can apply four, eight or twelve lines as illustrated in the
Configurations figure below. How many lines to measure,
depends on the relief of the seafloor, the period of time available
for the calibration etc., but as a rule eight crossing lines is
recommended. Eight crossing lines balance the requirement of
accuracy and the cost of running the calibration lines.

How to run SeaCal
There are several ways to run SeaCal, but to get a safe and fast
verification of the calibration parameters, the following
procedure is recommended.
1 Apply eight crossing calibration lines as defined in the

Configurations figure below.
2 Run the calibration with all parameters.
3 Run the reliability computation.

4 Introduce the calibration values with green reliability
factor into the multibeam system.

5 Run a new calibration to verify the new settings.
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Figure 63 Different configurations of
calibration lines

Resolution

The resolution of the grid model applied in the calculation
effects the computing time. The option auto asks SeaCal to
compute the resolution, but you can also define the resolution
manually.

Maximum number of iterations

Usually, SeaCal needs two or more iterations to compute the
calibration. You can define the maximum number of iterations
manually, or you select auto, i.e., SeaCal iterates until the
solution is stable.
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More on the field calibration method
A strength of our approach is that all the survey lines are
utilized in an optimal way, i.e., survey lines which cannot
determine a parameter, will have minor influence on the
computation. For a thorough description of the method see [2].
Often the eccentricity of the transducer is measured by land
surveying methods. Since our calibration method considers the
horizontal offsets in x and y, it can control that the horizontal
eccentricity values are loaded correctly into the multibeam
system.
SeaCal computes calibration parameters based on least-squares
adjustment as:
V= (ATP1A)−1ATP1L1 (1.1)
where V is a vector of the unknown parameters, A a coefficient
matrix, P1 a weight matrix and L1 a vector of observations.
Since the stability of the system of equations depends on the
relief of the seafloor and the configuration of the calibration
lines, restrictions are put on the unknown parameters by:
V= (ATP1A+ P2)−1(ATP1L1+ P2L2) (1.2)
where P2 is a weight matrix of the unknown parameters and L2 a
vector of a priori parameter value.
The variance-covariance matrix of the unknowns are computed
from:
QV= (ATP1A+ P2)−1 (1.3)
Here, the diagonal elements define the variance of the
parameters and the other elements their covariance. Therefore,
the variance σ2Vi of parameter Vi is derived as:
σ2Vi= QVii
and the covariance σViVj of the two parameters Vi and Vj is
computed as:
σVi,Vj= QVij
The correlation coefficient σViVj measures how separable two
parameters Vi and Vj are and is derived from QV as:

ÃVi,Vj=
σVi,Vj
σViσVj

(1.4)

In multibeam echo sounder calibration we usually have limited
knowledge of the stochastic properties of the observations.
Therefore, the standard deviation of the parameters we compute
from (1.3), will be too optimistic. For this reason, we define a
reliability factor R which measures the ability of the geometry
to determine the calibration parameters.
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The computation of R is done in a simulation procedure. In the
first round the calibration V′ is computed. Thereafter, the
measurements are corrected according to vector Á of offset
values and a new calibration V′′ is computed with Á as the start
value of the computation. Ideally, V′ and V′′ should be equal,
but due to many error sources, the two may be different. The
reliability factor for parameter v is computed as:

R=1− v′ − v′′Áv
 for|v′ − v′|< |Áv|

0otherwise
(1.5)

From the definition we recognize that R is defined on the
interval [0,1]. Factor 1.0 means that the simulated offset is
completely determined, but from the factor value considered, we
cannot draw the conclusion that the parameter is computed with
no uncertainty. The maximal factor value only tells us that we
have a strong geometry. In general, we can say that for low
values of the reliability factor we should supplement the
configuration with additional calibration lines.

The interpretation of R must also consider the weight of the
parameters. If R≈ 1, it may happen that the parameter is given
high weight. This is the case if the parameter is to be fixed to its
initial value.

The reliability test is very important since it gives a
comprehensive control of the calibration. Generally, it is hard to
prove that a computer program works as it should, but the
reliability test covers both the implementation of the calibration
procedure as well as the configuration of the calibration lines.

The calibration lines must follow straight lines, i.e., curved
calibration lines are not allowed. The number and the length of
the lines are limited by the amount of computer memory and the
speed of the computer processor.
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7.27 C-MAP CM-93/3

What it does
The C-MAP CM-93/3 Professional is a global chart database
intended for use on advanced electronic charting and navigation
systems.
CM-93/3 supports all the new object classes and attributes
defined by S-57 Ed. 3.0, as well as the S-57 data model and
updating mechanism.

Note The information in this chapter originates from C-MAP
technical documentation.

Specification of minimum performance
The C-MAP CM-93/3 Software Development Kits (version 3.0)
have been designed to allow manufacturers to implement the
various C-MAP CM-93/3 chart databases into their navigation
and land based systems. In order to ensure that the CM-93/3
cartography is used and displayed correctly within
manufacturers systems, the Specification of Minimum
Performance document to which we will run a system audit on
completion of the software development.

C-MAP S-57 Verifier and CM-93/3
Compiler

Installation

The S-57 verifier and CM-93/3 compiler (hereafter called the
compiler) is installed together with the software distributed by
the manufacturer. When this software is installed you should
ensure that the eToken (part number: CM-eToken-S57) is
inserted into one of the available USB sockets. This eToken is
used to unlock the compiler and to license CM-93/3 charts.
Once the software is installed clicking on the icon will start the
compiler.
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The compiler main screen looks approximately as follows:

Using the compiler

Browse to the location of the stored S-57/3 charts in the left
hand window (normally in an ENC_ROOT directory), and enter
the issuing Hydrographic Office at the top of the right hand
window. The issuing Hydrographic Office code is always the
same as the first two letters of the file name. For example a
Norwegian ENC may read something like “NO2B0412.000”
and therefore the issuing HO code is “NO”.

Enter the destination path for the compiled database. This
should be an existing directory on the hard disk (for example
C:\ENC).

Click on Execute to compile the S-57/3 charts to CM-93/3. If
the S-57/3 is fully compliant with the IHO specification, the
charts will be compiled into a local CM-93/3 database and
automatically registered in the database administrator. They can
then be viewed on the screen by either setting the ENC database
as default or by opening the application and go to the Add
Database option to add the recently imported S-57/3 into the
current view.
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During the verification phase it may become evident that the
S-57 files being imported are not fully compliant with the
S-57/3.1 specification. If this is the case then one or more
warnings or errors will be displayed and the user will be given
the choice to CONTINUE (in which case the compiler will
continue verification but not compiler the database), to SKIP
(the database will be compiled but may contain serious errors)
or to CANCEL. In general warning messages will not stop the
compilation process but errors may cause the database to be
incorrect or even the system displaying them to crash.

The C-MAP Cartographic Service

Overview

The system that you are now using has the capability of using
and displaying the latest C-MAP CM-93/3 worldwide vector
chart database. These charts are fully compliant with the latest
IHO S-57 3.1 specifications and, when using the CM-93/3 ENC
database in an approved ECDIS, are considered equivalent to
the navigational charts required by the SOLAS (Safety Of Life
At Sea) convention.
In order to prepare the system for use with the C-MAP CM-93/3
database, there are a number of things that will first need to be
carried out: -

Registration of the system at C-MAP Norway

When a system is installed that has the capability to use the
CM-93/3 database, it is required that an Aladdin eToken
supplied by C-MAP is connected to the system (if the system
has and supports USB). The eToken provides the system with a
unique System ID that enables C-MAP to issue correct licenses.
The actual System ID can be found on the eToken itself, on the
back of the installation CD box or on a sticker placed on the
equipment. This ID must be quoted on all chart orders, either by
email (license@c-map.no) or by fax +47 51 46 47 01.
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When a system does not have a USB port or does not have
support for the eToken, a file called USER.USR will be
automatically created during initial installation (normally in the
Program Files\CM93v3 SDK directory). This file contains the
Company ID and System ID assigned to the ECDIS/ECS system
when it is installed. These ID’s can be found on the back of the
installation CD box or on a sticker placed on the equipment.
This file must always be sent to C-MAP Norway by email
(license@c-map.no) when installing the software. Licenses can
only be generated once this file has been received and registered
by C-MAP. It is important to note that the software may need to
be reinstalled and reinitialised if the operating system or
hardware is upgraded (see the troubleshooting section).
Please note that in some cases the manufacturer of the system
will have already pre-registered the system by sending the
USER.USR file to C-MAP.
If during installation you do not know your Company ID or
System ID, please contact C-MAP Norway before continuing
installation of the software.

Ordering charts

A chart order may be sent together with the registration of the
system as described above. It is essential that the required
information be sent to C-MAP when ordering charts for a
system. C-MAP has issued order forms specifying the
information that is required, and contains vital information that
will allow us to monitor and maintain your licenses throughout
the lifetime of the system. Charts can be ordered by Zone, Area
or Cell and these can be seen on our Internet pages at
www.c-map.no or by downloading the Chart Product Catalogue
also available on the web site. Price quotations can be obtained
via your chart dealer or direct from your local C-MAP office.
Once the license order has been prepared it should be emailed to
license@c-map.no or faxed to C-MAP Norway AS (+47 51 46
47 01).
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Applying licenses

Once the order has been received at C-MAP, a license will be
generated and transmitted back to the user. This may be in the
form of a single alphanumerical string (16 characters), or in the
form of a file called PASSWORD.USR. Once this license has
been received it should be input using the License Administrator
software designed and supplied by the ECDIS/ECS
manufacturer. There are two types of licenses, purchase and
subscription. Purchase licenses are valid indefinitely while
subscription licenses need to be renewed each 12 months from
the start of the subscription. Failure to renew a subscription will
result in the charts becoming unavailable.

Troubleshooting

If you are having problems installing your software or charts
please check the following before calling C-MAP: -

• You are installing on Windows NT, Windows 2000 or
Windows 98 second edition. The system will not normally
run under Windows 95 or Windows 98 first edition.

• That you have registered the WORLD database in the
GDBADMIN application.

• That the registered WORLD database is available. If you are
running the database from the CD drive, the CD-ROM must
be loaded.

• That you have correctly typed the license string.

• That you have not reinstalled Windows or any major
hardware components. If you have done this you will
probably need to reinstall your software (only required for
systems that are not using eToken).

Contact Information

For information or help please call you’re nearest C-MAP
Office (details can be found on the reverse side of the C-MAP
chart CD box) or contact C-MAP Norway: -

C-MAP Norway AS
Post Box 212
Hovlandsveien 52
4379 Egersund
Norway

Tel. +47 51464700
Fax.+47 51464701
Email: technical@c-map.no
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7.28 SVP Editor

What it does
The SVP Editor is used to edit the sound speed profiles logged
in .asvp-formatted files. There are a number of tools to help the
operator to create a good sound velocity profile, including
manual editing. The main user interface for the SVP Editor is
displayed below.

Figure 64 SVP Editor main user interface

How it works
The user can read in and display several sound velocity profiles
at the same time, and the program can be started with filenames
so that the profiles are read in and displayed when the program
starts.

Pulldown menus

There are two pulldown menus Primary svp and Secondary
svp. These menus display a list of all the profiles that are read
into the program.
The primary svp is drawn using red circles and white lines, the
secondary using blue circles and green lines. All others are
drawn using gray circles and gray lines.
The numerical table to the right shows the data from the primary
svp. The operator can at any time change the values in this table.
Press “Return” to see the effects in the profile.
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The operator can select one value in the profile, and then the
row in the table will be selected as well. Note that the table may
be too big to fit in the window so the operator may have to
scroll the table to see the selected row.
Buttons

Copy row: This button copies the selected row in the table. This
allows the operator to add values to the profile because he can
then edit the copied row and change the data in it.
Delete row: Deletes all selected rows in the table.
Reset seletions: Resets all selections.
Redraw: Redraws the profile. The user must use this button
after selecting rows in the table to see where the selected values
are in the profile.
Calculate max. depth scale: By default the profiles are drawn
using 100 meters as maximum depth. Pressing the button will
cause the profiles to fill the entire window. You normally have
to press this button only once after reading in an profile.
From depth: This scroller is used to set the start depth to be
drawn. It can be used to scroll up and down the profile and the
profile range will remain constant, the To depth will be updated
when the operator uses the arrow buttons to scroll up and down.
The operator can also set this value from the keyboard and press
“Return” to see the effect.
To depth: Set the maximum depth to be displayed. This value
can never be less than 5 meters larger than From depth. When
the user presses the arrows to change this value, the profile will
stretch and shrink because the From depth is kept constant. The
operator can also set this value from the keyboard and press
“Return” to see the effect.
From speed: Set the minimum speed to be displayed. It can be
used to scroll the profile in the speed direction. The range will
remain constant as To depth is updated. The operator can also
set this value from the keyboard and press “Return” to see the
effect.
To speed: Set the maximum speed to be displayed. When the
user presses the arrows to change this value, the profile will
stretch and shrink in the speed direction because From speed is
kept constant. The operator can also set this value from the
keyboard and press “Return” to see the effect.
Automatic speed scale: When this button is enabled, From
speed and To speed are overridden and the minimum and
maximum speed is calculated automatically from the values in
all profiles.
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File menu

Open: Open a .asvp -file and make the profile primary.
Open in editor: Open selected file in a separate raw editor
program.
Save as: Save the primary svp with a name of your choice.
Save primary svp: Save the primary svp to its original file.
Note that this file will be overwritten.
Send primary svp to echosounder: Information about the
primary svp is sent to SIS where all mean absoption coefficients
are recalculated using the depths found in the .asvp -file. Note
that to actively use this svp it must be selected by the operator in
the Sound Speed frame in the Runtime parameters view
→ See page 225.
Close primary svp: Close primary svp and remove it from the
editor. Note that it will not be saved.
Close all: Close all profiles and remove them from the editor.
Note that the profiles are not saved.
Exit: Exit the program. Note that unsaved profiles are not
saved.

Tools menu

csv2asvp: Launch the program csv2asvp which helps you to
convert data from the Smart Probe logged in .csv-files using the
program Smart Talk. The output from csv2asvp is .asvp -files
which can be edited in SVP Editor.
→ Smart Talk, page 447.
Morse: Launch the Morse logging program. This program will
log data from the Morse sensor to an .asvp-file which can be
edited in SVP Editor.
→ Morse SVP, page 452.
Extend profile: The profile will be extended down to 12,000
meters. Note that the profile must be continuous for this
operation to be carried out. If not all depths in the profile are
ascending, the rows where the depth is equal or above the
previous row will be selected. The operator can then press
“Delete rows” and delete them. Now this operation can be
carried out.
Thin profile: Thin the profile by removing some points. The
operator types in a thinning factor (0.01 to 3.0). The smaller the
factor, the less thinning will be done. The results from the
thinning is then presented in a table, see the figure below. Note
that this operation requires that the profile is extended.
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Replace primary with data from secondary: If the primary
svp contains depths from 0 to 12,000 meters and the secondary
contains data from 0 to 100 meters, the values from 0 to 100
meters in the primary svp will be replaced with the data from
the secondary svp.

Thinning results table

The thinned primary svp is written to a file with thinned added
to the filename of the primary svp. This thinned profile is then
automatically read into SVP Editor.

The Thinning results table shows the results from using the
original and the thinned profile. Each table has selected beam
pointing angles as columns and selected depths as rows. The
approximate depth used is listed in the column to the left.

Figure 65 Thinning results table (example)

Note that the depth used in the calculations will differ from this
depth because the raypath routine requires time as input, and the
time is computed from the depth and the average sound speed in
the profile, which will be different from the true profile.

In the first table the depths from the two profiles are shown, and
in the second table the horizontal placement is shown using both
profiles.
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In the text field on top the operator can set the difference
between the two profiles to be shown. If the difference between
the original and the thinned profile is larger than the values set
(remember to press “Return” for the value to take effect), the
background of the cell will be set to red.
The operator can save these results to file by pressing the
“Print...” button.
Press “OK” to return to the SVP Editor.
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7.29 Smart Talk (SVP)

What it does
The Smart Talk program is used by SIS to configure and
download data from sound velocity probes by Applied
Microsystems. The program is installed using the SIS CD.
Normally the Smart Talk program is located under C:\Program
Files\SmartTalk. If the .exe file is not routed to the desktop, the
Smart Talk program can be started from this location.

How it works
The following tasks can be performed from the application’s
main window:
• Configure instrument
• Download data
• View data
• Communication settings
• Configuration
• Sensor calibration
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Configure instrument
Press the “Configure instrument” button to configure the
profiler prior to a sound velocity dip.
The profiler is connected to a serial port on the SIS PC, and it is
automatically detected by the PC.

Select the requested instrument from the list and press the
“Configure” button to open the Configuration dialogue.

Configure the profiler. Remember to enter a file name in the
“Log File” text box. When finished, press the “Program
Instrument” to load the settings into the profiler.
The profiler is now ready to be disconnected and launched.
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Download data
Press the “Download Data” button to download SVP data after a
sound velocity dip.

Select the requested instrument from the list and press the
“Select” button to open the Download Files dialogue. All files
logged inside the profiler is now displayed.

Select the correct file in the Directory listing. Specify the path
to where you want the file to be stored.
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View data

Press the “View Data” button to load the profile and inspect it.
In the View Data dialogue, press the “Load File” button to
browse for and open the requested SVP file.

The data is logged for both downwards and upwards movement
in the water column.

Press the “Export” button to open the Export File dialogue.

In the Destination File Name text box, type the SVP file name
and add the extension *.csv. Press the “Export Files” button.



Technical references

451850-164709 / E

The sound velocity file includes components from both
downwards and upwards SVP data in the Water colunm. The
program csv2asvp.jar will split the data into two separate files
automatically. This program is located under C:\Program
Files\Kongsberg Maritime\SIS\bin.
Start the program. Press the “Choose file” button to browse for
the SVP file. After selecting the requested file, press the “OK”
button in the Message dialogue.

The file is now split into *_downward.asvp and *_upward.asvp
components.
It is vital that valid sound velocity data is deeper than your
surveying depth. If this is not the case, use an ASCII editor to
extend the profile.
Finally the SVP data can be activated in the echo sounder. This
is done in the Sound speed dialogue located under the Runtime
parameters tab.
Related topics

→ Sound velocity profile window, page 120.
→ Runtime parameters, Sound speed, page 225.
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7.30 Morse SVP handling

Running the program
This program is an interface program for handling the Morse
SVP sensor. In the file morse.bat an instance of the program
RS2UDP is started. This program sets up the communication to
the serial port and the relay of data to a network port (UDP).
This UDP port is then input to the program that reads the serial
port. Please make sure that the settings to the serial port are the
ones used by the Morse SVP sensor.
The program requires that the environment variable
JAVA_HOME is set and that java is found in JAVA_HOME\bin.
Also perl must be in the path, and explorer must be found at
c:\windows\explorer. You can change this in the file help.pl if
necessary.

Using the program
The main user interface holds the following:
File to log raw data to...: Select the raw data destination file
for the data from the SVP sensor.
SVP file to write...: Set the filename the SVP will be written to.
This file should end with .asvp.
Latitude in degrees: Enter the latitude in degrees. It is used to
calculate the correct depth.
Surface pressure in bars: Enter the surface pressure in bars. It
is used to calculate the correct depth.

When the operator presses “Start”, the values from the UDP port
will be displayed in the SVP window. When the operator presses
“Stop”, the contents of the .asvp-file is shown.
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Figure 66 Morse SVP main user interface

Notes
The .asvp-file should be edited afterwards. The time and the
location in the header is not correct and should be corrected by
the operator.
The operator should also make sure that the profile contains a
value at exactly 0.0 meters depth, and at 12,000 meters depth.
If the file contains a great number of values, the operator should
concider thinning the values.
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7.31 How to use SIS on an AUV

Overview
This chapter explains how to use SIS on an Autonomous
Underwater Vehicle (AUV) where the EM 2000 echo sounder is
installed.

Procedure
In the figure below we see how the EM 2000 on board the AUV
is assumed to be controlled. When SIS starts up, it will search
for all echo sounders in the network, so as long as the Ethernet
is set up correctly, the EM 2000 will broadcast its existence and
SIS will pick it up.

Figure 67 Setting up the EM 2000 on the
AUV from SIS on the ship

1 First attach the internal disk in the EM 2000, see
document “Datagram Formats” (reg. no. 850-164602)
under PU Setup Command, on how to do this.

2 Open SIS, and go to Installation Parameters, see the
Enable PU logging to local disk chapter below.

3 In Installation Parameters, see Default or current settings
at PU startup chapter below.

4 In Installation Parameters there are four UDP port
numbers, labelled UDP 1-4. When using EM 2000
logging to internal disk, UDP 4 is renamed to PU
Logging. Note the UDP port number in use by UDP 2
because this is the port number where the third party
software shall listen for data on.

5 You can now shut down SIS and restart the EM 2000.
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When the EM 2000 is powered on again, it will start with the
installation parameters set. Datagrams will be sent to the UDP
ports as defined, and any software can be used to read these
datagrams.
To turn on logging, send datagram P10 to port 2012 to the PU.
The P10 datagram is described in the document “Datagram
Formats” (reg. no. 850-164602) under Remote control
command to PU. To stop logging, send P02.
In the figure below we se how the EM 2000 is set up afterwards.
P10 and P02 control datagrams are used to start and stop the
logging to disk.

Figure 68 How the
EM 2000 is set up

Enable PU logging to local disk

Note This feature is only available for EM 2000 and EM 3000.

The SIS user can turn this logging on and off by using a simple
tick button in the installation parameter’s ’Output Setup’ frame.
When this tick button is set, the ’Host UDP4’ port entry in the
’UDP Host Port’ combo box is substituted with a ’PU Logging’
port. By selecting this ’PU Logging’ port it is possible to select
which datagrams that should be logged to the PU hard disk.
Initially a default datagram selection is presented, but it is
modifiable by the operator as indicated.
When PU logging is set the port number displayed is 2999. This
is just a dummy number signifying that the PU is logging to
disk.
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The selected ’PU logging’ setup is activated (i.e. ’PU logging’
turned on or off) when the ’OK’ button is pressed.
Note that when the PU is logging to disk it will not send ANY
datagrams out on the ’Host ’UDP4’ port.
Note that when the PU logging feature is turned off (i.e. tick
button deselected) the normally configured settings for Host
UDP4 will be used again. Remember to press the ’OK’ button to
activate the new setting.

Default or current settings at PU startup

Note This feature is only available for EM 2000 and EM 3000.

When the PU is turned on this feature will enable the PU to use
a standard (factory) parameter setup or a setup previously
configured and installed in the PU by SIS.
In the latter case the PU may subsequently be started
independently, without SIS connected. This capability will
allow an AUV/ROV operator to use SIS to initialize the PU
with a specific setup before disconnecting SIS and launching the
AUV/ROV into the water.
The user can control of this feature by a pair of radio buttons
found in the installation parameter’s ’ROV. Specific’ frame. The
radio buttons are labeled ’Use default settings at PU startup’ and
’Use current settings at PU startup’ respectively.
The procedure for setting the PU to use the current parameter
setting is as follows:
1 The PU must have been started by SIS.
2 Configure the required installation and runtime parameters

as required using the normal configuration procedure.
(Specifically make sure to press the ’PU Installation OK’
button.)

3 In the installation parameter’s ’ROV Specific’ frame press
the ’Use current settings at PU startup’ radio button.

The PU is now configured and the current setting stored for use
when the PU is turned on again.
The procedure for setting the PU to use the default (factory)
parameter setting is as follows:
1 The PU must have been started by SIS.
2 In the installation parameter’s ’ROV Specific’ frame press

the ’Use default settings at PU startup’ radio button.
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The PU will now use the default (factory) settings when it is
turned on the next time and it will normally require that SIS is
connected to initialize and control it.
Note that when the radio buttons are pressed a signal is sent
directly to the PU without the need to press the OK button (as
for normal installation parameters). Therefore, when the ’Use
current settings at PU startup’ radio button is pressed the
required setup must already be present in the PU using the
procedure above.
Note that after the ’Use current settings at PU startup’ radio
button has been pressed the PU parameter setup at that time is
remembered and used during next startup. If further installation
and runtime configuration are performed, without pressing the
radio buttons again, the changed configuration will be used until
the PU is turned off and on again.

Fetch and delete data from the internal
harddisk
FTP can be used to fetch and delete data from the internal
harddisk, or replace the disk with another and insert it in another
PC to read the data.
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7.32 Javad and Trimble details
The user has to start the necessary modules to enable logging
from a Javad or Trimble GPS receiver. Each module is
described in sub-chapters, after the following manual start-up
procedures.

Note The “(space)” remark indicates space key in the start-up
commands; the letters are not a part of the commands.

Note Fill inn the constituent data file or port number between the
brackets <...>.

Mean Sea level module
- Windows:

sisMSL -d “C:\Program Files\Kongsberg Maritime\SIS\
bin” -i 9044 -o 9041

- LINUX:
./sisMSL -d /usr/local/sis/bin -i 9044 -o 9041

Real time tide module
- sisTide -f <constituent data file> F tide5.dat -i 1 -p(space)

9041 -p 4001
Here the Mean Sea level module is set up to receives GGA
messages from the Javad receiver and the Real time tide module
sends data to the gpsraw module logging data from the Javad
receiver.

Javad GPS receiver
- RStoUDP -com <port number>,19200,8,0,1 -udpin(space)

9049 -udpout localhost,9050 -bin
- gpsraw -p 1 -t JAVAD -i 9050 -u 9049 -c 9041 -e(space)

4002 -n 4002 -g 9044
Trimble GPS receiver

- RStoUDP -com <port number>,19200,8,0,1 -udpin(space)
9038 -udpout localhost,9039 -bin

- gpsraw -p 2 -t TR4000SSE -i 9039 -u 9038 -c 9041(space)
-e 4002 -n 4002 -g 9033

Raw GPS data logging module
The raw GPS data logging module enables the user to log raw
GPS measurements from a high quality GPS receiver, thus
enabling the user to post process the data using any available
tool, for example AbsPos (available autumn 2005 from Terratec
AS).
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At the moment, two different GPS receivers are supported:
Javad and Trimble 4000 series (tested with Trimble 4000 SSE)
Starting the programme with the option -h (gpsraw -h) gives the
following output, which should be self explanatory:
gpsraw $Revision: 1.4 $
Usage gpsraw [options]

-p <1-3> Set positioning system number
-t <gps receiver type> (JAVAD or TR4000SSE)
-i <portnum> Reads data from this port [in]
-c <portnum> Control port [in]
-e <portnum> Port for error messages [out]
-u <portnum> Port for messages to gps receiver [out]
-g <portnum> Port to receive GGA NMEA messages [out]
-n <portnum> Port to receive all NMEA messages [out]
-d Show debug messages
-v Show version and exit
-h Show this help

This programme reads raw gps data from one UDP port,
interprets and logs the the data to a file, extracts nmea messages
which may be distributed to other programs. It may control the
gps receiver by writing control datagrams to the gps receiver. It
reads control datagrams which may start or stop logging to file,
or set fixed hight (if supported by the receiver).
NMEA messages may be distributed to multiple ports, by
repeating the options -g and/or -n.
For output ports the port may be given as port, name:port or
ip:port A control port (-c) and an inport (-i) are required
options.
The control datagrams that are understood are:

- $KSSIS,102,dirname,ON (Start logging in given
directory)

- $KSSIS,102,dirname,OFF (Stop logging)
- $KSSIS,103,ON (Set fixed height)
- $KSSIS,103,OFF (Reset fixed height)
- $KSSIS,105,23.45 (Geoidal separation in

meters)
- $ATIDE,20051225123022,2.45 (Time and tide value

[meters])
- <Installation datagram> (To get antenna height)
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The error messages which may be returned to the port given by
-e have the form:

- $KSSIS,104, ; message text which may be long...

Mean Sea level module
The mean sea level module calculates the Mean Sea Level (in
many places almost the same as Geoid) from a set of input files
and interpolates accordingly to a position received as a GGA
message on an input (UDP) port. It sends the MSL value in the
given position to those who need it, in particular the raw gps
logging module, which needs it for calculating antennae height
when too few satellites are visible.
The programme is started from a command file or from a
terminal window and using the -h option gives the following
information:
Usage sisMSL <options>
Where options are:

- h Prints this help
- d <directory> Where to search for data files (required)
- p <pattern> Pattern used in search. Default: .grid
- i <portnum> Where to receive GGA messages from

(required)
- o <portnum> Where to send geoide separation (Can be

repeated. At least one is required)
- D Prints debug information

This programme reads geodie separation files from a directory
and interpolates in the files from a position received on a port
with NMEA GGA messages The ports can be given as either
hostnum:port, ip:port or just port.

Real time tide module
The real time tide module calculates the tide from a set of input
files. One normally called ”tide5.dat”, can be generated, and the
other contains the constituents for the nearest harbour. The
programme can calculate the tide using phase and amplitude
offsets as well as correcting for the current air pressure (given
that the correct tide is known). The internal clock of the
computer must be correct for this real time module to work
correctly.
The programme has also the capability to make a prediction file,
using other options.
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A typical usage for the programme, with typical options which
gives the tide corrected to LAT are:

- sisTide -f stavanger.xdo -F tide5.dat -p 4001 -s 1.1(space)
-t 12 -l 0.05 -z 0.65 -i 10

By using the -h option the following help message is returned:
use sisTide [options]

-h Show this message and return
-v Show version and return
-c Show copyright notice
-q Show file formats and return
-f <filename>Read constituent data from this file
-F <filename>Read Foreman data from this file
-i <number> Interval for sending or calculating data [min]
(default 60)

The following two options are for sending real time predictions:
p <portnum> Send to port (default localhost:4001)

The following two options are for generating predictions for a
date:

-D<YYYYMMDD> Start date for predictions
-d <number of days> Number of days to give predictions for
(default 1)

Note If -D is given, -p ignored.

Options for changing the calculations:
-a Amplitude factor (default 1.0)

Multiply the result with this factor.
-t Secondary harbour time correction [min] (default 0)

Added to time before calculating tide (delaying tide)
-l Level correction [m] default 0.0

Add to tide after calculations
-z Use this level (positive number) [m] for Z0 (default 0.0)

Add to tide after calculations

Note Z0 value from file is never used.

Constituent (-f) and Foreman (-F) files must always be given.
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Note Predicted tides are always referring to UT (GMT). This can be
changed using -t option (-t60 gives MET).

Note Environment variable TZ must be correctly set to get correct
real time predictions. (e.g. TZ = MET - 1METDST).

Note Predicted tides are calculated relative to mean sea level unless
Z0 (-z) and/or level corrections (-l) are given.

Note The results are negated so ADDING the results to measured
depths should give tide-corrected depths.

RStoUDP
The RStoUDP module makes it possible to control/receive data
on UDP from equipment attached to RS232 serial lines:
Usage RStoUDP -com
<prt>,<baud>,<databit>,<parity>,<stopbit> -udpin <port>
-udpout <ip,port> -udpout[1-4] <ip,port> -ts -distudp -log
<logfile> -confsock <port> -bin <buf size> -t <timeout (usec)>
Legal values for parity is 0=none, 1=odd and 2=even
Where:
-com (Comm port to use)
-udpout (Port nr. for incoming data)
-ts (Add timestamp to ASCII data)

-udpout[n] (Additional output sockets)
-distudp (Distribute incoming udp data to all udp out sockets)

-confsock (Socket for incomming config messages)
-bin <size> (Binary mode and buffer size)
-t (Timeout value when reading binary data)
Example: RStoUDP -com 4,9600,8,0,1 -udpout(space)
localhost, 2020 -log log.dat
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7.33 Difference in log file formats
SIS logs various types of datagrams from the echosounder in a
continuous stream. Each time the operator starts a new line, a
new survey data file is created which results in a break in the
data stream such that a depth datagram may be located at the
end of one file with its associated position datagram located at
the beginning of the next.
When SIS generates xyz-data from these files, if it encounters a
depth datagram at the end of the file for which there is no
corresponding position datagram, it looks for the missing
position datagram in the next survey file. However, when
Neptune generates xyz-data from these files, if it can’t find a
valid position datagram after the last depth datagram, it will
reject the depth datagram resulting in a “hole” in the data.
Previous versions of the Merlin logging system handled this
situation by storing duplicate position datagrams in both survey
files, but this is no longer done. Therefore, to eliminate this type
of “hole” when generating xyz-data, Neptune will be updated
with a tool that will insert the missing position datagram at the
proper location in the survey data files.
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8 MAIN INDEX
The next pages present the main index of this manual.
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